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Dear Reader,

Thank you for choosing Introducing Autodesk Revit Architecture 2011. This book is 

part of a family of premium-quality Sybex books, all of which are written by outstand-

ing authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to produc-

ing consistently exceptional books. With each of our titles, we’re working hard to set a 

new standard for the industry. From the paper we print on, to the authors we work with, 

our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your com-

ments and get your feedback on how we’re doing. Feel free to let me know what you think 

about this or any other Sybex book by sending me an email at nedde@wiley.com. If you 

think you’ve found a technical error in this book, please visit http://sybex.custhelp.com. 

Customer feedback is critical to our efforts at Sybex. 

	 Best regards,

	  

	 Neil Edde

	 Vice President and Publisher

	 Sybex, an Imprint of Wiley



Writing Introducing Autodesk Revit  Architecture 2011 

in the allotted timeframe required a lot of support.  ■  A special thank-you to Randy 

Anderson for stepping into the role of technical editor.  ■  We also want to thank the 

editors—Willem Knibbe, Pete Gaughan, Dassi Zeidel, Kim Wimpsett, and Rebecca 

Rider—for all their support and patience: We really do appreciate it.  ■  We want to thank 

Eddy Krygiel of HNTB for making this opportunity happen.  ■  Finally, we want to thank 

our family, friends, and employers. Even though the timeline was short, it required a lot 

of effort, and your patience is appreciated.

Acknowledgments



Patrick Davis is the manager of virtual design and construction at 

PBS&J headquartered in Tampa, Florida. He has used Revit since 2004 

to complete projects of all scopes and sizes. He is one of the founders of 

the Kansas City and Tampa Bay Revit User Groups. He instructs practic-

ing architects, engineers, and technicians to use Revit as part of a college 

curriculum. He has also been involved in the development of national 

BIM standards and has served as the communication task chairman for the National 

Building Information Model Standard (NBIMS). In his spare time, he enjoys riding his 

Harley to visit new parts of the country.

Charlie Busa joined Autodesk in 2007 after more than a decade and a 

half of experience in the AEC field, working primarily with architects, 

engineers, and corporate management staff to help them determine 

and plan optimal methods for implementing Revit BIM solutions that 

meld with their current, and future, processes. His product focus is on 

Revit Architecture and Revit Structure. He spent the majority of time 

prior to joining Autodesk operating his own firm, providing consulting and design services 

as well as training and implementation offerings. Charlie is also a frequent presenter at 

Autodesk University on multiple Autodesk products and multiple topics from BIM to visu-

alization. When not involved with BIM, Revit, and computers, Charlie enjoys good food, 

both cooking and eating it, as well as spending time in the garage performing motorcycle 

maintenance on his road-racing bikes.

About the Authors



Beau Turner is an architecture, engineering, and construction technol-

ogy subject matter expert with more than 15 years experience in tech-

nology consulting and design. Beau works with emerging technologies 

and programming APIs and blends these together with existing and 

new workflows to streamline and enhance documentation capabili-

ties through the use of technologies such as CAD, BIM, visualization, 

laser scanning, and facilities management. He has consulted with hundreds of compa-

nies across the United States to bring about successful technology shifts and is a regular 

speaker at industry events, such as Autodesk University.

Steve Stafford started using Revit at work in 2002, though he used 

it informally from its inception in 2000. In 2005, he formed Stafford 

Consulting Services to provide training and implementation support 

to firms that are using or intend to use Revit. He has since reorganized 

under the business name AEC Advantage, Inc. Steve has been very 

active in the Revit community. He was part of the Revit community 

forum at Zoogdesign, and he now serves as the forum manager for the Autodesk User 

Group International (AUGI) Revit community. He is also currently serving his first 

term as a member of AUGI’s board of directors. He has presented classes at Autodesk 

University since 2004 and at the Revit Technology Conference in Australia since 2006. 

He created, writes, and manages three Revit blogs: www.Revitoped.com, www.revitinside 

.com, and www.revitjobs.com. He lives in Southern California with his wife and two 

children.



CO NTE NT S at   a  glance    

Introduction	 ■	 xiii

Chapter 1	 ■	 The Revit Architecture User Interface    1

Chapter 2	 ■	 Views    15

Chapter 3	 ■	 Modeling    43

Chapter 4	 ■	 Constraints and Dimensions    115

Chapter 5	 ■	 Visibility Controls    135

Chapter 6	 ■	 Introduction to Families    167

Chapter 7	 ■	 Massing    183

Chapter 8	 ■	 Groups    235

Chapter 9	 ■	 Rendering    249

Chapter 10	 ■	 Working with Other Files    269

Chapter 11	 ■	 Rooms and Areas    299

Chapter 12	 ■	 Tags, Schedules, and Keynotes    315

Chapter 13	 ■	 Detailing    335

Chapter 14	 ■	 Sheets    359

Chapter 15	 ■	 Design Options    389

Chapter 16	 ■	 Phases    401

Chapter 17	 ■	 Creating Families    415

Chapter 18	 ■	 Revisions    465

Chapter 19	 ■	 Collaboration    473

Index	 ■	 497





Introduction	 xiii

	 Chapter 1  ■  The Revit Architecture  
User Interface	 1

The Home Screen	 2

The Main Screen	 3

	 Chapter 2  ■  Views	 15

Zoom and Pan Tools	 16

View Properties	 21

Other View Controls	 32

Adding New Views	 35

	 Chapter 3  ■  Modeling	 43

Levels	 44

Basic Editing Tools	 50

Creating and Modifying Column Grids	 61

Walls	 65

Modifying Wall Parameters	 69

Defining Wall Structure	 73

Creating Doors and Windows	 84

Creating Curtain Walls	 87

Creating Floors	 96

Creating Ceilings	 98

Creating Stairs	 104

Creating Roofs	 109

	 Chapter 4  ■  Constraints and Dimensions	 115

Temporary Dimensions	 116

Permanent Dimensions	 121

Equality Constraint and Lock	 127

Contents

Roof profile Roof reference plane

 Interface	

	
	

	

	
	

	
	

	 43



Spot Dimensions	 130

Units	 132

	 Chapter 5  ■  Visibility Controls	 135

Essential Concepts of Visibility	 136

Object Styles	 137

Properties Palette for Views	 138

Visibility/Graphics Overrides	 149

View Range	 152

Filters	 157

View Templates	 160

Linked Files	 161

Worksets	 164

	 Chapter 6  ■  Introduction to Families	 167

Understanding Family Organization	 168

Working with Families	 173

	 Chapter 7  ■  Massing	 183

Mass Objects	 184

References and Work Planes	 187

Preparing to Create Mass Forms	 191

Editing Forms	 206

Loadable Mass Families	 218

Face-Based Modeling	 225

Creating Mass Families from  
Imported Geometry	 232

	 Chapter 8  ■  Groups	 235

Group Organization	 236

Creating and Editing a Group	 236

Placing a Group	 238

Special Changes to a Group	 239

Saving, Loading, and Reloading Groups	 242

Practical Considerations	 244

a: Wireframe

c: Shading

e: Consistent Colors

b: Hidden Line

d: Shading with Edges

f: Realistic

a: Wireframe

c: Shading

e: Consistent Colors

b: Hidden Line

d: Shading with Edges

f: Realistic

Surface forms

Extrusions

Revolves Sweeps

Lofts



	 Chapter 9  ■  Rendering	 249

Rendering Workflow	 250

Setting the Background	 261

Adding and Adjusting Material	 263

Real-Time Rendering	 268

	 Chapter 10  ■  Working with Other Files	 269

Linking Revit Models	 270

Controlling Display	 273

Working with CAD Files	 283

Exporting DWF Files	 294

Using Raster Files	 297

	 Chapter 11  ■  Rooms and Areas	 299

Rooms	 300

Areas	 308

	 Chapter 12  ■  Tags, Schedules, and Keynotes	 315

Tags	 316

Schedules	 320

Keynotes	 327

	 Chapter 13  ■  Detailing	 335

Detail and Drafting Views	 336

Component Symbol Fundamentals	 337

Detailing Tools	 345

Creating and Managing Detail Libraries	 355

	 Chapter 14  ■  Sheets	 359

About Titleblocks and Sheets	 360

Setting Up Sheets	 373

Organizing Sheets	 380

Exporting Sheets and DWF	 383

	 Chapter 15  ■  Design Options	 389

Design Options Terminology	 390

Setting Up Design Options	 392



Editing Design Options	 393

Applying Design Options to Views  
and Accepting the Primary	 395

Tags and Annotation in Design Options	 398

	 Chapter 16  ■  Phases	 401

Phasing Tools	 402

Phases	 405

Infill Elements	 409

Demolishing Elements	 411

Rendering and Existing Phases	 412

	 Chapter 17  ■  Creating Families	 415

Preparing to Create a Family	 416

Examining the Tool Chest	 424

The Bigger Picture and Advanced Concepts	 446

Dissecting Some Practical Examples	 452

	 Chapter 18  ■  Revisions	 465

Numbering Revisions	 466

Drawing Revision Clouds	 468

Issuing a Revision	 470

	 Chapter 19  ■  Collaboration	 473

Coordinating Work Across Disciplines	 474

Exporting to Non-Revit Formats	 481

	I ndex	 497



Introduction
Welcome to  Introducing Autodesk Revit Architecture 2011, the fourth edition of 

the Introducing Revit series. This book covers the fundamentals of using the key features 

of Revit Architecture, including many features that are new additions to the 2011 version. 

Moreover, this book offers numerous Revit tips and tricks, with ample expert recom-

mended advice and techniques. The goal is that you will be able to identify and readily 

adapt these “best practices” to your daily Revit Architecture usage.

Revit Architecture allows you an architect, designer, or technician to design and docu-

ment a virtual representation of your project. Revit Architecture is an integrated archi-

tectural design and documentation environment. You create a virtual building model 

of your design with intelligent building elements. These smart, parametric building ele-

ments automatically adjust and interact with the design environment, and at the same 

time you are creating views such as floor plans, sections, elevations, schedules, and so on.

With the maturity of Revit Architecture in recent years, more and more firms and users 

are switching from AutoCAD or MicroStation. General contractors and owners are realiz-

ing the potential of BIM and Revit Architecture and requiring it as a deliverable. Although 

easy to learn, Revit Architecture is nonetheless a complicated product, and most advanced 

users would agree that they learn something new every day. This book is for the new user 

who is looking to understand the fundamentals of Revit Architecture and how 3D can be 

more efficient than just drawing lines, arcs, circles, and so on.

Whether you are new to BIM or Revit Architecture or you are an existing Revit 

Architecture user who simply wants to make your job or upgrade to Revit Architecture 

2011 easier, this book is an invaluable resource for learning Revit Architecture.

Who Should Read This Book
This book assumes that you know little or nothing about Revit Architecture. It starts 

out slowly, covering important basics, and then progresses to more intermediate top-

ics. The concepts in this book are laid out in order of importance, beginning with four 

basic requirements for working in Revit: user interface, views, geometry creation, and 

documentation.



xiv  ■   Introduction

Although it is intended for users who are beginning in Revit through to intermediate, it 

covers some advanced topics as well. In truth, Revit Architecture has so many features and 

offers so many benefits that no one book could realistically hope to fully cover them all. 

Thus, each chapter provides an overview of the tools and workflow for that particular pro-

cess or task-related area, covering it with illustrations, tips, and techniques from authors 

who use, teach, and support the application every day.

What Is Covered in This Book
Here is a glance at what is in each chapter of Introducing Autodesk Revit Architecture 2011:

Chapter 1: The Revit Architecture User Interface introduces you to the Revit Archi-

tecture 2011 user interface and jump-starts you into your first project.

Chapter 2: Views demonstrates working with view controls such as zoom and pan  

and creating views of your building model such as plans, sections, elevations, and  

3D views.

Chapter 3: Modeling demonstrates fundamental tools you need for creating geometry 

or modeling elements. We start by using the basic wall tools and move into curtain 

walls, stacked walls, and adding doors and windows. Along the way, we also introduce 

the basic editing commands such as copy, move, rotate, trim, and so on.

Chapter 4: Constraints and Dimensions demonstrates the constraint and dimensions 

functions. We explore temporary and permanent dimensions, constraints, and best 

practices to ensure that your modeling project is properly constrained.

Chapter 5: Visibility Controls demonstrates visibility controls. We start by creating 

and using filters, using graphic overrides, using and creating custom line styles and 

line patterns, and using fill patterns, and we wrap up with using scope boxes.

Chapter 6: Introduction to Families discusses the fundamental building blocks used 

in Revit families. We discuss how to load them into the project, the basic editing tools, 

and the different types of families that you will utilize in your project.

Chapter 7: Massing discusses the fundamentals of using the massing tools. Topics 

include dealing with visibility issues, creating basic forms, and constraining masses.

Chapter 8: Groups discusses using 2D and 3D groups in your project. We start with 

creating and placing a group and then go into editing, saving, and linking groups.

Chapter 9: Rendering discusses the fundamentals of rendering. This will include 

working with basic still images, adding and managing lights, and applying materials.
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Chapter 10: Working with Other Files discusses working with files from other appli-

cations. It may not always be feasible to create your entire building project in Revit. In 

these cases, it will be necessary to import or export to other file formats. This chapter 

discusses the tools and procedures you need to work successfully with other file for-

mats being imported or exported from Revit.

Chapter 11: Rooms and Areas discusses working with rooms and areas. Topics cov-

ered will be placing rooms, creating room schedules, rooms and phases, area plans, 

and the issues associated with rooms and linked Revit files.

Chapter 12: Tags, Schedules, and Keynotes discusses creating schedules, drawing 

lists, and creating material takeoffs.

Chapter 13: Detailing discusses creating the 2D embellishments such as text, dimen-

sions, fill patterns, and so on, to your views for documenting your design.

Chapter 14: Sheets discusses creating the printed documentation required for your 

building projects. We talk about creating sheets and title blocks, printing, and manag-

ing revisions.

Chapter 15: Design Options discusses design options. Sometimes it is necessary to 

explore different scenarios. Design options provide you with the flexibility to explore 

and retain different options in your building project.

Chapter 16: Phases are distinct, separate milestones within the life of the project. 

They can represent either the time periods themselves or the status of the project at 

specified points in time. In this chapter, we will discuss the techniques used to create, 

edit, and manage phases.

Chapter 17: Creating Families is very powerful because the Revit parametric change 

engine drives them. In this chapter, we cover using templates and other modeling tools 

to create families.

Chapter 18: Revisions discusses the basics of creating revisions. Revisions in Revit can 

sometimes be a struggle because they are far from perfect. In this chapter, we examine 

what revisions will not handle and what can be accomplished.

Chapter 19: Collaboration discusses a unique feature in Revit. Unlike AutoCAD or 

MicroStation, Revit allows multiple users to work in a single project file at the same 

time. Proper Revit collaboration in the Revit environment will greatly improve the 

workflow of a project. In this chapter, we will step through using the copy/monitor 

tool, coordination view, and interference checking.



xvi  ■   Introduction

All the demo and tutorial files that are mentioned in the book are available for download 

from the book’s online catalog page: www.sybex.com/go/introducingrevit2011.

How to Contact the Authors
We welcome feedback from you about this book or about books you’d like to see from us 

in the future. You can reach the authors by writing to authors@IntroRevitArchitetcure.com. 

For more information about our work, please visit our website at IntroRevitArchitecture.com.

Sybex strives to keep you supplied with the latest tools and information you need for your 

work. Please check their website at www.sybex.com/go/introducingrevit2011, where we’ll post 

additional content and updates that supplement this book if the need arises.



C hap te r 1

The Revit Architecture 
User Interface

In this chapter,  we’ll explore the Revit Architecture user interface (UI). 

If you have never used Revit Architecture before, then you will quickly notice that this 

doesn’t even come close to resembling AutoCAD or MicroStation. There is no command 

prompt, there are no crosshairs, and the background is white, not black (though you 

can adjust that). Revit Architecture is similar to other Windows-based applications that 

utilize the Microsoft Office ribbon interface. Users familiar with the ribbon should find 

learning Revit Architecture’s UI relatively straightforward after they have learned the 

underlying concepts.

In this chapter, we’ll cover the following:

The recent files screen■■

The main screen■■
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The Home Screen
After you start Revit, you are taken to the Recent Files screen (see Figure 1.1). This win-

dow provides you with quick access to a list of the most recently opened projects or fami-

lies. The main area of the screen is divided into three areas. The top section, Projects, 

provides options for opening and creating new projects as well as icons to the right listing 

any recent projects that you have been working on. The middle section, Families, pro-

vides options for opening and creating new families as well as icons to the right listing 

any recent families that you have been working on. The bottom section, Resources, pro-

vides access to additional resources on learning Revit.

If you have started Revit for the first time, then you will only be given the option to open or 

create new projects or families. The recent files icons will display two sample projects and 

two sample families.

So you can further explore the user interface, we will show how to create a new proj-

ect; Revit provides two methods to accomplish this. The first is to click the New button 

in the Projects area. When you do this, Revit will create a new project using the default 

settings found in the default template called default.rte. This method allows you to start 

working immediately but is normally not the best method. Later in the chapter we will 

discuss how to create a new project using a user-selected template.
Figure 1.1

Recent Files screen
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The Main Screen
Now that you have started a project using the template file by clicking New, the window 

shown in Figure 1.2, which is the main screen, appears. The user interface is divided into 

several areas; we will discuss each of them in the following sections.

Application menu Quick Access toolbar Tab bar InfoCenter toolbar

Properties palette

Options bar

Ribbon

Window controls

Drawing area

Navigation bar

Project Browser

View Control bar Workset controls Design option controls Filter controls

Menu and Toolbar
Located at the top left of the screen (see Figure 1.3), the application menu gives you access 

to most of your file management tasks such as New, Open, Save, and so on, as well as 

access to exporting tools, printing, recent documents, and the Options dialog box, which 

allows you to tailor some custom settings in Revit that we will discuss later in the book. 

The right side of the application menu contains a list of recently opened files. You can use 

the pushpin icon located to the right of the filename to “pin” that file to the list, making it 

easier to find it each time you start Revit. In addition to providing quick access to project 

operations in one place, the application menu also allows you to sort and access recent 

documents.

Figure 1.2

Main screen
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The Quick Access toolbar (QAT) is filled 

with some of the most popular commands and 

is user customizable (Figure 1.4). There are 

two ways to customize the QAT. To add a tool 

to the QAT, right-click the tool on the ribbon, 

and then choose Add To Quick Access Toolbar. 

The second method is to use the Add/Remove 

buttons (Figure 1.5) at the end of the QAT to 

add, remove, and rearrange the buttons on 

the QAT. You can also right-click the QAT to 

remove icons, add a QAT separator line, and 

customize the QAT.

1. Click the Add/Remove button.

2. Choose Customize Quick Access Toolbar.

3. Use the move, 
separator, and 
delete buttons.

The QAT can appear above or below the ribbon. To change the location, follow  

these steps:

	 1.	 Click the Customize Quick Access Toolbar drop-down.

	 2.	 Scroll to the bottom of the dialog box, and select either Show Below The Ribbon  

or Show Above The Ribbon.

Figure 1.3

Application menu

Figure 1.4

Quick Access toolbar

Figure 1.5

Customizing 
 the QAT
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To the right of the QAT is the InfoCenter toolbar (Figure 1.6). You use the InfoCenter 

to search for information using keywords or phrases, to access subscription services, and to 

search for topics in the help files. 

When you want to choose a template for creating your project, use the following steps 

after you’ve started Revit:

	 1.	 Click the application menu, and select New ➔ 

Project.

This opens the New Project dialog box (Figure 1.7). Here, you have the ability to 

choose which template you want to utilize to start your project. You can also start 

your project without using a template file or create a new template file.

	 2.	 In the New Project dialog box, click Browse 

under Template File.

	 3.	 Navigate to your local project template loca-

tion, select the template file (.rts file exten-

sion), and click Open.

	 4.	 For Create New, make sure that the Project 

radio button is selected.

	 5.	 Click OK.

Ribbon
Below the application menu and QAT is the ribbon (Figure 1.8). The ribbon is the most 

common method for initiating commands in Revit to help you define your building 

project. The Revit user interface is based on Microsoft Office 2007’s ribbon interface. The 

interface is a set of dynamic or contextual toolbars that are placed in tabs in a tab bar. 

What we mean by that is if you are placing a wall, a new Modify | Place Wall tab is dis-

played with specific functionality for placing or modifying walls. These new contextual 

tabs are visible only when that tool is active.

The ribbon is broken up into two main parts. The top is the tab bar. Nine main tabs 

hold all of the tools. Clicking a tab makes it active. Table 1.1 provides an overview of the 

tools in each tab.

Figure 1.6

InfoCenter

Figure 1.7

New Project  
dialog box

Figure 1.8

The ribbon
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T a b  N a m e T o o l s

Home The tools provided are commonly used tools for creating and placing building  
elements.

Insert The tools provided are for linking, importing, and loading families, as well as for  
searching for family content online.

Annotate The tools provided are for dimensions, detailing, adding text, tagging, keynoting,  
and adding symbols.

Structure The tools provided are for adding structural members, foundations, and datum  
elements.

Massing & Site The tools provided are for creating conceptual masses and creating and editing  
site elements.

Collaborate The tools provided are for collaborating with both internal and external team  
members.

View The tools provided are for controlling graphic settings of objects, creating views,  
adding sheets, and managing views.

Manage The tools provided are for managing the project settings and environment, which 
include project settings, the project location, design options, phasing, and macros.

Modify | Tag This a contextual tab that will change based upon the operation being performed.  
The tools provided are for modifying and tagging elements.

The second part of the ribbon is a set of toolbars, one for each tab. The toolbars are 

divided into panels with each panel holding tools or options pertaining to a specific 

activity or function. If you find yourself using a particular panel over and over again, 

it can be “torn off” the ribbon and placed where you want it on the screen (Figure 1.9). 

When you do this, you are making a floating toolbar on your screen. So if you are using 

multiple monitors, you can place some of your favorite and most often used ones on one 

screen, while your model is on another. When you do this, Revit will remember the user-

defined locations of the panels the next time you open Revit. You can move a panel by 

clicking and dragging the panel label to the new location either within the toolbar or into 

the drawing area or other location on your desktop.

If you have “torn off” a panel and want to restore it, move your 

mouse cursor over the panel you want to restore. Gray bars will 

appear on both sides of the floating panel (Figure 1.10). The gray 

bar on the left side allows you to relocate the panel when you drag to the new location. 

On the right side of the gray bar, you will see a small icon; when you click that icon, the 

panel will be restored to the original location.

Table 1.1

Ribbon Tabs 

Figure 1.9

Panels can be “torn 
off” the ribbon and 

repositioned.

Figure 1.10

Panels positioning 
controls

Click icon to reset panel 
to original location

Drag to move panel
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You can customize the ribbon further by changing the view state to one of the three 

settings. You can adjust the view state by clicking the arrow control to the far right of the 

tab bar to cycle through the options (Figure 1.11), as described here:

Show the full ribbon. This is the default state and shows the tab labels, panel labels, •	

and tool icons. 

Show the tab and panel labels. When you move your cursor over the panel label, the •	

tools for those panels will be displayed.

Show tab labels. When you move your cursor over the tab label, the tools for those •	

panels will be displayed.

Show full ribbon

View State 
Control button

Shows tab and panel labels

Show tab labels

Ribbon Controls

The final elements of the ribbon are the tool controls, of which there are three types:

Buttons that initiate a command, function, or option.•	

Expanded panel arrow allows you to expand the panel to display additional related •	

tools and controls.

Dialog launcher buttons that allow you to open another dialog box to define  •	

additional options or settings to complete a task. The dialog launcher buttons  

are the small icons to the far right of a panel on the same line as the panel name  

(Figure 1.12).

Buttons come in three different types: button, drop-

down, and split buttons. If you look on the Home tab, 

you can see the Door and Window tools on that Build 

panel; they are examples of buttons. When you click 

this type of button, the tool is invoked, and you are provided with options to place a door 

or window. In the Model panel, the Model Group tool is an example of a drop-down 

Figure 1.11

The three different 
ribbon view states

Figure 1.12

Dialog  
launcher icon
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button (Figure 1.13). When you click that type of button, a list appears showing the dif-

ferent options for the tool. You can then pick the different tool options.

The split button serves two functions; when you move 

your cursor over a split button, you will see either a hori-

zontal or vertical divider line on the icon. The Wall and 

Column buttons are examples of split buttons. The por-

tion of the button that contains the small block triangle 

(Figure 1.14) functions like a drop-down button. The 

other half of the button functions like a regular button.

Some ribbon panels have a drop-down arrow next to the panel 

title (Figure 1.15) that indicates that the panel can be expanded to 

display additional related tools and controls (Figure 1.16). These 

are known as expanded panels. 

Ribbon Clues

You might have noticed that some buttons in different 

toolbars are grayed out (Figure 1.17). If a particu-

lar tool is not available, then it will be grayed out 

because the tool will not function. An example of this 

is the Level tool in the Datum panel of the Home tab 

if you are in a plan view. Revit does not permit you 

to create a new level in a plan view, so the Level tool 

is grayed out. Titleblocks can be added in plan views, 

rendering needs to be done in a 3D view, and walls can’t be drawn 

in an elevation views—these are just some of the examples of the 

restrictions. If a tool is grayed out, switch to a different view type.

Another feature of the ribbon are tooltips 

(Figure 1.18). Tooltips provide a brief descrip-

tion of the tool’s function. When you move 

your cursor over a tool on the ribbon, by 

default Revit will display a tooltip. If you leave 

your cursor over the tool a little longer, addi-

tional information in the form of an expanded 

tooltip will be displayed. While the tooltip is 

visible, you can press F1 for context-sensitive 

help to provide additional information about 

the tool. (Elements that are traditionally called 

tooltips are typically a word or phrase, but 

as you can see in Figure 1.18, some of Revit’s 

tooltips are much larger, even a whole panel 

and illustration.)

Figure 1.13

Example of a  
drop-down button

Figure 1.14

Example of a  
split button

Figure 1.15

Dimension panel 
with expanded 

panel arrow

Figure 1.16

Dimension 
expanded panel

Figure 1.17

Examples of two 
grayed-out buttons

Figure 1.18

Expanded  
tooltip for the  

Trim/Extend tool
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Options Bar
The Options bar (Figure 1.19) is located just under the ribbon and displays options that 

are specific to the active tool or selected elements. For example, if you are placing a wall, 

you are presented with options that include the height, location line, chain, offset, and 

radius. When you place a window, you are presented with options for window tag orien-

tation, tag type, leader usage, and leader offset.

The Options bar is also active when you select an existing element to edit. If you select 

a window and want to copy that multiple times, simply select the window, click the Copy 

button on the Modify tab, and then select the Multiple 

check box on the Options bar (Figure 1.20).

It is very important to pay attention to the Options bar as you work, no matter your 

experience level. The Options bar will provide you with options to help you create ele-

ments in your project.

Properties Palette
The Properties palette (Figure 1.21) is where you can 

view and modify the various parameters that define 

the properties of elements in Revit. By default the 

Properties palette is located under the Options bar and 

to the far left; it is broken up into two main areas.

The top portion is the Type Selector and lists all of 

the various types available for given elements that are 

currently loaded into the project file. In Revit, families 

are components you use to build your model, such as 

walls, windows, doors, columns, and so on. A door 

family can have multiple variations or, in Revit terms, 

types. Types are different sizes, materials, and so on. 

For example, a Single-Flush window might have sev-

eral different standard-size configurations. If you make a change to a type that is already 

used in the project, then it is updated in every instance throughout the project. If you 

have a window type called 24×80 and you change the size to 30˝×75 ,̋ then all the 24×80 

windows will be updated so that they are now 30˝×75 ,̋ regardless of their name.

Figure 1.19

Options bar  
examples for  
different tools

Figure 1.20

Options bar  
example with  
the Multiple  
copy option

Figure 1.21

Properties palette

Instance properties

Type Selector
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u N I T S

This book references both imperial and metric units (imperial fi rst, followed by metric equiv-

alent in parentheses). We make an exception for instances like this, where we’re talking only 

about the element in general rather than the actual dimensions of something.

When you create new elements, you use the Type Selector to select the family and type 

that you want to insert into your project. If you select an element that is already in the 

model, you can use the Type Selector to change it to a different type.

Families are broken up into different element categories. Some examples of categories 

are doors, walls, windows, fl oors, and so on. When you use the Door tool to place a door, 

only door categories will be shown in the Type Selector. So, the Type Selector is only 

going to display the appropriate category, families, and types for the one in use. We will 

discuss more about families in later chapters.

The bottom portion of the Properties palette contains the instance properties. Instance 

properties control only the instances (in other words, the elements) you have selected. 

Instance properties are sometimes referred to as element 

properties. For example, when you change the door’s fi n-

ish material, then only the door you selected will have 

that fi nish description. When you change the door mark, 

then only that particular door is changed.

If you have selected multiple elements, the Type 

Selector will display the common type if possible. For 

example, if you selected fi ve windows but they are not 

the same type (Single-Flush and Double-Flush) or if you 

have elements of different categories such as a door and 

window, Revit will display a message in the Type Selector: 

“Multiple Categories selected.” The instance properties 

will display only those properties that are common to the 

selected elements (Figure 1.22).

While we are on the subject of properties, we should 

also discuss type properties. You can access them from the 

Properties palette by clicking the Edit Type button under 

and to the right of the Type Selector (Figure 1.23). Type 

properties control every instance (or all elements) of a 

specifi c type in the project, regardless of whether they are 

selected. Like instance properties, if multiple elements 

are selected, the Type Properties dialog box includes only 

those properties that all the selected elements have in com-

mon. Figure 1.24 shows an example of the type properties 

for a door.

u N I T S

This book references both imperial and metric units (imperial fi rst, followed by metric equiv-

alent in parentheses). We make an exception for instances like this, where we’re talking only 

about the element in general rather than the actual dimensions of something.

Figure 1.22

Properties palette 
with door and 

window selected

Figure 1.23

Click the Edit Type 
button on the Prop-

erties palette to 
access the element’s 

type properties.

Click to open the select 
element(s) type properties.
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The Properties palette displays properties that are both user-editable and read-only. 

To edit a user-editable property value, click in the field to the right of the property name, 

and either enter a new value, select one from a drop-down list, or select/deselect a check 

box. For some properties, the value box contains a button to the far right that opens a 

dialog box or browser window in which you define the desired value.

Project Browser
As you work with Revit, you are going to find you are working on 

a fully integrated model. This means that all your views, details, 

sheets, schedules, and so on, are generally in a single workspace. 

Other applications, such as AutoCAD Architecture or Bentley 

Architecture, use a federated model approach where you might 

have tens if not hundreds of drawing files in multiple folders for a 

project. Rather than using Windows Explorer or some other tool 

to manage files, in Revit you can use the Project Browser to man-

age and navigate your projects.

You can find the Project Browser under the Properties palette 

(Figure 1.25). The Project Browser is organized by category in 

a Windows Explorer–like tree. All the different view categories 

such as floor plans, ceiling plans, 3D views, legends, schedules, 

details, sections, elevations, sheets, families, groups, and Revit 

links are displayed. These views in the Project Browser can be 

Figure 1.24

Type properties 
for a Single-Flush 
34˝×84˝ door

Figure 1.25

Project Browser
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sorted, grouped, and filtered to help you organize your project. The Project Browser, like 

other dialog boxes in Revit, can be docked, or you can drag it to a new location such as a 

second monitor.

Using the Project Browser is very straightforward. We will cover a few of the basics 

here and get into more detail throughout the text. When you double-click a view name, 

that view is opened in the drawing area. When a view is active, the view name in the 

Project Browser is now bold.

Drawing Area
The drawing area is the large workspace under the Options bar; it’s to the right of the 

Project Browser and Properties palette. The drawing area displays the current view that 

you are working on, and a new window will open for each view. If you have multiple views 

open and the views are maximized, then the other views will be under the current view. 

View Control Bar

The View Control bar (Figure 1.26) is located in the lower-left corner of each drawing 

area window. The View Control bar serves a couple of different purposes to control the 

graphical view for each window. Working from left 

to right are the following functions for the View 

Control bar.

Scale  ​This allows you to change the scale of a view. 

When you click the scale text, a pop-up menu will 

display allowing you to change the scale of your view 

(Figure 1.27). One of the great things about Revit 

is that when you change the scale of a view, annotations and symbols will automatically 

adjust. You don’t have to worry about the scale factor or making adjustments to text sizes 

or dimension scales.

Detail Level  ​This allows you to select from three different detail levels: 

Coarse, Medium, and Fine. If you want to see more graphical information, 

then you would set your detail level from Coarse to Fine.

Visual Style  ​This allows you to you to specify visual style options, which are 

one of the following:

Wireframe  ​Displays the image of the model with all the edges and lines 

drawn but without surfaces

Hidden Line  ​Displays the image of the model with all edges and lines 

drawn except those obstructed by surfaces

Shaded  ​Displays the image of the model with all surfaces shaded 

according to their material color settings and project light locations

Figure 1.26

View Control bar

Scale
Detail Level

Visual Style

Sun Path
On/Off

Shadows On/Off

Crop Region On/Off

Show/Hide Crop Region

Temporary Hide/Isolate

Reveal Hidden Elements

Figure 1.27

Scale listings from 
View Control bar
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Shading With Edges  ​Displays the image of the model in shaded mode, but with all 

nonblocked edges drawn as well

Consistent Colors  ​Displays an image of the model similar to Shading With Edges 

with more consistent colors

Realistic  ​Displays the image of the model with materials in the active view 

Sun Path On/Off  ​This allows you to specify Sun Settings and to turn on or off Sun Path. 

Shadows On/Off  ​ This allows you to specify to turn on or off shadows. There are addi-

tional graphic display options consisting of Shadows and Silhouette Edges.

Show/Hide Rendering Dialog  ​This allows you to either display or hide the Render Settings 

dialog box.

Crop Region On/Off  ​This allows you to turn on or off a crop region.

Show/Hide Crop Region  ​This allows you to show or hide a crop region.

Temporary Hide/Isolate  ​This allows you to temporarily hide or isolate elements or 

categories.

Reveal Hidden Elements  ​This allows you to reveal hidden elements in the view.

Status Bar

The Status bar (Figure 1.28) is located at the very bottom of the UI. It provides you with 

the following information:

Displays the name and family type of the element your cursor is over•	

Prompts you for additional information regarding the active tool such as hints or •	

what to do next

Status bar information Worksets Design options Filter

In addition to providing feedback and information, the Status bar contains the follow-

ing controls:

Workset  ​Provides access to the Workset dialog box and displays the active workset when 

worksharing has been enabled

Design Options  ​Provides access to the Design Options dialog box and displays the active 

design option

Active Only  ​Allows you to filter your selections to only select active design options 

components

Exclude Options  ​Provides the ability to filter components that are part of a design option

Figure 1.28

Status bar prompt-
ing for additional 
information
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Editable Only  Allows you to fi lter your selections to only select editable workshared 

components

Press & Drag  Allows you to drag an element without selecting it fi rst

Filter  Allows you to refi ne your selection set using element categories

K E Y B Oar D aCC E LE r aTO r S

If you are a seasoned AutoCAD user, then you probably initiated most of your commands 

by pressing a one- or two-key shortcut on the keyboard rather than picking a button or 

selecting a tool from a menu. Revit pro-

vides the same functionality for using and 

editing shortcuts. Many of Revit tools have 

predefi ned keyboard shortcuts. You can 

fi nd them in several diff erent ways. In the 

example shown here, the fi rst line of the 

Component tooltip lists the name of the tool 

followed by the two-key shortcut.

You can also display and edit keyboard 

shortcuts by accessing the Keyboard Short-

cut dialog box. You can access the dialog by 

clicking the View tab, clicking the Windows 

panel, clicking the User Interface drop-down, 

and selecting Keyboard Shortcuts.

K E Y B Oar D aCC E LE r aTO r S

If you are a seasoned AutoCAD user, then you probably initiated most of your commands 

by pressing a one- or two-key shortcut on the keyboard rather than picking a button or 

selecting a tool from a menu. Revit pro-

vides the same functionality for using and 

editing shortcuts. Many of Revit tools have 

predefi ned keyboard shortcuts. You can 

fi nd them in several diff erent ways. In the 

example shown here, the fi rst line of the 

Component tooltip lists the name of the tool 

followed by the two-key shortcut.

You can also display and edit keyboard 

shortcuts by accessing the Keyboard Short-

cut dialog box. You can access the dialog by 

clicking the View tab, clicking the Windows 

panel, clicking the User Interface drop-down, 

and selecting Keyboard Shortcuts.



C hap te r 2

Views

Views are an  essential part of your building project. Revit is essentially 

a large database, and many of your projects will consist of a single model/file (unlike 

AutoCAD projects that can consist of hundreds of drawing views). For this single model 

to work effectively, you need a system to create different views of your building project. 

With Revit’s view tools, you create views of your model—such as floor plans, ceiling 

plans, detail views, section views, schedules—to graphically display that information.

The views that you create display specific information related to your building proj-

ect, and Revit provides you with view property controls to choose what information is 

represented and how it is represented.

In this chapter, we will discuss the different view types, their relationship to the model, 

and how they are organized in the Project Browser. You will learn how to create views and 

how to use view controls to edit and manage the display of elements in the views. We will 

discuss view properties, view templates, and best practices for working with views.

Specifically, you will learn about the following:

Zoom and Pan tools■■

View properties■■

Other view controls■■

Adding new views■■
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Zoom and Pan Tools
You can use the Zoom and Pan tools to assist in navigating and editing elements in the 

building model and to change the viewable area in a drawing window. Revit provides the 

following zoom options:

Zoom In Region•	

Zoom Out (2X)•	

Zoom To Fit•	

Zoom All To Fit•	

Zoom Sheet Size•	

Previous Pan/Zoom•	

Next Pan Zoom•	

Revit provides several methods for accessing these tools, one of which is the navigation 

bar (Figure 2.1), displayed in the upper-right corner of the drawing window. You can also 

access the View Cube and steering wheels from this navigation bar. If the navigation bar 

is not active, click the View tab, click Windows Panel, click the User Interface drop-down 

list, and select the Navigation Bar check box to activate the navigation bar. Deselecting 

the check box will hide the navigation bar.

Zoom In Region
You use the Zoom In Region tool when you need to zoom into a specified area or win-

dow. To zoom into a region, you need to specify a rectangle window by specifying diago-

nal opposite corners.

	 1.	 Move your mouse pointer, and click at the start point of your rectangle.

	 2.	 Move the mouse pointer to define the opposite diagonal corner of the Zoom In 

Region window, and click. Notice that as you define the window, a dynamic window 

is created (Figure 2.2).

Start point

End point

Figure 2.1

The Zoom and  
Pan tools on the 

navigation bar

Figure 2.2

Defining the start 
and end points for 

Zoom In Region
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The region within your Zoom In Region area is enlarged in the current view 

(Figure 2.3).

One-Click Zooms
These are quick actions you can take to change the magnification or range of your view:

Zoom Out (2X)  ​Use this tool when you need to zoom out of an existing view by twice the 

size of the current view. In other words, when you use this tool, the new view is going to 

show twice the length and width of the original view.

Zoom To Fit  ​Use this tool when you want to display the entire extents of the model and 

annotation elements in the available view space on the screen.

Zoom All To Fit  ​This works the same way as the Zoom To Fit tool but in all the views that 

are open.

Zoom Sheet Size  ​Use this tool when you want the drawing window to match the print 

size based upon the scale of the view. This is useful when you want to make sure that you 

are showing the correct level of detail based upon the scale of the drawing.

Previous Pan/Zoom  ​Use this tool when you need to revert to the last view displayed using 

the Zoom and Pan tools. You can think of this tool as an undo function for zooming and 

panning.

Next Pan/Zoom  ​Use this tool when you want to undo the previous pan/zoom operation.

View Cube
The View Cube is a persistent tool that can be used to switch between standard and 

isometric views. When the View Cube is displayed, it is shown with one of the edges or 

corners highlighted. This is the current orientation of the view. Clicking one of the faces, 

edges, or corners will switch to that view.

Figure 2.3

Results after using 
Zoom In Region
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The View Cube has two display states: inactive and active. When the View Cube is 

inactive, it appears in halftone so that it does not interfere with the view of your model. 

When active, it is opaque and may obscure the view of the model.

The View Cube also acts as a compass and indicates which direction is north for the 

model. When you click the cardinal direction letter on the compass, the model will 

rotate. You can also click the compass ring and interactively rotate the model around the 

pivot point.

The real power of the View Cube, though, is shown when you right-click it. When you 

do, you can quickly create 3D sections, plans, elevations, and so on. The View Cube con-

text menu has the following options (Figure 2.4):

Go Home  ​Restores the Home view saved with the model

Save View  ​Allows you to save the current view

Lock To Selection  ​Uses the selected objects to define the center of the view when a view 

orientation change occurs with the View Cube

Set Current View As Home  ​Defines the Home view of the model based on the current view

Set Front to View  ​Allows you to define a new front view from a predefined list

Reset Front  ​Resets the Front view of the model to its default orientation

Show Compass  ​Toggles on and off the View Cube Compass

Orient to View  ​Used to reorient the current view of the model by selecting from a set of 

preset views

Orient to Direction  ​Used to reorient the cur-

rent view of the model by selecting from a set 

of preset view directions

Orient to a Plane…  ​Used to reorient the cur-

rent view of the model by specifying a new 

orientation plane

Help…  ​Launches the online help system and 

displays the topic for the View Cube

Options…  ​Opens a dialog box that has 

options for adjusting the appearance and 

behavior of the View Cube

Steering Wheels
Steering wheels are special tracking menus that follow your mouse pointer as you move 

it across the drawing area. In theory, these wheels can save you time since they combine 

multiple navigation tools into a single menu. Typically these wheels allow you to zoom, 

Figure 2.4

View Cube menu
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rewind, orbit, and so on. Because different types of operations have different view 

requirements, there are seven steering wheels (Figure 2.5) for navigating and orientating 

models in different views.

Full Navigation wheel

Mini Full
Navigation wheel

Mini Tour
Building wheel

Mini View
Object wheel

Tour Building wheel View Object wheel 2D Steering wheel

In the next example, we will walk you through the process of utilizing the zoom and 

rewind functions from the steering wheel:

	 1.	 Click the Steering Wheel icon on the navigation bar (Figure 2.6).

	 2.	 Move the steering wheel to an area in the drawing area you 

want to zoom in and out of.

	 3.	 Place your mouse pointer over the Zoom tool. Notice that  

as you move your mouse pointer over a function, it will 

highlight.

	 4.	 Click and hold the Zoom tool. Moving your mouse forward 

zooms in, and moving the mouse backward zooms out. Notice that varying the 

mouse speed varies the speed of the zoom.

	 5.	 Release the mouse button to stop the Zoom command and return to the steering 

wheel.

Now that you have used the Zoom tool, you will use the Rewind tool to return to your 

previous zoom state. As you perform zooms and pans, Revit keeps track of these actions. 

When you use the Rewind tool, Revit displays a strip of previous zoom and pans.

	 1.	 In the steering wheel, move your mouse over the Rewind tool.

	 2.	 Click the Rewind tool.

	 3.	 Move your mouse pointer over the rewind strips (Figure 2.7). Revit will change the 

zoom or pan location. When you find the view that you desire, click, and you are 

returned to the steering wheel.

Figure 2.5

Steering wheels

Figure 2.6

Activating the steer-
ing wheel from the 
navigation bar

Figure 2.7

Using the Rewind 
function allows you 
to select a previous 
zoom or pan.
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The steering wheel also offers a wheel menu (Figure 2.8). You can use this menu to 

switch between the big and mini wheels that are available. The behavior and options 

available in the wheel menu are dependent on the current wheel and program. Table 2.1 

lists the complete wheel menu options.

Click to open
menu options

Wheel menu options
for a camera view

Wheel menu options
for a 3D view

M e n u  I t e m D e s c r i p ti  o n / F u n c ti  o n

Mini View Object Wheel Displays the Mini View Object wheel.
Mini Tour Building Wheel Displays the Mini Tour Building wheel.
Mini Full Navigation Wheel Displays the Mini Full Navigation wheel.
Full Navigation Wheel Displays the big Full Navigation wheel.
Basic Wheels Displays the big View Object or Tour Building wheel.
Go Home Switches to the Home view saved with the model.
Fit to Window Resizes and centers the current view to display all objects.
Restore Original Center Restores the center point of the view to the extents of the model.
Orient to View Orients the camera to match the view angle of the selected view. This function 

is also available in the View Cube menu.
Orient to a Plane Adapts a view according to the user specified or selected plane. This function is 

also available in the View Cube menu.
Save View Saves the current view orientation with a unique name. Save View allows you 

to save a 3D view only when working in the default 3D view. If you are working 
in a previously saved 3D or perspective 3D view, the view is simply saved with 
the new orientation and you are not prompted to supply a unique name.

Increase/Decrease Focal 
Length

Changes the focal length (zoom lens).

Move Crop Boundary Moves the position of the crop boundary around the perspective view.
Re-center Crop Boundary Repositions the crop boundary to the center of the perspective view.
Help Opens the help system to the wheel topics.
Options Displays the dialog box where you can adjust the options for the wheels.
Close Wheel Closes the wheel.

Figure 2.8

Full Navigation 
wheel with wheel 
menu for 3D and 

Camera view

Table 2.1

Wheel menu 
Options
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View Properties
You use view properties (Figure 2.9) to set the various settings for the active view. These 

settings consist of the scale, detail level, underlay, phase, and so on. Table 2.2 lists some 

common view properties and a brief description of how they function.

I n s t a n c e  P a r a m e t e r F u n c ti  o n / D e s c r i p ti  o n

View Scale Changes the scale of the view.
Scale Value Defines the custom view scale. This option is available only when View 

Scale is set to Custom.

Display Model Normal: Displays all elements in the view normally.

Do Not Display: Hides the model elements and displays only detail/annota-
tion view-specific elements such as lines, text, dimensions, and symbols.

As Underlay: Displays all detail/annotation view-specific elements nor-
mally, and model elements appear dimmed.

Detail Level Sets the detail level for newly created views based on a view scale. View 
scales are organized under the detail level headings Coarse, Medium, and 
Fine. When you create a new view in your project and set its view scale, its 
detail level is automatically set according to the arrangement in the table.

Visibility/Graphics Overrides Allows you to control the display and appearance of element categories on 
a view-by-view basis.

Visual Style Changes the display style; options are Wireframe, Hidden Line, Shaded, 
Shaded with Edges, Consistent Colors, and Realistic.

Graphic Display Options Offers settings to enhance the visual display of your model view.

Figure 2.9

Properties palette

Table 2.2

View Instance  
Properties

Continues
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I n s t a n c e  P a r a m e t e r F u n c ti  o n / D e s c r i p ti  o n

Underlay Displays another plan view under the current plan view. The underlay  
can be set to any level above, below, or at the same level as the current 
view. Underlays are used for coordinating levels and other building con-
tent. Underlays will print.

Underlay Orientation Sets the underlay’s view orientation. If the value is set to Plan, then the 
underlay displays as if you are viewing from above, like a plan view. If  
the underlay is set to Reflected Ceiling Plan, then the underlay displays as 
if you are viewing it from below. Setting this to Reflected Ceiling Plan is 
useful when you want to see the furniture layout and how that coordinates 
with the lighting.

Orientation Switches the orientation of the project between Project North and True 
North. Our projects are generally set to Project North to make it easier to 
model and draft. True North enables you to set up your project with the 
true orientation.

Wall Join Display Sets the behavior of wall joins.
Discipline Sets the discipline for the project to either Architecture, Structural, 

Mechanical, Electrical, or Coordination.
Color Scheme Location Sets the color scheme location to either the front of the model (fore-

ground) or the back of the model (background).
Color Scheme Opens the Edit Color Scheme dialog box to create new or edit existing 

schemes.
View Name Specifies the name of the active view and is what will be displayed in the 

Project Browser as well as the name of the viewport on the sheet unless it is 
renamed using the Title On Sheet parameter.

Title on Sheet Specifies the name of the view as it will appear on the sheet.
Referencing Sheet Comes from the referencing view that is placed on a sheet (read-only).
Referencing Detail Comes from the referencing view that is placed on a sheet (read-only).
Default View Template Sets the default view template for this view.
Crop View Activates the crop region for the view, which can limit the extents of the 

visible area of the view.
Crop Region Visible Makes the crop region visible or invisible.
Annotation Crop Shows or hides the annotation crop when crop regions are visible in the view.
View Range Controls how you view your view.
Associated Level Lists a view that may be associated with this view (read-only). 
Scope Box Similar to crop region, limits the extents of levels and grids.
Phase Filter Allows you to control which of the defined phases are used in the view.
Phase Allows you to control the phase visibility properties for the view.

Overriding Visibility/Graphics
As you work on your building project, there will come a time when you find that you have 

too much going on in the view and you want to turn on or off certain element categories, 

such as all furniture or all columns. You may also want to change the way that different ele-

ment categories display in the view. Most of the time you will use the Visibility/Graphics 

Overrides dialog box (Figure 2.10), usually just called Visibility/Graphics, to control the 

visibility per view. Therefore, you want to be very familiar and comfortable using this dia-

log box. There are a few other methods of controlling the visibility of objects in a view, 

and we will cover those methods in this section as well.

Table 2.2

View Instance  
Properties  

(Continued)
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When you start a new project, the Visibility/Graphics dialog box is broken up into 

four tabs. Additional tabs will be displayed if you enable phasing, link files, or workshar-

ing. The first tab in Visibility/Graphics is Model Categories. On this tab, you have the 

ability to turn on and off model categories in the view and to override the cut, projection 

and surface, halftoning, transparency, and detail level of an element category. Generally 

speaking, model elements are the geometry or 3D objects that make up your building 

project, such as doors, walls, windows, floors, and so on.

The Visibility column contains a list of all the Revit element categories available. 

Subcategories for each element category can be displayed by clicking the expand button. 

For example, Doors is a category, and when you expand Doors, you are provided with 

several door subcategories, including Elevation Swing, Frame/Mullion, Glass, and so on.

Next to the category or subcategory name is a check box. When you select this check 

box, the category or subcategory will be displayed in the view. Deselecting will turn the 

visibility off in that view. Turning the visibility of the category off will also turn off the vis-

ibility of the subcategory items.

Let’s turn off Furniture and Furniture Systems in a floor plan view:

	 1.	 Open the source file rac_advanced_sample_project.rvt. You can find this file in 

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples, which was 

installed with Revit Architecture 2011. (You are using this model because it has dif-

ferent elements such as furniture that you can use to explore the Visibility/Graphics 

settings.)

Figure 2.10

Visibility/Graphics 
dialog with Model 
Categories tab 
active
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	 2.	 Save the file elsewhere, naming it Rendering02vg.rvt.

	 3.	 Switch to the 01 – Entry Level – Furniture Layout, Floor Plans.

	 4.	 Zoom into the northwest corner of the building.

	 5.	 On the View tab’s Graphics panel, click Visibility/Graphics. (You can also open the 

dialog box by clicking the Edit button to the right of Visibility/Graphics Overrides in 

the Properties palette.) 

	 6.	 In Visibility/Graphics, deselect the check box next to the Furniture category.

	 7.	 Click OK to close the dialog box.

After deselecting the Furniture category, the round dining tables are turned off. 

Remember that when you deselect a category in the Visibility/Graphics dialog box, that 

category is turned off in the current view only.

Another shortcut method for control the visibility of elements in a view is to the use 

the Hide In View tool. To use this tool, select an element in the view in which you want 

to turn off the visibility, such as a piece of furniture. Right-click and choose Hide In View 

(Figure 2.11).

You are then presented with three options:

Elements  ​Only the element or elements selected will be turned off. For example, if a 

single chair is selected, only that chair will be turned off.

Category  ​This will turn off the entire category for the element selected. For this 

example, if you select a single chair, all the furniture elements will have their visibil-

ity turned off in this view because a chair is part of the furniture category. This is the 

same as going to the Visibility/Graphics dialog box and turning the category off.

By Filter  ​This will turn off the group of elements that you defined in your filter. We 

will discuss filters in more detail later in this chapter.

Click Category. All of the furniture in the view has 

had its visibility turned off.

Now that you have hidden your furniture in the 

view, you may want to turn it back on. If you turned 

off the entire category, you could simply go back to 

the Visibility/Graphics dialog box and turn the cat-

egory back on. But if individual elements have been 

hidden, then how do you find them? Revit provides 

a tool called Reveal Hidden Elements. This tool will 

Figure 2.11

Options for  
Hide In View
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display any elements that are currently hidden in the view. To reveal hidden elements, 

follow these steps:

	 1.	 On the View Control bar, click the Reveal Hidden Elements icon .

When this icon is active, the lightbulb on the View Control bar will have a red border 

and the lightbulb is on. The border of the drawing window will be in red, indicating 

that you are in Reveal Hidden Elements mode. All the hidden elements will be dis-

played in red, and the visible elements will be in halftone (Figure 2.12).

Visible elements

Reveal Hidden

Hidden elements

Colored border indicates
we are in Reveal Hidden 
Elements mode

	 2.	 Select the elements you want to unhide.

	 3.	 On the ribbon in the Reveal Hidden Elements panel  

(Figure 2.13), click Unhide Element or Unhide Category.

	 4.	 When you have unhidden all the elements, click the Close button on the ribbon to 

turn off Reveal Hidden Elements mode. You can also click the lightbulb on the View 

Control bar to exit Reveal Hidden Elements mode.

Another method of restoring the visibility of elements while in Reveal Hidden Elements 

mode is to select an element, right-click, and choose Unhide In View.

In addition to being able to control the visibility of element categories, Visibility/Graphics 

also enables you to override the visibility and graphic display of model elements, annota-

tion elements, imported elements, linked Revit model elements, and workset elements 

for each view in a project. These settings that you are overriding are those specified at 

the project level. If you want to change the settings for all views in the project, then you 

should modify them in the Object Styles dialog box.

Figure 2.12

The thick border 
(red in Revit but 
dark gray here)  
indicates you are  
in Reveal Hidden 
Elements mode.

Figure 2.13

Ribbon options for 
revealing hidden 
elements
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In this example, you are going to override the visibility and graphic display of model 

elements in a view. You will first duplicate a view and then apply a transparency to faces 

on model elements, and then you will poche the exterior walls.

	 1.	 Open the source file i_Groups-Condominium.rvt 

from the book’s companion file download 

page (www.sybex.com/go/introducingrevit2011). 

This is one of the sample tutorial files from 

Autodesk.

	 2.	 In the Project Browser, make the {3D} view 

active. You are going to duplicate this view and 

then apply your transparency.

	 3.	 Right-click the view name (Figure 2.14).

Right-clicking any view name in the Project 

Browser and highlighting Duplicate View pro-

vides you with three duplication options:

Duplicate  ​This makes a copy of the view without any annotation objects with the 

exception of levels, grids, and reference planes. Model changes made in the origi-

nal view will appear in the duplicated view. Annotation changes (with the excep-

tion of levels, grid, and reference planes) will not appear in the duplicated view 

(Figure 2.15).

Figure 2.14

Right-clicking a view to duplicate
Figure 2.15

The view on the 
right was created by 
duplicating the view 
on the left. Because 

we used Duplicate 
here, annotation 
objects were not 

copied.
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Duplicate With Detailing  This makes a copy of the view with the annotation objects. 

Model changes made in the original view will appear in the duplicated view. Anno-

tation changes (with the exception of levels, grids, and reference planes) will not 

appear in the duplicated view.

Duplicate As A Dependent  This makes a complete or exact copy of the view, includ-

ing all annotations. The copy of this view is also dependent on the original view. Any 

changes in the model or annotation made in either of the two views will appear in 

the other view.

h OW TO C h O OS E a D u pLI C aT E O p T I O N

Use Duplicate when you need a copy of that view for various reasons but the annotations are 

not important.

Use Duplicate With Detailing when the annotations are important but you need to 

develop the new plan diff erently. For example, you may want to duplicate many of the anno-

tations on your Level 1 plan and your Level 1 Furniture plan.

Use Duplicate As A Dependent when you have a large plan that needs to be broken up 

into several plans to drop on sheets or you need to place the same view on multiple sheets.

 4. Choose Duplicate View ➔ Duplicate. In the Project Browser, a new view named Copy 

of {3D} was created. Let’s rename this to something more meaningful.

 5. Right-click the view called Copy of {3D}, and select Rename.

 6. Name the view Transparent Walls and Roof.

You will now begin the process of applying transparency to model face categories.

 7. Open the Visibility/Graphics dialog box by choosing one of these actions:

On the View tab’s Graphics panel, click Visibility/Graphics.•	

Right-click a wall in the drawing area, and choose Override Graphics In View •	 ➔ 

By Category.

Press VG on the keyboard without hitting the Enter key.•	

 8. In the Visibility/Graphics dialog box, make sure that the Model Categories tab is 

active.

 9. Click the Walls cell under Visibility to highlight the entire row.

 10. In the Transparent column, select the check box.

 11. Repeat steps 9 and 10 for Floors.

 12. Click Apply and OK to view your changes (Figure 2.16).

h OW TO C h O OS E a D u pLI C aT E O p T I O N

Use Duplicate when you need a copy of that view for various reasons but the annotations are 

not important.

Use Duplicate With Detailing when the annotations are important but you need to 

develop the new plan diff erently. For example, you may want to duplicate many of the anno-

tations on your Level 1 plan and your Level 1 Furniture plan.

Use Duplicate As A Dependent when you have a large plan that needs to be broken up 

into several plans to drop on sheets or you need to place the same view on multiple sheets.



28  ■   Chapter 2 : Views

In this next example, you are going to use the Visibility/Graphics overrides to poche 

walls in a view. Let’s continue using the i_Groups-Condominium.rvt file.

	 1.	 Switch to First Floor level plan.

	 2.	 Open the Visibility/Graphics dialog box.

	 3.	 Select Walls row, and click the Override button 

for Cut Patterns. This will open the Fill Pattern 

Graphics dialog box (Figure 2.17).

	 4.	 Set Color to Black.

	 5.	 Set Pattern to Solid Fill.

	 6.	 Click OK to close the Fill Pattern Graphics  

dialog box.

	 7.	 Click Apply and OK to view your changes (Figure 2.18).

Figure 2.16

Model with trans-
parency off (left); 
model with trans-
parency on (right)

Figure 2.17

Fill Pattern Graphics dialog box

Figure 2.18

Example of poched 
walls using  

Visibility/Graphics 
Overrides
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The second tab in the Visibility/Graphics Overrides dialog box is Annotation Catego-

ries (Figure 2.19). This includes objects such as text, tags, legends, dimensions, and so on. 

The third tab is Imported Categories (Figure 2.20). If you have linked in any CAD files, 

you will be able to control the visibility and graphic display of layers. The fourth tab, Fil-

ters, is discussed in the next section.

Figure 2.19

Visibility/Graphics 
Overrides dialog  
box’s Annotation  
Categories tab

Figure 2.20

Visibility/Graphics 
Overrides dialog 
box’s Imported  
Categories tab
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Using Filters
Filters is a very powerful tool that gives you the ability to control the visibility of a group 

of elements that you define. In this section, we will discuss using the Filter tool to sort 

and control elements. In this example, you are going to use the Filter tool as a method to 

check your models for accuracy. You will create a filter that looks at the walls in the view 

and changes the poche of walls that have an assembly description of “exterior walls” to a 

solid black poche.

	 1.	 On the View tab’s Graphics panel, click the Filters button.

	 2.	 In the Filters dialog box (Figure 2.21), click the New button.

New button

	 3.	 Name the new filter Exterior Walls.

	 4.	 Under the Categories, select Walls.

Categories allow you to determine the parameters that are available in the Filter By 

lists. You can select more than one category. For example, if you wanted to create 

a filter that shows two-hour rated walls and doors, then you would select both the 

Doors and Walls categories.

	 5.	 Under Filter Rules, change Filter By to Assembly Description.

	 6.	 For the filter operator, select equals.

	 7.	 For the filter value, enter Exterior Walls.

	 8.	 Click Apply and OK to save and close the Filters dialog box.

Because you used the equal filter operator, when you type in the filter value, you 

must use the exact spelling and capitalization. You have now created a new filter that 

will find any walls in a view that have an assembly description of Exterior Walls.

	 9.	 Open the Visibility/Graphics dialog box.

	10.	 Switch to the Filters tab (Figure 2.22).

Figure 2.21

Filters dialog box
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	11.	 Click the Add button to add a new filter.

	12.	 In the Add Filters dialog box, select the Exterior Walls filter.

	13.	 Click OK to close the Add Filters dialog box.

Back in the Visibility/Graphics dialog box on the Filters tab, notice that the Exterior 

Walls filter is now added, and you have options similar to the Model Categories tab. 

You have the following options that you can adjust:

Visibility  ​Determines whether your filter overrides will be visible in the view.

Projection/Surface  ​Used in Elevation views or anything in the distance that is not 

being cut or sliced by the view. The Lines and Patterns override provides you with 

the ability to change the line color and thickness, as well as a fill pattern color and 

thickness.

Cut  ​Used in views where the objects are displayed as cut. This could be plans, sec-

tions, or details. The Lines and Patterns override provides you with the ability to 

change the line color and thickness, as well as a fill pattern color and thickness.

Halftone  ​Allows you to halftone the filtered element category.

Transparent  ​Allows you to make the filtered element category transparent.

	14.	 In this particular view, you want all walls with an assembly description of Exterior 

Walls to display with a solid blue poche. Click the Cut Patterns Override button.

	15.	 In the Fill Pattern Graphics dialog box, set Color to Black.

Figure 2.22

Visibility/Graphics 
dialog box’s Filter 
tab
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	16.	 Set Pattern to Solid Fill.

	17.	 Click OK to close the Fill Pattern Graphics dialog box.

	18.	 Click Apply and OK to close the Visibility/Graphics dialog box.

Figure 2.23 shows the results of the filter you applied to the First Floor view. Note that 

it appears that none of the walls that have the solid black fill pattern are exterior walls. 

This is a good example of how you can use tools to help validate your model.

Other View Controls
In this section we are going to discuss some of the other view controls. These would 

include changing the level of detail, using crop regions, and using temporary hide/isolate.

Changing Level of Detail by View Scale
In Chapter 1, “The Revit Architecture User Interface,” we briefly touched on using the 

View Control bar to change the level of detail in a view. You can also make these changes 

using the Properties palette. Detail level and view scales go 

hand in hand. In Figure 2.24, you can see an example of a wall 

at Course and Fine/Medium detail levels.

The level of detail is important when you need to print 

your drawings. For example, if you have a drawing at 1/16˝ 

= 1´-0˝ [1 : 192] and your detail level is set to Fine, then your 

printed drawing is more likely to lose detail because of all the 

Figure 2.23

Filter applied to 
the current view 

to poche walls in a 
solid black with an 
assembly descrip-

tion of exterior walls

Figure 2.24

Wall example at 
Course (top) and 

Fine/Medium (bot-
tom) detail levels
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lines that are being printed. So, using the proper level of detail is important to ensure a 

consistent look of your drawings.

Revit provides a mechanism to control how 

Revit should automatically set the level of detail 

for a specific scale. This is done through the View 

Scale-To-Detail Level Correspondence dialog box 

(Figure 2.25). To adjust the detail level scale values, 

follow these steps:

	 1.	 On the Manage tab’s Settings panel, click the 

Additional Settings drop-down, and click 

Detail Level.

	 2.	 Click the left and right move arrows to move 

scale values from one detail level to another.

	 3.	 If you want to return to the original settings, 

click Default.

	 4.	 Click OK to close the View Scale-To-Detail 

Level Correspondence dialog box.

Later in this chapter, you will create a schedule to help you manage your detail levels 

in Revit.

Using Crop Regions
The crop region defines the boundaries of the project view. A crop region consists of  

two parts:

Model Crop  ​Crops model elements, detail elements, section boxes, and scope boxes at the 

model crop boundary.

Annotation Crop  ​Crops annotation elements when it touches any portion of the annota-

tion element so that no partial annotations are drawn. In other words, if any portion of 

an annotation is touching the annotation crop, the entire annotation is displayed. By 

default, the annotation crop is not displayed.

To display the crop region, you need to select the Crop View check box in the Proper-

ties palette (Figure 2.26). This enables the crop region. If you want to display the crop 

region so that you can edit the region, select the Crop Region Visible check box. If you 

want to adjust the annotation crop, then select the Annotation Crop check box.

Figure 2.27 shows the model and annotation crop turned on. To adjust the model and 

annotation crop regions, use the blue handles.

Figure 2.25

Setting the detail 
level scale values
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Show/Hide Crop Region

Enable/Disable Crop Region

Annotation crop

Model crop

Using Temporary Hide/Isolate
Temporarily hiding or isolating elements or element categories can be very useful when 

you want to see or edit only a few elements of a certain category in a view. The Hide tool 

will hide the selected elements in the view. The Isolate tool shows the selected elements 

and hides all other elements in the view. Temporary Hide/Isolate is very useful since the 

changes are temporary. Any changes you make using Temporary Hide/Isolate will revert 

to the original state when you close the project and will not impact printing.

To temporarily hide or isolate an element or element category, select one or more  

elements in the drawing area; then on the View Control bar, click the Temporary Hide/

Isolate button that looks like a pair of glasses, and select one of the following operations:

Isolate Category  ​Of the elements selected, only those element categories will be displayed. 

All other element categories will be hidden.

Figure 2.26

Enabling the Crop 
Region, Crop Region 
Visible, and Annota-

tion Crop options

Figure 2.27

Model and annota-
tion crop turned on
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Hide Category  ​Of the elements selected, only those element categories will be hidden.

Isolate Element  ​Only the selected elements will be displayed.

Hide Element  ​The selected elements will be hidden.

When Temporary Hide/Isolate is active, the border of drawing area will be cyan.

To exit Temporary Hide/Isolate mode, choose one of these steps:

To exit without saving the changes, click the Temporary Hide/Isolate button on the •	

View Control bar, and then click Reset Temporary Hide/Isolate. All temporary hid-

den elements are then restored.

To exit and make the changes permanent, click the Temporary Hide/Isolate button •	

on the View Control bar, and then click Apply Hide/Isolate To View.

If you make temporarily hidden elements permanent, you can reveal them later using 

the Reveal Hidden Elements tool.

Adding New Views
When working on your building project, you will need to create different views such as 

floor plans, ceiling plans, details, section, schedules, and so on, to develop and docu-

ment the building project. Revit provides a number of methods for creating new views. 

The most common method is to duplicate an existing view. Why would you do this? You 

duplicate views to allow you to utilize different view settings that display the same por-

tion of your building project.

When duplicating an existing view, you have three options:

Duplicate  ​Creates a copy of the selected view. Note that on the model, elements will be 

duplicated, but annotation or detailing elements will not be duplicated.

Duplicate With Detailing  ​Creates a copy of the selected view and contains both the model 

and annotation elements from the original view.

Duplicate As A Dependent  ​Creates a copy of the selected view, contains both the model 

and annotation elements, and inherits the view properties of the primary view. Any 

changes made to either the original or dependent views will be synchronized. You use 

this option when you need to create views that show portions of a plan when the entire 

plan is too large to fit on a drawing sheet.

Creating Floor and Ceiling Plans
As you work on your building project, you will find that you will need to create new levels 

and plans in order to build and document your project. In this section, you are going to 

create new floor and ceiling plans based upon existing levels. Floor plans (Figure 2.28) 

are the default plan for your building project; a floor plan is a horizontal slice of your 

building project. Reflected ceiling plans (Figure 2.29) are also a horizontal slice of your 
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building. In Chapter 3, “Modeling,” we will go into detail about creating new levels. To 

create a new floor plan, follow these steps:

	 1.	 Open the source file Create_Plans.rvt from the companion files on the book’s web 

page (www.sybex.com/go/introducingrevit2011).

	 2.	 In the Project Browser, expand Views (All), expand Elevations (Building Elevation), 

and double-click the North elevation.
Figure 2.28

Example of the  
floor plan

Figure 2.29

Example of 
 a reflected  
ceiling plan
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	 3.	 Zoom into the level name at the right of each level line (Figure 2.30).

Notice that some of the elevation datums symbols are 

blue and some are black. The blue elevation datums 

have a floor plan associated with them. In the next 

steps, you are going to create floor and ceiling plans for 

the levels with the black datums.

	 4.	 From the View tab’s Create panel, click the Plan Views 

drop-down, and click Floor Plan. This opens the New 

Plan dialog box (Figure 2.31).

	 5.	 In the Floor Plan Views section, select all the levels for 

which you want to create a plan view.

	 6.	 If you want to create an additional plan view for a level 

that has an existing plan view, deselect Do Not Dupli-

cate ExistingViews.

	 7.	 Select the appropriate scale.

	 8.	 Click OK.

To create a new ceiling plan, follow these steps:

	 1.	 From the View tab’s Create panel, click the Plan Views drop-down, and click 

Reflected Ceiling Plan. This opens the New Plan dialog box.

	 2.	 In the Reflected Ceiling Plan Views section, select all 

the levels for which you want to create a plan view.

	 3.	 If you want to create an additional reflected ceiling 

plan view for a level that has an existing plan view, 

deselect Do Not Duplicate Existing Views.

	 4.	 Select the appropriate scale.

	 5.	 Click OK.

The Project Browser in Figure 2.32 shows the new floor 

and ceiling plans you’ve added.

Figure 2.30

Elevation datums 
from default  
template

Figure 2.31

New Plan dialog box

Figure 2.32

Project Browser 
with updated views
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Creating Elevation Views
Elevations provide a view of your model projected onto a vertical plane. These can be 

used to evaluate and document building exterior and interior wall elevations. When you 

start a new project using one of the Revit template files, Revit will automatically create 

exterior elevation views for north, south, east, and west (Figure 2.33). With Revit, you 

can create both exterior and interior elevations.

Elevations are created by placing the elevation tags in your model. To create an eleva-

tion view, from the View tab’s Create panel, open the Elevation drop-down. Click Eleva-

tion. In the drawing area, move the mouse pointer near the 

exterior walls.

Notice that as you move the mouse pointer near the wall, 

the elevation symbol (Figure 2.34) appears. As you continue 

to move the mouse pointer around the walls in the project, 

the arrow on the arrowhead of the elevation symbol will automatically align perpendicu-

lar to the wall. When creating interior elevations, Revit draws the extent of the elevation 

of the room to where the bounding walls, floors, and ceilings are located.

	 1.	 To create an exterior elevation, click when the elevation arrowhead symbol points 

toward the desired direction.

	 2	 To create an interior elevation, move your mouse pointer inside the walls, and click 

when the elevation arrowhead symbol points toward the desired direction.

Notice that in the Project Browser the new views have been added.

Figure 2.33

Sample  
elevation view

Figure 2.34

Exterior elevation 
symbol Elevation direction

and name

Elevation datum control
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The elevation symbol consists of several components. When you click the square or 

round part of an elevation tag (Figure 2.35), you have the ability to create four different 

elevation views by selecting or deselecting the check boxes.

Used to rotate the elevation

Check box to activate or deactivate 
the elevation.

Sheet on which the
elevation is placed

View number

When you click the elevation arrow, you get an additional 

option to change the width and depth on an elevation. In 

Figure 2.36, the solid bar represents the width of the elevation. 

The dashed line represents the depth of the elevation and can 

be adjusted by moving the arrows. Double-clicking the arrow-

head will open that elevation view.

Creating Section Views
Section views are a vertical slice through your building project 

(Figure 2.37). You can create section views in plan, section, 

elevation, and detail views.

To create a section view, follow these steps:

	 1.	 Open a plan, section, elevation, or detail view.

	 2.	 Click the View tab’s Create panel, and click the Section 

button.

	 3.	 In the Type Selector, select one of the following:

Detail•	

Building Section•	

Wall Section•	

	 4.	 On the Options bar, select the view scale.

Figure 2.35

Highlighted  
elevation tag

Figure 2.36

Adjusting the  
elevation width  
and depth
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	 5.	 In the drawing area, place the mouse pointer at the starting point of the section  

and drag through the model or family.

	 6.	 Click when you reach the end point of the section.

	 7.	 If applicable, resize the crop region by dragging the blue controls.

	 8.	 Click Modify or press Esc to exit the Section tool.

To open a section, you can double-click the section head or select the section view 

from the Sections group of the Project Browser.

When you click the section, you get an additional option to change the width and 

depth on an elevation. In Figure 2.38, the solid bar represents the width of the section. 

The dashed line represents the width and depth of the section and can be adjusted by 

moving the blue arrows. Double-clicking the arrowhead will open that section view.

Create a gap in the section.

Control to rotate
the section.

Dashed line adjusts depth 
and width of the section.

View number and sheet
number of the section.

Flip the depth of the section.

Double-clicking
opens section view.

Figure 2.37

Section view 
example

Figure 2.38

Section view  
controls
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Creating Callout Views
Callout views are typically enlarged or detail views of a parent view from your build-

ing project (Figure 2.39). You can create callout views from plan, section, elevation, and 

detail views, and they are dependent on the parent view in which they were created.

To create a callout view, follow these steps:

	 1.	 Open a plan, section, elevation, or detail view.

	 2.	 Click the View tab’s Create panel, and click the Callout button.

	 3.	 In the Type Selector, choose either Detail or View.

	 4.	 On the Options bar, select the view scale.

	 5.	 In the drawing area, define the callout area. You need to pick one point and then 

another point to create a rectangular shape to define the callout boundary.

	 6.	 If applicable, resize the callout area by selecting the callout and dragging the blue 

controls.

	 7.	 Click Modify or press Esc to exit the Callout tool.

Creating Drafting Views
Drafting views are 2D views used to generate geometry or information that would not 

normally be visible in the model. You can use drafting views for just about anything 

because they have no relationship to any specific portion of the model unless you specifi-

cally reference it to the model. Drafting views can be used to import existing CAD geom-

etry to make it part of your Revit documentation.

To create a drafting view, click Drafting View in the View tab’s Create panel. In the 

New Drafting View dialog box, provide the name for the drafting view and change the 

scale of the view as necessary.

Figure 2.39

Callout view  
example
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Creating 3D Orthographic Views
An orthographic 3D view is a 3D view that shows the building model where all the com-

ponents are the same size regardless of the camera’s distance. Revit can also create 3D 

perspective views that show the model in 3D where the building components that are far-

ther away appear smaller and components that are closer appear larger. We cover creating 

3D perspective views in Chapter 9, “Rendering.”

To create a 3D orthographic view, follow these steps:

	 1.	 Open a plan, section, or elevation view.

	 2.	 On the View tab’s Create panel, click the 3D View drop-down, and click Camera.

	 3.	 On the Options bar, make sure to deselect the Perspective option.

	 4.	 Click once in the drawing area to place the camera, and click again to place the  

target point.

Adding Legends
Legends are another type of view that allows you to place graphical representations of ele-

ments in the model to explain the symbols used in the project. When working in a legend 

view, you can add legend components, which are symbolic versions of all families and 

types in your project. To create a legend, follow these steps:

	 1.	 On the View tab’s Create panel, select the Legends drop-down, and click Legend.

	 2.	 In the New Legend View dialog box, type the legend name, for example Doors.

	 3.	 Choose the scale, and click OK. A new blank drawing window will open. In the view, 

you will use the Legend Component tool to place a symbolic representation of the 

families and types used in your project.

	 4.	 On the Annotate tab’s Detail panel, click the Component drop-down, and click  

Legend Component.

The Options bar (Figure 2.40) provides the means to select the family and view  

to use.

	 5.	 From the Family list on the Options bar, select the family name.

	 6.	 From the View list on the Options bar, choose the view type.

	 7.	 Click to place the symbolic view of the family on the sheet.

	 8.	 Repeat the process for as many family and types as you need to document in  

your legend.

	 9.	 Add labels, notes, and dimensions as appropriate.

Figure 2.40

Options bar for  
the Legend  

Component tool
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Modeling

In this chapter,  we cover the basics of modeling in Revit. We begin with a 

discussion of object selection and how to filter a group of objects that you have selected. 

We then move into a discussion on walls and wall properties.

This includes selecting objects; creating and editing walls, doors, and windows; using 

levels and grids; grouping; and adding columns. We will start by showing you how to 

select, move, copy, trim, extend, cut, delete, rotate, mirror, array, align, and match.

In this chapter, you will learn about the following:

Levels■■

Basic editing tools■■

Creating and modifying column grids■■

Walls■■

Modifying wall parameters■■

Defining wall structure■■

Creating doors and windows, curtain walls, floors,  ■■

ceilings, stairs, and roofs
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Levels
Levels are horizontal planes that go on indefi nitely. These planes act as references in your 

building project to host certain elements such as walls, fl oors, roofs, and ceilings. Levels 

allow you to defi ne fl oor elevation and key vertical elevation elements. What’s a key verti-

cal elevation element? The top of a parapet is one example. The nice thing about levels is 

that you can choose whether you want them associated with a fl oor and refl ected ceiling 

plans. In the case of the top of the parapet, you would not necessarily need to create a 

fl oor plan or refl ected ceiling plan of that view. Levels are key to modeling because you 

use them to help you defi ne the vertical extents of certain elements and for the vertical 

placement of other elements such as furniture.

In any given project, you should be creating levels for all the key heights and datums. 

You do this so that you can constrain your elements to those levels, and if for some rea-

son you make a change to the fl oor-to-fl oor heights, your elements will adjust in height 

accordingly. If you don’t do this, then it would be necessary to create your elements and 

assign absolute values to the height of the walls. But if you need to change the height of 

the parapet or fl oor-to-fl oor heights, then you would have to select all the objects and 

change their heights manually, which is very time-consuming.

It is not as simple as saying, “I have a fi ve-story building that consists of fi ve levels.” That 

is not really the case; you will defi nitely have many more than fi ve levels in that project. 

Nor should you have 115 levels in a typical four-story project, which we have actually seen.

W h aT ar E DaT u m S?

Datums are nonphysical items such as levels, grids, and reference planes that are used to 

establish project context. Grid lines, for example, are used for placing columns and other 

building elements. The grid lines are nonphysical elements that are not part of the building 

but are used to help defi ne and constrain the building model.

Datums can host elements. If you assign a wall’s base to a specifi c level, then when the 

elevation of that level changes, the wall will move with the level. Grids are similar to levels. If 

an element is constrained to a grid line, then when the grid moves, that element moves.

Another important feature of levels is that you can associate views with your levels. Levels 

can be associated with fl oor plan views and refl ected ceiling plan views. Both views and 

the level should have the same name. If you change the name of the level, you will be asked 

whether you want to change the names of the fl oor plan and refl ected ceiling plan views.

Let’s look at levels in a project. Start a new project using the default template. In the 

Project Browser, the Revit tree shows the different view categories. Under Views (All), 

look at the views under Floor Plans. Notice that there are three views: Level 1, Level 2, 

W h aT ar E DaT u m S?

Datums are nonphysical items such as levels, grids, and reference planes that are used to 

establish project context. Grid lines, for example, are used for placing columns and other 

building elements. The grid lines are nonphysical elements that are not part of the building 

but are used to help defi ne and constrain the building model.

Datums can host elements. If you assign a wall’s base to a specifi c level, then when the 

elevation of that level changes, the wall will move with the level. Grids are similar to levels. If 

an element is constrained to a grid line, then when the grid moves, that element moves.
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and Site. Under Elevations (Building Elevation), four views have 

been defined: East, North, South, and West (Figure 3.1). If you 

double-click one of the elevation view names, that view will open 

in the drawing area. Below the level name is the vertical height of 

the level (Figure 3.2).

Before you add or modify the levels, let’s look at the various 

controls for adjusting the appearance of a level. To follow along, 

zoom in on Level 2. Select either the level reference line or the 

level name or elevation (Figure 3.3).

When you select an element and a blue object or object controls appear, this indicates you 

can perform some kind of action to that object or object controls.

To change the name of the level, double-click the level 

name, and type a new name (Figure 3.4). Or you can 

select the level and change the name in the Properties pal-

ette. Type Roof for the new name, and press Enter. Revit 

will open a dialog box asking whether you really want to 

rename any corresponding views. Because levels are typi-

cally tied to floor plan and ceiling plan views, Revit will automatically keep the level and 

corresponding views name the same. Choose Yes, and note in the Project Browser that 

the floor and ceiling plan views have also been renamed to Roof (Figure 3.5).

Figure 3.2

Level examples

Figure 3.3

Selecting a level

Figure 3.4

Renaming a  
level to Roof

Levels
Levels are horizontal planes that go on indefinitely. These planes act as references in your 

building project to host certain elements such as walls, floors, roofs, and ceilings. Levels 

allow you to define floor elevation and key vertical elevation elements. What’s a key verti-

cal elevation element? The top of a parapet is one example. The nice thing about levels is 

that you can choose whether you want them associated with a floor and reflected ceiling 

plans. In the case of the top of the parapet, you would not necessarily need to create a 

floor plan or reflected ceiling plan of that view. Levels are key to modeling because you 

use them to help you define the vertical extents of certain elements and for the vertical 

placement of other elements such as furniture.

In any given project, you should be creating levels for all the key heights and datums. 

You do this so that you can constrain your elements to those levels, and if for some rea-

son you make a change to the floor-to-floor heights, your elements will adjust in height 

accordingly. If you don’t do this, then it would be necessary to create your elements and 

assign absolute values to the height of the walls. But if you need to change the height of 

the parapet or floor-to-floor heights, then you would have to select all the objects and 

change their heights manually, which is very time-consuming.

It is not as simple as saying, “I have a five-story building that consists of five levels.” That 

is not really the case; you will definitely have many more than five levels in that project. 

Nor should you have 115 levels in a typical four-story project, which we have actually seen.

W h at Ar e Dat u m s?

Datums are nonphysical items such as levels, grids, and reference planes that are used to 

establish project context. Grid lines, for example, are used for placing columns and other 

building elements. The grid lines are nonphysical elements that are not part of the building 

but are used to help define and constrain the building model.

Datums can host elements. If you assign a wall’s base to a specific level, then when the 

elevation of that level changes, the wall will move with the level. Grids are similar to levels. If 

an element is constrained to a grid line, then when the grid moves, that element moves.

Another important feature of levels is that you can associate views with your levels. Levels 

can be associated with floor plan views and reflected ceiling plan views. Both views and 

the level should have the same name. If you change the name of the level, you will be asked 

whether you want to change the names of the floor plan and reflected ceiling plan views.

Let’s look at levels in a project. Start a new project using the default template. In the 

Project Browser, the Revit tree shows the different view categories. Under Views (All), 

look at the views under Floor Plans. Notice that there are three views: Level 1, Level 2, 

Figure 3.1

Elevations in the 
Project Browser
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Any time a view is renamed, whether it is a floor plan, ceiling plan, or level, if there is a cor-

responding view, Revit will always ask whether you want to rename the corresponding view. 

If you allow Revit to perform this task, which is recommended, then your Project Browser’s 

corresponding view names will be renamed. If you do not allow Revit to rename correspond-

ing views, then you could have a floor plan with a different name than its corresponding 

ceiling plan and level.

To change the elevation of the level, you can follow similar steps as you did with 

changing the level name. You can double-click the elevation value and type in a new 

value (Figure 3.6). You can also change the elevation value in the Project Browser.

Another method involves changing the temporary dimension constraint of the level. 

Zoom out in your view so that you can see at least two levels. When you select the Roof 

level, a temporary dimension will be dis-

played between the two levels (Figure 3.7). 

Notice that the dimension value is blue, indi-

cating that you can edit it. If you click the 

dimension text and change it to 12 6, the roof 

level elevation will adjust accordingly.

Figure 3.5

Renamed level

Figure 3.6

Changing the eleva-
tion of level
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When you type in units, Revit will automatically assume that you are typing in feet and 

inches. Typing 10 6 in a dialog box is the same as typing 10´ 6˝. Revit sees the space between 

the 10 and the 6 as a feet/inch separator. If you only want to type in six inches, you could 

type either 6˝ or 0 6.

You can move levels by selecting the level or levels and dragging them up or down to 

the new location. The temporary dimension and snap settings increment will assist in 

positioning the levels.

S N ap S E T T I N G I N C r E m E N T S

When you place or move an element in a view, it will snap at user-defi ned dimension incre-

ments. For example, when you are moving the elevation of a level, as you move the mouse 

pointer up or down in the drawing area, you see the dimensions for the level increase or 

decrease according to the defi ned length dimension snap increments. The same applies to 

rotating an element; angle snap dimensions increase or decrease according to the defi ned 

angle dimension snap increments.

Unlike AutoCAD, in Revit you can defi ne multiple length and angle snap increments to 

account for changes as you change your zoom level (the closer you zoom in, the smaller the 

increment; the further you zoom out, the larger the increment).

To set or review snap increments, follow these steps:

 1. Click the Manage tab, go to the Settings panel, and click Snaps.

 2. Select Length Dimension Snap Increments and Angular Dimension Snap Increments to 

turn on the snaps. Deselect to turn off  the snaps.

 3. Edit or add the snapping increment values, separating each increment with semicolons. 

There is no limit to the number of increments you can specify.

 4. Click OK to apply the changes.

Figure 3.7

Selected level 
showing temporary 
dimensions

S N ap S E T T I N G I N C r E m E N T S

When you place or move an element in a view, it will snap at user-defi ned dimension incre-

ments. For example, when you are moving the elevation of a level, as you move the mouse 

pointer up or down in the drawing area, you see the dimensions for the level increase or 

decrease according to the defi ned length dimension snap increments. The same applies to 

rotating an element; angle snap dimensions increase or decrease according to the defi ned 

angle dimension snap increments.

Unlike AutoCAD, in Revit you can defi ne multiple length and angle snap increments to 

account for changes as you change your zoom level (the closer you zoom in, the smaller the 

increment; the further you zoom out, the larger the increment).

To set or review snap increments, follow these steps:

 1. Click the Manage tab, go to the Settings panel, and click Snaps.

 2. Select Length Dimension Snap Increments and Angular Dimension Snap Increments to 

turn on the snaps. Deselect to turn off  the snaps.

 3. Edit or add the snapping increment values, separating each increment with semicolons. 

There is no limit to the number of increments you can specify.

 4. Click OK to apply the changes.
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Creating a Level
Two methods are available to create a level, the Pick Lines tool and the Sketch tool.  

To add new levels to a project with the first method, use the following steps:

	 1.	 Change the active view to a section or elevation view.

	 2.	 Click the Home tab, go to the Datum panel, and click Level. Notice that the ribbon 

switches to the Modify | Place Label tab.

	 3.	 You have two options to draw the level. The first allows you to draw a line segment 

(by default), and the second option allows you to pick lines. Select the Pick  

Lines tool.

	 4.	 On the Options bar, make sure that Make Plan View is specified, and specify an  

offset value of 10´ 0 .̋

	 5.	 Move the mouse pointer over one of the existing level lines that you want to use as an 

offset to create the new level (Figure 3.8). Notice the new level line that appears above 

the previous level line.

	 6.	 Click the left mouse button to create the new level.

2. Revit provides a preview for the 
    location of the new level.

1. Move the cursor over an existing level.

The Options bar for the Level tool has several options (Figure 3.9):

Make Plan View  ​When this option is selected, after you draw your level line, the floor 

plan and reflected ceiling plan views will be automatically created. If this option is not 

selected, then the level is considered a reference or nonstory level, and no associated floor 

or ceiling plan view is created.

Plan View Types  ​This opens a dialog box that allows you to choose the view types (floor 

plan and ceiling plan) that will be created when the Make Plan View is selected.

Offset  ​Specifying an offset value will create a new level parallel to the level selected by  

the amount that is specified.

Figure 3.8

Creating a new level 
using the offset 

method and getting 
a preview of the 

location

Figure 3.9

Placing a level, 
Options bar
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Now, let’s create another level using the Sketch tool:

	 1.	 Click the Level tool on the Home tab’s Datum panel, and click the Line option.

	 2.	 In the drawing area, move your mouse pointer in the general area where you want to 

place your level. Notice that a temporary dimension is displayed showing the offset 

from the previous level. 

	 3.	 As you move the mouse pointer near the tail of an existing level line, a dashed cyan 

alignment line appears indicating its alignment with an existing level. Click to spec-

ify the first point of the level reference line, and move the mouse pointer to the right. 

Notice that level name, level line, datum, and elevation appear.

	 4.	 When the alignment line appears, click to place the level head. The level line is cre-

ated, and the temporary dimension is displayed indicating the level offset.

When you finish drawing the new level, the Level tool is still running. To stop a tool in 

progress, either select the Modify tool from the ribbon or hit the Esc key twice.

If you want to place multiple levels, using the Level tool is one method, but it’s not very 

efficient. You can use some of the basic editing tools to help with this task.

Clicking a level line displays the graphic controls shown in Figure 3.10. The blue squares 

on each end of the grid are check boxes used to control the visibility of the level heads. The 

blue circles on the end of the grid lines are the drag controls. These enable to you to extend 

or reduce the length of the grid line. The Add Elbow drag control allows you to move the grid 

bubble away from the grid line. When you use the Add Elbow drag control, the change will 

appear in the current view only.

The final control you want to look at is the Resizing Datum Extent controls. When the 

grid line shows the 3D designation, the grid line is in Model Extent mode. This means 

that if you drag and change the length of the grid line, the change will appear in all other 

parallel views, provided these grid lines also are set to the 3D model extent control. If the 

Resizing Datum Extent control is set to 2D, then the resizing of the grid line will take place 

only in that view.

With the intelligence of BIM and the ability to share this intelligence with other appli-

cations, it is important to be able to display your levels at the correct elevation above sea 

level. Revit provides you with 

the ability to use project and 

shared elevations. The project 

elevations are what we use 

and typically show in our 

document sets. Shared eleva-

tions allow you to display the 

true elevation of the project 

without moving the project.

Figure 3.10
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Basic Editing Tools
Before you get too far into learning basic modeling techniques, you need to learn how to 

use the various editing tools so you can modify the elements that you have created. You 

can fi nd these tools on the Modify tab (Figure 3.11).

Selecting Objects
To edit an element, you need to be able to select it. Revit provides a number of ways to do 

this, some of which are similar to AutoCAD. The basic method for selecting objects is to 

use the mouse.

You can select a single element simply by clicking it. The element will turn light blue 

indicating that it has been selected.

To select multiple elements, several methods are available:

Ctrl+clicking•	

Creating a “window” or “crossing window” marquee•	

Chain selecting (walls and lines)•	

Using the Select All Instances command•	

Ctrl+clicking each element individually adds it to a selection set. The elements turn 

light blue indicating that they have been added to the selection set.

You can create a window selection by using a click-and-drag operation in the drawing 

area: pressing the left mouse button and dragging the mouse pointer diagonally from left 

to right to create a selection box around the elements to be selected. Only the elements 

that are completely within the window will be selected (Figure 3.12). The window selec-

tion rectangle will be a solid gray line. Items 

added to the selection set will turn light blue.

You can create a crossing window selection 

by pressing the left mouse button and dragging 

the mouse pointer diagonally from right to left to 

create a selection box around the elements to be 

selected. All elements that either are in the win-

dow boundary or are touched by it are added the 

selection set (Figure 3.13). The crossing window 

rectangle will be a gray dashed line. Items added 

to the selection set will turn light blue.

Figure 3.11

Modify tab

Figure 3.12

Window selection—
red elements (here, 

gray) selectedgray) selected

First clickirst click

Selection window Second click
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First clickSelection window

Second click

You can use the Chain option to select objects 

such as walls and/or lines that are joined in a 

continuous chain. To create a chain selection, first 

select one element by clicking it or hovering the 

mouse pointer over it (Figure 3.14). Press the Tab 

key once, and Revit highlights all the elements in 

the chain (Figure 3.15). You may have to press the 

Tab key more than once for more complex chains.

You can also use the Select All Instances 

options to select all instances of an element type 

that is used in the project. You might want to do 

this to globally change element properties, such 

as manufacturer or finish information. You might 

want to change the element type to switch from a 

single-flush to a double-flush door. You might also 

need to delete or modify a specific element.

To use Select All Instances, first select a single 

instance of the element type that you want to add 

to the selection set. You can do this in any view. In 

Figure 3.16, we have selected a toilet, right-clicked 

to open a context menu, and selected the Select All 

Instances item. You have two options:

Visible In View  ​This option will only select 

instances of the elements that are visible in the cur-

rent view. By view, Revit means the view that you 

have open such as the Level 1 floor plan and not just 

the area that is visible in the drawing area window.

In Entire Project  ​This option will select every 

instance of the element in the entire project.

Figure 3.13

Window crossing 
selection—red ele-
ments (here, gray) 
selected

Figure 3.14

Selecting the first 
element that is part 
of the chain

Figure 3.15

Chain selection

Figure 3.16
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Filtering and Element Selection Count

When you select multiple elements, you often end up selecting unintended elements. 

Hold down the Shift button and click on the unwanted elements to remove them from 

the selection set.

For more complicated changes to the selection set, you can use the Filter tool (the item 

that looks like a funnel on the status bar) to eliminate elements by category from your 

selection set. When you have elements selected, the Filter tool will display the total num-

ber of elements selected. Figure 3.17 shows that 44 elements are selected.

To remove element categories from a selection set, click the Filter tool on the status 

bar. This will open the Filter dialog box (Figure 3.18). The Filter dialog box lists the 

selected elements categories. It also displays the number of selected elements in each cat-

egory and the total number of selected elements. 

Clearing the check boxes deselects categories of 

elements.

Moving Objects
Revit provides numerous methods for moving 

and copying elements in the drawing area: rib-

bon options, keyboard actions, and on-screen 

controls. The fi rst option for moving an element 

is to utilize the temporary dimensions.

LI S T E N I N G D I m E N S I O N S

When you are sketching, rotating, moving, and so on, Revit will provide temporary reference 

dimensions. These are known as listening dimensions. At any time during the editing, you can 

enter a new value for length or rotation.

Figure 3.17

Selection count tool 
and filter listing on 

status bar

Figure 3.18

Filter dialog box

LI S T E N I N G D I m E N S I O N S

When you are sketching, rotating, moving, and so on, Revit will provide temporary reference 

dimensions. These are known as listening dimensions. At any time during the editing, you can 

enter a new value for length or rotation.
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As you create or place elements in Revit, temporary dimensions will be displayed 

around the element. This helps you accurately defi ne and place an element relative to the 

surrounding elements in your building project. There are two different types of tempo-

rary dimensions: listening and viewing.

Listening dimensions are present when you are creating or placing elements, and you 

can specify values during placement. Listening dimensions appear bold and blue, and 

they update when you move your mouse pointer, such as dragging the length of a wall.

Viewing dimensions become active when you select an element. They display a dimen-

sion in reference to the nearest element. You can move the witness lines (dimension 

extension line) of a temporary dimension to a new location to reference specifi c elements.

Figure 3.19 displays a wall selected that shows temporary dimensions. Clicking the 

witness line grip (the blue square grip on the temporary dimension witness line) allows 

you to toggle between the center of the wall, fi n-

ish face, core face, and so on, depending on the 

type of wall. Changes you make to the witness 

line are saved for the current Revit session.

The blue circles are the Drag Wall End 

controls. The position of the blue circles indi-

cates the wall location line and the ability to 

change the length of a wall by dragging. The 

two opposite-facing arrows are fl ip controls. 

Flip controls on elements are always on the exterior side of the object. Clicking the fl ip 

controls fl ips the element and, in the case of walls, uses the location line as the axis line. 

Temporary dimensions also have a switch to convert a temporary dimension to a perma-

nent dimension.

FaK I N G D I m E N S I O N S I N r E V I T

In Revit you are not able to fake a dimension. A dimension’s value is the actual distance, and 

if you change a dimension value, the model will change to refl ect the new dimension.

Another method for moving as well as copying an object involves using the dragging 

option. To move or copy an object using the dragging option, follow these steps:

 1. Select an object in the drawing window.

 2. On the status bar, make sure that the Press & Drag check box is selected.

 3. Move the mouse pointer over the element, and click and hold the left mouse button.

Figure 3.19
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FaK I N G D I m E N S I O N S I N r E V I T

In Revit you are not able to fake a dimension. A dimension’s value is the actual distance, and 

if you change a dimension value, the model will change to refl ect the new dimension.
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	 4.	 Move the mouse pointer to the desired location. As you drag the mouse pointer, 

Revit will display the original element and an image of the element moving with the 

drag, as shown in Figure 3.20.

	 5.	 When the element reaches the desired location, release the left mouse button.

As you move, copy, or perform editing tasks on elements, Revit will provide you with visual 

cues regarding the end result of what you are trying to accomplish.

Another method for moving elements is to use the Move tool. The Move tool is very 

similar to Press & Drag, except that you will not get the same preview of the elements. 

The Move tool will also provide more precision, allowing you to take advantage of the 

temporary dimensions.

To use the Move tool , follow these steps:

	 1.	 Select the element(s) to be moved.

	 2.	 On the Modify tab’s Modify panel, click the Move tool. The Options bar for this tool 

has a couple options:

Constrain  ​Selecting this restricts the movement of the selected elements along vec-

tors that run perpendicular or collinear to the element.

Disjoin  ​Selecting this breaks the association of an element with its associated ele-

ments and moves it to a new location. Some example uses are when you want to 

move a wall that is joined to another wall.

	 3.	 Click in the drawing area to pick the start point for moving.

	 4.	 Move the mouse pointer to the desired move location, and click to specify the end 

point. You can also move the mouse pointer and edit the temporary dimension to 

specify the new location.

	 5.	 The elements are moved to the new location.

Figure 3.20

Moving a wall with 
preview image
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Copying Objects
Using the Copy tool  is very similar to using the Move tool:

 1. Select the elements to be moved.

 2. On the Modify tab’s Modify panel, click the Copy tool.

The Options bar for the Copy command shares several of the same options as the 

Move tool. In addition, Copy also utilizes the Multiple option. Select this check 

box to create multiple copies of the elements and then click where you want to 

place them.

 3. Click in the drawing area to pick the start point for copying.

 4. Move the mouse pointer to the desired copy location, and click to specify the end 

point. You can also move the mouse pointer and edit the temporary dimension to 

specify the new location.

 5. The element(s) are moved to the new location.

The following list is a general set of rules regarding moving and copying:

Walls that are moved or copied using the press and drag method will have the wall •	

joins adjusted automatically.

Some elements can be moved only in a particular direction. Pressing Shift removes •	

this constraint.

Some elements can be moved in all directions. Pressing the •	

Shift key restricts the direction of movement.

When moving and copying elements, specify •	

a distance with the listening dimension 

(Figure 3.21) to move in the direction you 

move the mouse pointer. Specifying a negative 

dimension value will move the element in the 

opposite direction of the mouse pointer.

Rotating Objects
The Rotate tool  allows you to rotate elements around a specifi ed axis or point. In 

fl oor plans, ceiling plans, elevation views, and section views, elements will be rotated 

around an axis perpendicular to the view. In 3D views, elements will be rotated about an 

axis perpendicular to the current work plane of the view.

The trick to using the Rotate tool is understanding the 

rotate controls shown in Figure 3.22. The symbol is used 

to change the center of rotation. By default, Revit will 

position the center of rotation symbol by fi nding the cen-

ter of the objects selected. This often will probably not be 

Figure 3.21
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the location that you need for the origin of your rotation. By left-clicking and dragging 

the center of rotation symbol, you can relocate it. The symbol automatically snaps to 

points and lines such as walls and intersections of walls and lines.

To rotate an element, follow these steps:

	 1.	 Select an object to rotate.

	 2.	 On the Modify tab’s Modify panel, click the Rotate tool.

	 3.	 On the Options bar, select any of the following options if applicable:

Disjoin  ​Selecting this option breaks any connection between the selection and other 

elements before the rotation.

Copy  ​Selecting this option creates a copy of the selection, and the original remains 

in place.

Angle  ​With this option, you can specify the 

angle of rotation. After pressing Enter, the rota-

tion is performed, and no further steps are 

necessary.

	 4.	 In the drawing area, click to specify the first ray 

of rotation.

	 5.	 Move the mouse pointer to place the second ray 

of rotation, or specify an angular dimension 

(Figure 3.23).

	 6.	 Click to place the second ray, and finish rotating 

the selection.

If you are trying to rotate and the rotation symbol does not appear, this means that the 

active workset is turned off in the view. Change the active workset to one that’s visible or 

turn its display on in the view, and the rotation symbol will reappear.

Arraying Objects
When you need to create multiple copies of selected elements in a rectangular or radial 

fashion, use the Array tool . The Array tool has two options:

Linear (Default) allows you to copy items along a straight line.•	

Radial allows you to copy items around a circle or arc and is very similar to the •	

Rotate tool.

To create multiple copies along a straight line, use the Linear Array option. In the next 

example, you will array a series of doors along a wall:

	 1.	 On the Modify tab’s Modify panel, click the Array tool.

	 2.	 Select the door.

Figure 3.23

Rotating by editing the listening 
dimension
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	 3.	 Right-click and select Finish Selection, or hit the Enter key or spacebar. The Options 

bar (Figure 3.24) for the Array tool provides these settings:

Linear/Radial  ​The first two buttons indicate whether you will be creating a linear or 

radial array.

Group and Associate  ​This check box enables 

you to create a group of the selected elements, which are then copied as a group 

rather than as individual elements. If deselected, once placed, each copy acts inde-

pendently of the others.

Number  ​Used to specify the total number of copies in the array.

Move To  ​Indicates how Revit should space the objects in the array.

The option named 2nd specifies the distance from the original selected member to 

each member of the array. Additional array members will appear after the second 

member. The option Last specifies the entire span of the array from the first to the 

last; the array members are evenly spaced between the first and last member of the 

array.

Constrain  ​This check box will restrict the movement of array members along vectors 

that run perpendicular or collinear to the selected elements.

	 4.	 In the Options bar, set the number of items to 4 and set the Move To radio button  

to Last.

	 5.	 Click in the drawing window to pick the start point of the array.

	 6.	 Move your mouse pointer along the wall until the length is 50´ 0˝ (Figure 3.25). Click 

to accept the length.

The array is then completed, and you are provided with an option to change the num-

ber of elements in the array (Figure 3.26).

Figure 3.24
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Creating a radial array is similar to creating a linear array. The Options bar for creat-

ing a radial array provides a new Angle edit box to specify the angle at which the array is 

to be created.

Resizing Objects
You can use the Scale  tool to modify the scale of a single element or a selection of 

elements. This tool is limited to walls, lines, images, DWG and DXF imports, reference 

planes, and the positions of dimensions. Items such as doors, windows, and furniture 

cannot be scaled. In the following example, you have a rectangle of four walls and are 

going to change the length of the vertical walls to 60´ 0˝ from 30´ 0 .̋

	 1.	 Select the horizontal (top and bottom) walls.

Why are you selecting the horizontal walls to change the vertical wall length? You are 

using the top and bottom walls to define your reference length. You will then use the 

Scale tool to specify a new reference length.

	 2.	 On the Modify tab’s Modify panel, click the Scale tool. The Options bar provides  

two options:

Graphical  ​When this option is enabled, you will scale your elements graphically in 

the drawing area. To use this option, specify three points, first to specify the origin 

of scaling and the other two to define the scale vectors. Once you have defined the 

origin, you move the mouse pointer and click to specify the length of the first vector. 

Revit will then calculate the proportion of the two vectors and resize the element in 

the same proportion using the specified origin.

Numerical  ​When this option is used, you specify a numeric value for the scale.

	 3.	 Select the lower end point of the wall for 

the first input, the origin point, or the base 

point (Figure 3.27).

	 4.	 Select the upper end point of the wall for 

the second input, the reference length,  

or the drag point.

	 5.	 Select the midpoint of the wall for the third 

input or the desired length.

The walls then immediately adjust.

The following list is a general set of rules 

regarding resizing:

All elements must lie in parallel planes.•	

All walls in the selection must have the •	

same base level.
Figure 3.27
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Resizing changes the position of dimensions but not their values. If you resize an ele-•	

ment that a dimension references, the dimension value does not change.

When you resize a wall, inserts remain at a fixed distance from the wall’s midpoint.•	

Resizing moves the position of the location line of the walls, but it does not change •	

either the height or the thickness.

Mirroring Objects
The Mirror tool is used to create a mirror image of the selected elements around an axis 

defi ned by a line passing through two points. To create this reference axis line, you can 

either draw an axis line or pick geometry to be used as the 

axis for the mirroring. When you start the Mirror tool, the 

Options bar will present you with the Copy option. By default 

this option is selected and will create a mirrored copy of the 

elements. If this option is not selected, then the selected ele-

ments are mirrored to the new location. To mirror an element, 

follow these steps:

 1. Select the elements that you want to mirror (Figure 3.28).

 2. Click the Modify tab’s Modify panel, and click Pick Mir-

ror Axis or Draw Mirror Axis. If you select Pick Mirror 

Axis, select a line or element to use as the axis line. If you 

choose Draw Mirror Axis, then you will need to sketch a 

temporary mirror axis line.

 3. Select or draw the line or element you want to use as a 

mirror axis. After you select or draw a reference line, a 

new element will be created. You can only pick a line or a reference place that the 

mouse pointer can snap to. You cannot mirror a component around empty space.

Revit then either moves or copies the selected ele-

ments and reverses its position opposite the selected 

axis (Figure 3.29).

Aligning Objects
As you work on your building project, you will fi nd 

a situation when you need to align  two or more 

objects with one another. You can choose an element 

that acts as a reference line or a place along which the 

other elements can be aligned.

Figure 3.28
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When you align them, a padlock key is displayed, which represents the alignment 

constraint. With the padlock key, you can lock or unlock the alignment of the elements. 

Once elements are alignment locked, when one is moved, they will all move together.

In the following example, you have a group of desks that need to be aligned with one 

another, as shown in Figure 3.30. The topmost desk is properly positioned, and you will 

use the leftmost edge of the desk as your reference point.

	 1.	 On the Modify tab’s Modify panel, click the Align tool. The Options bar provides 

you with two options:

Multiple Alignment  ​Selecting this option allows you to align multiple elements with  

a selected element.

Prefer  ​This drop-down indicates the method of how the selected wall will be aligned. 

The options are Wall Faces, Wall Centerlines, Face Of Core, and Center Of Core.

	 2.	 Select the Multiple Alignment option on the Options bar.

	 3.	 Select the top desk’s left edge for the reference element.

	 4.	 Select the left edges of the bottom three desks to align to the top desk. After you 

make this selection, the desks will align (Figure 3.31).

Select these edges to
align to reference

Reference line for
alignment

Trimming and Extending Objects
Unlike some CAD applications, the trim and extend actions are integrated into a single 

tool. You can trim or extend an element to meet other elements at a boundary, which is 

defined by selecting an element. You can use this tool with walls, lines, beams, and braces.

Figure 3.30
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Figure 3.31
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If you want to trim or extend two selected elements to form a corner, follow these steps:

 1. On the Modify tab’s Modify panel, click the Trim/Extend To A Corner tool.

 2. Click the first line or wall to define the trim/extend boundary. Make sure that you 

click the part of the element you want to keep.

 3. Move your mouse pointer over a second line or wall 

to trim/extend. Notice the dashed blue line. This 

provides a preview of what the end result of the 

operation will be. Click the part of the element you 

want to keep, and that element will automatically be 

trimmed or extended (Figure 3.32). The elements 

are trimmed.

You can also trim or extend multiple elements using a common boundary or edge. 

Figure 3.33 shows the walls you want to trim and extend.

 1. On the Modify tab’s Modify panel, click the Trim/

Extend Multiple Elements tool.

 2. Click the first line or wall to define the trim/extend 

boundary. Make sure that you pick the part of the ele-

ment you want to keep.

 3. Move your mouse pointer over a second line or wall 

to trim/extend. Notice the dashed blue line. This pro-

vides a preview of what the end result of the operation 

will be. Make sure that you click the part of the ele-

ment you want to keep.

 4. Click additional elements that you want to trim/

extend, making sure that you click the part of the element you want to keep.

 5. Click the Modify tool on the ribbon, or hit the Esc key to end the command. 

The walls should now look like Figure 3.34.

Creating and Modifying Column Grids
You can use grids for spacing, aligning, and placing elements 

such as columns in your building project. You can also use  

grids to be references to the position of building elements in 

plan, section, and elevation views.

Grids in Revit are fi nite vertical planes that are represented as lines 

in plan, section, and elevation views (Figure 3.35). In plan views, you 

can create grid lines as either straight lines or arcs. In a section or elevation 

view, you can only create straight grid lines. If you create an arc grid line in 

plan view, it will not be displayed in section and elevation views.

Figure 3.32
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Figure 3.34
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and extending

 in Revit are fi nite vertical planes that are represented as lines 

in plan, section, and elevation views (Figure 3.35). In plan views, you 

can create grid lines as either straight lines or arcs. In a section or elevation 

view, you can only create straight grid lines. If you create an arc grid line in 

plan view, it will not be displayed in section and elevation views.

Figure 3.34
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Grids will not be displayed in 3D views. If you need to show your grids in a 3D view, then  

the grid lines in Revit need to be exported to a DWG file and then imported back into your 

3D view.

You have two methods for creating grid lines. The first is to draw them and use the 

various sketch options to draw either a line or arcs. The second option is to use the Pick 

tool to create grid lines from existing geometry. This can be from other Revit geometry 

or geometry from an imported or linked CAD file. In the following example, you are 

going to create a sample column grid, add dimensions to place and constrain the grid, 

and add structural columns to that grid.

Revit provides three options for drawing grid lines:

Draw •	 : Used to create straight-line grid segments

Arc •	 : Used to create curved grid lines

Pick •	 : Used to select an element

To create a straight grid line, follow these steps:

	 1.	 Start a new project using the default template.

	 2.	 On the Home tab’s Datum panel, click Grid.

	 3.	 In the drawing window, click a start point, and 

move the mouse pointer to the right.

As you start to sketch the grid line, notice that the start point of the grid line 

remains fixed. As you move the mouse pointer, a temporary dimension indicating 

the angle of the line with the horizontal axis is displayed, as shown in Figure 3.36.

	 4.	 Click to specify the end point of the grid line.

Figure 3.35

Column grid 
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Figure 3.36
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When drawing orthogonal grids, hold down the Shift key to force the movement of the 

mouse pointer to be on either the horizontal or vertical axis.

As you create grids, Revit will automatically number each grid line. Each grid line 

must have a unique identifier. No two grids can have the same number. To change a grid 

number, click the number, enter the new value, and press Enter. Numbers and letters can 

be used for grid values.

Clicking a grid line displays the graphic controls, as shown in Figure 3.37. The blue 

squares on each end of the grid are check boxes used to control the visibility of the grid 

bubbles. The blue circles on the end of the grid lines are the drag controls. These enable 

to you to extend or reduce the length of the grid line. The Add Elbow drag control allows 

you to move the grid bubble away from the grid line. When you use the Add Elbow drag 

control, the change will appear in the current view only.

Drag control

Grid bubble visibility control

Grid bubble 
visibility controlDatum extent control

Datum extent control

Add Elbow control

Grid bubble

Drag control

The final controls we’ll cover is the Resizing Datum Extent controls. When the grid 

line shows the 3D designation, the grid line is in Model Extent mode. This means that if 

you drag and change the length of the grid line, the change will appear in all other par-

allel views, provided these grid lines are also set to the 3D model extent control. If the 

Resizing Datum Extent control is set to 2D, then the resizing of the grid line will take 

place only in that view.

A quick way to create a structural grid is to draw the first grid line and then use the 

Copy command for the other grid lines. The number or letters will automatically incre-

ment as you copy. If your grid lines are going to be evenly spaced, then use the Array tool.

Keep the following issues in mind when working with column grids:

If you have multiple grids to place in a row, you can select one of the grids and use •	

the Copy tool with the Multiple option or use the Array tool.

Revit does not permit grid lines to have the same name.•	

Grid lines can be a single-line or arc segment only.•	

You can pin grid lines after they have been created to prevent the lines from being •	

inadvertently moved. To pin the location of the grid, select the grid lines and use the 

Pin tool on the Modify tab’s Modify panel.

It is recommended that when you draw your grid lines, you keep the end points •	

aligned with each other.

Figure 3.37
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Adding Columns
Revit provides two tools for adding columns to a project: Architectural and Structural. 

Architectural columns can and should be viewed as placeholders or decorative ele-

ments. Architectural columns also inherit the material of other elements to which they are 

joined, such as walls. Compound layers in walls will also wrap at architectural columns.

Structural columns are used to model vertical load-bearing elements in your building 

project. Structural columns share many of the same properties as architectural columns. 

Other structural elements such as beams, braces, and isolated foundations join to struc-

tural columns; this is not the case with architectural columns.

To place columns in this example, you are going to use the column grid from Figure 3.35:

	 1.	 To place a column, on the Home tab’s Build panel, click the Column drop-down, and 

select the Architectural Column tool.

	 2.	 In the Type Selector of the Properties palette, select the column type Rectangular 

Column 24˝ × 24 .̋ On the Options bar (Figure 3.38), Height and Room Bounding 

are self-explanatory. The Rotate After Placement check box allows you to rotate the 

column after it has been placed. An alternate option for rotating the column is by 

hitting the spacebar as you are placing the column.

	 3.	 Place columns by clicking a grid line intersection in the drawing area.

When placing architectural columns, the columns will snap to the column grid and 

grid line intersections. You can also place a column in the drawing area independent of 

a grid line or grid line intersection. You can use the temporary or listening dimensions 

to aid in the placement of the columns. After you’ve placed the columns, you can use the 

basic editing tools such as Move, Copy, and Array to aid in the placement of columns.

To place structural columns, you have several more options to speed the process up. 

You can find these options on the Modify | Place Structural Column tab on the ribbon 

(Figure 3.39) after selecting Structural Column from the Column drop-down. 

Placement •	 ➔ Vertical Column

Placement •	 ➔ Slanted Column

Multiple •	 ➔ At Grids

Multiple •	 ➔ At Columns

Tag •	 ➔ Tag on Placement

Structural columns and architectural columns share the same Options bar options.

Figure 3.38
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Figure 3.39
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In this example, you are going to place multiple columns by grid using the column 

grid from Figure 3.35:

	 1.	 To place a column, on the Home tab’s Build panel, click the Column drop-down, and 

select the Structural Column.

	 2.	 From the Type Selector of the Properties pal-

ette, select the column type W-Wide Flange-

Column W10X49.

	 3.	 On the Options bar, set the height of the  

columns.

	 4.	 On the Modify | Place Structural Column’s 

Multiple panel, click the At Grids button. 

	 5.	 Select all grid lines.

	 6.	 On the Modify | Place Structural Column’s 

Multiple panel, click Finish. The columns are 

automatically placed at every intersection of 

the selected grid lines (Figure 3.40).

Walls
Walls are one of the fundamental building blocks of building projects. Walls are 3D para-

metric elements that can host elements such as door and windows. They can also host 

other wall-based elements such lights, light switches, and electrical outlets. Wall sweeps 

and reveals can also be applied to walls. Walls will also define rooms. In this section, we 

will cover the basic concepts of creating walls, modifying wall properties, and under-

standing the different basic wall types.

Revit provides several predefined wall types that are divided into families based upon 

usage:

Basic  ​Basic walls can either be monolithic and have a simple structure with varying wall 

thickness or be composed of multiple layers that represent the material types that define 

the wall. Some examples of layers are gyp board, studs, insulations, bricks, and so on.

Curtain  ​Curtain walls consist of panels divided by grid lines.

Stacked  ​Stacked walls consist of basic walls being stacked on top of one another.

Walls are part of a special group of families called system families. This means they 

reside and are defined in either a project or project template files. There are not wall family 

templates that allow you to create new wall types outside of your project environment. The 

good news is that you can still define new wall types and share them between projects.

For more information on families, see Chapters 6, “Introduction to Families,” and 17, “Creat-

ing Families.”

Figure 3.40
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There are several different methods for accessing these different wall styles in Revit. 

One method is to access the wall styles through the Project Browser (Figure 3.41).

Creating a Basic Wall
The Wall tool button is a split button (Figure 3.42) allowing you to 

choose between creating a wall, structural wall, wall by face, wall 

sweep, and reveal. A structural wall is the same as a normal wall with 

the usage set to structural for creating load bearing or shear walls. The 

Wall By Face tool allows you to create a wall from the face of a mass or 

generic model. Wall sweeps and reveals are applied to existing walls, 

which is why those options are grayed out here.

The Modify | Place Wall ribbon has the following options (from left 

to right).

Whenever you are creating or editing an element, the Modify tab will be displayed, and the 

ribbon is broken up into two parts. The leftmost part has the basic editing and element cre-

ation tools such as move, copy, element properties, and clipboard tools. These will be avail-

able for every tool. The right most part of the ribbon will be the tools specific to the element 

category you are editing. These panel names will have a light green background and will 

vary depending on the element being edited or created.

Properties panel  ​These buttons provide access to instance properties for an individual 

wall or the type properties for the wall type you are working with.

Clipboard panel  ​This provides tools for copying and pasting elements to the Windows 

clipboard.

Geometry panel  ​This provides tools used to modify 3D elements, such as cut, join, and 

applying materials.

Modify panel  ​This provides tools used to modify the elements, such as move, copy, and 

extend.

View panel  ​This provides tools for changing the display options for the view.

Measure panel  ​This provides tools for dimensioning or measuring a distance.

Create panel  ​This provides tools to either duplicate the element or create groups.

Draw panel  ​There are a variety of tools that can be used to define walls. Some of these 

tools allow you to sketch the location for the walls, and the Pick Line option allows you 

to pick existing lines to define your walls. The Pick Faces option allows you to pick faces 

from masses or other 3D geometry.

Figure 3.41
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From left to right are the following options for a wall’s Options bar:

Height  ​This option allows you to specify the wall’s top constraint (level) or 

enter a fixed top constraint. There are two options for setting the height of a 

wall. You can specify a fixed unconnected height of a wall to a fixed distance. 

If any changes are made to the level heights, then walls set to an unconnected 

height would not be impacted by the level change. Or you can specify a level 

to constrain the top of the wall to. Figure 3.43 shows two walls. The wall on 

the left has the height set to an unconnected height of 15´ 0 .̋ The wall on the 

right has the height constrained to the roof.

Location Line  ​This option determines where the wall sits around the line that you sketch 

to define the wall location. A wall’s Location Line property sets which vertical plane is 

used to position the wall in relation to the sketch you are creating to define the wall. 

The six different wall vertical planes are Wall Centerline, Core Centerline, Finish Face 

Exterior, Finish Face Interior, Core Face Exterior, and Core Face Interior (Figure 3.44).

In the Revit world, the “core” of a wall is the main structural layer or layers. In a typical stud 

wall, the core is the metal or wood studs.

Chain  ​When this option is selected and you are drawing a series of walls, the different 

wall segment end points will be connected.

Offset  ​Use this field to specify how far from the mouse pointer position the wall’s loca-

tion line will be and how much the wall will be offset.

Radius  ​Use this option when you need to create rounded corner joins as during the wall 

creation process.

Core Face: Interior

Wall Centerline Core Centerline

Finish Face: Interior Finish Face: Exterior

Core Face: Exterior

Figure 3.43
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The following steps describe the basic procedure for creating walls by sketching:

	 1.	 Click the Home tab’s Build panel, click the Wall drop-down, and select Wall. The 

Modify | Place Wall tab is displayed (Figure 3.45).

	 2.	 In the Properties palette’s Type Selector, select the Interior – 4 7/8˝ Partition (1-hr) 

wall type (Figure 3.46).

	 3.	 On the Modify | Place Wall tab’s Draw panel, click the Line tool.

	 4.	 Anywhere in the drawing window, click a point, and then move your mouse pointer 

to either the left or the right (Figure 3.47). As you start to draw, Revit will display a 

temporary listening dimension. As you drag your mouse, you can use this as a ref-

erence, or you can directly enter a distance value. To do this, after you pick a start 

point, just type in the value for the length of the wall, and press Enter. The light blue 

dashed line indicates the location line.

	 5.	 Prior to clicking to define the wall’s end point, you can hit the spacebar to flip  

the interior/exterior orientation of the wall. This features works on other elements  

as well.

	 6.	 Pick a second point to finish the wall.
Figure 3.45
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Now that you have the basics of creating a wall by sketching, let’s look at some of the 

other options, starting with creating walls by using the Pick tool and Offset option.

	 1.	 Open the source file rac_basic_sample_project 

.rvt. You can find this file in c:\Program Files\

Autodesk\Revit Architecture 201\Program\

Samples, which was installed with Revit Archi-

tecture 2011.

	 2.	 In the Project Browser, verify that the 01 – Entry 

Level f loor plan is active. (The text will be bold 

if it is the active view.) If it is not active, then 

either double-click the view name or right-click 

it and choose Open (Figure 3.48).

	 3.	 Click the Home tab’s Build panel, click the Wall 

drop-down, and select Wall.

	 4.	 On the Draw panel, click the Pick Lines draw option (Figure 3.49).

	 5.	 On the Options bar, set the Height con-

straint to 02 – Floor; then for Offset, type 13, 

and press Enter to set the offset to 2500 mm 

(Figure 3.50).

	 6.	 Move your mouse pointer over the wall to 

the right of grid line 3 between grid lines A 

and B until you see the dashed blue alignment 

line appear to the left of grid line 3, as shown in 

Figure 3.51.

	 7.	 Click, and the new wall is offset 2500 mm.

Modifying Wall Parameters
Now that we have covered the basics of creating walls, let’s look at the 

different element properties that control the definitions of walls and 

other elements in Revit.

Every element in Revit is an instance of a family type. A family could 

be a single-flush door, and that single-flush door could consist of a half-

dozen different sizes, each size being a different type. Each element in 

Revit—such as a Single-Flush 36˝ × 84˝ door—has two sets of element 

properties, called type properties and instance properties.

Figure 3.48

Context menu 
options

Figure 3.49

The Pick Lines icon 
from the Draw panel 
will allow you to use 
existing geometry.

Figure 3.50

Options bar settings 
for creating a wall 
by offset

Figure 3.51

Creating a wall 
using the offset 
function
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Instance Properties
Whenever you click an element in Revit, the Properties palette (Figure 3.52) displays 

the properties for that element, and you can immediately edit the instance parameters. 

If you select multiple elements, the Properties palette 

will display the common instance properties for all the 

selected elements. Instance parameters are those param-

eters that change only the individual object being added or 

modified.

The instance parameters will vary for each differ-

ent element type. Figure 3.52 shows an example of the 

various parameters for walls. These parameters are 

broken up into several different categories, including 

Constraints, Structural, Dimensions, Identity Data, and 

Phasing. The twin arrows to the right of the category 

name either expand or collapse the parameters for each 

category. Table 3.1 describes the various instance param-

eters for walls.

I n s t a n c e  P a r a m e t e r D e s c r i p ti  o n

Location Line Reference plane for sketching a wall
Base Constraint Level or reference plane of the wall
Base Offset Distance of the height of the wall from the base constraint
Base Is Attached Check box showing whether the wall is attached to another model compo-

nent such as a floor (read-only)

Base Extension Distance Distance that the base of the layers in the wall has been moved
Top Constraint Whether the wall height is defined by a specific level or a specific uncon-

nected height
Unconnected Height Specific height of the wall
Top Offset Distance of the top of the wall from the top constraint
Top Is Attached Check box showing whether the wall is attached to another model compo-

nent such as a roof (read-only)
Top Extension Distance Distance that the top of the layers in the wall has been moved
Room Bounding Check box showing whether the wall constitutes the boundary of a room
Related to Mass Check box indicating whether the wall was created from a mass (read-only)
Structural Usage Structural usage of the wall
Length Length of the wall (read-only)
Area Area of the wall (read-only)
Volume Volume of the wall (read-only)
Comments Text field to add comments to describe the wall
Mark Unique label or value; must be unique to every wall
Phase Created The phase when the wall was created
Phase Demolished The phase when the wall was demolished

Figure 3.52

Instance Properties 
dialog box for a wall

Table 3.1

Instance parameters 
for walls
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Room Bounding

It might seem out of place to discuss rooms during a topic of walls, but walls are the 

key elements to creating rooms. By default, whenever you create a wall, it is a bound-

ary element for the room elements. There are times, though, when you may not want 

this to happen. Figure 3.53 shows an example where you have a large office. Notice the 

room in the upper-left corner. By default, the walls are room bounding. When the Room 

Bounding switch in the wall instance Properties palette is deselected, you are left with 

one large room.

Structural Usage

Structural Usage can be set to define whether an element can “support” structural ele-

ments. Figure 3.54 shows the different options. Setting the Structural Usage option 

correctly is important when coordinating with the structural 

engineer. Figure 3.55 shows the different display options and how 

the walls will appear in Revit Architecture and Revit Structure. A 

wall created in Revit Architecture with a usage set to Non-bearing 

will not display in Revit Structure.

View set to Architectural View set to Structural

Non-bearing Non-bearing

Bearing Bearing

Figure 3.53

Room Bounding 
selected (left);  
deselected (right)

Figure 3.54

Structural Usage 
drop-down

Figure 3.55

Visibility with View 
set to Architectural 
(left); visibility with 
View set to Struc-
tural (right)
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Type Properties
Type parameters will alter every item in that type in the model. To access type param-

eters, click the Edit Type button to the right of the Type Selector in the Properties pal-

ette to open a separate Type Properties dialog box (Figure 3.56). These parameters are 

also broken up into several different categories, including Construction, Graphics, and 

Identity Data. When you make a change to a type parameter, that change will impact 

every instance of that wall type. Table 3.2 describes some of the type parameters for walls.

Clicking on 
the Edit Type

button brings 
up the Type 

Properties button

T y p e  P a r a m e t e r D e s c r i p ti  o n

Structure Allows you to define the composition for the wall type
Wrapping at Inserts Sets the wrapping around complex inserts such as doors, windows, and  

nonrectangular shapes
Wrapping at Ends Defines layer wrapping of wall end caps
Width Defines the width of the wall (read-only)
Function Used to define whether a wall is Exterior, Interior, Retaining, Foundation,  

Soffit, or Core-shaft
Coarse Scale Fill Pattern Sets the fill pattern for the wall in a coarse view
Coarse Scale Fill Color Sets a user-defined color to the fill pattern for a wall in a coarse view
Keynote Keynote for the wall
Model Model information (generally not used for walls)
Manufacturer Manufacturer information (generally not used for walls)
Type Comments General comments about the wall type
URL Hyperlink to a web page
Description Description of the wall
Assembly Description Description of the wall assembly, which is based upon the assembly code 

selection (read-only)
Assembly Code Uniform at assembly classification code
Type Mark Mark number for wall; must be unique for each wall in the project
Fire Rating Fire rating of the wall
Cost Cost of the wall

Figure 3.56

Click the Edit Type 
button to access 

type properties for 
a wall.

Table 3.2

Type Parameters  
for Walls
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Defining Wall Structure
As you start creating walls in Revit, you will notice that it is a relatively simple task work-

ing with walls. But when you need to use a wall type that does not ship with Revit, creat-

ing that new wall type can be tricky and time-consuming. The tools to accomplish this 

could be better, but with plenty of practice and patience, you can create new wall types. 

The real trick to doing this is understanding how Revit defi nes the structure of walls. 

This can be confusing, and it is not surprising that issues related to walls are one of the 

top issues that Autodesk’s 

Revit support team has to 

address. In this section, 

you are going to dive into 

the structure of walls and 

create and edit wall types.

In Revit, walls are com-

prised of different layers. 

Figure 3.57 shows a cutaway 

of the different components 

(layers) that make up a wall, 

in this case a wall in Revit. 

Each layer is a different compo-

nent of the actual wall composition, such 

as gyp board, metal studs, insulation, and so on. Each layer can be a differ-

ent thickness, can serve a different purpose, and of course can be made up of different 

materials.

The term layer in Revit has a completely different meaning in Revit than in AutoCAD. AutoCAD 

uses layers to help you categorize your drawings so that you can add or remove drawing ele-

ments all at once. They provide a means for managing and controlling the individual layout 

of the drawing. In Revit, layers refer to a building material that is part of a wall assembly such 

as a metal stud, insulation, gyp board, and so on.

Figure 3.58 is the Edit Assembly dialog box. This dialog box contains the tools nec-

essary for defi ning or editing your wall types. In this example, you are going to take a 

generic 8˝ wall and modify it to create an 8 ,̋ two-hour STC 60-rated interior partition.

 1. Start a new project from the default template.

 2. Open the Level 1 floor plan.

 3. On the Home tab’s Build panel, click Wall.

 4. In the Properties palette, click the Type Selector, and change the wall type to Basic 

Wall Generic – 8 .̋

Figure 3.57

Anatomy of a wall

Each layer is a different compo-

nent of the actual wall composition, such 
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	 5.	 On the Options bar, set Height to Level 2.

	 6.	 Draw a wall in the drawing window.

	 7.	 After you have drawn a wall segment, cancel the Wall tool by hitting the Esc key 

twice and clicking the Modify button on the ribbon.

	 8.	 Select the wall you just created.

	 9.	 In the Properties palette under the Type Selector, click the Edit Type button. This 

will bring you to the type properties for the wall. Because you are going to be modi-

fying this wall to create a new wall type, click the Duplicate button.

	10.	 Call the new wall Interior Partition – 2 hr 8˝ STC 60.

	11.	 Under Type Parameter in the Type Properties dialog box, click the Edit button in the 

Structure row under the Construction category.

	12.	 Figure 3.58 shows the wall Edit Assembly dialog box where you can edit or create 

new wall types. The top-right portion of the dialog box contains basic informa-

tion about the wall you are editing. Below that is a section marked Layers. This is 

where you define the different layers of your wall assembly. At the bottom of the Edit 

Assembly dialog box, click the Preview button.

	13.	 With the preview window open, to the left of the Preview button, change the View 

list to Floor Plan: Modify Type Attributes (Figure 3.59).

Figure 3.58

Edit Assembly 
dialog box with 

the preview pane 
opened

Figure 3.59

View drop-down
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Figure 3.60 shows the Layer fields of the Edit Assembly dialog box. This area allows 

you to modify or define new layers or the components that define the compound wall 

structure. When defining the wall, the exterior side of the wall is always defined toward 

the top of the dialog box and the interior side toward the bottom. In the example in 

Figure 3.60, you see three layers; two of them are core boundaries. These two layers define 

the boundary for the structure of the wall. Any layers that are within the core boundaries 

will be part of the wall structure.

This is very important. When you create a 

new wall and use a location line such as Core 

Centerline, the location line will be set in the 

middle of those two boundaries regardless of 

the number of components and thickness of the 

compound wall structure. In the following steps, 

you are going to change the structure of the wall 

by adding a stud layer and metal furring layers:

	 1.	 In the Layers field, click in the Material field in row 2.

	 2.	 Click the Browse button  to open the Materials dialog box.

	 3.	 Select the material Metal – Stud Layer (Figure 3.61), and click OK.

	 4.	 In the Layers field, click in the Thickness field in row 2, and change the thickness to 6 .̋

	 5.	 In the Layers field, click the number 3 that marks the bottom, Core Boundary, row.

Figure 3.60

Layers of a wall, 
from the Edit 
Assembly  
dialog box

Figure 3.61

Materials dialog box
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	 6.	 Click the Insert button to add an additional layer. This new layer should now be item 3. 

Select the new layer, and then use the Up button to change the location to item 2.

	 7.	 Click the Material cell, change the finish to Metal – Steel, and click OK.

	 8.	 Change the thickness to 1/2 ,̋ and press Enter.

You will now add two layers of gyp board to the exterior side of the wall definition.

	 1.	 Click 1 to highlight the entire row that reads Core Boundary Layers Above Wrap  

0´ 0 .̋

	 2.	 Click the Insert button. A new layer will appear as the new row 1.

	 3.	 Change Function to Finish 1 [4]. When you define a new wall layer, you must also 

define a function associated with it. Table 3.3 describes the six layer functions.

P r i o r it  y L a y e r  F u n c ti  o n D e s c r i p ti  o n

1 Structure Structural core of the wall
2 Substrate Secondary structural member that acts as a founda-

tion for another material
3 Thermal/Air Layer Insulation layer
4 Finish 1 Exterior finish layer
5 Finish 2 Interior finish layer

Membrane Layer Vapor barrier with zero thickness

	 4.	 Change the material to Gypsum Wall Board, and click OK.

	 5.	 Change the thickness to 1/2 .̋ The first layer is complete. You will follow similar steps 

to complete the second layer.

	 6.	 Click 1 to highlight the entire row that reads Finish 1 [4] Gypsum Wall Board 1/2 ,̋ 

and press Enter.

	 7.	 Click the Insert button. A new layer will appear as the new row 1.

	 8.	 Change the function to Finish 2 [5].

	 9.	 Change the material to Gypsum Wall Board, and click OK.

	10.	 Change the thickness to 1/2 ,̋ and press Enter. The second layer is complete.

You now need to add one final layer, the gyp board on the interior side of the wall 

definition:

	 1.	 Click 6 to highlight the entire row that reads Core Boundary layers Below Wrap 0´ 0 .̋

	 2.	 Click the Insert button. A new layer will appear as the new row 6 and is inside the 

core boundary. This layer needs to be moved outside the core boundary.

	 3.	 Click 6 (new layer) to highlight the entire row.

	 4.	 Use the Down button to move the row so that it becomes 7.

	 5.	 Change the function to Finish 1 [4].

Table 3.3

Wall layer function 
and wall cleanup 

priority listing
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	 6.	 Change the material to Gypsum Wall Board, and click OK.

	 7.	 Change the thickness to 1/2 ,̋ and press Enter.

	 8.	 Click OK twice to finish editing the wall type.

Figure 3.62 shows the completed compound wall layer definition.

Wall Joins
One of the great features of Revit is the almost always automatic wall join cleanups. These 

joins represent the display of intersection wall layers in plan view and are displayed in 

either a medium or fine view detail level. When two or more walls join, Revit will look at 

the wall’s layers and prioritize how they should be joined. Wall layers have different func-

tions and are represented by a hierarchy of numbers. This is used to determine how one 

layer should clean up with a layer from an adjoining compound wall. Table 3.3, shown 

earlier, described the priority and function for the six different types of wall layers.

The rules for how layers join is fairly simple: 1s will clean up with 1s, 2s with 2s, 3s 

with 3s, and so on. Also, the lower the number, the higher the priority when a cleanup 

is required. For example, when two walls join, the structure layer (Priority 1) will clean 

up before finish layers. This means that higher-priority layers will pass through lower-

priority layers. Revit does this by a prioritizing how the various layers of the wall will join 

together. This system generally works very well and requires little to no user interaction 

unless you want to change how the walls are joined or prevent walls from automatically 

joining.

Figure 3.62

Wall assembly for 
Interior Partition –  
2 hr 8˝ STC 60
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Figure 3.63 shows the three different wall join classifications: Butt, Miter, and Square 

Off. By default, Revit will create butt joins. If a join has an angle that is less than 20 degrees, 

then a miter join is created. If there is an end wall join condition with the angle being 

90 degrees, then a square-off join is created.

Butt joint Miter joint

Square-off joint Square-off joint

The last type of join is a radius join. A radius join is created when you have a rounded 

corner wall intersection. The radius join is created by drawing a wall using the Fillet Arc 

draw option and then selecting the two walls to create a fillet 

between them. You then specify the radius or drag a radius 

to create the wall join.

To edit a wall join, use the following steps:

	 1.	 Switch to a plan view. Make sure that your View Detail 

level is set to either Medium or Fine.

	 2.	 On the Modify tab’s Geometry panel, click Wall Joins.

	 3.	 Move your mouse pointer over the wall join that you 

want to edit. A large square will be displayed around the 

wall join (Figure 3.64). Click to select that wall join.

Figure 3.63

Wall join example

Figure 3.64

Selecting a wall join 
for editing
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	 4.	 On the Options bar, select Clean Join from the Display drop-down list to clean up 

the join by forcing the internal wall layers to join.

	 5.	 From the Configuration Options bar, select either Butt, Miter, or Square Off. (The 

Square Off option is grayed out for 90-degree joins.)

	 6.	 Click the Previous or Next button to cycle through the various join options.

	 7.	 Press Esc to end the command and to set your wall join.

There might be times when you do not want walls to automatically join, such as when 

creating expansion joints. In those cases, select one of the walls, right-click the blue circle, 

and select Disallow Join in the context menu. If you want to reenable automatic joining, 

select the wall again, right-click the blue dot, and select the Allow Join option.

The following are some rules regarding layer joining:

Higher-priority layers are connected before lower-priority layers.•	

Higher-priority layers will pass through lower-priority layers.•	

Layers need the same material applied to them in order for them to join properly.•	

Walls can have multiple core layers. An example is a plumbing chase wall.•	

Modifying Wall Profiles and Adding an Opening to a Wall
At some point when working with walls, it will be necessary to create an opening in the 

wall. Revit provides numerous options for creating openings in walls. Each method has 

its own pros and cons. We will discuss two methods, the Wall Opening tool and Wall 

Edit Profile tool.

The first method is to use the Wall Opening tool, which will allow you to create a rect-

angular opening in a wall:

	 1.	 Open a section or elevation view where you can see the wall you need to create an 

opening in.

	 2.	 On the Home tab’s Opening panel, click Wall Opening.

	 3.	 Select the wall to which the opening will be applied.

	 4.	 Sketch the rectangle of the opening. Once 

the sketch is complete, the opening is  

created.

You can modify the opening by either 

using the drag controls to modify the size and 

location or editing the temporary dimensions 

(Figure 3.65).

Figure 3.65

Using the Opening 
tool to create an 
opening in the wall
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The following are issues to keep in mind when using the Wall Opening tool:

Will only create a rectangular opening.•	

Will only cut one wall at a time.•	

Will create an opening in a curtain wall.•	

Opening will be perpendicular to the wall.•	

Opening is level based. If the level moves, so does the opening.•	

Is not room bounding.•	

The second method is modifying the profile of the wall (Figure 3.66). This allows you 

to create an opening and to also change the shape of the wall.

	 1.	 Open a section or elevation view where you can see the wall you need to create an 

opening in.

	 2.	 Select the wall you want to add an opening into.

	 3.	 On the Modify | Walls tab’s Mode panel, click Edit Profile.

	 4.	 The original outline of the wall will turn magenta, and Revit switches your view into 

Sketch mode. Using the basic 2D editing tools in the Draw panel on the ribbon, you 

can create new openings or change the shape of the wall.

	 5.	 When finished editing your sketch, on the Modify | Edit Profile tab’s Mode panel, 

click the green check  to finish the sketch.

Original wall Profile being edited wall Edited wall

You can edit the opening or profile change by selecting the wall, and then on the 

Modify | Walls tab’s Mode panel, click Edit Profile. If you want to reset the wall to the 

original shape, on the Modify | Walls tab’s Mode panel, click Reset Profile.

The following are issues to keep in mind when modifying the profile of a wall:

Will create just about any shape.•	

Will only cut one wall at a time.•	

Figure 3.66

Edit profile example. 
Left to right: The 

original wall, while 
the profile is being 

edited, and the 
edited wall.
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Opening will be perpendicular to the wall.•	

Opening is wall base offset based. Move the wall base and the opening will move.•	

When you place components like doors and windows, Revit will automatically create the 

opening when the component is placed.

Embedding Walls
Embedding walls is when you take one wall and place it within a wall of another type. A 

common use for embedding walls is to place a curtain wall inside walls of another type to 

represent glazing. Another use is to add a masonry panel into a brick wall.

A curtain wall is not a window. So if you embed a curtain wall into another wall to represent a 

window, be aware that it will not schedule as a window.

Automatically Embed allows curtain walls to be embedded into another wall. The curtain 

wall is then associated with the host wall. If you move or rotate the host wall, the embedded 

curtain wall moves with it. The embedded curtain wall will act in a similar fashion to that of a 

door or window in a wall.

In this example, you are going to embed a Curtain Wall Exterior Glazing wall in a 

brick wall, but this could also easily be a masonry panel:

	 1.	 Start a new project using the default template.

	 2.	 Draw a wall using the Basic Wall Exterior – Brick on Mtl. Stud type. Set the height to 

Level 2. Make the length 20´ 0 .̋

	 3.	 Create a new wall using the Curtain Wall Exterior Glazing wall type.

	 4.	 Draw the new curtain wall shorter and directly over the existing wall.

As soon as you finish placing the second wall, Revit will beep and display the Warning 

dialog box (Figure 3.67). What this message is indicating is that two walls are overlap-

ping, and they may not work properly with rooms. Use the Cut Geometry tool to correct 

the issue.

	 5.	 On the Modify tab’s Geometry panel, 

click the Cut tool.

	 6.	 Pick the host or main wall.

	 7.	 Pick the curtain wall.

By adjusting the height and adding both horizontal and vertical grids and mullions, 

you quickly added a glazed viewing window into the wall (Figure 3.68).

Figure 3.67

Warning dialog  
box about walls 
overlapping
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The following are the issues to keep in mind when working with embedded walls:

When using the Cut Geometry tool, pick the Host wall (main wall) first and then  •	

the wall to be embedded.

By default, a curtain wall will embed into a host wall.•	

Profiles of embedded walls can be edited.•	

Embedded walls can be edited (length, width, and height).•	

Stacked Walls
Sometimes on your building project you will need to create a compound wall by verti-

cally stacking two or more walls. A stacked wall uses a main wall for the base and one or 

more subwalls that are stacked on top of each other. The stacked walls are attached and 

have their geometry joined to each other.

In the next example, you are going to create a stacked wall that uses a standard interior 

partition, and you will stack a metal stud wall that goes up to the ceiling. The first step to 

accomplish this is to create your two different wall types. Revit ships with a wall type that 

you can use for your base. You will also use this as the basis to create the metal stud wall 

with no gyp board.

	 1.	 Start the Wall tool, and change the type to Basic Wall Interior – 4 7/8˝ Partition (1-hr).

	 2.	 Click the Edit Type button.

	 3.	 In the Type Properties dialog box, click Duplicate, name the new wall type Interior – 

3 5/8˝ Stud Wall, and click OK.

	 4.	 Click the Edit button in the structure row under Type Parameters to edit the wall 

structure.

	 5.	 Delete both the Finish 2 [5] Gyp Wall Board Layers. Your wall definition should now 

look like Figure 3.69.

Figure 3.68

Completed curtain 
wall embedded in 

the wall
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	 6.	 Click OK to close the Edit Assembly  

dialog box.

	 7.	 Click Apply to save your changes and 

then OK to close the Type Properties 

dialog box.

The next step in the process is to define 

your new stacked wall type. To do this, you 

are going edit the existing stacked wall type 

in the project.

	 1.	 Start the Wall tool, and change the type to Stacked Wall Exterior – Brick Over CMU 

w Metal Stud.

	 2.	 Click the Edit Type button.

	 3.	 In the Type Properties dialog box, click Duplicate, name the new wall type Interior – 

4 7/8˝ Partition – Unfinished Above Ceiling, and click OK.

	 4.	 Click the Edit button in the structure row under Type Parameters to edit the wall 

structure.

Notice that the middle section of the Edit Assembly dialog box (Figure 3.70) displays 

types rather than layers. The items listed in the Types list are displayed from the top 

of the stacked wall to the base. You are going to change the wall types listed to meet 

your needs.

Figure 3.69

Interior – 3 5/8˝ Stud 
Wall layer definition

Figure 3.70

Interior partition 
stacked wall
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	 5.	 Click Type 1, Exterior – Brick on Mtl. Stud. Click in the Name field, and then click 

the down arrow to enable the drop-down list.

	 6.	 Select Interior – 3 5/8˝ Stud Wall for the top wall type. Leave Height set to Variable 

because you want this top wall to grow or shrink in height as needed.

	 7.	 Click Type 2, Exterior – CMU on Mtl. Stud. Click in the Name field and then on the 

down arrow to enable the drop-down list.

	 8.	 Select Interior – 4 7/8˝ Partition (1-Hr) for your base wall type.

	 9.	 Change Height to 9´ 0 .̋ This will set the base wall to always be 9´ 0˝ tall and will be 

the starting point for your top wall. Click the Preview button. Figure 3.70 shows the 

newly defined stacked wall.

	10.	 Click OK to close the Edit Assembly dialog box, and click Apply and OK to save the 

Type Properties changes.

Keep the following issues in mind when working with stacked walls:

They are made from predefined basic wall types and are stacked vertically.•	

Curtain wall can’t be stacked.•	

One of the subwalls must be of a variable height.•	

Subwalls are scheduled and tagged individually.•	

To edit the structure of a stacked wall, you edit each subwall individually.•	

You can’t edit the profile of either the stacked wall or the individual subwalls.•	

You can separate a stacked wall into the individual wall types by right-clicking the •	

wall and selecting Break Up.

You can separate a stacked wall into the individual wall types by right-clicking the wall and 

clicking Break Up. The subwalls will have a Base Constraint value assigned based upon their 

relevant offset. The Top Constraint value will be assigned as unconstrained with a correct 

Unconnected Height. Once you Break Up a stacked wall, it cannot be rejoined, unless the 

Undo command is used.

Creating Doors and Windows
In this section, we will cover adding and modifying doors and windows to the building 

project. Doors and windows are wall-hosted elements. If you try to place a door or win-

dow into your project, it must be within a wall, or Revit will not permit the insertion. 

Generally speaking, doors and windows can be placed into any type of wall, with the 

exception of curtain walls. Curtain walls require you to swap a panel with a special door 

panel. Doors and windows can be placed in a plan, elevation, or 3D view.
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Doors and windows are component elements in Revit. Components are defined in sep-

arate Revit family (RFA) files. You can edit existing files and create new door and window 

families to develop your own library.

To add a new door and window to a project, follow these steps:

	 1.	 Open the source file rac_advanced_sample_project.rvt. You can find this file in 

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples, which was 

installed with Revit Architecture 2011.

	 2.	 Switch to the 01 –Entry Level f loor plan.

	 3.	 Zoom into the area between grids 3 through 6 and A through B (Figure 3.71).

	 4.	 On the Home tab’s Build panel, click 

the Door tool.

	 5.	 Select the M_Single-Flush 0915 × 

2134mm from the Type Selector. The 

Options bar for doors has one option 

related to the placement of the door 

and three related to the placement of 

the door tags:

Orientation  ​This drop-down list 

allows you to choose either Horizontal or Vertical orientation.

Tags  ​This button allows you to load new tags.

Leader  ​This option allows you to create a leader line between the tag and the door.

Dimension  ​This field allows you to change the default length of the leader.

	 6.	 In the drawing area, position the mouse pointer between grid lines 3 and 4 along 

grid line B. The precise location is not important. As you move your mouse pointer 

to one side of the wall or the other, this will f lip the location of the door. Pressing the 

spacebar will allow you to change the swing location of the door prior to placing it. 

Once you have located the door correctly, click the left mouse button to add the door.

After the door is placed, the Door tool is still active. The temporary or 

listening dimensions are still active displaying the distance between the door 

and either wall.

Figure 3.72 shows the different door controls. Clicking the double arrows 

that are perpendicular to the wall will flip the face of the door so that it opens 

outward and back again. Clicking the double arrows that are parallel to the 

wall will flip the hand of the door from right to left and back again.

Figure 3.71
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Figure 3.72
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In the next step, you will add a window to the left of the door you just placed.

	 1.	 On the Home tab’s Build panel, click the Window tool.

	 2.	 Select Fixed 24˝ × 48˝ from the Type Selector. The Options bar is the same as it was 

in the preceding procedure.

	 3.	 In the drawing area, position the mouse pointer between grid lines 3 and 4 along 

grid line B and to the left of the door you created in the previous example. The pre-

cise location is not important. As you move your mouse pointer along the wall, the 

position of the window will change. Click to add the window.

After the window is placed, the Window tool is still 

active. The temporary or listening dimensions are still 

active displaying the distance between the window and 

either wall.

Figure 3.73 shows the different window controls. The 

location of the double arrows indicates which side of the 

window is the “outside” face. Clicking the double arrows 

will flip window.

As you work on your building project, you will need to load additional door and win-

dow families. To load additional content, on the Insert tab’s Load From Library panel, 

click the Load Family tool. This will open the Load Family dialog box, which will allow 

you to select additional content to be loaded into your project file.

Editing Door and Window Properties
After you create a door or window, you can modify both the type and instance param-

eters. Type parameters include dimensions and materials. Instance parameters include 

swing direction and side, materials, and level. Keep in mind that any changes you make 

to the type parameters apply to all instances of that type in the project. Changes to 

instance parameters apply only to the selected instances of that particular door.

Keep the following issues in mind when working with doors and windows:

Deselect the Tag On Placement check box if you do not want to place tags automati-•	

cally when a door or window is placed.

Select the tag with the door or window if you want the tag to move with the door  •	

and window.

Use the spacebar to change the door swing while positioning the door for placement.•	

Place doors and windows quickly in their general location, and use the temporary or •	

listening dimensions for precise placement.

If door and windows are symmetrical on multiple floors, use the Copy tool in an •	

elevation or section view or copy to the clipboard to speed the process.

Sometimes it is much easier and faster to place doors and windows without tags.•	

Figure 3.73

Window controls 
and listening 

dimensions
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Creating Curtain Walls
Curtain walls in Revit are vertical panelized wall systems that are attached to 

the building structure but do not carry any floor or roof loads of the building. 

A typical curtain wall consists of panels, curtain grids, and mullions, as shown 

in Figure 3.74. Each of these curtain wall elements can be edited individually. 

Curtain walls come in two different varieties: curtain wall and curtain systems.

Curtain walls are drawn in a similar manner to walls. Curtain walls consist 

of panels that are divided by grid lines. These panels can consist of different 

materials, and mullions of specific shapes, sizes, and materials can be placed on 

grid lines to represent actual mullions. When you draw a curtain wall, Revit will 

create either a single panel that is extended the length of the wall or a panel that 

is subdivided into several panels based upon the curtain wall type. A curtain 

system is a component that comprises panels, grids, and mullions and is not 

normally rectangular in shape. Curtain systems are created by selecting the ele-

ment faces of existing geometry.

Curtain systems are created by using faces from other geometry such as 

masses. This allows for more complex forms such as sloped and curved.

Revit provides three curtain wall types: Curtain Wall, Exterior Glazing, and 

Storefront, as shown in Figure 3.75. You can access these types from the Type Selector 

when you are using the Wall tool.

When you create a curtain wall using 

the Wall tool and select the Curtain Wall 1 

type, the curtain wall is created as a single 

panel. You then use the Curtain Grid tool 

(go to the Home tab’s Build panel, and click 

Curtain Grid) to define the curtain grid sys-

tem. You will create your first curtain wall 

using the Wall tool.

	 1.	 Start a new project using the default template, and 

make sure you are on the Level 1 floor plan.

	 2.	 On the Home tab’s Build panel, click the Wall tool.

	 3.	 In the Proper t ies pa let te’s Ty pe Selector, cl ick Cur- tain 

Wall: Curtain Wall 1.

	 4.	 On the Options bar, set the height to Unconnected with a height value of 17´ 0˝ and 

deselect the Chain check box.

	 5.	 In the drawing window, click the start and end points for the wall.

	 6.	 Switch to a 3D view. Perform a zoom to fit if your curtain wall is not entirely dis-

played in the view window.

	 7.	 On the View Control bar, set the visual style to Shaded With Edges.

Figure 3.74
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Curtain wall

Curtain grid
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Figure 3.75
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When you create a curtain wall using the Curtain Wall 1 

type, Revit creates a single panel, as shown in Figure 3.76. To 

make this single panel look and behave like a curtain wall, 

you need to add curtain grids and then apply mullions to 

those grid lines. You can manually or automatically place 

the grid lines.

You will now add your horizontal grid lines by adjusting 

the type properties of the wall. Table 3.4 describes some of the 

curtain wall type properties that you will be working with.

N a m e D e s c r I p T I o N

Function Purpose of the wall: Interior, Exterior, Retaining, Foundation, Soffit, or Core-Shaft
Automatically Embed Determines whether the curtain wall automatically embeds into the wall
Curtain Panel Sets the curtain panel family type for the curtain element
Join Condition Controls how the mullions join at an intersection
Layout Sets the automatic horizontal and vertical layout for the curtain grid lines
Spacing Specifies the grid line spacing
Adjust for Mullion Size Check box for automatically ensuring panels are of equal size
Interior Type Specifies mullion family for interior mullions
Border 1 Type Specifies mullion family for vertical mullions on the left border
Border 2 Type Specified mullion family for vertical mullions on the right border

 1. Select the curtain wall panel you just created.

 2. In the Properties palette, click Edit Type.

 3. In the Type Properties dialog box, click the Duplicate button, name the new type 

My First Curtain Wall, and click OK. Remember, when you make a change to a type 

property, it impacts all instances of that type. So, it is a good idea to create new types 

rather than editing the default types that ship with Revit.

 4. Make the following change to the type properties:

Horizontal Layout Fixed Distance
Horizontal Spacing 5´ 0˝
Adjust for Mullion Size Checked

 5. Click the OK button to close the Type Properties 

dialog box. Your curtain wall is now divided into 

four panels, as shown in Figure 3.77.

Figure 3.76

Curtain wall panel

Figure 3.76

Curtain wall panel

Table 3.4

Curtain Wall 1 
Type Properties

Figure 3.77

Curtain wall divided into 
horizontal grid lines

Figure 3.77

Curtain wall divided into 
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To create the vertical grid lines, you will use the Curtain Grid tool.

	 1.	 On the Home tab’s Build panel, click Curtain Grid.

The Modify | Place Curtain Grid tab will be displayed, and the last panel, Placement 

(Figure 3.78), will provide you with three different options for defining your curtain 

grids.

All Segments  ​Places a grid segment on all panels. A preview is provided to 

aid in placement.

One Segment  ​Places one grid segment on one panel. A preview is provided 

to aid in placement.

All Except Picked  ​Places a grid segment on all panels except those you 

choose to exclude.

	 2.	 From the Placement panel, select a placement type.

	 3.	 Move the mouse pointer along the edge of the curtain panel. A temporary 

grid line with dimensions will be displayed previewing the placement. Click 

to place the grid line.

Modifying Curtain Wall Grids
Curtain wall grids are created in one of two methods, automatic and manual. 

When you edit the type parameters of a curtain wall, this will create an auto-

matic curtain grid. Curtain walls created in this manner are known as an automatic 

curtain grid. The vertical and horizontal grid pattern parameters are 

used to divide the curtain wall with the user-defined number of grid 

lines. The position of the curtain grids in an automatic curtain grid 

remain fixed if the length or height of the wall is modified. The wall 

types Curtain Wall Exterior Glazing and Curtain Wall Storefront are 

examples of curtain walls that use the automatic curtain grid.

If the Curtain Grid tool was used to create curtain grid lines in your 

curtain wall manually, then that curtain wall uses the manual curtain 

grids. 

Modifying Automatic Curtain Grids

Modifying the curtain wall grid is a straightforward process once you 

unpin the grid lines. When you create a curtain wall in Revit, the grid 

lines automatically have their position pinned or locked in place so 

that you do not accidently adjust them during the editing process. In 

Figure 3.79, we have clicked a grid line, and in addition to the tempo-

rary dimensions, there is a small icon that resembles the head of a pushpin.

Figure 3.78

Curtain Grid Place-
ment options

Figure 3.79
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The pushpin is a control that provides a quick way to either allow or prevent changes 

to an element’s location. Use the Pin Position tool to lock a modeling component in place. 

When you pin a modeling component, it cannot be moved. If you try to delete a pinned 

component, Revit Architecture warns you that the component is pinned. A pushpin con-

trol appears near the element to indicate that it is locked.

If you pin a component, it can still move if the component is set to move with nearby 

elements or if the level where it is placed moves up or down.

	1.	 Open the ModifySFGrids.rvt file.

	2.	� Switch to the {3D} 3D view, and select one of the curtain grid lines 

that you want to modify. You are modifying a storefront curtain 

wall, which contains grids, panels, and mullions. If you are having 

trouble selecting a grid, move your mouse pointer over a grid line, 

and hit the Tab key to cycle through available selection options. The 

status bar at the bottom-left corner of the Revit window will display 

which element is ready for selection.

	3.	 Click the pushpin to unlock the curtain grid line.

	4.	� Move the grid as desired. This can be done either by dragging the 

grid to a new location or by editing the temporary dimension  

(Figure 3.80).

At any time, you can return a modified automatic curtain grid line to its 

original location by clicking the pushpin with the red x (Figure 3.81).

Modifying Manual Curtain Grids

Modifying a manual curtain grid is very straightforward:

	 1.	 Open the ModifyManualGrids.rvt file.

	 2.	 Switch to the {3D} 3D view, and select one of the curtain grid lines that you want to 

modify. Click the pushpin to unlock the curtain grid line.

	 3.	 Move the grid as desired. This can be done either by dragging the grid to a new loca-

tion or by editing the temporary dimension.

At any time, you can return a modified automatic curtain grid line to its original loca-

tion by clicking the pushpin with the red X (Figure 3.81).

Adding Mullions
Once you have created a curtain wall grid, you can then add mullions to the grid. The 

nice thing about mullions in Revit is that they will automatically resize to fit your grid. 

When placing mullions, if you add a mullion to an inside grid, then the mullion is  

Figure 3.80
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centered on the grid. If you add a mullion to the perimeter grid, the mullion will align 

itself so its border is flush with the outside of the wall.

	 1.	 Open the AddMullions.rvt file.

	 2.	 Switch to the {3D} 3D view.

	 3.	 On the Home tab’s Build panel, click the Mullion button.

	 4.	 In the Properties palette, select the Rectangu-

lar Mullion 1.5˝ × 2.5˝ rectangular in the Type 

Selector.

	 5.	 On the Modify | Place Mullion tab’s Placement 

panel, click the Grid Line button.

	 6.	 In the drawing window, move the mouse 

pointer over one of the vertical grid line, and 

click to place the mullion.

	 7.	 Continue to add mullions to the six remaining 

vertical mullions (Figure 3.82). 

In the next few steps, you will create a new mul-

lion type for the top and bottom horizontal 

curtain wall grid lines.

	 8.	 With the Place Mullion tools active, click the 

Edit Type button in the Properties palette.

	 9.	 In the Type Properties dialog box, click the 

Duplicate button. In the Name dialog box, enter 6˝ x 6˝ rectangular (150 mm x 150 

mm rectangular), and click OK.

	10.	 In the Type Properties dialog box, enter the following under Dimensions:

Width on Side 2: 3˝ (75 mm)•	

Width on Side 1: 3˝ (75 mm)•	

	11.	 Click OK to close the Type Properties dialog box.

	12.	 On the Modify | Place Mullion tab’s Placement panel, click the Grid Line button. 

Ensure that the 6˝ × 6˝ rectangular (150 mm × 150 mm rectangular) mullion is active 

in the Type Selector.

	13.	 In the drawing window, move the mouse pointer over the bottom horizontal curtain 

wall grid line, and click to place the mullion. Repeat for the top horizontal curtain wall 

grid line.

You now need to add a 1.5˝ × 1.5˝ (20 mm) mullion to the remaining horizontal 

mullions.

Figure 3.82

Mullions added to 
vertical grid lines
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vertical curtain wall 
grid lines
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 14. With the Place Mullion tools active, click the Edit Type button in the Properties 

palette.

 15. In the Type Properties dialog box, click the Duplicate button. In the name dialog 

box, enter 1.5˝ × 1.5˝ rectangular (20 mm × 20 mm rectangular), and click OK.

 16. In the Type Properties dialog box, enter the following under Dimensions:

Width on Side 2: 3/4˝ (20 mm)•	

Width on Side 1: 3/4˝ (20 mm)•	

 17. Click OK to close the Type Properties dialog box.

 18. On the Modify | Place Mullion 

tab’s Placement panel, click 

the Grid Line button. Ensure 

that the 1.5˝ × 1.5˝ rectangular 

(20 mm × 20 mm rectangular) 

mullion is active in the Type 

Selector.

 19. In the drawing window, move 

the mouse pointer over the bottom 

horizontal curtain wall grid line, and 

click to place the mullion. Repeat for the top 

horizontal curtain wall grid line (Figure 3.83).

Adding a Door to a Curtain Wall
As you work with your curtain wall, you will need to place a door or change 

a panel from glazed to solid. A curtain wall, however, does not allow you to use the 

Door tool like you would if you were working with a basic wall type. With a curtain wall, 

you need to swap out a wall panel for a door panel. The fi rst thing you need to do is load 

a door panel from the Revit library. Then you will need to remove a mullion and grid 

line to accommodate your door. Finally, you will modify a row of panels. To load a door 

panel, follow these steps:

 1. Open the AddDoor.rvt file.

 2. On the Insert tab, click Load Family.

 3. In the Door\Curtain Wall Doors folder of the default Revit library, select Curtain 

Wall Dbl Glass.rfa (M-Curtain Wall Dbl Glass.rfa), and then click Open. The family 

will then be loaded into your project.

Figure 3.83

Mullions added to 
curtain wall

the mouse pointer over the bottom 

horizontal curtain wall grid line, and 

click to place the mullion. Repeat for the top 

horizontal curtain wall grid line (Figure 3.83).

Adding a Door to a Curtain Wall
As you work with your curtain wall, you will need to place a door or change 

Figure 3.83
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 4. Switch to the {3D} 3D view. You need to remove the two mullions and one grid line, 

as indicated in Figure 3.84.

 5. Select the two mullions, and delete them. You can do 

this individually or both at the same time. You can 

now delete the curtain wall grid line.

 6. Select the curtain wall grid line. This will be the sec-

ond grid line from the bottom. On the Modify | Cur-

tain Walls Grids tab’s Curtain Grid panel, click the 

Add/Remove Segments button.

 7. Click the curtain wall grid line, and the grid line will be 

deleted (Figure 3.85). You can now replace the panel with your 

curtain wall door.

 8. Select the glazed panel by placing the mouse pointer over an edge of the panel. 

Press the Tab key repeatedly, and monitor the status bar until it reads Curtain Panel: 

System Panels: Glazed and the panel is highlighted and then click.

 9. In the Properties palette, click the Type Selector drop-down, and select the Curtain 

Wall Dbl Glass (M-Curtain Wall Dbl Glass.rfa) element. The Glazed panel has now 

been replaced with the Double Doors. You 

swap out the entire row of glazed panels 

above the door with a solid panel.

 10. Select the glazed panel above the double 

doors. In the Properties 

palette, click the Type 

Selector drop-down, and 

select the System Panel 

Solid element.

 11. Repeat step 10 for all the 

glazed panels in the row 

above the door 

(Figure 3.86).

Figure 3.84
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curtain wall.

deleted (Figure 3.85). You can now replace the panel with your 

 8. Select the glazed panel by placing the mouse pointer over an edge of the panel. 

Press the Tab key repeatedly, and monitor the status bar until it reads Curtain Panel: 

System Panels: Glazed and the panel is highlighted and then click.

 9. In the Properties palette, click the Type Selector drop-down, and select the Curtain 
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TaB K E Y

You can press the Tab key for a wide variety of time-saving techniques. One of the uses is for 

object selection. You can use the Tab key to cycle through objects that either overlap or are 

close enough together to cause selection diffi  culties. When trying to select an object, move 

your mouse pointer over one of the objects. Revit will highlight the object and provide infor-

mation about the object in the status bar. Hitting the Tab key will allow you to cycle through 

other nearby objects.

The next step in fi nishing the current wall is placing a mullion. When you add mul-

lions, they will automatically resize in length to fi t the grid. When a mullion is added to 

an inside grid, then the mullions are centered on the grid. If a mullion is placed on an 

outside or parameter grid, the mullion aligns so its border is fl ush with the outside of the 

wall. To place a mullion, follow these steps:

 1. On Home tab’s Build panel, click Mullion.

 2. From the Type Selector, choose the Rectangular Mullion 1.5˝ × 2.5˝ rectangular.

 3. On the Modify | Place Mullion tab, select one of the three mullion placement tools:

Grid Line  Places a mullion across the entire grid line

Grid Line Segment  Places a mullion on the individual grid line segment

All Grid Lines  Places a mullion on all grid lines

 4. Click a grid line in the drawing area to place mullions.

Exterior Glazing and Storefront
In the next example, you will embed a storefront curtain wall into the sample project 

shown in Figure 3.87.

 1. Create a wall or sample building project, as shown in Figure 3.87, using any generic 

wall type.

TaB K E Y

You can press the Tab key for a wide variety of time-saving techniques. One of the uses is for 

object selection. You can use the Tab key to cycle through objects that either overlap or are 

close enough together to cause selection diffi  culties. When trying to select an object, move 

your mouse pointer over one of the objects. Revit will highlight the object and provide infor-

mation about the object in the status bar. Hitting the Tab key will allow you to cycle through 

other nearby objects.

Figure 3.87

Example project
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	 2.	 On the Modify tab, click the Split tool (Figure 3.88) to divide a wall into three seg-

ments. The middle wall segment will then be switched to a Storefront wall type.

	 3.	 Switch to a 3D view.

	 4.	 Select the middle wall segment.

	 5.	 In the Properties palette’s Type Selector, 

change the wall type to Walls: Curtain 

Wall: Storefront (Figure 3.89).

Now that you have created a couple basic 

curtain walls, let’s explore modifying the grid 

and placing mullions. Select the Storefront cur-

tain wall. When selecting a curtain wall, 

there are four different object selection 

options (Figure 3.90):

Mullions•	

Curtain Wall Grids•	

Curtain Wall Panels•	

Entire Curtain Wall•	

Mullion selected Grid selected Panel selected Entire curtain wall selected

Figure 3.88

Locating the Split 
tool on the Modify 
tab to split a wall

Figure 3.89

Wall with storefront

Figure 3.90

Curtain wall selec-
tion examples
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Make sure that you select the entire curtain wall. Use the Tab key 

to cycle between objects until you find the entire curtain. Use the 

status bar to help identify what object is selected.

With the Storefront selected, open the Storefront type proper-

ties (Figure 3.91). Through the Type Properties dialog box, you can 

modify the grid pattern and mullions.

Creating Floors
A floor is a horizontal surface supported by the structure of the 

building. Floors are level based, and you can create either flat or 

sloped or tapered floors (Figure 3.92). To create a floor, you need 

define a boundary of the floor. The boundary must be a closed loop, 

and boundary loops cannot overlap or cross any other floor bound-

ary. When a floor is created, you specify its vertical position by creat-

ing it on a level. The top of the floor is placed on the level where it is 

created with the thickness of the floor projecting downward. Floors 

are like walls and use one or more layers of materials to define the 

floor type. To create floors, you need to sketch their perimeters.

	 1.	 Open the AddFloor.rvt file, and verify that the Level 1 floor plan is active. You will 

create a floor on this level.

	 2.	 On the Home tab’s Build panel, click the Floor tool.

	 3.	 On the Modify | Create Floor Boundary tab’s Draw panel, click the Pick Walls  

button . On the Options bar, leave the Offset set to 0´ 0 ,̋ and ensure that the 

Extend Into Wall (To Core) is selected.

	 4.	 Click each of the exterior walls. Revit will automatically define the boundary to  

the core of the wall and form a closed boundary.

Horizontal floor Sloped floor Tapered floor

Figure 3.91

Type properties  
for Storefront  

curtain wall

Figure 3.92
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 5. On the Modify | Create Floor Boundary tab’s Mode panel, click the Finish Edit 

Mode button (the check mark) to create the floor.

 6. Switch to the Level 2, f loor plan. Repeat 

steps 2 through 4.

 7. On the Modify | Create Floor Boundary 

tab’s Mode panel, click the Finish Edit Mode 

button (the check mark) to create the floor. 

Revit will display a dialog box and ask, 

“Would you like the walls that go up to this 

f loor’s level to attach to its bottom?” Click 

Yes to have the wall attach the bottom of the 

floor (Figure 3.93).

Creating a Sloped Floor
As you work on your building project, it may be necessary to create a sloped fl oor. This is 

a very straightforward process. To do this, follow these steps:

 1. Select an existing floor.

 2. From the Modify | Floors tab’s Mode panel, click the Edit Boundary button.

 3. On the Modify | Floors tab’s Draw panel, click the Edit Boundary button.

 4. Click the Slope Arrow button, and then either Line or Pick Lines.

 5. Place a slope arrow in the floor sketch so that it is parallel to the direction of the 

desired slope. In the Properties palette, you can define the height offset for both the 

head and the tail.

 6. In the Mode panel, click the Finish Edit Mode button to create the sloped floor 

(Figure 3.94).

Step 1: Create the floor

Step 2: Add the slope arrow The floor slopes

Figure 3.93

3D section view 
showing the floors 
added to the model

Mode button (the check mark) to create the floor.

Figure 3.94

A sloped floor
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Creating a Tapered Floor
Creating a tapered floor is useful when you want to create a floor of a variable thickness. 

To do this, follow these steps:

	 1.	 Open the file TaperedFloor.rvt.

	 2.	 Select the existing floor.

	 3.	 On the Modify | Floors tab’s Shape Editing panel, click the Add Point button.

	 3.	 On the Options bar, set Elevation to –6˝ (–150 mm).

	 4.	 In the drawing window, move the mouse pointer to the center of the floor, and click 

to place the point. Note that the Add Point tool does not provide you with temporary 

dimensions for precision. If you need to define a precise point, draw some reference 

lines to define the precise insertion point.

	 5.	 Click the Esc key twice to exit the Modify | Floors mode.

	 6.	 Open the Section 1 section (Building Section). Figure 3.95 shows that the point that 

was added tapered the floor and the floor maintains a consistent thickness. You need 

to make one further adjustment so that your floor has a variable thickness. 

	 7.	 From the section view, select the floor, and click the Edit Type button in the Proper-

ties palette.

	 8.	 In the Type Properties dialog box, click the Duplicate button. Name the new type 

Generic – 12˝ Variable, and click OK.

	 9.	 Click the Edit button to the right of Structure. This opens the Edit Assembly dia-

log box.

	10.	 In the Edit Assembly, select the Variable check box for row 2. This allows this layer of 

the floor assembly to have a variable thickness.

	11.	 Click OK twice to finish the variable thickness floor (Figure 3.96).

Creating Ceilings
A ceiling is a building element in Revit that can host ceiling components such as lights, elec-

trical equipment, smoke detectors, fire sprinklers, and ventilation elements. Ceilings can be 

sloped and contain complex structures. Ceilings are level-based elements and are automati-

cally offset from a level. You view and add elements to ceilings in ceiling plan views.

Figure 3.95

Tapered floor with a 
consistent thickness

Figure 3.96

Tapered floor with a 
variable thickness
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Automatic Ceiling Creation
In this section, you will use the automatic ceiling creation tool to create your ceiling on 

the first level of your sample project:

	 1.	 Open the file AddCeiling.rvt (M-AddCeiling.rvt).

	 2.	 Open the Level 1 ceiling plan.

	 3.	 On the Home tab’s Build panel, click the Ceiling button. This open the Modify | 

Place Ceiling tab.

	 4.	 On the Ceiling panel, ensure that the Automatic Ceiling 

button is enabled, and in the Properties palette, make 

sure Compound Ceiling 2´ × 4´ ACT System (600 mm × 

1200 mm Grid) is selected.

	 5.	 In the Properties palette, under Height Offset From 

Level, set the value to 8´ 6˝ (2590 mm). 

	 6.	 In the drawing window, move your mouse pointer into 

the southwest corner room (Figure 3.97). Click to add the 

ceiling.

	 7.	 Using Figure 3.98 as a reference, add ceilings to the rest of 

the enclosed spaces.

	 8.	 Hit the Esc key to exit the Ceiling tool.

With your ceilings in place, you can demonstrate several 

techniques for editing the ceiling grid. When you place a ceil-

ing, Revit will place the grid to center it in the room. In the 

next steps, you will change the placement of the grid by shift-

ing the grid to the right.

	 1.	 Zoom into the southeast corner room. 

	 2.	 Place your mouse pointer over the most eastern grid line, 

and click to select it. The Modify | Ceilings tab is now 

displayed on the ribbon. You can use any of the modify 

tools to edit the ceiling grid.

	 3.	 From the Modify panel, click the Move button. For the 

move start point, click anywhere on the line you selected 

in the previous step.

	 4.	 For the move end point, drag the mouse pointer right, and click the interior wall face 

(Figure 3.99). The grid then shifts to the right.

Figure 3.97

When you click 
inside a wall that 
forms a closed loop, 
Revit automatically 
generates a ceiling 
boundary.

Figure 3.98

Ceilings added to 
Level 1
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Manual Ceiling Creation
In this section, you will create a ceiling by manually defining the ceiling boundary on the 

second level of your sample project. You will also walk through the steps to create a new 

ceiling type.

	 1.	 Open to the Level 2 ceiling plan.

	 2.	 On the Home tab’s Build panel, click the Ceiling button. This opens the Modify | 

Place Ceiling tab.

	 3.	 On the Ceiling panel, click the Sketch Ceiling button. In the Properties palette, click 

the Edit Type button.

	 4.	 In the Type Properties dialog box, click the Duplicate button. Name the new type 

2´ × 2´ ACT System (600mm ´ 600mm Grid). Click OK to close the Type Properties 

dialog box.

	 5.	 Click the Edit button.

	 6.	 In the Edit Assembly dialog box in the Layers section, click the Browse button  of 

row 4 in the Material column.

	 7.	 In the Materials dialog box, select Finishes – Interior – Acoustic Ceiling Tile 24 × 24 

[Ceiling Tile 600 × 600] (Figure 3.100). Click OK three times to exit the Materials, 

Edit Assembly, and Type Properties dialog boxes.

	 8.	 In the Properties palette, under Height Offset From Level, set the value to 8´ 6˝  

(2590 mm).

Figure 3.99

Using the Move tool 
to shift the grid
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	 9.	 On the Modify | Create Ceiling Boundary tab’s Draw panel, click the Pick Walls  

button .

	10.	 Using Figure 3.101 as a reference, select the indicated walls. When using the Pick 

Walls tool, make sure that after you have picked the wall the magenta lines drawn are 

on the inside of the wall for which you are creating a ceiling. Use the flip arrows  

as necessary to select the interior edges of the walls.

Figure 3.100

Assigning a mate-
rial definition to the 
ceiling tile

Figure 3.101

Using the Pick Wall 
tool, select the indi-
cated walls.
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	11.	 When defining a ceiling boundary, the boundary must form a closed loop. Trim the 

boundary using the Trim tool found in the Modify panel.

12. Click Finish Edit Mode  on the Mode panel to create the ceiling. If you want to 

discard the operation to define the ceiling boundary, click the Cancel Edit Mode  

button on the Mode panel.

	13.	 Create ceilings using the manual method for the remainder of the enclosed spaces on 

the Level 2 ceiling plan (Figure 3.102).

Placing Components in a Ceiling
With your ceilings created, you can begin the process of adding ceiling hosted elements 

such as lights, electrical equipment, smoke detectors, fire sprinklers, and ventilation ele-

ments. In this section, you will add a light fixture, align, and lock it to your ceiling grid. 

Should the grid move, then the light fixture will move with it.

	 1.	 Open the file AddCeilingComp.rvt (M-AddCeilingComp.rvt). 

	 2.	 Open the Level 1 ceiling plan.

	 3.	 On the Home tab’s Build panel, click the Component button.

	 4.	 In the Properties palette’s Type Selector, select Troffer Light – 2x4 Parabolic 2´ × 4´  

(2 Lamp) – 120V [M_Troffer Light – Parabolic Rectangular 0600x1200mm(2 Lamp) 

– 120V].

	 5.	 In the drawing window, click somewhere in the middle of southwest corner ceiling 

to place the light (Figure 3.103). The exact placement and rotation are not important. 

Click Esc twice to exit the Component tool.

	 6.	 You now need to align the light fixture with your ceiling grid. Move the mouse 

pointer over the light, and click to select it. Press the spacebar once to rotate the light 

fixture 90 degrees.

Figure 3.102

Ceilings on the  
second floor
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	 7.	 You now need to align the light fixture with the vertical 

gridline. From the Modify | Lighting Fixture tab’s Modify 

panel, click the Align button .

	 8.	 Pick a vertical gridline for the reference point of align-

ment, and then select the left edge of the light fixture to 

align it with the gridline (Figure 3.104). The light fixture 

is then aligned with the vertical gridline.

	 9.	 After the light fixture has been aligned, click the padlock 

 to lock the left side of the light fixture to the vertical 

gridline. 

	10.	 While still in the Align tool, pick a horizontal gridline for 

the reference point of alignment, and then select the top 

edge of the light fixture to align it with the gridline. The 

light fixture is then aligned with the horizontal gridline.

	11.	 After the fixture is then aligned with the horizontal grid-

line, click the padlock to lock the top edge of the light fixture to the horizontal  

gridline.

Since you locked the aligned of the light fixtures to the grids, if the grid moves, so will 

the light fixtures or any other element locked to a gridline. You can now add additional 

light fixtures and other additional ceiling-based items such as the ceiling fan shown in 

Figure 3.105. 

2. Select this edge of
    light fixture to align
    with gridline.

1. Select this gridline for the 
    reference point of alignment.

Figure 3.103

Light fixture placed 
in the ceiling

Figure 3.104

Using the Align tool to align the edge of the light fixture 
with the gridline

Figure 3.105

Example of a rotated ceiling grid with lights, ceiling fan
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Creating Stairs
Stairs and railings can be very simple to extremely complex, and you could fill a book 

just on this one topic. In this section, we’ll cover how to create a basic stair with railings. 

Stairs are created by defining the run of the stairs or by sketching riser and boundary 

lines. Revit allows you to create several different styles of stairs including straight runs, 

L-shaped runs with a platform, U-shaped stairs, and spiral stairs. When stairs are created 

in Revit, the railings are automatically created for the stairs. In multistory buildings, you 

can design one set of stairs, and Revit creates identical sets up to the highest level defined 

in the stair properties.

To create stairs, you need to be in a plan or 3D view. You click the start point of the 

stairs, and Revit will automatically calculate the number of treads, based on the distance 

between the floors and the maximum riser height defined in the stair properties. Revit 

will generate a rectangle representing a preview footprint of the run of the stairs. As the 

mouse pointer is moved, the rectangle adjusts accordingly. If you move the mouse pointer 

outside of the end preview footprint and click, Revit will create the stairs.

When creating stairs, you begin by creating a sketch of the start and end points of the 

stair. Stairs have two Sketch modes: Run and Boundary and Run. Sketching a run is the 

easiest method. As you sketch the run, the boundaries and risers are generated automati-

cally. After you finish sketching and create the stair, the railing is automatically added. 

With the Run tool, you are limited to straight runs, straight runs with landings, and spi-

ral staircases. When you create a stair using the Boundary and Run mode, two separate 

tools are used to define the stair. To create a stair, you define the boundary and riser. You 

use this method when you want more control when sketching the footprint of your stair.

Straight Run Stair
In these sections, you will create three stairs: a straight run, a straight run with a landing, 

and a spiral staircase.

	 1.	 Open the file CreateStair.rvt (M-CreateStair.rvt). 

	 2.	 Open the Level 1 floor plan.

	 3.	 On the Home tab’s Circulation panel, click the Stairs button.

	 4.	 On the Modify | Create Stairs Sketch tab’s Draw panel, click the Run button. 

	 5.	 In the Draw panel, click the Line tool. Using Figure 3.106 as a reference, use the 

intersection of the two reference planes as the start point of the run of the straight 

stair.

	 6.	 Drag the mouse pointer to the end of the run, and click to define the end of the run 

(Figure 3.107).
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Stair with landing 
first run location

Straight run stair 
start location

Center of spiral stair

Start point 
of spiral stair

Stair with landing 
second run location

	 7.	 Click the Finish Edit Mode button to create the stair.

	 8.	 The stair has been created correctly; however, there is no opening in the Level 2 floor 

for the stair. You need to create an opening in that floor. Open the Level 2 floor plan. 

Notice that part of the stair’s railings are visible on the second floor (Figure 3.108).

	 9.	 Select the floor on Level 2. On the Modify | Floors tab’s Mode panel, click the Edit 

Boundary button. The boundary of the floor will turn magenta. To create an open-

ing in the floor, you are going to use the sketch tools.

	10.	 In the Draw panel, click either the Rectangle or 

Line tool to sketch an opening, as shown in Fig-

ure 3.109. Click the Finish Edit Mode button to 

finish the editing of the floor boundary sketch. 

Click Yes to accept having the walls attach to the 

bottom of the floor level (Figure 3.110).

Figure 3.106

Stair creation  
reference

Figure 3.107

Defining the run of 
the straight stair

Figure 3.108

Railings extending 
through the second 
floor
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Stair with Landing
To create a straight stair with a landing, do the following:

	 1.	 Open the file CreateStair.rvt (M-CreateStair.rvt). 

	 2.	 Open the Level 1 floor plan.

	 3.	 On the Home tab’s Circulation panel, click the Stairs button.

	 4.	 On the Modify | Create Stairs Sketch’s tab Draw panel, click the Run button. 

	 5.	 In the Draw panel, click the Line tool. Using Figure 3.106 as a reference, locate “Stair 

with landing first run.” Use the intersection of the two reference planes as the start 

point for the run of the stair with landing. Drag the mouse pointer until the dynamic 

feedback on the risers reads “9 RISERS CREATED, 9 REMAINING,” and click  

(Figure 3.111).

Figure 3.109

Sketching an  
opening in the  

Level 2 floor

Figure 3.110

Completed  
straight stair
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	 6.	 Using Figure 3.106 as a reference, locate “Stair with landing second run.” Use the 

intersection of the two reference planes as the start point for the run of the stair  

with landing.”  Drag the mouse pointer until the dynamic feedback on the risers reads 

“18 RISERS CREATED, 0 REMAINING,” and click to complete the stair sketch  

(Figure 3.112).

	 7.	 Click the Finish Edit Mode button to create the stair.

The stair is created correctly; however, you still need to create an opening on the second 

floor as outlined in the previous example and shown in Figure 3.113.

Figure 3.111

Stair creation reference for stair with landing

Figure 3.112

Defining the run of the straight stair

Figure 3.113

Completed stair 
with landing with 
opening on second 
floor
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Spiral Staircase
To create a spiral stair, do the following:

	 1.	 Open CreateStair.rvt (M-CreateStair.rvt). 

	 2.	 Open the Level 1 floor plan.

	 3.	 On the Home tab’s Circulation panel, click the Stairs button.

	 4.	 On the Modify | Create Stairs Sketch tab’s Draw panel, click the Run button.

	 5.	 On the Draw panel, click Center-ends Arc.

	 6.	 In the Draw panel, click the Line tool. Using Figure 3.106 as a reference, use the  

center of spiral stair as the start point of the run of the stair with landing.

	 7.	 Using Figure 3.106 as a reference, drag the mouse pointer to the start point of the 

spiral stair to define the arc run radius, and click a second time to define the arc 

boundary radius (Figure 3.114).

	 8.	 Click the Finish Edit Mode button to create the stair.

The stair is created correctly; however, you still need to create an open on the second 

floor as outlined in the previous examples and shown in Figure 3.115.
Figure 3.114

Completed sketch 
of the spiral  

staircase

Figure 3.115

Completed spiral 
staircase
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Creating Roofs
Revit provides multiple options for creating roofs. Like walls and floors, roofs are system 

components and are defined in the project file, not as separate family components. There 

are three basic roof types in Revit: Roof By Footprint, Roof By Extrusion, and Roof By 

Face (sometimes referred to as Roof From Mass), as shown in Figure 3.116.

By footprint By extrusion By face

Roof by Footprint
To create a roof by footprint, you are going to sketch the perimeter of the roof. This 

sketch must form a closed boundary. You’ll create a gable roof.

	 1.	 Open the file CreateRoof.rvt (M-CreateRoof.rvt). 

	 2.	 Open the Level 3 floor plan.

	 3.	 On the Home tab’s Build panel, click the Roof button.

	 4.	 On the Modify | Create Roof Footprint tab’s Draw panel, click the Pick Walls  

button .

	 5.	 On the Options bar, set the following:

Defines Slope = selected.•	

Overhang = 2´ 6 .̋•	

Extend to Core Wall = selected. This option allows you to measure the overhang •	

from the core of the wall.

If you try to add a roof at the lowest level of your project, a dialog box will prompt you to 

move it to a higher level. If you do not move the roof to a higher level, Revit will then notify 

you that the roof is too low.

	 6.	 Pick the walls to form a closed loop. When picking the walls where you have speci-

fied an overhand, make sure you use the dashed line on the side of the wall where 

you want the overhang to be displayed.

Figure 3.116

Examples of roof by 
footprint, extrusion, 
and face
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Figure 3.117 shows the sketch of the roof by footprint. If you were to create the roof 

now, the result would be a Hip roof because you are sloping all four sides of the roof. You 

want to create a gable roof, only sloping the north and south sides of the building. When a 

roof boundary line has the slope symbol  adjacent to it, this defines a slope for that roof 

line. You need to remove the slope symbol from the east and west roof boundary lines.

	 7.	 Select the west roof boundary line, and on the Options bar, deselect the Defines 

Slope check box. Repeat this for the east roof boundary line.

	 8.	 On the Mode panel, click the Finish Edit Mode button. A dialog box will ask you if 

you want the highlighted walls to attach to the roof. Click Yes, and your roof should 

look like Figure 3.118.

Figure 3.117

Sketch of roof  
footprint

Figure 3.118

Completed gable 
roof with overhang
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Roof by Extrusion
To create a roof by extrusion, you sketch a profile of the roof. This determines the height 

of the roof. This can be done in section or elevation, and then you extrude that profile. 

The Roof By Extrusion sketch must be a series of connected lines and/or arcs that do not 

form a closed loop.

	 1.	 Open the file RoofExtrusion.rvt (M-RoofExtrusion.rvt). 

	 2.	 Open the West elevation (Building Elevation).

	 3.	 On the Home tab’s Build panel, click the bottom portion of the Roof split button, 

and select Roof By Extrusion.

When the Roof By Extrusion command is started, Revit will display the Work Plane 

dialog box so that you can specify which workplace you will sketch on. In an eleva-

tion or section view, you need to set the work plane. In this particular case, you are 

going to use the Pick A Plane option and then select an element in elevation to use as 

a reference for your work plane.

The Work Plane dialog box has three options for specifying a new work plane:

Name  ​This allows you to select an existing named work plane in the project.

Pick a plane  ​This option creates a plane that is coincident to the selected plane. You 

can select any plane that can be dimensioned. Some examples are wall faces, faces in 

linked models, extrusion faces, levels, and grids.

Pick a line and use the work plane it was sketched in  ​This option creates a work plane 

that is coplanar with the work plane of the selected line.

	 4.	 In the Work Plane dialog box, click the Pick A Plane radio button, and click OK to 

close the dialog box.

	 5.	 Move your mouse pointer over the west wall, and click. A dialog box will be dis-

played asking you to specify the Roof Reference Level and Offset. You can use this 

to raise or lower the roof from the reference level. When you click OK in this dialog 

box, Revit will create a reference plane that can be used to control the position of the 

roof in relation to the level.

	 6.	 In the Roof Reference Level and Offset options, specify an offset value of 4´ 0 ,̋ and 

click OK.

	 7.	 On the Modify | Create Roof Footprint tab’s Draw panel, click the sketch tools. Using 

Figure 3.119 as a loose reference, sketch a profile for the roof, making sure that it is 

an open loop.

	 8.	 On the Mode panel, click the Finish Edit Mode button.

	 9.	 Switch to 3D view. Select the roof, and in the Properties palette change the roof type 

to Basic Roof Generic – 9˝ [Generic – 125mm], as shown in Figure 3.120.
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Roof profile Roof reference plane

Attaching Walls to Roofs

In the previous section, you created a roof by extrusion, but the walls are not attached to 

the roof. This can lead to some serious drafts for the residents on the third floor. Revit 

provides an option that allows you to set or override the initial top and base constraints 

by attaching its top or base to another element in the same vertical plane. Walls can 

attach to a floor, a roof, a ceiling, a reference plane, or another wall that is directly above 

or below. The height of the wall automatically increases or decreases as necessary to 

conform to the boundary represented by the attached element. When you attach a wall 

to another element, you can avoid having to manually edit the wall’s profile when your 

design changes. 

	 1.	 Open the file AttachWalls.rvt. 

	 2.	 Open the {3D} 3D view.

	 3.	 Select one of the exterior walls that you want to attach to the roof.

	 4.	 On the Modify | Walls tab’s Modify Wall panel, click the Attach Top/Base button.

Figure 3.119

Sketch of roof by 
extrusion profile

Figure 3.120

A roof by extrusion
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 5. On the Options bar, for Attach Wall, select Top as you want to adjust the top attach-

ment of the wall.

 6. Select the roof to attach the top of the wall to 

the roof.

 7. Repeat steps 3 through 6 for the 

remaining exterior walls that 

need to be attached to the roof. 

(Figure 3.121).

Adding Roof Soffits
Revit allows you to add other roof ele-

ments including soffi ts, facia, and gut-

ters. In this section, you are going to walk 

through the process of creating a soffi t. 

Because design intent for soffi ts can widely 

vary, the method for creating soffi ts in Revit varies.

 1. Open the file Add Soffit.rvt. 

 2. Open the Roof floor plan.

 3. On the Home tab’s Build panel, click the lower portion of the Roof Split button, and 

select Roof Soffit.

 4. On the Modify | Create Roof Soffit Boundary tab’s Draw panel, click the Pick Lines 

button . As shown in Figure 3.122, click the north and south roof edges.

Figure 3.121

Completed roof by 
extrusion with walls 
attached 6. Select the roof to attach the top of the wall to 

ters. In this section, you are going to walk 

Because design intent for soffi ts can widely 

vary, the method for creating soffi ts in Revit varies.

extrusion with walls 
attached

Figure 3.122

Roof edges selected
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	 5.	 On the Draw panel, click the Pick Walls button , highlight the outside face of the 

north wall beneath the roof, and click to select. Repeat for the south wall (Figure 3.123).

	 6.	 Using the sketch tools and trim in the Draw panel, complete the sketch of the soffits 

as a closed loop (Figure 3.124).

	 7.	 On the Mode panel, click the Finish Edit Mode button. The soffit is created.

	 8.	 Open the Section 1 section (Building Section) view. The soffit was created. To com-

plete the operation, you need to join the soffit to the roof, join the soffit to the wall, 

and join the wall to the roof.

	 9.	 On the Modify tab’s Modify panel, click the Join button. Click the soffit and then the 

roof. Then select the soffit and wall. Press Esc to exit the Join command.

	10.	 Select the wall. On the Modify | Walls tab’s Modify Wall panel, click the Attach Top/

Base button.

	11.	 On the Options bar, for Attach Wall, select Top as you want to adjust the top attach-

ment of the wall.

	12.	 Select the roof to attach the top of the wall to the roof (Figure 3.125).

Figure 3.123

Sketch lines for walls for the soffit

Figure 3.124

Complete soffit sketch

Figure 3.125

Complete roof soffit
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Constraints and Dimensions

Autodesk Revit  provides a unique method of embedding your design 

intent in the form of locks and constraints with dimensions. In this chapter, you will 

become acquainted with dimensions, the use of constraints on objects within your 

design, and the flexible relationship that these offer for changes that will take place in 

your project. This chapter covers the following topics:

Temporary dimensions■■

Permanent dimensions■■

Equality constraint and lock■■

Spot dimensions■■

Units■■
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Temporary Dimensions
Dimensions are annotation elements within the project that convey the distance or angle 

between elements or parts of elements in the model. The dimensions are bidirectional 

annotations that behave like a tag for the distance and size of project elements. Calling 

this bidirectional means that you can edit the dimension value shown, which will move 

your element to match the value entered. Or if you move the element, it will update the 

dimension value to display the true value.

Dimensions are an annotation element and are view-specific elements within your 

project, meaning that when placed, they will show up only in the view in which they are 

placed and will not be automatically added to other views. To understand these a bit bet-

ter, we will look at the types and options available, starting with temporary dimensions.

As you create or select geometry, Revit displays temporary dimensions around the 

component. The temporary dimensions display values as they relate to the nearest per-

pendicular component. Temporary dimensions 

are unique in that they exist and are dis-

played while you are placing a component (see 

Figure 4.1).

Once a new component is placed, any temporary dimensions that were displayed while 

placing a previous component will no longer be visible. When you select a component, 

the temporary dimensions will again be displayed, as shown in Figure 4.2.

Figure 4.1

Temporary dimen-
sion displayed while 

placing a wall

Figure 4.2

Top: Unselected 
walls with no tem-

porary dimensions 
displayed. Bottom: 

Selecting a single 
wall will display 

temporary dimen-
sions relative to the 

nearest perpendicu-
lar components.
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When multiple components are selected, the temporary dimension will not be displayed, 

as shown in Figure 4.3.

To enable temporary dimensions, you can click the Activate Dimensions button on the 

Options bar, as shown in Figure 4.4, which will then show the temporary dimensions.

With a component selected and the temporary dimension displayed, you can adjust the 

location of the component by editing the dimension value. To do this, click the dimension 

value, and it becomes an editable text field. Enter the desired numerical value; if there are 

no constraints, Revit will move the selected component to the specified location.
Figure 4.3

Selecting multiple 
components will not 
display temporary 
dimensions.

Figure 4.4

With multiple com-
ponents selected, 
the Activate Dimen-
sions button will 
be available in the 
Options bar.
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Temporary Dimension Settings
You can control the display and reference placement used with temporary dimensions  

for walls, doors, and windows by using the following:

Measure From Wall Centerlines, Wall Center Of Core, Wall Faces, or Wall Faces  •	

Of Core

Measure Doors and Windows To Centerlines Or Openings•	

You can access these settings by going to the Manage tab on the ribbon, selecting the 

Additional Settings panel, and clicking Temporary Dimensions, as shown in Figure 4.5. 

This opens the Temporary Dimension Properties dialog box, as shown in Figure 4.6.

Figure 4.7 shows an example of placing a 

window within a wall using the default options, 

doors and windows set to Centerlines.

Figure 4.8 shows the same window being 

placed within a wall with the doors and windows 

set to Openings. Here the nearest perpendicular 

element is the wall and existing window, which 

displays the dimensions to the outside of the 

window being placed.
Figure 4.6

Temporary dimension additional proper-
ties for walls, doors, and windows

Figure 4.5

Accessing  
additional proper-

ties’ temporary 
dimensions

Figure 4.7

Window being placed within a wall using the additional settings for doors and windows set  
to Centerlines

Figure 4.8

Window being placed within a wall using the additional settings for doors and windows set  
to Openings
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Snap Increments
When sketching a wall or other compo-

nent and moving the cursor from left 

to right in the drawing area, the tem-

porary dimensions that are displayed 

for the wall increase/decrease. This 

distance is based on the value provided for the snap increment. You can access the snap 

increment values from the Manage tab; just click Snaps within the Settings grouping (see 

Figure 4.9).

The Snaps dialog box has a Length 

Dimension Snap Increments setting 

(see Figure 4.10). Within this location, 

you can enter or edit existing values or 

add new increments. Although there is 

no limit to the number of increments 

you can have when adding or remov-

ing increments, be sure each value you 

enter has a semicolon after it. Revit 

uses these increments when the zoom 

level changes, and the closer you are 

zoomed in, the smaller the increment 

that is used.

When adjusting the Angular 

Dimension Snap Increments setting, 

as shown in Figure 4.10, you enter the 

angle value, and Revit will automatically 

place the degree symbol after you click 

OK in the dialog box.

When adding values to the Length Dimension Snap Increments or Angular Dimension Snap 

Increments setting, Autodesk Revit will automatically change the displayed order of the 

entries—sorting them from larger to smaller—after you click the OK button.

Converting Temporary Dimensions
With an object selected and the temporary dimensions displayed, you can turn them into 

permanent dimensions by selecting the dimension symbol  that appears near the tem-

porary dimension.

Figure 4.9

The Snaps option 
allows you to set 
the snap increment 
that is used by the 
temporary dimen-
sions when placing 
components.

Figure 4.10

Snaps dialog box: 
The temporary 
dimensions that 
are displayed will 
increment based 
on the values in this 
location.
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In Figure 4.11, you can see a selected wall with a temporary dimension displayed and 

the dimension symbol available. After selecting the symbol, the dimension is converted 

to a permanent dimension, as shown in Figure 4.12. The dimension will now be visible 

after the object is no longer selected, as shown in Figure 4.13.
Figure 4.11

Wall selected with 
the temporary 

dimension shown 
and the blue dimen-

sion symbol avail-
able to convert this 

to a permanent 
dimension

Figure 4.12

Temporary wall 
dimension now 

converted to a per-
manent dimension 

while selected

Figure 4.13

Permanent dimen-
sion for the wall 

now displayed 
within the view
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Permanent Dimensions
A permanent dimension is a dimension that is placed specifically for the purpose of 

conveying the distance or angle between elements or parts of elements in the model and 

is visible only within the view in which it is cre-

ated. Dimensions are annotation elements, and 

like other annotations, if the scale of the view 

is changed, the dimensions will automatically 

resize (scale up/down).

Permanent dimensions can be created either by converting a temporary dimension 

(shown in the Temporary Dimensions section) or by selecting a dimension option on the 

Annotate tab and selecting the desired 

dimension type (see Figure 4.14).

When you select a dimension type, the Options bar will display avail-

able dimension options to aid in placing your dimensions correctly. 

Figure 4.15 show the options available when using the Aligned dimen-

sion tool.

Place Dimension Options
The Place Dimension options area helps you choose which references in walls you would 

like to dimension to/from during placement. When placing dimensions, if you need to 

change the placement choice you can press the tab key while placing the dimension to cycle 

through nearby references. These options include: Wall Centerlines, Wall Faces, Center of 

Core, and Face of Core.

Pick Options
The Pick drop-down provides you with a choice of using individual references to select 

your dimension reference one entity at a time or using the Entire Walls option to pick 

a wall and let Revit automatically find the ends of the wall and place a dimension at the 

desired location.

Additionally, when you are using the Entire Walls 

option, the Options button, displayed in Figure 4.15, 

provides additional settings, called Auto Dimension 

Options, that can be used to automate the dimensioning 

of openings, intersecting walls, and grids when you are 

using the Pick Entire Walls method (see Figure 4.16).

Figure 4.17 shows a combination of the auto dimen-

sion options set to Openings with Widths and the Pick: 

Entire Walls option for the lower dimension to dimension all the openings in the wall 

without having to individually pick the location of each opening. The upper dimension is 

using the Pick: Individual References.

Figure 4.14

Choosing a dimen-
sion type on the 
Annotate tab

Figure 4.15

Aligned Dimen-
sion Modify | Place 
Dimension Options

Figure 4.16

Auto dimension 
options available 
when using the Pick 
Entire Walls method
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Dimension Styles
You can select from the following dimension styles;  

each is described in more detail for your reference in  

the following section:

Aligned•	  dimensions are the most common 

dimension type used. When selected, Revit 

places dimensions between two or more paral-

lel elements or two or more points such as wall 

ends. In the case of an angled wall, the dimen-

sion reads parallel to the direction of the angled 

wall (see Figure 4.18).

Linear •	 dimensions are placed between selected 

points and when placed they are in alignment 

with the horizontal or vertical axis of the view 

(see Figure 4.18 and Figure 4.19).

Angular •	 dimensions show the angles between 

two selected elements that share a common  

intersection (see Figure 4.20).

Radial •	 dimensions show the radius of an arc or  

circle (see Figure 4.21).

Arc length •	 dimensions show the length of an arc  

(see Figure 4.22).

Figure 4.17

Using two differ-
ent Pick methods 

for placing dimen-
sions. The top 

dimension is using 
the individual 

references, while 
the bottom dimen-
sion string is using 

the Entire Walls 
option with Open-
ings options set to 

Widths and set to 
be automatically 

generated after 
picking the wall.

Figure 4.18

Wall being dimensioned with Aligned 
(angle) and Linear (horizontal) 
dimension styles
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Figure 4.19

Irregular wall layout 
being dimensioned 
with Linear dimen-
sion style

Figure 4.20

Angled walls with a 
common intersec-
tion being dimen-
sioned using the 
Angled dimension 
style

Figure 4.21

Arc wall with the radius being dimensioned 
using the Radial dimension style

Figure 4.22

Arc wall with the arc length (inside and outside) 
being dimensioned using the Arc Length dimen-
sion style
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Baseline and Ordinate Dimensions
Baseline dimensions are multiple dimensions measured from the same baseline point, as 

shown in Figure 4.23. Ordinate dimensions measure the perpendicular distance from a 

picked origin point called the datum, as shown in Figure 4.24.

The Aligned or Linear dimension style can be used to display as baseline or ordinate 

dimensions. Before doing this, you will need to edit the dimension type settings and 

create a new type with the proper settings. Start by selecting the Aligned dimension and 

choosing the Edit Type option in the Properties palette (see Figure 4.25).

In Figure 4.26 you will find the type properties. If 

you do not already have a type created for the base-

line or ordinate type, you can duplicate an existing 

type by choosing the Duplicate button. You will be 

prompted to enter a name for this new type, as shown 

in Figure 4.27. You will find it is a good idea to keep a standard naming format. For varia-

tions, add text that will help you and others know why the type was created.

Figure 4.23

Floor plan layout 
dimensioned  

using baseline 
dimensioning

Figure 4.24

Floor plan layout 
dimensioned  

using ordinate 
dimensioning

Figure 4.25

Properties palette 
showing the current 

dimension type 
being used; choose 

Edit Type to create a 
new type
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In the Type Parameters ➔ Graphics area, use the Dimension String Type drop-down, 

and choose either Continuous, Baseline, or Ordinate. In Figure 4.28, we have set this to 

use the Baseline value. Click OK in the dialog box to create this new type, and select the 

elements for dimensioning. There is an addi-

tional set of options available when you set 

Dimension String Type to Ordinate. As shown 

in Figure 4.29, it can be found next to Ordinate 

Dimension Settings in the Type Parameters 

portion of the dialog box. Clicking Edit will 

open the Ordinate Dimension Settings dialog 

box, as shown in Figure 4.30, with additional 

options for the graphical display of the ordi-

nate dimension. You can repeat this process as 

needed to create additional types to meet your 

project needs.

An example file showing these two dimension styles, named 04_Dimension_Baseline 

Ordinate.rvt, is available among the book’s companion download files at www.sybex.com/

go/introducingrevit2011.

Figure 4.26

Type properties to create a new dimension type
Figure 4.27

Duplicate and enter a new name for  
the dimension type.

Figure 4.28

Type parameters 
dimension string 
type set to Baseline
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Dimension Text Overrides
Dimensions in Revit always report their exact value and do not allow the use of faking 

dimensions. There will be times while working with dimensions where you will need to 

add supplemental text such as a suffix or prefix. Supplemental text can be added on any 

side (above, below, left, or right) of the permanent dimension value and in some cases 

replace the actual dimension value with text, as shown in Figure 4.31.

Figure 4.29

Type parameters dimension string type set to 
Ordinate with the Ordinate Dimension Settings 
property now editable

Figure 4.30

Ordinate Dimension Settings for additional options 
related only to ordinate dimensions

Figure 4.31

Text that has been 
added in place of 
the actual dimen-

sion value
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To add a dimension text override to your dimension, select your dimension, and then 

pick the dimension value. This will display the Dimension Text dialog box, as shown in 

Figure 4.32.

Within this dialog box, you can choose how to display the 

dimension value (or replace it with other text, for example, Field 

Verify) and display text either above, below, prefix, or suffix to the 

dimension value. When using overrides, you do not have to enter 

text in all the available fields.

Equality Constraint and Lock
The Equality Constraint option is available for objects that have a 

multisegment dimension and is shown using the EQ symbol  

within the dimension string. Figure 4.33 shows a permanent dimen-

sion that has been placed for the walls and windows in the project. 

With the dimension string selected, you can use the EQ option 

(which by default has a red diagonal line through it indicating that the values are not 

equally constrained) by picking the symbol to make the actual dimension distance 

between each window equal, as shown in Figure 4.34.

Figure 4.32

Dimension Text 
overrides dialog box

Figure 4.33

Floor plan with 
dimensions and 
Equality Constraint 
option visible

Figure 4.34

Floor plan with 
dimensions and 
Equality Constraint 
option selected



128	 ■  Chapter 4 : Constraints and Dimensions

When using an equality constraint, the value shown changes from displaying the 

numeric value to showing the letters EQ at each dimension location. This can be adjusted 

to display the actual value if desired. To make this 

change, select your dimension string in the Properties 

palette (see Figure 4.35). You can change the instance 

parameter under the Other ➔Equality Display from 

EQ to Value and click Apply. This will then change 

the dimension display, as shown in Figure 4.36.

With the equality constraint applied, the walls or other references used will remain at 

equal distances from one another as long as the constraint remains active. To remove the 

constraint, select the dimension string and then click the blue EQ option. The dimen-

sions will stay, but the actual constraint will be removed. Now you can independently 

move any of the objects, and the dimension will change only for that reference and not 

for other related elements along the dimension string.

When using permanent dimensions, you can also lock the dimensions, which will 

make a relationship between the referenced objects that cannot be changed unless the 

constraint is purposefully removed. Figure 4.37 shows an example fl oor plan that has 

walls and a door with dimensions. The door needs to maintain the 1´-4˝ distance from 

the inside face of the bottom wall. As the fl oor plan develops, the exterior is shift-

ing, and the use of a locking constraint will help you to maintain that relation-

ship. In Figure 4.38, we have selected the dimension, and in Figure 4.39 
we are going to pick the small lock icon. Doing this will change the 

lock from an unlocked symbol to a locked 

symbol. Later when the bottom wall is moved 

down, we can see the distance for the door 

will be maintained, and the door will stay 

1´-4˝ from the inside face of the bottom wall, 

as shown in Figure 4.40.

Figure 4.35

Dimension equality 
instance parameter 

display options

Figure 4.36

Floor plan with 
dimensions and 

equality constraint 
display set to Value

Figure 4.37

Floor plan with 
dimensions

make a relationship between the referenced objects that cannot be changed unless the 

constraint is purposefully removed. Figure 4.37 shows an example fl oor plan that has 

walls and a door with dimensions. The door needs to maintain the 1´-4˝ distance from 

the inside face of the bottom wall. As the fl oor plan develops, the exterior is shift-

ing, and the use of a locking constraint will help you to maintain that relation-

ship. In Figure 4.38, we have selected the dimension, and in Figure 4.39 
we are going to pick the small lock icon. Doing this will change the 
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Figure 4.38

Floor plan with 
dimension selected

Figure 4.39

Floor plan with 
dimension and 
locking constraint 
picked

Figure 4.40

Floor plan with 
dimensions and 
locking constraint 
applied. Compare 
with Figure 4.39: 
the bottom wall 
has moved, but the 
distance from the 
inside face of the 
wall to the door is 
maintained.
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If you were to delete the dimension, Revit will give you a warning (Figure 4.41) letting 

you know that a lock relationship exists and that you can delete the dimension and keep 

the relationship or you can delete the dimension and remove the constraint.

When the dimension is removed and 

the locking constraint remains, when 

you select an element that has been 

constrained, you will see the lock icon 

selected on the temporary dimension 

that is displayed when the element is 

selected, as shown in Figure 4.42.

Spot Dimensions
Spot dimensions offer the ability to report information about a single point or slope in 

relation to a chosen set of points. With the Revit environment, these can be placed as Spot 

Elevation, Spot Coordinate, or Spot Slope from 

the Annotation tab on the Dimension toolbar 

(see Figure 4.43).

Spot Elevation •	 displays the actual elevation 

(height) of a selected point and can display 

the top and bottom elevations of an element 

with a thickness (see Figure 4.44).

Figure 4.41

The Revit warning  
you get when 

removing a dimen-
sion that has a 

locking constraint 
applied

Figure 4.42

Door selected  
and showing the 

locking constraint  
in the temporary 

dimension

Figure 4.43

Spot Dimension options on the Dimension 
toolbar
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Spot Coordinate •	 displays the north/south, east/west coordinates of a selected point 

and can display the elevation (height) of the selected point (see Figure 4.45).

Spot Slope •	 displays the slope at a specific point on a face or an edge of an element 

(see Figure 4.46).

Figure 4.44

Spot Elevation showing the top of the roof
Figure 4.45

Spot Coordinate showing roof coordinates

Figure 4.46

Spot Slope showing the roof pitch
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Units
The dimension types provided in the out-of-the-box Revit templates take advantage of 

the units and accuracy assigned to the project (Manage ➔ Project Units). You will find a 

need at some point where the units and/or level of accuracy will need to be adjusted to 

achieve the results you need. For example, 

in a project that is using imperial units, 

you may need to show metric units or use 

different rounding options. All of this is 

possible to adjust using an override for 

the dimension type.

To create a dimension with an over-

ride, select the dimension style, and select 

Edit Type from the Properties palette. 

This will open the Type Properties dialog 

box, as shown in Figure 4.47. Select the 

Duplicate option to create a copy, and 

provide a name for this new type. Under 

the Type Parameters ➔ Text grouping, 

you will find the units format. Select the 

button under the Value column for Units 

Format.

This will provide a Format dialog box 

for the dimension units, as shown in 

Figure 4.48. By default the Use Project Settings 

check box is selected. To make your override, 

deselect this box. This will make the entries avail-

able for editing/setting as desired. Make the changes 

that you need, and click the OK button in the 

Format dialog box, and then click OK in the Type 

Properties dialog box.

Your changes are now part of the style; from 

here you can place new permanent dimensions 

using the modified type or select existing dimen-

sions and change the type used from the Properties 

palette. Figure 4.49 shows a partial floor plan that was created using an imperial template, 

and Figure 4.50 shows the same floor plan with the dimension type units formatted to 

display meters.

Figure 4.47

Dimension type 
properties

Figure 4.48

Dimension Units 
Format options
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Figure 4.49

Partial floor plan 
based on the impe-
rial template and 
dimension type 
using imperial  
project units

Figure 4.50

Partial floor plan 
based on the impe-
rial template and 
a dimension type 
with an override set 
to meters





C hap te r 5

Visibility Controls

We all want control.  A design document has a purpose, and how 

it is prepared either enables or hinders that purpose. Revit has a collection of features 

and tools that are intended to provide the control you want in order to ensure that your 

documents fit their purpose. Some tools are exceedingly simple, and others are a bit con-

voluted. Often, the more convoluted a tool or feature is, the more granular the control 

you have becomes. This control not only helps define how well your documents tell the 

story, but it also can create the need to be a very good detective when the plot of the story 

goes astray.

Chapter 2, “Views,” focused on how views work and what you can do with them. This 

chapter is focused on the appearance of your model within the views of the project, the 

management of information that you add to views, and the various tools you can use to 

get these tasks done.

This chapter delves into these items:

Essential concepts of visibility■■

Object styles■■

Properties palette for views■■

Visibility/graphics overrides■■

View range, filters, and view templates■■

Linked files■■

Worksets■■



136  ■   Chapter 5 : Visibility Controls

Essential Concepts of Visibility
With all the Revit tools at your disposal, four concepts help define just how much control 

you have. At the highest level, a single change will have far-reaching implications, usually 

affecting the entire project. Although efficient and fast, this kind of control is usually a 

bit too general and will leave you wanting for exceptions.

The following are the four important visibility control concepts:

Global vs. local  ​When you need to change something, you have to choose whether you 

want that change to happen in all views or in an individual view instead. You have to 

keep this in mind as you work. Revit’s tools are intended to let you balance your desire 

to do something fast and globally against your need to deal with very specific exceptions 

locally. You use the Object Styles feature to manage the appearance of elements globally. 

You use the Visibility/Graphics Overrides feature to manage this locally.

Category vs. element  ​Once you begin to focus on the local level, you find that the global/

local concept repeats itself, in a way, but with regard to element categories and the ele-

ments themselves. The changes you make in individual views (locally) can be applied to 

an entire category of elements (global) or to an individual element (local). It is simpler 

to manage elements as a category since it changes many at once. It is more work to deal 

with elements individually, but it’s much more flexible. It is important to have this kind 

of flexibility, and most wouldn’t trade it away despite it taking more effort. Ultimately, it 

is up to you to find the right balance. You manage visibility and appearance of categories 

using the Visibility/Graphics Overrides feature. Individual control of elements is accessed 

either through the ribbon or via context (right-click) menu options. Either route assumes 

you are selecting an element or elements first and then choosing the action to take.

Hiding vs. overriding  ​Many times you just want to hide an element simply because it isn’t 

appropriate to see it in a given view. Other times you just need to change (override) the 

appearance of an element. The tools address both naturally. You can hide or override 

elements by category (which is fast) or by element (individually, which is slower). When 

you hide elements, you will need to find them later. The Reveal Hidden Elements tool 

makes it easy to see which elements are affected (Figure 5.1). Elements that have had their 

appearance overridden are more difficult 

to assess. You’ll have to examine a view 

carefully to find these.

Temporary vs. permanent  ​By permanent, we don’t mean that you can’t ever alter or restore 

something later. Permanent in this context means that your changes will be persistent and 

that they will print and export this way until you change them again. When collaborating 

with other users in the same project, permanent also means what they see will be affected 

by your changes. The use of the word temporary in this case means that the changes you 

make will not affect printing or exporting information. Technically speaking, changing a 

Figure 5.1

The Reveal Hidden 
Elements tool
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value and then restoring it shortly thereafter qualifies as temporary actions too, just not 

what we have in mind here.

Truly temporary changes are limited to 

the Temporary Hide/Isolate tool on the 

View Control bar (the “sunglasses” icon, as shown in Figure 5.2). This tool affects only 

what you see on-screen; it doesn’t affect anyone else working on the project and will be 

reset when you close the project, assuming you haven’t already done so. If you refer to 

Figure 5.3, you’ll see that you have these four options: Hide 

Element, Hide Category, Isolate Element, and Isolate Category. 

You can remove all the temporary changes you’ve made using 

Reset Temporary Hide/Isolate. You can choose to cause a tem-

porary change to become permanent using Apply Hide/Isolate 

To View.

Object Styles
Returning to the notion of global settings or behavior, Object Styles are defined in a 

project template and determine how all elements will appear in all views initially. This 

is an essential part of getting Revit implemented well in your practice. You can open the 

Object Styles dialog box from the Settings panel of the Manage ribbon tab. This dialog 

box contains three tabs: Model Objects, Annotation Objects, and Imported Objects (see 

Figure 5.4). All the categories that are defined by Revit are listed in rows, and the settings 

you control for each are Line Weights for Projection and Cut, Line Color, Line Pattern, 

and Material. The available settings vary slightly for each tab, but the purpose for each is 

the same, which is to give you a way to decide how your model, annotation, and imported 

elements should look as a rule.

Figure 5.2

The Temporary 
Hide/Isolate tool on 
the View Control bar

Figure 5.3

The other hide-
isolate tools

Figure 5.4

The Object Styles 
dialog box
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Quite often, dissatisfaction you might have about how your documents look initially 

can be resolved by making relatively minor adjustments to the Object Styles. Each category 

has subcategories, and you can adjust these too. For example, the way a door panel appears 

in a plan is confi gured in the Panel subcategory, as shown in Figure 5.5. Just remember, 

these are global settings that affect the entire project.

Properties Palette for Views
The Properties palette provides quick access to a great many view controls. This palette 

is docked above the Project Browser as its default location. You can move it to other loca-

tions and even outside of the Revit workspace onto a second monitor if one is available 

to you.

T h E V I E W CO N T r O L Bar aN D T h E paLE T T E

The View Control bar isn’t part of the Properties palette, but it complements it, so we’ll men-

tion it briefl y here. Located at the bottom-left corner of most of the view types, the View 

Control bar provides fast access to a select few features. It was added to Revit originally to 

help you avoid the need to open the Properties dialog box. The View Control bar was cov-

ered in depth in Chapter 1, “The Revit Architecture User Interface.”

The Properties palette is a new approach to providing access to properties (see 

Figure 5.6). If you keep it open all the time, as the product’s designers are anticipat-

ing you will, you get quick access to a view’s properties at either location. Within the 

Figure 5.5

A door’s subcat-
egory for Panel

T h E V I E W CO N T r O L Bar aN D T h E paLE T T E

The View Control bar isn’t part of the Properties palette, but it complements it, so we’ll men-

tion it briefl y here. Located at the bottom-left corner of most of the view types, the View 

Control bar provides fast access to a select few features. It was added to Revit originally to 

help you avoid the need to open the Properties dialog box. The View Control bar was cov-

ered in depth in Chapter 1, “The Revit Architecture User Interface.”
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Properties palette are buttons that provide access to 

deeper parts of Revit, which often provide access to still 

other features; see the Edit buttons in Figure 5.6. It can 

be a bit labyrinthine. These additional routes to features 

are provided primarily to save you the hassle of retracing 

your steps to alter related settings only to have to return 

to your original agenda afterward.

Graphics Group
Let’s examine the first group of features found in the 

Properties palette for the floor plan view called Floor 

Plan: Level 1 (as found in a default template), as shown 

in Figure 5.7. The Graphics group includes the following 

properties:

View Scale Underlay Orientation
Scale Value Orientation
Display Model Wall Join Display
Detail Level Discipline
Visibility/Graphics Overrides Color Scheme Location
Visual Style Color Scheme
Graphic Display Options Analysis Display Styles
Underlay Sun Path

When you examine the properties of other views such 

as elevations or sections, you’ll find another setting, 

Hide At Scales Coarser Than. When design options are 

being used, you’ll also find the Visible In Option setting. 

You’ll learn more about these in more detail a little later 

in this section.

View Scale and Scale Value  ​The first two are pretty 

obvious because of their names, but it may not be obvi-

ous that each view defines its own scale, as shown in 

Figure 5.8. This means that the model you build in 

Revit is full size at all times, but you are consistently 

conscious of an intended drawing scale. This helps you determine how well a design will 

fit on paper. The second field under View Scale called Scale Value is the expression of a 

scale’s numeric ratio as opposed to the traditional feet and inches or metric values dis-

played above in View Scale. It doesn’t serve much purpose other than to inform the curi-

ous since you can’t alter the value here.

Figure 5.6

The Properties  
palette for a floor 
plan view

Figure 5.7

Properties palette’s 
Graphics group

Figure 5.8

Scale properties
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Display Model  ​The Display Model setting has three choices: Normal, As Underlay, and 

Do Not Display (see Figure 5.9). The first and most common setting is Normal, and this 

displays the model without bias according to the settings that have been defined in your 

project’s template and Object Styles (more about these a bit later). Using As Underlay will 

cause Revit to apply a “halftone” to the model elements 

in the view so that you can draft details over the model 

but let your drafting work take precedence. The last 

choice, Do Not Display, is intended to hide the model 

when the drafting exercise produces everything required by the view and the model 

will only serve as a distraction. The second two choices allow you to blur the distinction 

between 2D in the Revit 3D model, where the abstract can take priority over the virtual 

reality of the building model. This setting is most commonly used in conjunction with 

details rather than in conventional floor plans, elevations, or building sections. As with 

anything, we’re sure there are exceptions to be found that counter this claim.

Detail Level  ​Detail Level is a clever method that allows you to transition between simple 

and complex or, put another way, between preliminary/schematic design and later design 

phases (see Figure 5.10). There are three settings: Coarse, Medium, and Fine. Elements 

appear at their simplest with a Coarse setting. Walls are shown as just two lines. The 

same is true for floors, ceilings, and roofs. A simple 

switch to Medium will show the additional subtle 

construction layers of each type of Revit element. The 

Fine setting has no bearing on walls, floors, roofs, or 

ceilings, but for other content like doors, windows, or casework, it can have dramatic 

impact. Casework could show drawer pulls and locking hardware at Fine, while only 

showing door or drawer forms when the view is set to Medium. At Coarse these same 

cabinets could be simple rectangle forms with little definition. The ultimate goal is to 

provide a sophisticated level of display control with a modest amount of effort while 

working in the project environment. To truly make the most of this feature, the content 

you use and make yourself must be built with it in mind. We’ll revisit this concept in the 

Family Editor sections in this book.

Visibility/Graphics Overrides  ​The Visibility/Graphics Overrides feature (and the slender 

Edit button that appears next to it) is a much deeper topic and deserving of more than a 

simple paragraph (see Figure 5.11). We will devote time to this a bit later in this chapter. 

VG, as you’ll probably come to refer to this feature, lets 

you tailor an individual view to your needs while leav-

ing all others alone.

Figure 5.9

Display Model  
property

Figure 5.10

Detail Level choices

Figure 5.11

Visibility/Graphics 
Overrides button
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Visual Style  ​Visual Style is probably a familiar concept 

to you consisting of Wireframe, Hidden Line, Shaded, 

and Shaded with Edges (see Figure 5.12). New to 2011 are 

Consistent Colors and Realistic. The Consistent Colors 

setting turns off the light source used in the Shaded and 

Shaded with Edges settings so that the colors are not altered by the shadows that are cast 

on the model. Realistic is the first step toward real-time material representation in views. 

Refer to Figure 5.13 for examples of each.

a: Wireframe

c: Shading

e: Consistent Colors

b: Hidden Line

d: Shading with Edges

f: Realistic

Graphic Display Options  ​Graphic Display Options controls sun and shadow settings and a 

slightly more arcane feature called Silhouette Edges (see Figure 5.14). Once you’ve opened 

the dialog box, by clicking the slender gray Edit button, you can choose to display shadows 

and even define how the shadows should be cast. They can respond to time/day/date or a 

specific orientation. It is also possible to create a single day or multiple day shadow study. 

Silhouette Edges overrides the appearance of the model so that outer boundaries such as 

walls and roofs, as well as the boundary edges of openings in walls, “pop.” The intention 

is to take an otherwise drab exterior elevation view and make it more dramatic.

Figure 5.12

Visual Style choices

Figure 5.13

Visual Style  
examples
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Underlay Settings  ​It can be handy to display a portion of the model that is above or below 

the current plan elevation. For instance, lining up shaft walls is not as easy unless you 

can “see” them. The Underlay and Underlay Orientation settings control 

whether Revit shows another level and which way the information should 

be displayed—either according to plan or according to reflected ceiling 

plan view (see Figure 5.15). Most of the default templates that come with 

Revit have an underlay assigned to the floor plan views that use the plan 

orientation. When it comes time to print a view, you may want to adjust the 

Halftone/Underlay settings so that your underlay will print dark enough 

(see Figure 5.16). There is also a setting in the Print Setup dialog box called 

Replace Halftone With Thin Lines, as shown in Figure 5.17.

Figure 5.14

Graphic Display 
Options

Figure 5.15

Underlay Settings: 
setting Underlay to 

something other 
than None activates 

the Underlay  
Orientation option.

First selection leads to second option
becoming available

Figure 5.16

Halftone/Underlay 
settings

Figure 5.17

Replace Halftone 
With Thin Lines  

setting
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Orientation  ​A project is usually drawn so that it is easy to describe on a printed page. The 

actual north bearing of a project is important but is not often conducive to creating draw-

ings. It is therefore a pretty common habit to create drawings that use a project north orien-

tation while providing a north arrow symbol that tells the reader which direction true north 

is. The templates that come with Revit have their plan-oriented views assigned to Project 

North (see Figure 5.18). This means that you should start by being just a little ambivalent 

about which direction north really is. It is easy to let Revit 

know which direction true north is later via the Rotate 

True North tool. Once this has been done, then any plan 

view can be assigned to either True North or Project 

North as needed.

Wall Type Joins  ​Wall Type Joins is a bit arcane and available only in views that are using a 

Detail Level setting of Coarse. There are just two choices: Clean All Wall Joins and Clean 

Same Type Wall Joins (see Figure 5.19). As you can imagine, the first choice will cause 

Revit to clean up all the intersections between walls that occur in the view. The second 

choice is intended to be a bit more selective by having Revit focus on cleaning up the 

intersection of walls that are the same type of wall. The first setting is used the most, by 

far. The second can be useful if you don’t want dissimilar walls to appear as though they 

blend together. Imagine shaft walls or rated walls that have a nonrated wall that come 

into contact with them. It is fairly 

common practice to show a line 

where these walls touch instead 

of having the software show them 

blending together. This can be use-

ful in overall plan views until you 

use enlarged plans that will likely 

use a Detail Level of medium to 

make this difference more obvious 

and relevant to the reader because 

differences in material assignment 

are displayed.

In elevation or section views, this setting isn’t present because it is irrelevant.

Discipline  ​Revit uses the Discipline setting to alter the appearance of the model accord-

ing to how each discipline tends to display information. These disciplines include 

Architectural, Structural, Mechanical, Electrical, and Coordination (see Figure 5.20). In 

Revit Architecture, this setting may not get as much use compared to in Revit Structure 

or Revit MEP. The Structural discipline setting reduces the view to display structural 

Figure 5.18

Orientation  
property

Figure 5.19

Clean Wall  
Joins choices

Same wall types join

Different wall types 
don’t join
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items only. Walls that are not assigned as “bearing” 

(structural purpose) are hidden from view, for example. 

The Mechanical and Electrical disciplines alter the view 

so the architectural and structural elements are trans-

parent and halftone. Each discipline takes precedence in the view over the others. The 

Coordination discipline displays everything as equal without overrides.

It isn’t possible to add/remove or change the Disciplines offered in the list.

Color Scheme and Others  ​There are two items in this group of properties dedicated 

to views that will have color schemes applied. They are Color Scheme Location and 

Color Scheme (see Figure 5.21). The first offers you Background or Foreground. The 

Background setting keeps the color scheme beneath 

(behind) walls and other elements in the view. The 

Foreground setting moves it above (in front of) other 

elements. This works nicely when you are interested 

in large blocks of color, uninterrupted by walls, to 

define a portion of the plan. The Background set-

ting works better for views that need to focus more 

on individual rooms but still indicate their relation-

ship with other rooms through color. Color schemes 

can be applied to rooms and areas in Revit Architecture. If you are collaborating with 

an engineering firm using Revit MEP, then you might find it useful to know that this 

extends to their spaces and ducts.

Hide At Scales Coarser Than  ​When you examine this group for other kinds of view, such 

as elevations or sections, you’ll find another setting called Hide At Scales Coarser Than 

(see Figure 5.22). This allows you to choose a plateau at which the annotation for these 

view types will not display below. This makes it easier 

to prevent finer-scale wall sections or detail sections 

from having their annotation appear in your overall 

plan views or elevations. Just choose the last scale value 

you want them to show up in, and they won’t show up 

in any below that value.

Analysis Display Style  ​This is a new feature intended to support third-party applica-

tions for analysis. Clicking the small “browse” button that appears when you place your 

cursor in the field next to the label (see Figure 5.23) will 

open a dialog box that offers two reporting styles that are 

supported at this time: colors (coloring of surfaces) or 

legends (text information). The dialog box isn’t much use 

Figure 5.20

Available disciplines 
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Figure 5.21

Color Scheme set-
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color scheme loca-

tion and choosing a 
color scheme

Selecting Color Scheme Location affects
the display of the Color Scheme chosen

Figure 5.22

Hide At Scales 
Coarser Than  

setting

Figure 5.23

Analysis Display 
Style setting



Properties Palette for Views ■  145

yet because as of this writing it isn’t apparent which applications will take advantage of it. 

However, a couple relevant examples of a third-party application that could use this are 

reports for lighting levels or thermal radiation levels.

Visible In Option  You fi nd this only when your project 

has a design option (refer to Figure 5.24). This setting 

determines whether the annotation for this view should 

be visible in all views or only when a specifi c design 

option is assigned to a view. For example, a section view 

has associated annotation, and when you create a new 

section view while editing the main model, it will be assigned to All. If you are editing a 

specifi c option when you create the section view, it will be assigned to that option instead.

Sun Path  This is a new feature that will display a 

representation of the sun and its path around and 

over your project (see Figure 5.25). It provides a 

tactile and interesting (more useful and fun too) 

way to manipulate the sun positioning informa-

tion for the project instead of using the estab-

lished Location and Position dialog boxes. You 

can turn this on by selecting the Sun Path setting 

(see Figure 5.26) or by using the View Control 

Bar button (refer to Figure 5.27).

Identity Data Group
The next group listed in View Properties is 

Identity Data (see Figure 5.28). This is intended 

to manage information related to the view, such as its 

name and the Title On Sheet parameter. There is one 

important visibility control item here, though, called 

Default View Template. This setting is a critical part 

of managing your project and its views. If you spend 

a signifi cant amount of time adjusting the way a view 

looks, you won’t be thrilled to repeat the entire exer-

cise many times. You will be thrilled, however, to 

learn that a view template can make short work of 

that repetitive task. You will see more about these 

later in the chapter. 

Figure 5.24

Visible In Option 
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Figure 5.25

The new Sun Path 
setting and feature
The new Sun Path 
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Figure 5.26

View properties, 
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Figure 5.27
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Figure 5.28
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Extents Group
The Extents group in View Properties provides control over the following features: Crop 

View, Crop Region Visible, Annotation Crop, View Range, Associated Level, Scope Box, 

and Depth Clipping (see Figure 5.29). In other view types, there are some additional set-

tings: Far Clipping, Far Clip Offset, and Parent View.

Cropping  ​It is possible to crop a view, such as a floor 

plan, elevation, or section. There are some views that 

do not allow it, such as drafting, legend, and schedule 

views. Cropping is typically applied to a view to cre-

ate partial plans or enlarged scale views of the build-

ing model. You can choose to display the crop region 

(boundary) with the Crop Region Visible setting. Some don’t mind seeing it, while  

others are distracted by the extra rectangle in the view—it’s your call (see Figure 5.30).

This rectangle is the crop region

The Annotation Crop is a secondary boundary that defines when the annotation in the 

view should show up. For example, room tags for rooms that are partially displayed in 

the view because of the crop boundary will appear only if they are within the Annotation 

Crop boundary (see Figure 5.31). Naturally you can adjust the extents of the crop region 

and the annotation crop separately.

Figure 5.29

Properties palette 
group: Extents

Figure 5.30

Cropping a view
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Room tags are visible because 
the Annotation Crop boundary 
is beyond the tag.

View Range  ​View Range determines how elements are drawn in the view. It defines where 

Revit cuts a plan or ceiling plan and whether elements are using a thick, thin, or thinner 

pen. This little paragraph won’t do it justice, so we’ll discuss it in greater detail later in 

this chapter (see Figure 5.32).

Associated Level  ​Associated Level is a read-only 

setting (you can’t change it—sorry!), as shown in 

Figure 5.33. Each plan-oriented view type is forever 

associated with a specific level. We occasionally see a 

user trying to create a new level by duplicating a floor 

plan view and just renaming it, like 6th Floor. Unfortunately for them and their team, 

they end up with a view with a nice name that is still associated with a different level, and 

confusion ensues. Just keep in mind that you can quickly check this setting for any view 

to confirm it is being used as intended.

Scope Box  ​Imagine a project that has several floors and is large enough that an overall 

plan just doesn’t fit on a single sheet. This is where scope boxes and this setting come in 

handy (see Figure 5.34). When you need a consistent portion of the building to appear 

in each floor’s plan view, you’ll want a scope box. You sketch a rectangular boundary to 

define the “scope” for each partial plan. Each view can be assigned to a specific scope 

Figure 5.31

Annotation Crop 
boundary

Figure 5.32

View Range prop-
erty and button

Figure 5.33

Associated Level 
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box, and as a result the crop region adheres to this new boundary. All the partial plan 

views for a given part of the project can be assigned to the same scope box. This provides 

control that is both easy to manage as well as effective. You can also apply this feature to 

other views and datum (levels, grids, and reference planes) to help manage their visibility. 

Scope boxes are a very useful, often-overlooked, portion of Revit’s arsenal of features.

Scope box, typical of 
four in the figure

Depth Clipping  ​This feature is related to a view’s View Range settings, which as we men-

tioned earlier, are covered a bit later in the chapter. When you click the slender gray but-

ton labeled No Clip (the button wording changes according to the setting chosen), you’ll 

see the Depth Clipping dialog box shown in Figure 5.35. The graphics in the dialog box 

explain what it is intended to do pretty effectively. The most likely reason to use this is for 

a slanted wall that extends beyond the current level’s view range. If you want Revit to stop 

displaying the wall as if it were not continuing below, then you should choose Clip with 

Line. The help documentation has nice graphic images that help explain the concept well.

Far Clipping and Far Clip Offset  ​There are two others in Section, Elevation, and Camera 

views called Far Clipping and Far Clip Offset (see Figure 5.36). These govern the depth 

Figure 5.34

Scope Box setting

Figure 5.35

Depth Clipping 
options
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of these views and are how far forward Revit will look and therefore display information. 

These are especially important when rendering views to limit how much of the model 

Revit will attempt to render to just the part that is actu-

ally necessary or actually visible. There isn’t much to 

gain by rendering the portion of the model hidden by 

walls and other elements.

Phasing and Camera Groups
Wrapping up the contents of the View Properties 

palette, for most of the view types you’ll see a small 

group with just two Phasing tool settings: Phase Filter 

and Phase, as shown in Figure 5.37. The phasing fea-

tures in Revit are intended to graphically aid the documentation of Existing, Demolished, 

Temporary, and New Construction conditions. It is primarily a graphical tool to change 

the appearance of elements according to their phase conditions. It can also be manipu-

lated to create a series of construction sequence views, but often this use contradicts the 

primary purpose of the tool.

The Camera properties group appears when you start using the Default 3D View, 

Camera, and Walkthrough view tools (see Figure 5.38). They allow you to adjust the ori-

entation of the camera position with numerical input. Most users find it is more natural 

and intuitive to use the other navigation tools that 

Revit provides to orient a camera.

As you can see, we weren’t kidding when we said 

that there are a lot of features and tools tucked away 

in this palette.

Visibility/Graphics Overrides
This section will tackle how you can selectively redefine how an individual view will look. 

For example, a plan view dedicated to showing the scope of work for furniture, fixtures, 

and equipment (FFE) needs to look a bit different than a construction plan intended 

to explain how to build all the partitions for the offices on a given floor. The Visibility/

Graphics Overrides dialog box gives you this sort of control as well as provides access to 

other related features.

Let’s start by taking a look at the dialog box; it is one of the biggest that Revit has (see 

Figure 5.39). It features tabs (four at a minimum) across the top. How many tabs will be 

displayed depends on the other features that you could use for your project. For example, 

if you are using a linked Revit model, worksets, or design options, you’ll find that new 

tabs join the four default ones. These default tabs correspond to the nature of informa-

tion presented in a view: Model Categories, Annotation Categories, Imported Categories, 

and one tab dedicated to a special view control tool called Filters (more on Filters later).

Figure 5.36

Far clip settings

Figure 5.37

Properties palette 
group: Phasing

Figure 5.38

Properties palette 
group: Camera
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These tabs are always present. These tabs are present only when your 
project is using the feature named in the tab.

The first column, Visibility, lists each category used in Revit. 

At the top is a check box that will turn off or on the visibility of 

everything listed on the tab. This can be useful, as an adminis-

trative technique, to see only annotation elements in the view, 

for example. For each category, the accompanying check box is a 

switch that will turn off or on the category or its subcategories. 

The little plus sign next to a category indicates that it has at least 

one subcategory, if not many (see Figure 5.40).

Once you’ve decided which categories should be visible, you can deal with the indi-

vidual appearance of each according to the Projection Lines, Surface Patterns, Cut Lines, 

and Cut Patterns settings. Remember, all views adhere to the settings defined in Object 

Styles (global settings), while Visibility Graphics Overrides allows for unique situations 

(local settings). Ideally, your Object Styles will cover the majority of the conditions you 

have. Revit has a button to access the Object Styles settings in this dialog box just in 

case you decide that changing something there is the best course of action instead (see 

Figure 5.41).

Figure 5.39
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Figure 5.40
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Figure 5.41

Object Styles  
button
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Several other settings such as Halftone, Transparent, and Detail Level can be quite 

useful to adjust the intensity or priority of various categories so that your view tells the 

correct story. For example, your architectural floor plan may want to use a Detail Level 

setting of Coarse to show information as simply as possible. Structural steel elements 

only show as “stick” symbols when you choose Detail Level: Coarse. They only become 

more obvious steel shapes when you choose a setting of Medium or Fine instead. It is an 

easy change, one setting, to show steel beams (Structural Framing) in a more meaningful 

way (see Figure 5.42).
Figure 5.42

Example of Detail 
Level overrides
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If you are using the View Property: Discipline assigned to anything other than Architectural 

or Coordination, be careful with the Halftone setting. The disciplines Structural, Mechanical, 

and Electrical apply halftone to the view automatically. Using the Visibility/Graphics Over-

rides tool to assign a category to halftone is doubling the halftone, making it even lighter. It 

is reasonable to expect that this will cause some printing/plotting problems!

View Range
As we mentioned earlier, the View Range feature requires a bit more explanation to 

appreciate how it affects what you see in your views. It is applied individually to views, 

and it allows Revit to choose which line weight settings to apply to elements in plan-

oriented views.

You can use view templates to apply changes to the view range more efficiently and to lots 

of other settings too!

Imagine you are standing on the second floor of a building. Revit uses a metaphorical 

knife to cut and present a plan view to you. This knife’s height above the floor is Revit’s 

cut plane. Any element that is cut by this plane will use Revit’s Cut line weight setting, 

if it has one, found in Object Styles or overridden with Visibility/Graphics Overrides. 

Elements in the view that are not specifically cut by Revit will display using the projec-

tion line weight found next to the Cut line weight in either location. Revit uses two more 

planes to establish how far above the cut plane you want it to “look” and how far below 

the cut plane it should “look.” As long as an element exists between the Bottom and Top 

planes, Revit will see it and use the Projection line weight to show it. Before you go fur-

ther, refer to the View Range dialog box to help you see these settings (see Figure 5.43).

To help resolve situations where there 

is more information below the floor, like 

standing on a mezzanine level looking down 

to the floor below, Revit has one additional 

plane called View Depth. If the elements in 

the view are not found between the Bottom 

and Top planes but are located between the 

Bottom and View Depth planes, Revit will 

use another line style called Beyond to show 

them. Therefore, Revit is capable of using a combination of three different line weights to 

show elements in a plan-oriented view, all according to their vertical relationship to the 

floor they are related to.

Figure 5.43

View Range dialog 
box for a floor plan
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It is important to think of each plane (Top, Cut Plane, Bottom, and View Depth) as physical 

entities (plates of glass, for example) that cannot travel past each other. You cannot enter a 

value that would push the Bottom plane beneath the View Depth plane. They can share a 

value, but they can’t travel past one another. You can avoid getting error messages if you 

remember this fundamental rule.

All plan views in a template start with basic, viable settings. You may have to adjust 

them from time to time, and it is important to understand the role templates play with 

controlling the visibility of elements.

To tackle a practical example, let’s consider the stock template default.rte and the 

ceiling plan view range settings. The View Range settings are adjusted to avoid allowing 

the cut plane to pass through doors, at least doors that are less than 7´-6˝ tall. The result-

ing ceiling plan view doesn’t give you any indication where door penetrations are. Some 

users don’t like this because they are in the habit of showing where openings are in walls. 

Let’s compare two ceiling plan views using a simple model to focus on the settings, not 

the design. The first ceiling plan is using the stock settings captured on top of the plan 

(see Figure 5.44).

The next image to consider is the revised ceiling plan using different settings, also 

captured in place (see Figure 5.45). Now you see the doors, but you also see the panel and 

the arc of the door swing. Many firms don’t show these this way at all. A short visit to the 

Visibility/Graphics dialog box to turn off the categories for them will resolve that (see 

Figure 5.44

Ceiling plan,  
stock settings
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Figure 5.46). If you expand on what you just learned about Visibility/Graphics Overrides 

and combine it with this View Range adjustment, you can fix the problem with the doors 

(see Figure 5.47).
Figure 5.45

Ceiling plan, modi-
fied settings

Figure 5.46

Visibility/Graphics 
Overrides applied
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Another approach is when you have a slightly unusual ceiling plan that shows you the 

panel and swing of the doors so it is easier to determine where light switches should go 

(see Figure 5.48).

These are the settings used to adjust the appearance of the door panel and plan swing 

subcategories. Pay close attention to the fact that the Panel subcategory is adjusted under 

the Cut Lines column (see Figure 5.49), and the Plan Swing subcategory (see Figure 5.50) 

Figure 5.47

Ceiling plan after 
Visibility/Graphics 
Overrides

Figure 5.48

Ceiling plan, modi-
fied View Range and 
Visibility/Graphics 
Overrides
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is adjusted under the Projection Lines column. These are created using separate Object 

Styles subcategories in the family to provide individual control over them.
Figure 5.49

Visibility/Graphics 
Overrides of Panel 

settings

Figure 5.50
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On this subject, we want to encourage you to review the help documentation that 

comes with Revit. Its technical documentation team has put quite a bit of effort into 

making this quirky subject more accessible.

Filters
You can use filters to hide elements or to alter their appearance. How they affect elements 

depends on the criteria being used to apply them and how many elements share the cri-

teria that you use to create the filter. There are two roads you can take to create a filter. 

The managerial road starts at the View rib-

bon tab and the Filters tool found on the 

Graphics panel (see Figure 5.51). You can 

create and edit them using this route, but 

you can’t apply them. Filters are applied 

from within the Visibility/Graphics Overrides dialog box (see Figure 5.52). It is also pos-

sible to apply them by selecting an individual element or elements and using the context 

menu option Hide Element or Override Graphics In View and choosing By Filter. The 

result, however, is that Revit just opens the Visibility/Graphics Overrides dialog box to let 

you choose and apply a filter.

Click the Edit/New button to open the Filters dialog box.

Add a new filter from existing filters or remove one you already applied.

Figure 5.51

Filters tool on  
the Ribbon

Figure 5.52

The Filters tab in the 
Visibility/Graphics 
Overrides dialog 
box: click Add or 
Remove to apply or 
remove existing fil-
ters, and click Edit/
New to open the 
Filter dialog box.
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When you create a filter, you usually have a problem to solve—something doesn’t look 

the way you want. We see that architects tend to use filters to solve documentation subtle-

ties. Engineers using Revit MEP tend to use them as much to help them see different 

systems of equipment as they work, such as supply air vs. return air ducts or hot/cold and 

sanitary piping, as they do for documentation.

You can take a closer look at a practical example based on sketching a quick bathroom 

partition layout with walls instead of using component families. It isn’t an obvious approach 

for some, but those who want a faster way to get an idea on paper might find it useful.

The ingredients for this are a filter, a wall type, and a door type. Mix them together, 

and you can get the kind of result shown in Figure 5.53. We’ll call the wall type Toilet 

Partitions, and it is just 1˝ thick, like a real toilet partition. The trouble with this thick-

ness is that it will print poorly, as a single, really heavy line, because the two wall faces are 

so close together. The door type will also be altered to be thinner than a regular door for 

the same reason as the wall. The filter will fix these graphical issues quickly. The end result 

is a quick toilet room layout, which isn’t bogged down by equipment selection, finding 

the right family. Being successful in early design phases with Revit comes from being able 

to differentiate between what you need now and what you need later.

Before filter After filter

Creating the filter is easy; just take these steps:

	 1.	 Open the Filters dialog box (go to the View ribbon’s Graphics panel).

	 2.	 Create a new filter by clicking the New Filter button. Name the filter Toilet Partitions.

	 3.	 In the center section of the dialog box, choose the categories your filter applies to 

(Doors and Walls).

	 4.	 In the right section of the dialog box, choose the criteria your filter will use to “find” 

your elements (see Figure 5.54).

	 5.	 Click OK to save the filter.

Figure 5.53

Toilet Partition  
walls before and 

after filter
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2

Applying the filter to your view is easy too:

	 1.	 Open the view, and then open Visibility/Graphics (keyboard shortcut VG).

	 2.	 Click the Filters tab, and then click the Add button. This opens the Add Filters dialog box.

	 3.	 Choose your new filter from the list (Toilet Partitions), and then click OK to return 

to the main dialog box.

	 4.	 To test the filter, deselect Visible, and then click Apply. Did it turn them off?

If it did, select the Visible option, and override the settings (see Figure 5.55).

If it didn’t, your criteria are incorrectly defined (case sensitive and logic issues).

	 5.	 Override the settings for Cut: Lines and Projection/Surface: Lines.

Figure 5.54

Creating a new filter

Figure 5.55

Overriding  
the settings
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Following these steps should help you create and apply any filter you need. Eventually 

you will need to become comfortable with defining your own custom parameters to pro-

vide criteria that aren’t available out of the box.

View Templates
Templates allow you to apply consistent changes to multiple views quickly. View tem-

plates are not aggressive, however. They don’t automatically apply changes to views that 

have been assigned to them. The product designers stopped short of doing this because 

they have just as much potential to harm as to help. In the wrong hands, a view template 

can create some serious problems. Unfortunately, view templates get changed and applied 

incorrectly on the day of a big deadline. Applying the correct view template(s) again will 

often undo the damage pretty easily. Just remember they are powerful, and it is necessary 

to be careful with powerful things.

View templates can be created from two points of 

view, manager and user. As a user, you are likely to create 

a template using a view that you spent some time adjust-

ing carefully with View Properties and/or Visibility/

Graphics. It just makes sense to use something you’ve 

fine-tuned well as the template for the template. If you 

are the manager, then you’ll be comfortable with the first 

approach or just creating or editing a raw template with-

out seeing the results immediately in the view itself.

As the user, you need to use the context menu, in the 

Project Browser, on the view name that has the settings 

you need in your template. The context menu displays a list that includes the command 

Create View Template From View (see Figure 5.56). Choosing this will prompt you to 

provide a name for the template. Once you satisfy that request, Revit will open the View 

Templates dialog box. This gives you a chance to review settings before saving the tem-

plate to the project.

The View Templates dialog box is loaded with things to adjust. It is a combination of 

the View Properties and Visibility/Graphics Overrides features. You can also reduce the 

number of view templates displayed in the list of names by choosing from the Show Type 

selector to filter by view types. In addition to each template setting featured are check 

boxes at the right side of each row. These check boxes are intended to let you override one 

or many of the settings that are defined in a given template. You can open this dialog box 

at any time, deselect a box, close the dialog box, and then apply the view template; the 

deselected feature will be ignored. All the other settings are honored as the template is 

applied to a view or views.

Figure 5.56

Right-click and 
choose Create View 

Template From 
View.
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Each view can be assigned to a template, and later you can apply templates to many 

views quickly by right-clicking and choosing Apply Default View Template. Regardless 

of the views you have selected, Revit will only apply the view template that is assigned to 

each view, ignoring the view if none is assigned yet (refer to Figure 5.57).

Linked Files
Chapter 10, “Working with Other Files,” delves into working with other files, 

so this section will only touch on the control you have over the visibility of 

them. It is often necessary to link other data into your project, whether it is 

from other CAD applications or other Revit models. The features discussed 

in this chapter extend to managing the information in these linked files too. 

For links based on DWG file data, you can manage the layers of the link with 

the Visibility/Graphics Overrides settings. This means it is necessary for 

these external files to be well made so that you have as much control over the 

information stored on their layers as possible.

Revit files that are linked together enjoy a bit deeper level of control 

than you have for external CAD file data. You can choose to let the host file 

“drive” the links, or you can use the link’s own appearance and settings. At 

the most granular, you can access categories and elements individually even 

though they are part of a link. This control isn’t exactly equal to being part 

of the host file, but it gives you much greater control than just letting the host 

control the link.

Imported DWG files have their layers added to the Revit database, and 

this gives you similar control over the elements on those layers as AutoCAD 

users have over their DWG files. The file and its layers are listed on the 

Imported Categories tab in the Visibility/Graphics dialog box. As long as the elements in 

the file are defined By Layer, you can override their color, line type, and line weight (see 

Figure 5.58).

When you link a Revit project file, a new tab is added to the Visibility/Graphics set-

tings for them just as for DWG files (and other formats), as shown in Figure 5.59. Initially 

the linked file is controlled by the host project. It is through this tab that you can dig 

deeper into the link to have more control over its elements. The next level of control is 

to display information by linked file (see Figure 5.60). This will expose the views of the 

linked project and let you choose which one to display instead. This means you also see 

notes and other annotation that otherwise are not visible at all in the host project (see 

Figure 5.61).

Figure 5.57

Apply Default View 
Template option 
via Shortcut Menu 
(right click).
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Figure 5.58

Imported catego-
ries in Visibility/

Graphics Overrides 
settings

Figure 5.59

Revit Links tab in 
Visibility/Graphics 

Overrides

Figure 5.60

Changing to By 
Linked View
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Linked files ordinarily do not show any annotation (text, symbols, tags, dimensions, and so 

on) that is in their views; only the model is visible. You can ask the team that is providing 

the other Revit model to create specific views for you so that you can use these overrides to 

include annotation that otherwise would not be available. The new tagging features in Revit 

Architecture 2011 limit the necessity for this to some degree but not completely.

The next level you can descend to offers quite a bit more control but also represents 

much more effort to get what you want. When you click the Custom option, you’ll see 

all the settings exposed for your consideration (see Figure 5.62). If you examine the 

other tabs, such as Model, Annotation, and Imported Categories, you find that the 

Custom option changes each of them now too. This is the deepest level of control that 

you have now. When you choose Custom on each tab, you have access to each category 

in the linked project file, as if you were working within the file itself, at least as far as the 

Visibility/Graphics settings are concerned (see Figure 5.63).

Figure 5.61

Choosing a linked 
view to show

Figure 5.62

Choosing custom 
overrides for the 
Basics tab
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Ideally you will get what you need to see of an external file just by going to the trouble 

of linking it. If you need more control, Revit has it. It is there waiting for you to take 

advantage of it.

Worksets
We lied. We told you just a moment ago that you reached the deepest level of control for 

linked files. This release of Revit goes a bit deeper. Worksets are a feature that we will 

cover in Chapter 20, “Collaboration.” Suffice it to say for now that worksets are necessary 

when you want to work on the same project at the same time, sharing the same model 

data with other users. You may prefer to skip this section for now and come back later.

Linked Revit projects that are using worksets provide yet another option for taking 

control over their visibility. The Worksets tab in the Visibility/Graphics Overrides dialog 

box isn’t new, but it has a different approach in this release. When a workset is created, 

Revit offers a Visible In All Views option (see Figure 5.64). This is a time-saver when the 

elements you want to assign to this workset don’t need to be visible in many views but just 

in a few. It is less work to turn the workset on in a few views than to turn it off in many.

In the past, this feature negatively affected other projects that imported this project. 

The worksets that you chose not to make visible in all views caused them to be invisible 

in the host project. The only recourse was to reassign the elements to a new workset that 

is set to be visible in all views.

Figure 5.63

Choosing custom 
overrides for  

the Model  
Categories tab

Figure 5.64

Visible In All  
Views setting
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When you examine the dialog box, you’ll see that Revit provides three (new) options: 

Use Global Setting, Show, and Hide (see Figure 5.65). Use Global Setting means that it 

will work the way it did in the past: the Workset property for Visible In All Views takes 

precedence. Show and Hide override this setting in this view and do what they suggest, 

that is, show or hide the workset.

Thus far we are only discussing what affects the worksets of the host project. It is 

now possible to turn on and off worksets in a linked file on a view-by-view basis. When 

you reexamine the Visibility/Graphics Overrides dialog box and look at the Revit Links 

dialog box, you should see the Worksets tab (when the link uses worksets), as shown in 

Figure 5.66. When you have selected the Custom option on the Basics tab, you get the 

right to override the setting for worksets, which you can change to Custom too. Now you 

can turn on or off each workset listed.
Figure 5.65

New visibility 
options for worksets

Figure 5.66

Worksets tab avail-
able via the Revit 
Links dialog box





C hap te r 6

Introduction to Families

You have already  encountered families such as walls, doors, and win-

dows in the previous chapters. In fact, every element in Revit can also be referred to as 

a family. The founders chose the word family to describe the elements you use in Revit 

because it aptly applies to the relationships that each has in a building project as well as 

to each other. For example, a cabinet manufacturer offers various kinds of cabinets, and 

each has a range of sizes. You just need to exchange “kind of cabinets” with “family of 

cabinets” to see how well it works. Each size that is available is a child of the parent cabi-

net family. The family parent-child relationship is present in many of Revit’s features.

This chapter covers the following topics:

Understanding family organization■■

Working with families■■
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Understanding Family Organization
Everything you use in Revit is referred to as a family, so it is important to explain how 

Revit manages families and then makes them available to you. Fundamentally, families 

are divided into three functions: model, annotation, and datum. Beneath these functions, 

families are all expressed in a family tree structure consisting of category, family, type, 

and instance. Finally, you interact with families according to three concepts: system fam-

ily, loadable family, and in-place family.

Functions of Families
The following functions make up the grand scheme underlying Revit and its families. All 

projects are comprised of tasks that use each of them. What sets Revit apart from other 

applications is the way that it integrates the families between their unique functions: 

model, annotation, and datum (see Figure 6.1).

Model function Annotation
functions

Datum
function

Datum
function

Model  ​These families are usually three-dimensional and represent real objects in or on 

a building. They will appear in all model views of your project as well as being listed in 

schedules. Some easy examples are walls, floors, doors, windows, furniture, and roofs.

Annotation  ​These are families that do not have a three-dimensional purpose. They also 

do not appear in multiple views. They are intentionally limited to be visible only in a 

single view so you can add specific information to your documentation. Some examples 

for these are text, dimensions, symbols, tags, detail lines, and detail components.

Datum  ​This function is reserved for three items: levels, grids, and reference planes. These 

families straddle model and annotation functions because they have some capabilities 

of both. Datums appear in multiple views without extra intervention on your part. They 

also provide view-specific features that make it possible to format your documents well.

Figure 6.1

Examples of each 
function in a view
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There are model-to-model relationships such as a wall and door. There are model-to-

annotation relationships such as a door or wall and a related door or wall tag. Datum 

elements such as a level can revise an entire building’s floor elevation, moving everything 

associated with it at the same time as well as updating every view and sheet for the project. 

Dimensions can both display important information and allow you to change a family’s 

position in the model.

The Family Tree
Families are organized on four branches: category, family, type, and instance. Every family, 

at the uppermost branch, is assigned a category, such as doors. This Doors category, for 

example, deals with all the doors of a project. The next branch addresses the definition 

of a family in your project: the door, for example, is available for you to use. The third 

branch, type, transitions to inside the family and provides the list of its children (sizes  

or kinds).

The top three branches represent the idea or notion of a door (the door and its sizes 

are available), but the lowest branch—instance—represents the actual occurrence of a 

door when you place one in your project.

For many of the categories of families, you can see the top three branches expressed 

in the Project Browser and the lowest in the project’s views when you interact with the 

individual families you use (refer to Figure 6.2). The top three are also displayed for you 

in a tool tip (when your cursor is over a family and it is highlighted) and on the Status 

bar. The family your cursor is over represents the lowest branch, the instance. This orga-

nization is present for every family in your project whether it is a door, a wall, a view, a 

dimension, text, or a wall tag.

Classifying Families
Families are divided into three classes: system families (sometimes also called host 

families), loadable families (also known as components), and in-place families (refer to 

Figure 6.3). Each presents families to you differently, and each is different in how much 

work is required to create and use them.

Figure 6.2

Category (Doors), 
family (Single-
Flush), types, and 
instances in the 
Project Browser  
and a view
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System family (walls)

Loadable family
(component)

In-place family (wall)

It might be helpful if you think of system families as internal and you think of load-

able families as external with respect to the project environment. In-place families are a 

combination of system and loadable family capabilities.

System Families

System families are entirely defined by the Revit product developers. You only have the 

features and options that they designed into them. For example, walls can be a system 

family, and you can alter only the properties the walls family has provided. You cannot 

introduce new behavior to a wall, for example, or introduce a lean or angle property. The 

system family is not designed to lean; therefore, you can’t cause walls to lean with the 

available properties.

When you start a project, your template contains a collection of walls, as well as other 

system families. If you don’t find a wall family that you need, then you have to duplicate 

an existing wall to create a new version, as shown in 

Figure 6.4. You do this right in your project, which 

is why we suggested you think of them as having an 

internal relationship with your project. The more you 

anticipate what is needed and establish these system 

families in your office’s template, the quicker you can 

start your design.

Some system families are also called host families. 

The words system and host are often used interchange-

ably, which can be a bit confusing. The use of the 

term host is meant to explain that some families—

such as walls, floors, ceilings, and roofs—can hold other families, such as doors, win-

dows, and light fixtures (Figure 6.5). A hosted family cannot be placed in a project 

without its host. (A hosted family is always a loadable family, by the way.)

Figure 6.3

Examples of  
each class

Figure 6.4

Creating a new wall 
type by duplicating 

an existing one
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Stairs, railings, and ramps are 

also system families. Stairs and 

ramps can act as hosts for railings 

(see Figure 6.6), but they don’t host 

other families, such as doors or 

windows, because they don’t do so 

in actual buildings either. Hosting 

is meant to mimic real building 

element-to-element relationships. 

Not all system families are host 

families, such as railings. They are 

managed internally, in the project, 

but don’t provide hosting for other 

families.

In addition to the three classifi cations used for families (sys-

tem, loadable, and in-place), a fourth concept applies to them 

but is really a hybrid of system and loadable classes. There is no 

offi cial terminology used to describe them other than to call 

them system families too. In some families, a loadable family 

such as a profi le defi nes their shape or appearance, but system 

family behavior is designed into the software. You can control 

the shape or appearance but not what Revit lets you do with 

the family when you use them in your project. The level, grid, 

wall sweep, fl oor slab edge, repeating detail, and roof gutter are 

examples of this hybrid (see Figure 6.7).

Figure 6.5

Wall hosting a door 
and two lights

Figure 6.6

Sample railings 
“hosted” by stairs

managed internally, in the project, 

but don’t provide hosting for other 

families.

Figure 6.7

Wall sweep and roof 
gutter families

Figure 6.7

Wall sweep and roof 
gutter families
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Loadable Families

As mentioned earlier, loadable families (also called component families) can be thought 

of as external items, in other words, families that are added to your project from an 

external source. Doors, windows, casework, and furniture are all loadable families (see 

Figure 6.8). In a perfect world, all the families you need are already made; you just need 

to find them, add them to the project, and use them. The reality is that no matter how 

many families are provided by Autodesk or created by others, you will eventually need 

something that isn’t there.

Loadable families are built outside the project environment and use their own file 

format (.rfa/.rft) in a special mode of the Revit user interface called the Family Editor. 

Revit doesn’t display this title or inform you of this subtle change; it only offers the tools 

that are relevant for creating a family. As soon as you open a family file, you are using the 

Family Editor.

Remember that these families play into the model and annotation functional roles 

described earlier. Therefore, a door is a model family, while a door tag is an annotation 

family. Both are loadable families and are created in the Family Editor mode, but they 

play different roles. It is important to know that these families are restricted from using 

the same categories as system families.

In-Place Families

In-place families are built using all the same tools as loadable families except that you 

create them within the context of your project (internal vs. external). As we mentioned 

Figure 6.8

Doors and windows 
loadable families
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earlier, a wall (system) family cannot be induced to lean. We also just explained that 

loadable families are not allowed to use categories reserved for system families. This 

means you can’t build a leaning, loadable wall family, thus the in-place or “in-between” 

family. The in-place family doesn’t share this restriction, so you can build an in-place 

wall family that leans. It takes a bit more work than just sketching a wall with the Wall 

tool, but you have much more control over the outcome. The penalty for this flexibility is 

the singular, unique nature of the final result.

The in-place family is not intended to be used extensively or for many of the same 

items; it’s not for repetition. Using them too much or inappropriately is less efficient and 

takes more effort. Regardless, there are design features that cannot be created in any other 

way, so they exist to provide the flexibility you need to convey your ideas. Figure 6.9 shows 

an example of a Sprung roof structure (http://sprung.rtrk.com/). The system family roof 

tools don’t lend themselves to modeling this kind of structure. In fact, this type of struc-

ture is not just a roof or just a wall but acts as both by stretching a membrane over a skel-

eton frame. Judicious use of loadable families and in-place families provides a way to do a 

project that might, at first glance, be deemed not possible for Revit.

Working with Families
This section is dedicated to the routine interaction you will have with loadable families. 

Working with system families such as walls, floors, and roofs is covered in other chapters. 

It is possible to be quite productive with the concepts covered here long before you ever 

need to make or design a loadable family yourself. In fact, some people never need to cre-

ate a family from scratch because someone at their firm handles family creation and edit-

ing for everyone else. We will delve into designing and creating families in Chapter 17, 

“Creating Families.”

This section is devoted to finding, loading, placing, and replacing families (hosted and 

nonhosted); creating new types; and using type catalogs. We will also introduce you to 

nested families, shared families, and shared parameters. These are more advanced con-

cepts, but you should be aware of them as you start using families.

Figure 6.9

In-place Sprung 
roof design
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Finding and Loading a Family
Some stock families are provided with Revit; also, several websites are dedicated to peers 

sharing families and to product manufacturers providing families, and some companies 

create families as a (paid) service. You just need to make sure that a team has access 

to content and knows where to find it and, if necessary, how to acquire it. Your project 

template can simplify this process by having the content the team needs already loaded. 

When that’s impractical, then the process to load a family is easy enough to learn and 

remember.

Loading a family is easy; take these steps:

	 1.	 Go to the Insert tab on the ribbon, select the Load From Library panel, and click  

the Load Family button.

	 2.	 Browse to the Imperial or Metric library folders (or your own company library 

folder), and then choose the category you need, such as Doors.

	 3.	 Choose the family or families you need from those in the folder (press Ctrl to add 

individual files or Shift to select a group).

	 4.	 Click Open to add them to your project.

There are a few other ways to load a family. You can click Load Family when using the Com-

ponent tool, you can click the Load button when viewing the type properties of a family, or 

you can drag and drop a family from a folder view using Windows Explorer.

Placing a Loadable Family
Placing content varies according to the kind of family you are dealing with, but again, it 

is easy to learn and remember. 

Placing a family is easy:

	 1.	 Click the Place A Component button, which is the upper portion of the Component 

split button (on the Home tab’s Build panel); or click the specific buttons for Door, 

Window, or Column.

	 2.	 Choose the type from the Properties palette’s Type Selector.

	 3.	 Review the instance parameters in the Properties palette, and make any necessary 

changes.

	 4.	 Click in the drawing area (on a host family if required) to place the family.

There are other techniques to place a loadable family. You can drag and drop a family type 

from the Project Browser; you can right-click a family and choose Create Similar from the 

context menu; with a family selected, you can click Create Similar on the ribbon (on the 

Modify Context tab’s Create panel); or you can just use the Copy tool after selecting an exist-

ing family nearby.
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Replacing a Loadable Family
It is quite common to use a family as a placeholder during the conceptual and schematic 

design phases. A generic door or window is probably sufficient to convey your intentions 

during that time. Later you may need to replace these generic placeholder families with 

more accurate representations of products that have been selected. Fortunately, this is 

pretty easy too.

To replace one door family or type for another, take these steps:

	 1.	 Select the current family.

	 2.	 Choose a different family or type from the Type Selector (on the Properties palette).

	 3.	 Click Apply in the Properties palette.

You can do the same thing to replace many doors at once—just select multiple families 

in the same category in step 1.

You can replace every single occurrence of one type of family by using the Select All Instances 

In A View or Select All Instances In Project command on the context menu when you right-

click a family. Once you’ve selected one of those options, you can use the same steps listed 

earlier. You can also use the Match Type Properties tool on the Modify tab’s Clipboard panel.

Adding More Information to a Family
Sometimes you just need to add some missing information in an existing family. For 

example, you could decide that you want to include the manufacturer and model infor-

mation for the windows in your project. Revit has standard parameters for both of those. 

You might also choose to use a different identifying window type value in your window 

tags. A specific window might need a unique comment to warn the contractor that it has 

to meet emergency exit requirements. The first few changes affect a family’s type prop-

erties, while a single unique comment should apply to a specific window, not all, which 

means that it should be applied as an instance property.

To add manufacturer and model information to a window family, follow these steps:

	 1.	 Select the family.

	 2.	 In the Properties palette, click the Edit Type button.

	 3.	 Enter values for Manufacturer and Model.

	 4.	 Click OK, and then click OK again when prompted to apply to many families.

To add a unique comment to a window family, follow these steps:

	 1.	 Select the family.

	 2.	 Enter the information in the Comment parameter found in the Properties palette.

	 3.	 Click Apply.
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The most likely place to show the information for either of these examples is in a schedule. 

Part of Revit’s charm is that you can enter this information as described earlier in the schedule 

or in a tag if one is available in the view. Revit makes it easy to enter and keep these things 

coordinated.

Working with Hosted and Nonhosted Families
All model families are related to the levels of your project (think of the floors or stories of 

the building). When you place a family (a door, for example) in a plan view of the second 

floor of your project, it is associated with the level family that defines the second floor. You 

can see this parameter in the Properties palette when you select a family, such as a door.

In addition to this notion of being related to or associated with a level, a family can be 

hosted by a system family, such as a wall. When you click the Door or Window button 

on the Home tab, you are using a hosted family, and hosted families are intended to be 

hosted by wall families. They can’t exist without a host wall. These families are created in 

a template that contains a placeholder host wall. (We’ll cover creating families in Chapter 

17.) When you click the component button and place a chair family, you are using a fam-

ily that isn’t hosted. A chair family is assigned to the furniture category, and they are 

usually not hosted. They are associated with a level in the project, though. Like with the 

door mentioned previously, Revit will display the level the chair is associated with in the 

Properties palette.

Hosted families naturally need a host to exist first in order to place them. Families can 

also be hosted by the face or surface of various parts of the building model. This kind of 

family is referred to as face-based, and it is less particular about the kind of host you want 

to place the family on. It can be a wall, floor, top of a table, ceiling, underside of a steel 

beam, and more. You get three options for placing a face-based family: Place On Vertical 

Face, Place On Face, and Place On Work Plane.

Just to keep things interesting, each family category 

that isn’t a face-based family already can elect to be 

work-plane-based as an option (see Figure 6.10). As 

shown in Figure 6.11, when you see only two options on 

the ribbon’s Placement panel—Place On Face and Place 

On Work Plane—you are attempting to place a family that has the Work Plane-Based 

option selected. Just remember to examine the ribbon placement options that appear for 

each kind of family you use.

Figure 6.10

Work Plane- 
Based option

Figure 6.11

Placement cue on 
the ribbon: left, 

face-based; right, 
work-plane-based
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You do not have to choose to have your family hosted unless your family needs to cut 

or alter the host like the slab depression family shown in Figure 6.12. If the family has no 

actual relationship with a building other than with a specifi c host, then it makes some 

sense to make the family hosted by that host, like a wall.

Many objects in a building, such as a light switch, 

power receptacle, or thermostat, might 

normally be part of a wall, but even 

these items have been found on 

other surfaces than walls. 

For example, cabinetry 

might have receptacles or switches 

mounted on them. Therefore, choosing to 

make a light switch family wall-based might actually be 

a hindrance at some point in a project. A similar classic example is 

a ceiling fan. These are mounted to ceilings many times, but you’ll fi nd them attached to 

the underside of the fl oor structure above, beams, 

and other structural elements at times. 

Therefore, a ceiling-based ceiling fan 

will eventually be rather inconvenient 

(see Figure 6.13).

This is where the face-based tem-

plate becomes useful. This family has 

a host element, but it isn’t a wall, fl oor, 

ceiling, or roof. It is a “host” that can 

pretend to be whatever surface you 

want to believe it is. Revit is equally 

willing to believe that your family is as 

at home attached to the underside of a 

beam as to the top of a table.

You can create nonhosted families, and if you really need them to be hosted later, just 

nest them into a hosted template. It is much easier to do this than rebuild the family to not 

require a host.

Creating a New Family Type
Quite often a family is nearly suffi cient, but you just need a new type. For example, a 

stock Single-Flush door family has a 36˝ × 84˝ (900 × 2100 mm) as its largest type (size).

Figure 6.12

Floor-based slab 
depression family

Many objects in a building, such as a light switch, 

power receptacle, or thermostat, might 

normally be part of a wall, but even 

might have receptacles or switches 

mounted on them. Therefore, choosing to 

make a light switch family wall-based might actually be 

a hindrance at some point in a project. A similar classic example is 

Figure 6.12

Floor-based slab 
depression family

Figure 6.13

Face-based and 
ceiling-based 
ceiling fans
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These are the steps required to add a 42˝ wide (1050 mm) door type:

	 1.	 Select the family that should be the larger size in the drawing area.

	 2.	 Click the Edit Type button on the Properties palette.

	 3.	 Click the Duplicate button, and provide a new name, such as 42˝ × 84˝  

(1050 × 2100 mm).

	 4.	 Change the Width parameter to 42˝ (1050 mm); change the Height parameter if  

necessary.

	 5.	 Click OK to close the Type Properties dialog box. The selected family is now using 

the new size.

When you select the family type listed (right-click and then select Duplicate) in the 

Project Browser, you aren’t dealing with a specific occurrence of the family, so only the 

new type will be added without changing any families. This is a better way to create a new 

type when you don’t want to alter an existing family.

This is the same process you use to create a new wall family, so it applies equally well to sys-

tem families too. In fact, this process is used for nearly every kind of family in Revit. It should 

become second nature pretty quickly.

Updating the Family in Your Library
In the previous exercise, you created a new type in the family that is part of your project. 

The original family in the Revit library or your own office’s library has not been altered. 

This is both good and bad. It is good if the new type is a unique situation and not com-

monly used. In this case, it doesn’t need to be in the library version. It is bad when the 

opposite is true—that everyone else who encounters this family in their own projects will 

end up repeating the same steps to add a very common type. The responsible thing to do 

instead is to make the change to the library version of the family and load this updated 

version into your project. This gives you what you need for the short term but accommo-

dates the longer-term needs of your co-worker’s and the firm.

To update the family and load the new version, follow these steps:

	 1.	 Select the family, and click the Edit Family button (on the Modify tab’s Mode panel).

	 2.	 Click the Family Types button (on the Home tab’s Properties panel).

	 3.	 Click the New button, and provide a new name for the type.

Be judicious when naming families and their types. Erratic naming habits will affect their useful-

ness in schedules. Other people who use the families where you’ve added new types will also 

find any naming inconsistency frustrating. We won’t presume to tell you exactly how to name 

your families, but we do encourage you to consider your process and create consistent habits 

that make everyone’s interaction with your family library as good an experience as possible.
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	 4.	 Edit the parameters to reflect the new type size or information needed, and then 

click OK.

	 5.	 Click the Save button on the Quick Access toolbar. If this is the stock content or a 

protected folder, Revit will prompt you for a new filename. This means you need  

special permission to modify the library of families available to you. Save the new 

version elsewhere if necessary, and have someone with the necessary permission put 

the new file in the folder for you later.

	 6.	 Click Load Into Project (on the Home tab’s Family Editor panel).

	 7.	 Place or replace the family as required.

You can also edit a family by using the context menu (right-click) and choosing Edit Family. 

Remember, it is better to open the file separately from the project, make the changes, and 

save the file. Later when you are back in the project, you can load the family.

Placing Loadable Families That Use Type Catalogs
A type catalog is used to create a list of all the parameters for each family type, and the 

information is saved in a separate text file (.txt). It is intended to provide an easier 

way to deal with families that have many types. Most families have a modest number of 

types, such as the Single Flush.rfa door family that has seven types (sizes). When a family 

can represent many more different types (think sizes or configurations), it often makes 

more sense to use a type catalog. Many of the structural framing families, such as W-Wide 

Flange.rfa, use a type catalog to make it more practical to load just the types your project 

actually needs.

When you load a family that uses a type catalog, Revit will open the Specify Types  

dialog box (refer to Figure 6.14). Take these steps to select types and load the family:

	 1.	 Select the type(s) you need. When you choose more than one family that has a type 

catalog, you will see a list of each selected family on the left side of the dialog box. 

Press Shift+click to select a group; press Ctrl+click to select various individual types.

	 2.	 It is possible to filter the listed types by clicking the small drop-down arrow in the 

heading of a column.

	 3.	 Click OK after all the types 

are selected.

Figure 6.14

Type catalog sample 
with multiple fami-
lies selected
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Take these steps to place the family:

	 1.	 Choose the Component tool or one of the specific component tools like Door or 

Window.

	 2.	 Select the type you need, and notice that only the types (sizes) you chose previously 

are listed, not all the types that were visible in the Specify Type dialog box.

	 3.	 Click in the drawing area to place the family.

Encountering Advanced Features
You will run into a few features as you work with families that are worth explaining. 

We’ll explain how you create a family that uses them in Chapter 17. For now, we’ll limit 

the discussion to just what you need to know about them or should expect from them as 

you find, load, place, edit, and replace families.

Nested Families

You have nested drawings in CAD all the time, except they’re called referencing or exter-

nal references (Xref) in Revit. You can create families as a “kit-of-parts” so you can mini-

mize or eliminate redundant tasks and reuse these parts effectively (see Figure 6.15).

A well-made family that uses a nested family or families will not be all that noticeable 

unless you attempt to create a new type or take a closer look at the family by opening it. 

The doors pictured in Figure 6.15 consist of panel families that you can exchange for one 

another by changing one parameter. If you examine the properties of a family closely and 

you see a parameter that has what looks like another family name listed, then you are see-

ing a nested family in use.

Several stock families use a nested family or families, such as DLH-Series Bar Joist.rfa 

(structural framing folder), Alternating Tread Device.rfa (specialty equipment folder), 

and Outlet Duplex.rfa (electrical fixtures folder). The first two use them to allow for vari-

able length/height families by creating an array of a nested family. The outlet family uses 

a nested annotation family to represent the symbol graphics you see in a plan view.

To take a closer look at the DLH-Series Bar Joist family, follow these steps:

	 1.	 Click the application menu, select Open, and navigate to Imperial Library/Structural/ 

Framing/Steel.

	 2.	 Choose the file DLH-Series Bar Joist.rfa.

Figure 6.15

Door panel  
“kit-of-parts”
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	 3.	 Expand the Families branch of the Project Browser, expand the Structural Framing 

branch, and expand the Angle Web branch.

	 4.	 Select the type Angled-Web, right-click, and choose Select All Instances ➔ Visible In 

View. The elements that are highlighted in the drawing area are the nested families.

	 5.	 If desired, repeat steps 3 and 4 for each of the other two Structural Framing families 

listed in the Project Browser.

	 6.	 Close the file without saving changes when you are finished.

If you take the steps listed earlier in this section to create a new type in a family and 

you get errors that you don’t understand, it is possible that you have encountered a family 

that uses a nested family, and it isn’t prepared sufficiently to provide the change you need. 

The concepts covered in Chapter 17 should help prepare you for such a situation.

Shared Families

When a family is nested and its host is loaded into a project, Revit loads only enough of 

the nested family to be able to display it—a symbol of it, not the real family. As a result, it 

does not appear in the Project Browser under the Families branch. It doesn’t really exist 

in the project even though you can see it.

When the nested family is shared, then Revit loads it into the project in addition to 

its host family. As a result, this family is listed in the Project Browser under the Families 

branch. This means you can place the nested family alone as well as have it appear 

whenever its host family is placed. More importantly, since the actual family is loaded, it 

becomes possible to schedule the nested family as if it were an individual apart from its 

host. Numerous interesting possibilities are available to you as a result.

For example, a schedule can report how many cabinets you have in a project. Using 

shared families Revit can now also provide a schedule of cabinet doors and hardware. 

This might be an extreme example, but it could be quite effective for a firm that could use 

this level of detail.

There are not many examples of these in the stock library, but you can examine one 

more closely. To see an example of a shared family, take these steps:

	 1.	 Click the application menu, select Open, and navigate to Imperial Library/Casework/

Domestic Kitchen.

	 2.	 Choose the family Counter Top-L Shaped w Sink.rfa, and click Open.

	 3.	 Select the sink that is visible in the drawing area; notice that it is a family and its type 

(Sink Kitchen-Double 42˝ × 21˝) is displayed in the Type Selector of the Properties 

palette.

	 4.	 With the sink selected, click the Edit Family button on the Modify tab’s Mode 

panel. Revit opens the sink family (you are now two family files deep into the  

Family Editor mode).
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	 5.	 Click the Family Category And Parameters button on the Home tab’s Properties 

panel. You should find that the shared parameter in the Family Parameters frame  

is selected. Also notice that the assigned family category is Plumbing Fixtures.

	 6.	 Close each family file without saving any changes.

This setting means that the sink can be scheduled separately as a plumbing fixture 

even though it is part of the countertop family. The counter can be scheduled too, but 

because the sink belongs to a different category, it won’t be part of the casework schedule.

Shared Parameters

Parameters exist for every family in Revit. Some are created by the software developers 

and designed to work without any extra effort on your part. Others are created by you as 

you develop or modify content. Parameters are part of projects and families. You can cre-

ate project parameters that are assigned to specific categories. These project parameters 

can be included in schedules and are an elegant way to include important information 

that applies to many families of one or more categories but that doesn’t actually alter the 

physical family itself (think “information only”).

When you create families, you can define more parameters than what you find in each 

template. Many of these are just family parameters that only have the role inside the fam-

ily to determine how big or small it should be 

and what should be visible. These parameters 

are available to you in the project, but you 

can’t schedule them or display their values in 

tags. When you need to do either, you need to plan for shared parameters (Figure 6.16).

Think of a shared parameter file as a dictionary (see Figure 6.17). It contains defini-

tions that you can make available to projects and families as you work in either environ-

ment. When you want a parameter to both change the physical nature of a family and 

schedule it or tag it, you just need to create the shared parameter and 

assign it in the family. When you get back to your project, you add the 

same shared parameter to the project. This common definition helps 

Revit understand that the information we enter in a family and in 

projects are really to be the same information.

If you are going to be the go-to person for Revit families, then 

you’ll want to become familiar with shared parameters. You’ll also 

want to read Chapter 17 as well as get hold of the Revit Family Style 

Guide mentioned in that chapter.

Figure 6.16

Shared Parameters 
button on the  

Manage tab

Figure 6.17

Selecting a shared 
parameter
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Massing

Three-dimensional  modeling tools have many uses within a build-

ing project. Two types of modeling tools are available in Revit Architecture. The solid 

modeling tools are covered in Chapter 6, “Introduction to Families,” and this chapter 

concentrates on the tools used to create conceptual building models for design analysis 

and spatial planning. The specific need and family type chosen will determine which set 

of tools is available for use.

This chapter explores these topics:

Mass objects ■■

References and work planes■■

In-place mass families■■

Preparing to create mass forms■■

Building mass forms■■

Editing forms■■

Loadable mass families■■

Face-based modeling■■

Creating mass families from imported geometry■■
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Mass Objects
The mass object category within Revit has unique capabilities that differ from other cate-

gories and types of three-dimensional elements. Mass objects are used to define the shape 

and geometric design of the building. Once a building shape is modeled using a mass 

object, area and volumetric calculations can be automatically calculated and reported. 

If desired, walls, floors, roofs, and curtain systems can also be created directly from the 

faces of the mass object for conceptual design exploration. These models help you quickly 

visualize the building shape, compare floor areas, and add exterior finishes generated 

directly from the faces of the mass.

You can take two approaches when creating mass objects. The first is to create the 

mass object as an in-place family within a project. This type of mass is used for creating 

elements that are unique within a project, that access other project geometry directly, and 

that occur only once in the project. The second approach is to create a loadable, or exter-

nal, mass family that is then loaded into a project and placed as needed, once or multiple 

times. Any edits to the mass family will then be applied to all instances of that mass fam-

ily when the family is reloaded.

Table 7.1 defines some key terms you’ll need to know to learn about massing.

T e r m D e s c r i p ti  o n

Massing The process of visualizing, studying, and resolving building forms 
using mass instances. 

Mass family A family of shapes, belonging to the mass category. An in-place mass 
is saved with the project; it is not a separate file. 

Mass instance or mass An instance of a loaded mass family or an in-place mass. 

Conceptual design  
environment

A type of Family Editor that creates conceptual designs using in-place 
and loadable family mass elements.

Mass form The overall form of each mass family or in-place mass.

Massing study A study of one or more building forms made from one or more mass 
instances. 

Mass face A surface on a mass instance that can be used to create a building  
element, such as a wall or roof.

Mass floor A horizontal slice through a mass at a defined level. Mass floors pro-
vide geometric information about the dimensions of the mass above 
the slice, up to the next slice or the top of the mass.

Building elements Walls, roofs, floors, and curtain systems that can be created from  
mass faces. 

Cross section shapes Cross section shapes represent slices through the objects that are 
being modeled and are used to create  forms. Shapes can be open or 
closed. A closed shape consists of a continuous series of lines, arcs, 
and so on that returns to the original starting point. A closed shape 
cannot overlap, cross, or intersect itself. An open shape is a series of 
continuous lines, arcs, and so on that does not return to the original 
starting point. An open shape may intersect or cross over itself and 
will still be a valid shape to create a form. Cross section shapes are 
also referred to as profiles, curves, and shapes.

Table 7.1

Massing Glossary
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Visibility and Display
Mass elements are not visible by default in the project environment. Activate the Show Mass 

tool on the Conceptual Mass panel on the Massing & Site tab (Figure 7.1). The tool will 

have a white background when it is off (disabled) and a blue background when it is on 

(enabled).

The Show Mass tool is a project setting that will show all mass objects in all project 

views. This display mode is used for creating and editing mass objects as well as model-

ing building elements from the faces of the mass object. Mass objects will not print even 

though they are visible on the screen.

To enable the visibility of mass objects 

per view and also allow them to print, use 

the Visibility/Graphics Overrides window to 

modify the visibility and graphic settings of the 

view. Open the Visibility/Graphics Overrides 

dialog by selecting the Edit button, as shown in 

Figure 7.2. This setting makes the mass objects 

visible in a single view and overrides the Show 

Mass tool.

Select the check box beside the Mass category to turn on the 

visibility of mass elements and their associated subcategory 

elements, as shown in Figure 7.2.

The default material for Mass objects is named Default 

Form, as shown in Figure 7.3. This is the material assigned to the mass object category in 

the Object Styles setting on the Manage tab; this material will automatically be assigned 

using the <By Category> setting. Other materials can be assigned to the mass object in 

the Properties palette while creating, or later while editing, the mass object.

Figure 7.1

Show Mass enabled

Figure 7.2

Edit Visibility/
Graphics Overrides

Figure 7.3

Materials dialog box
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To change the material assigned to a mass object, select the mass object, and click the 

<By Category> material parameter setting in the Properties palette, as shown in Figure 7.4; 

then click the ellipsis �button that appears at the right end of the slot. Select a different 

material from the material window, and click OK to 

complete the material change.

In-Place Mass
In-place mass families are used when creating objects that are unique to the project and 

will be used only once. Examples include an overall building mass model or unique 

building element. If a mass family is to be repeated multiple times in a project, for exam-

ple, a tower feature or silo, then creating a mass family outside of the project and loading 

the family into the project is the preferred method. This will help reduce file size and 

simplify the updating of the families.

To explore the menu and tools available for creating solid and void forms, start the 

In-Place Mass tool from the Conceptual Mass panel on the Massing & Site tab; once the 

tool is activated, you will be prompted to provide a name for the mass object. Click OK 

after you have typed a name.

Note that if Show Mass mode has not been enabled prior to starting the In-Place 

Mass tool, an alert message will be displayed informing you that Show Mass mode has 

been enabled. Select Close to dismiss the alert; if you want, select Do Not Show Me This 

Message Again before selecting Close to permanently disable the alert.

Assigning a logical name for mass objects will enable easier selection later in the project. 

With a logical name, you will be able to easily locate the mass in the Project Browser families 

section listing by name.

Once you select OK in the Name dialog box, you are working in the mass Family 

Editor environment. The Home tab and associated panels are shown in Figure 7.5.

Mass objects are created by drawing cross section shapes using model lines and/or  

reference lines and then creating forms from those objects. Additional tools used for  

creating and controlling forms are reference planes and reference points. The Draw  

panel contains the tools used for creating the base elements of forms.

Figure 7.4

Materials instance 
parameter

Figure 7.5

In-Place Editor 
Home tab
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The forms can be categorized into five basic types, listed here and demonstrated in 

Figure 7.6:

Surface forms•	

Extrusions•	

Lofts•	

Revolves•	

Sweeps•	

These forms can be mod-

eled as solids or voids. Solids 

are additive to the model, and 

voids are subtractive. Mass 

models can be assembled 

using multiple form types 

using combinations of solid 

forms and void forms. The 

in-place mass objects created 

later in this chapter are sepa-

rate in-place families, but they 

could have all been combined 

into one. Creating the mass objects as separate in-place families may allow for a simpli-

fied creation process but limits interaction between the objects and requires the mainte-

nance of multiple families.

To close the In-Place Editor, select Cancel Mass from the In-Place Editor panel. Note 

if you tried creating cross section shapes or forms, you will receive a warning alerting you 

that you may be discarding elements; click Yes to cancel (Figure 7.7).

References and Work Planes
References and work planes are the planes that model elements and objects are created 

on. Objects in Revit are sketched or modeled on work planes, which control their place-

ment and location. Understanding how to create references and how they can be used to 

control the model elements is critical to using Revit efficiently.

Figure 7.6

Five types of mass 
object forms

Surface forms

Extrusions

Revolves Sweeps

Lofts

Figure 7.7

Warning message: 
click Yes to cancel 
your mass.
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Reference Planes
Reference planes are infinite flat planes created by drawing two pick points. They are used 

to align and locate separate elements of a model or to control the location of model elements 

using parameter-driven dimensions. Reference planes have the following characteristics:

Can be created in the project file and used to control numerous separate objects in •	

the project.

Can be created within families for controlling or aligning objects modeled within •	

the family.

Can be used for dimensioning within the family or outside of the family directly in •	

the project. This is true whether the reference plane was created inside the family or 

directly in the project.

Can be named in the Properties palette once the reference plane is selected. This pro-•	

vides easier management and allows them to be selected from a name list and used 

for alignment when creating elevations.

To create a reference plane, select Plane from the Draw panel, select the Line tool as 

shown in Figure 7.8, and then pick a start point and an end point to create the reference 

plane. You have two options when creating reference 

planes, which will allow you to draw the lines or pick 

lines, which allows you to select the edges of existing 

model objects and linework.

Reference Lines
Reference lines are used to control geometry or sketch elements in multiple types of fami-

lies, including loadable mass families and in-place mass families. For mass forms, they 

can also be used as cross section shapes, curves, or paths for sweeps. The use of reference 

lines as paths and shapes is particularly valuable because they create their own perpen-

dicular reference planes on which curves and shapes can be sketched. Reference lines 

have the following characteristics:

Have a start point that can be used as their center of rotation when being controlled •	

by an angular parameter.

Are visible in 3D views.•	

Can be linear shapes, such as lines, rectangles, and polygons. These create four work •	

planes per segment on which to draw elements and perform modeling.

Can be curved, including splines. These create work planes perpendicular to the start •	

and end of the shape (as shown in Figure 7.9).

Can be used as cross section shapes directly to create forms or can be used as a path •	

for swept forms.

May be created in any family.•	

Figure 7.8

Draw panel’s  
Line tool
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To create a reference line, select the Reference but-

ton on the Draw panel (Figure 7.10), and select a shape 

to draw. Any shape in the Draw panel may be used to 

create a reference line or multiple reference lines at 

one time.

Reference Points
Reference points are used to define coordinates in three-dimensional work spaces, to 

define specific points along a shape, and to control geometry. There are three types of  

reference points: free, hosted, and driving.

Free   P oints   

Created based on a work plane and maintain an association with the work plane. •	

Free points can be moved in three axes: x, y, and z. If the work plane is moved, the 

points will maintain their offset from the work plane.

Are visible in 3D views.•	

Available for use for mass families, both in-place and loadable.•	

H osted    P oints   

Can be placed on existing lines, arcs, ellipses, splines, or surfaces.•	

Appear visually smaller than free or driving points.•	

Are added to an existing object.•	

Figure 7.9

Reference lines 
showing work 
planes

Figure 7.10

Draw panel’s  
Reference tool
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Will move with their host surface.•	

Will move along a spline or line.•	

Create three planes for drawing or modeling. The planes define a local XYZ system •	

with one of the planes perpendicular to the line or spline host or in the case of a sur-

face parallel to that surface.

D riving      P oints   

Used to create surfaces or linework by picking on the preexisting points.•	

Become part of the form they are used to create.•	

Can be edited to manipulate the form after creation or the spline created using the •	

Spline Through Points tool.

Can be created and selected prior to starting the Spline Through Points tool to auto-•	

mate the creation of the spline.

To create a reference point, select the Point tool on 

the Draw panel (Figure 7.11); a reference point will be 

created by default based on the conditions outlined 

previously.

Setting and Showing the Active Work Plane
Once references have been created, a work plane of the reference needs to be set active in 

order to sketch or model on that work plane. The Set tool in the Work Plane panel on the 

Home tab will allow you to set a work plane as active by one of three methods:

By name from a drop-down list•	

By picking a work plane•	

By selecting an existing model line and setting the work plane it was created on active•	

If you select a work plane that is perpendicular to your current view, Revit will open the Go 

To View dialog box, which will show a list of views parallel to the selected work plane in the 

upper portion and a list of 3D views in the lower portion. This will happen immediately when 

you are using either the “pick a plane” or “pick a line” method; when the Name list is used to 

select a work plane, the dialog box opens after you select OK.

Choose a plane by name  ​The Name drop-down list will contain the following:

All project levels (both story and nonstory levels)•	

Grid lines•	

Named reference planes•	

Figure 7.11

Draw panel’s  
Reference Point tool
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Pick a plane  ​User selects a reference plane, reference line, reference point, or face of exist-

ing model element to set that work plane active. When selecting elements with multiple 

work planes, such as reference lines or reference points, hovering over the element and 

pressing the Tab key will cycle through 

the available work plane. Once the desired 

work plane is highlighted, left pick to make 

that work plane active. See Figure 7.12.

Pick a line and choose the work plane it  

was sketched in  ​Model lines record the 

work plane that was active when the line 

was created. This option allows the user to 

pick a model line and set that work plane 

active.

Work planes can also be set using the placement plane drop-down list on the Options 

bar when you are sketching cross section profiles.

In the Work Plane panel, the Show tool will toggle the visibility of the active work 

plane in the current view.

Preparing to Create Mass Forms
Here we will create a new project and add levels and reference planes to the project. This 

new project will be used to create mass forms using the Extrusion, Loft, Revolve, Sweep, 

Surface, and Void form tools. The steps outlined for creating the forms will allow you to 

create mass form models for building design and analysis.

Save your changes to any open files prior to starting the new project.

	 1.	 From the application menu, select New to begin a new project. The default template 

and template location for Revit Architecture is as follows:

C:\ProgramData\Autodesk\RAC 2011\Imperial Templates\default.rte

If this is the template listed in the template file list, click OK. This creates a new proj-

ect and opens with the Level 1 view active.

	 2.	 Open an Elevation view of the project; there are two levels already created. Change 

the height of Level 2 to 16 ,́ and add five additional levels above the existing two. The 

heights and names of the levels will be as follows:

Level 7 266´
Level 6 214´
Level 5 162´
Level 4 110´
Level 3 58´

Figure 7.12

Reference line 
planes

Horizontal work plane Vertical work plane End work plane
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You will use these levels in the later portions of this chapter.

The mass model you are building in this exercise will be composed of multiple sepa-

rate in-place family elements, and you will use reference planes to maintain the coor-

dinated center point of the model.

	 3.	 Double-click the Level 1 view in the Project Browser to make it the active view.

	 4.	 Choose the Ref Plane tool from the Home tab, and then use the Line tool from the 

Draw panel (Figure 7.13). Draw two reference planes, one horizontal and one verti-

cal, as shown in Figure 7.14. Once you have completed the two reference planes, 

click Modify at the left end of the ribbon, or click the Escape key twice to return to 

Modify mode.

	 5.	 Select the vertical reference plane, and in the Properties palette, fill in a name for the 

reference plane using Building Center Left/Right for the name property. Select the 

horizontal reference plane, and repeat the step, naming this reference plane Build-

ing Center Top/Bottom. (Note the names will appear on the screen only when the 

reference plane is selected or highlighted, as in Figure 7.15.) The intersection of these 

planes will be used as the center point of the building mass object.

Figure 7.13

Reference  
Plane tool

Figure 7.14

Creating reference planes

Figure 7.15

Named reference plane
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Building an Extrusion Form
Extrusion forms are created by defining a closed cross section profile using model lines 

or reference lines and then creating a form from those closed shapes. There are numerous 

common instances of objects most easily modeled using the extrude form. Glazing panels, 

circular pedestals, and water heaters would be just a few examples.

	 1.	 Start the In-Place Mass tool from the Conceptual Mass panel on the Massing & Site 

tab; once the tool is activated, you will be prompted to provide a name for the mass 

object. Name it Main Building Form, and then click OK.

	 2.	 Double-click the Floor Plan Level 1 view in the Project Browser to make it the 

active view.

	 3.	 Select Model Line from the Draw panel, and then select the Circle shape; leave the 

Make Surface From Closed Loops check box on the Options bar empty (Figure 7.16). 

Create a circle centered at the intersection of the crosshairs with a radius of 52 .́ Once 

the circle profile is created, click Modify on the ribbon to exit the Model Line tool.

	 4.	 Change to the Default 3D view by selecting the Default 3D view button from the 

Quick Access toolbar, use Zoom Extents (ZE) if you do not see the circle, and then 

select the circle (Figure 7.17).

	 5.	 From the Form panel in the ribbon, click the Create Form tool. At the bottom center 

of the screen, you will see two buttons (Figure 7.18). The button on the left will cre-

ate a cylindrical form from the circle profile, and the button on the right will create a 

spherical form from the circle. Click the cylindrical form button.

	 6.	 Double-click the South Elevation view to make that the active view. Use the Align 

tool from the Modify panel to align and lock the top of the extrusion form to Level 2 

(Figure 7.19). By locking the top of the form to Level 2, the height of the form will 

Figure 7.16

Options bar

Figure 7.17

Circle cross section 
selected
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automatically change to match any height changes made to the level. The bottom 

of the form will automatically be locked to Level 1 because that was the active work 

plane that the profile was created on.

	 7.	 Choose Finish Mass from the In-Place Editor panel. This finishes this editing session 

for this mass object. To save the project file, you must exit in-place editing by either 

selecting Finish Mass, which will save changes to the mass, or selecting Cancel Mass, 

which will discard any changes made to the mass object during that editing session.

	 8.	 This completes the extrusion form. The steps that follow will build on this extrusion 

exercise. Save the file as Extrusion Form.rvt for use in the following exercise.

Figure 7.18

Cylindrical form 
button and result

Figure 7.19

The original form 
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aligned and locked
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Building a Loft Form
Similar to the extrusion form, a loft form begins by drawing a closed cross section profile 

on the desired level or reference plane. Examples of common loft objects would be taper-

ing furniture legs, twisting building forms, and many columns. Unlike the extrusion 

form, a loft form can use multiple cross section profiles and will interpolate the loft form 

surfaces between the different shape profiles. The shape profiles are created at the desired 

distances along the loft form. Shape profiles can be any closed shapes, but more than one 

profile cannot exist at the same distance along the length or height of the loft. The loft 

shown in Figure 7.20 is formed using three circles all created at different levels. The cross 

section shape profile shown in Figure 7.21 has two circles drawn at the midlevel and can-

not be used to form a loft.

Cross section profiles can be created on project levels, on reference planes, or on refer-

ence lines. The loft created will be perpendicular to the reference selected or on the face 

of existing model geometry, such as walls, and so on, where the loft will also be perpen-

dicular to the face selected.
Figure 7.20

Good loft cross  
section shapes

Figure 7.21
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We will use the levels created in the previous exercise to place the cross section shapes 

for a loft form. Continue working in the Extrusion Form.rvt file saved previously, or 

reopen the file to continue.

	 1.	 Double-click Floor Plan Level 5 to make it 

the active view, and then from the Mass-

ing & Site tab, select In-Place Mass on the 

Conceptual Mass panel. Name the mass 

Loft Tower. The reference planes that were 

placed in the project earlier are visible 

and can be used to ensure alignment with 

other objects.

To view the extrusion created previously, 

ensure that the current view name, Floor 

Plan: Level 2, is listed in the Properties pal-

ette; then click in the Edit column beside Underlay, 

and select Level 1 (Figure 7.22).

	 2.	 From the Draw panel, select Model, and then select 

the Rectangle tool. You may select the rectangle, 

or any other shape, first, which will also create a 

model line. Verify that the desired level, Level 2, is 

listed on the Options bar in the Placement Plane drop-

down list (Figure 7.23).

	 3.	 Create a rectangular cross section profile that is 36´ square, as shown in Figure 7.24. 

The lower-right corner of the rectangle will be at the intersection of the reference 

planes.

	 4.	 Create the following cross section shapes on the level listed.

The upper-left corner of the square shape will remain a consistent point for all cross 

section shapes. This is the corner shown highlighted in Figure 7.25. Dimensions are 

Figure 7.22

Floor Plan Properties palette

Figure 7.23

Options bar’s Placement Plane list

Figure 7.24

A rectangle size  
and location
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shown for reference, but there is no need to dimension the shapes; their sizes are  

as follows:

Level 4: 36´ •	 × 36´

Level 5: 32´ •	 × 32´

Level 6: 28´ •	 × 28 ,́ with angled corner

Level 7: 24´ •	 × 24 ,́ with angled corner

	 5.	 Once you have sketched all the cross section shapes, click the default 3D View tool on 

the Quick Access toolbar to activate the default 3D view.

Floor Plan Level 4 Floor Plan Level 5

Floor Plan Level 6 Floor Plan Level 7

Figure 7.25

Cross section 
shapes
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	 6.	 Select the five shapes (Figure 7.26), verify that you’ve selected all segments of the 

shapes, and then choose Create Form from the Form panel. You can Ctrl-click or  

use a window or crossing window to select the shapes.

	 7.	 Choose Finish Mass from the In-Place Editor panel to complete the loft form  

(Figure 7.27).

	 8.	 From the application menu, use the Save As command to save a copy of the file 

named Loft Form.rvt.

Building a Revolve Form
Revolve forms are created by turning a cross section shape around a single center line ele-

ment. Examples would be turned handrail balusters, vases, and donut shapes. Both the 

shape and the center line element must be drawn on the same work plane. The cross sec-

tion shapes can be closed or open shapes (if shape is open, a surface form will be created), 

and the line element can be a model line or a reference line. When using a reference line, 

the line will remain in the mass family for future use. If a model line is used as the center 

point, it will be discarded once the revolve form is created.

Figure 7.26

Cross section 
shapes selected

Figure 7.27

Completed loft form
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The centerline element will not be part of the revolve form 

regardless of which type of line is created. If two line elements 

are selected, the first line element created will be the default 

center line. There will be up to three options available using 

the on-screen buttons: default centerline, switch centerline, 

and create surface. The number of options available will vary 

depending on the shapes selected. Selecting two open shapes 

will provide more options than a line and a closed shape. 

When option buttons are displayed on screen, select the 

desired option or cycle through the options by pressing the 

spacebar.

Let’s create a revolve form that fills the open space between 

the previously modeled extrusion and loft forms. Continue 

working in the Loft Form.rvt file saved previously, or reopen 

the file to continue.

	 1.	 Double-click the South Elevation view in the Project  

Browser to make it the current view, as shown in Figure 7.28.

	 2.	 Select the In-Place Mass tool to begin a new Mass object. Name the mass Meeting Areas.

	 3.	 Choose Set from the Work Plane panel, and select Reference Plane: Building Center 

Top/Bottom from the Name drop-down (Figure 7.29). Click OK.

	 4.	 Using Model Line from the Draw panel, sketch a closed cross section shape similar to 

what is shown. Then select Reference and then Line to draw a vertical reference line. 

Both are shown in Figure 7.30.

	 5.	 Select both the closed cross section shape and the reference line, and then choose 

Create Form. Click the default 3D View tool on the QAT (Quick Access Toolbar).  

The closed shape is turned around the reference line to build a 360-degree shape.

Figure 7.28

South  
Elevation view

Figure 7.29

Work Plane dialog box
Figure 7.30

Cross section shape and reference line
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 6. Select Finish Mass from the In-Place Editor panel to complete the revolve form 

(Figure 7.31).

 7. From the application menu, use the Save As command to save a copy of the file 

named Revolve Form.rvt.

Building a Sweep Form
Sweep forms, like the one in Figure 7.32, are created when a cross section shape, or multiple 

shapes, is extruded along a path. Building-related examples commonly modeled include 

most moldings applied in a building, handrails, and hoses. The sketching method for both 

the cross section shape and the path affect whether the sweep form will be created.

Here are your options when modeling a sweep form:

Cross section shapes can be either open or closed.•	

Cross section shapes must be created perpendicular to the seg-•	

ment of the path that they are sketched on.

Paths can be single segmented or multisegmented.•	

Paths may be closed when •	

sweeping a closed cross 

section shape.

Open shapes can be swept •	

only along single segment 

paths.

Multiple cross section shapes can be swept along single segment paths.•	

A sweep form will be used to create an equipment screen element on the roof of the 

loft form previously modeled. Continue working in the Revolve Form.rvt fi le saved previ-

ously, or reopen the fi le to continue.

 1. Double-click the Floor Plan Level 7 view to make it the current view. Click the In-

Place Mass tool, and name the new mass Screen. Click Reference and then Line from 

the Draw panel. Sketch a chain of reference planes, as shown in Figure 7.33. The 

Figure 7.31

Finished 
revolve form

Figure 7.32

Sample sweep form

Here are your options when modeling a sweep form:

Cross section shapes can be either open or closed.

Cross section shapes must be created perpendicular to the seg-

ment of the path that they are sketched on.

Paths can be single segmented or multisegmented.
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reference planes shown are offset from the edge of the Loft Tower mass by a distance  

of 1´-0 ;̋ the exact distance does not matter.

	 2.	 Using the Point tool from the Draw panel, place a point at the midpoint of the left-

side vertical reference line segment, as shown in Figure 7.34.

	 3.	 Click the default 3D view on the QAT, and adjust your point of view close to what is 

shown in Figure 7.35. Select Set from the Work Plane panel, and hover over the refer-

ence point. Press Tab, if necessary, until the reference plane that is perpendicular to the 

reference line highlights, and then left pick. Use the Model Line tool to create a cross 

section shape similar to the shape shown in Figure 7.36. The shape is roughly 3´-0˝ tall.

Figure 7.33

Chain of reference lines

Figure 7.34

Reference point added to sketch

Figure 7.35

Work plane highlighted

Figure 7.36

Cross section shape
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	 4.	 Select the closed cross section shape and the path of reference line segments, and 

then choose Create Form. Select Finish Mass to complete the sweep form.

	 5.	 From the application menu, use the Save As command to save a copy of the file 

named Sweep Form.rvt.

Building a Surface Form
Surface forms are created from closed or open shapes and have no thickness. Unlike other 

forms, the shapes used to create the form can be on the same level or work plane or on 

different work planes. When sketching a shape for a surface form, selecting the Make 

Surface From Closed Loops check box on the Options bar will automatically create a sur-

face form when you finish sketching a closed shape. Common examples of surface forms 

would be hanging fabrics, screen walls, and free-form curving panels.

A surface form will be used to create a privacy screen element on Level 3. This sur-

face form will appear on the top surface of the revolve form created in the earlier exer-

cise. Continue working in the Sweep Form.rvt file saved previously, or reopen the file to 

continue.

	 1.	 Double-click the Floor Plan Level 3 view to make it the current view. Select the  

In-Place Mass tool once again, and name this Mass Privacy Screen. Sketch a Model 

Line arc similar to what is shown in Figure 7.37.

	 2.	 Use the Center – Ends Arc tool, and initially draw the arc only to an angle of  

180 degrees. Then click Modify to activate Modify mode, and drag the ends of the 

arc to meet the Tower Loft. Select the arc, and choose Create Form.

Figure 7.37

Surface model  
line curve
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	 3.	 Double-click the South Elevation view to make it the current view, and select Finish 

Mass from the In-Place Editor panel to finish the surface form (Figure 7.38).

	 4.	 From the application menu, use the Save As command to 

save a copy of the file named Tower Mass.rvt.

Building Void Forms
Void forms can be created using any of the five types of forms 

shown earlier in this chapter. Voids are negative forms that 

make openings or subtract their shape and volume from solid 

forms. Void forms can be modeled within the solid form mass 

at the same time the mass is created or after the mass has been 

finished by editing the mass solid. While editing the mass 

solid, void forms may be added or deleted. You will add mass 

void forms to your previously created mass tower.

	 1.	 Continue working in the Tower Mass.rvt file saved previously, or reopen the file 

to continue. Make sure the default 3D view is the current view, and orbit the view 

to approximately the SW view direction; you can observe the compass on the Nav 

Cube while orbiting to verify view direction.  

This view direction will enable easy selection  

of both corners of the loft that will be used as  

the center points of the cylindrical forms.

	 2.	 Select the Loft Tower element previously cre-

ated, and from the View Control Bar, choose 

Temporary Hide/Isolate, and then choose 

Isolate Element (Figure 7.39). This will turn 

off the display of all other elements in the model and provide a clear view in which to 

model the voids.

	 3.	 Once the tower mass is isolated, select the Edit In-Place tool from the Model panel.

	 4.	 Choose Set from the Work Plane panel, and select Level 3 from the Name drop-

down; this will set the work plane at the base of the loft. Sketch two circles with a 

radius of approximately 12 ,́ as shown in Figure 7.40. You will create void forms using 

each circle.

Figure 7.38

Finished  
surface form

Figure 7.39

View Control bar, 
Temporary Hide/
Isolate control

Figure 7.40

Circle sketches
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 5. Select the right circle, expand the Create Form tool on the Form panel, and choose 

Void Form, as shown in Figure 7.41 (Click the lower half of the Create Form tool to 

expand the drop-down.)

 6. Choose the leftmost icon that displays on the screen similar to the cylindrical extru-

sion created earlier in order to create a cylindrical extrusion. The void is created and 

automatically subtracts itself from the solid form. The void extrusions will be created 

at a height of 10´-0˝ by default. In the following steps, the height of the extrusions 

will be changed to better fit the model. Without deselecting the void element, pick 

the 10´-0˝ dimension text, as shown in Figure 7.42, change the dimension to 48 ,́ and 

press Enter; the void element extends to a height of 48´ and 

subtracts that volume from the mass solid. Clear the selec-

tion by clicking in an empty area of the graphics screen to 

see the result (Figure 7.43). Void forms are invisible unless 

selected and therefore disappear once the selection is cleared.

 7. For the next void form, select the sketch circle on the left, 

and create a void form. Use the same methods as before to 

change the default 10´-0˝ height of the void to 24´-0˝ tall.

S E LE C T I N G a VO I D

If a void form becomes deselected after being created, hover over an edge that is coincident 

with the solid form, press the Tab key until you see the void highlight, and then left pick to 

select the void. Note both voids will highlight, but only one will be selected.

Highlighted void Selected void

Figure 7.41

Choosing Create 
Form ➔ Void Form

Figure 7.42

Temporary 
dimensions and 

void updates

Figure 7.43

Deselect to see 
final results.

Figure 7.43
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Converting Solid Forms to Void Forms

Converting solid forms to void forms can be done in the Properties palette (Figure 7.44). 

Creating the form as a solid first provides more visual feedback and simplified selection 

when creating, editing, and placing the form. Once the desired design has been achieved, 

the solid form can be converted to a void.

The procedure for converting solid forms to void forms (Figure 7.45) is as follows. 

Hover over the form to be converted, press Tab repeatedly until the entire form high-

lights, and then left pick to select the form. In 

the Properties palette, open the Solid/Void list, 

and select Void. Forms can be converted from 

solids to voids but not from voids to solids. 

Although voids cannot be converted back to 

solids, they can still be edited using standard 

methods.

Using the Cut and Join Geometry Tools

Void forms will only automatically cut, or subtract, their mass from solid forms that exist 

in the mass family prior to the creation of the void form. If a solid form is added after the 

void form, the Cut Geometry tool will need to be used to cut the void from the solid.

Using the Cut Geometry tool from the Geometry panel, select the new solid form 

(Figure 7.46), and then select the void form by clicking the Tab key until it is highlighted 

and then left picking to finalize the selection.

Figure 7.44

Converting a solid 
form to a void in the 
Properties palette

Figure 7.45

Two solid forms con-
verting to a void
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Join Geometry will merge the two solid forms 

into one object and remove the lines where they 

meet (Figure 7.47). Use Join Geometry whenever 

you need to join multiple forms together whether 

they are in the same mass family or separate 

mass families. The Join Geometry tool will clean 

up the model, remove any overlapping volumes, 

and create edges at form and mass intersections. 

Individual elements, both forms and masses, will 

remain editable independently after joining. Start 

the Join Geometry tool, and select one form and 

then the other.

Editing Forms
Through the conceptual and schematic design stages of a building project, massing 

models evolve and change, and mass forms will require editing in order to still match  

the design intent. Form-editing tools, shown in Figure 7.48, provide a method to manipu-

late and adjust the model in order to modify existing forms or to finalize forms that are 

Figure 7.46

Solid form selected

Figure 7.47

Joined solid forms
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difficult to model directly by means of cross section curves and shapes. In addition, the 

form can be broken down to the component parts used when originally creating the form, 

which can be a fast method of quickly making major changes.

The void forms and the Cut and 

Join tools introduced in the previous 

section are a type of editing opera-

tion that is performed using the same 

tools that were used to create the solid 

forms initially. In addition, there are editing tools available for mass forms that provide 

the ability to stretch and manipulate the form by pulling and pushing surfaces, edges, 

and vertex points. These editing tools allow rapid changes to size and shape and also pro-

vide a more intuitive process for creating organic mass elements. These tools can be used 

in conjunction with the solid and void form creation tools.

Editable subcomponents are as follows:

Surfaces•	

Edges•	

Vertexes•	

Placing the cursor over the edge, vertex, or surface will highlight the subelement to be 

edited (Figure 7.49). Pressing the Tab key will cycle through available subelements and 

also allow selection of the entire form for editing. Selections and edits can be made in any 

view where the form is visible, including orthographic 3D views. In camera views, selec-

tion is possible, but editing is limited to deleting subelements or deleting the entire form.

Edge Vertex

Surface Form 3D Edge

Figure 7.48

Editing tools

Figure 7.49

Highlighting  
subelements
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Push/Pull Editing
Once the selection is made by left picking, the subelement 3D Control object will display. 

The 3D Control object allows manipulation of the subelement by clicking and dragging. 

By hovering over the x-, y-, or z-axis and picking and holding, the stretch move will be 

constrained to that axis. For constraining stretches to a double axis, hover over the small 

planes between the 3D Control axes and then pick and hold to constrain the movement 

to either XY, YZ, or XZ. In Figure 7.50, 

the highlighted axis, or plane, will appear 

bolder than the other axes and planes. On 

your computer screen, the highlighted axis 

or plane will be much clearer.

The orientation of the 3D Control object 

will be aligned to the local coordinates of 

the subelement selected by default, and the 

three axes will be aligned to the edge or face 

being manipulated. Pressing the spacebar 

will toggle the 3D Control orientation from 

local coordinates back to global coordinates 

(Figure 7.51).

Curved cross section solid form edges 

will display additional editing options not 

available for linear edge segments. Closed 

cross section shapes will allow editing of 

the circle radius by dragging the 3D control (Figure 7.52), and the center of the form will 

remain fi xed. Open cross section edges on surface forms will allow either editing the radius 

as above or editing the radius and having the endpoints remain fi xed. This option will not 

function when you are editing a closed circular shape.

Figure 7.53 shows examples of the radius-editing options on a curved surface form.

New arc with 
endpoint location 
fixed

New arc with center point fixed

Original arc

Original arc

Figure 7.50

3D Control object 
and axis constraints

Single-axis 
constraint

Double-axis 
constraint

Figure 7.51

Changing alignment 
of the 3D Control 

object
Local coordinate 
control

Global coordinate 
control

Figure 7.52

3D Control radius 
editing fixed center 

and fixed end points

Figure 7.52

Figure 7.53

Arc editing with 
fixed center and arc 

editing with fixed 
end points
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Dimensional Editing
As is standard with all Revit object editing, you can use temporary dimensions to exactly 

control dimensional changes to the form during editing operations. Temporary dimen-

sions for editing forms will be available for vertex, edge, or surface editing. Select the 

subelement to be edited, click the temporary dimension to edit and type a new dimension 

(Figure 7.54), and then press Enter; the form will resize to refl ect the dimensional change. 

The direction of the view, plan, elevation, section, or 3D will affect which tempo-

rary dimensions are displayed. If the desired temporary dimensions 

are not readily available, permanent dimensions can be added to 

the form, or form subelements, to allow accurate manipulation 

and modifi cation. The temporary dimensions can also be 

used to control and adjust the two-dimensional cross sec-

tion shapes and curves prior to creating forms from them.

Permanent dimensions can be added manually using 

the tools on the Dimension panel located on the Home 

tab or by making the temporary dimensions permanent 

by clicking the Make This Temporary Dimension Permanent 

icon displayed at the midpoint of the dimension 

(Figure 7.55).

Permanent dimensions can be added manually 

in plan, section, elevation, and orthographic 3D 

views. Once the permanent dimension is added to 

the mass model, it will be visible and editable in 

all appropriate views including 3D (Figure 7.56) 

regardless of which view it was created in. Dimensions, 

either permanent or temporary, are not available in a 

camera view.

Permanent dimensions added in the mass family will 

behave and display the same whether they were created 

on the two-dimensional cross sections or on the three-

dimensional form element. These dimensions will be 

visible and accessible for editing while in the In-Place 

Editor only and will not display once the mass has been 

fi nished.

When you are creating permanent dimensions in 3D orthographic views (Figure 7.57), 

the dimension will be created on the active work plane. Using the Set tool to pick the 

dimension plane will allow dimensions to be created on any plane needed.

Figure 7.54

Dimensional 
radius editing

rary dimensions are displayed. If the desired temporary dimensions 

are not readily available, permanent dimensions can be added to 

the form, or form subelements, to allow accurate manipulation 

and modifi cation. The temporary dimensions can also be 

used to control and adjust the two-dimensional cross sec-

tion shapes and curves prior to creating forms from them.

Permanent dimensions can be added manually using 

the tools on the Dimension panel located on the Home 

tab or by making the temporary dimensions permanent 

by clicking the Make This Temporary Dimension Permanent 

Figure 7.55

Click to make a tem-
porary dimension 
permanent.

Figure 7.55

Click to make a tem-
porary dimension 
permanent.
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To place the dimension parallel to the angled face, choose Set from the Work Plane 

panel, hover over the angled face, and pick the face to make it the active work plane 

(Figure 7.58). Start the Aligned Dimension tool on the Home tab, pick two edges of the 

plane, then pick away from any edge, or pick back on the dimension segment already  

created to place and finish the dimension (Figure 7.59).

Figure 7.56

Vertical aligned 
dimension created 

in elevation and the 
same dimension  

displayed in 3D view

Figure 7.57

Dimensions  
created in 3D view
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Parametric Controls: Dimensional Parameters
By using dimensional parameters you will gain the capability to adjust the dimensions of 

a mass element from outside of the In-Place Editor and also provide the capability to edit 

multiple dimensions at one time by changing a single parameter value. Once the param-

eter value is changed, the mass will update to reflect the dimension changes. These 

changes can be performed within the mass family or in the project itself.

Dimensional parameters are created using one of two methods. The easiest method 

of adding parameters to dimensions is to first create the dimension. After the dimen-

sion is created, select it, open the Label list on the Options bar, 

and choose Add Parameter (Figure 7.60). You can select mul-

tiple dimensions at one time when adding a parameter, and that 

parameter will be applied to all the selected dimensions.

When adding dimensional parameters to already existing dimensions, the dimension values 

should be be the same when selecting multiple dimensions, or the values will be changed to 

a common value when the parameter is created and attached and could cause unexpected 

changes to the form or shape. The dimension value of the first dimension created in the 

selection set will be the value used for multiple dimensions.

Figure 7.58

Setting the face as the active work plane
Figure 7.59

Creating the aligned dimension

Figure 7.60

Converting a dimen-
sion into a dimen-
sional parameter 
in the Family Types 
dialog box
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The parameters can also be created using an alternate method before you attach them 

to a dimension by opening the Family Types dialog box from the tool on the Properties 

panel on the Home tab (Figure 7.61).

This opens the Family Types dialog box where you can add parameters to the family, 

modify or remove parameters, or change parameter values. Once the parameter has been 

added to the family, it is attached to the dimension by selecting the dimension (or mul-

tiple dimensions), opening the label list on the Options bar, and choosing the previously 

created parameter to attach. When using this method, verify that the type of parameter 

is set to Length in the Parameter Properties dialog box. This is the default type of param-

eter and is the only type that can be attached to a dimension.

We will not use the check box in the Lock column for these parameters. Leaving 

a parameter unlocked allows you to edit the elements controlled by the dimensional 

parameter using push/pull techniques. When a dimensional parameter is locked, the 

form and that parameter can be changed only in the Family Types dialog box or by 

changing the dimension value on the screen. The ability to lock parameters applies only 

to dimensional parameters and includes Length and Angle parameters.

Creating Dimensional Parameters

The next steps will walk through both methods of creating parameters and attaching 

them to two separate dimensions:

	 1.	 Begin a new project using the default template as used previously. This creates a new 

project and opens with the Level 1 view active.

	 2.	 Create a new in-place mass family, working in the Level 1 Floor Plan view for simplicity.

	 3.	 Create a rectangular cross section shape of approximately 30´ × 20´ (10 m × 7 m). Add 

two aligned dimensions for width and depth, as shown in Figure 7.62.

Figure 7.61

Click the Family 
Types tool to open 

the dialog box.
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	 4.	 Select the 30´ (10 m) dimension, open the label drop-down list on the Options bar, 

and then choose Add Parameter. This will open the Parameter Properties dialog box 

where the parameter will be created as shown in Figure 7.63.

	 5.	 Using this method of parameter creation automatically forces the Type Of Parameter 

setting to Length and groups the parameter in the Dimensions group. This param-

eter will be a family parameter and will be an instance parameter. In the Name text 

box, type Width, select the Instance radio button, and then click OK at the bottom 

of the dialog box. Keep your file open for now.

Figure 7.62

Rectangular shape

Figure 7.63

Parameter Proper-
ties dialog box
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The name of the parameter or group it is assigned to has no effect on the function of the 

parameter; that name is used only to identify the parameter in the Family Types or Properties 

dialog box.

Instance parameters (Figure 7.64) allow each individual 

object to vary from each other. Type parameters control all 

elements of that family type; whenever the parameter setting 

is modified, all elements of that family type will be modified. 

For in-place mass families, the selection of parameter type 

will not have any effect on the function but will control only 

whether the parameter appears in the instance or type prop-

erties of the mass.

When the dialog box closes, you will see the parameter name has been added to the 

dimension value (Figure 7.65). This always alerts you that a family dimension is con-

trolled by a parameter. This type of dimension is called a labeled dimension.

Still in the same file where you just created the Width parameter, let’s continue. Let’s 

use an alternate method to create the Depth parameter:

	 1.	 From the Properties panel on the Modify tab, select the Family Types tool to open 

the Family Types dialog box. The already created Width parameter appears in the 

dialog box. All family parameters will appear in this dialog box regardless of which 

method is used to create them or which type of parameter they have been created as.

	 2.	 Choose Add in the Parameters area at the right side of the dialog box (Figure 7.66), 

which will open the Parameter Properties dialog box. (This is the same dialog box 

you just used to create the Width parameter.)

	 3.	 Type the name Depth, and verify that Type Of Parameter is set to Length; the 

parameter is not forced to be Length using this method! Also, verify that the param-

eter will be grouped in the Dimensions group. Select the Instance radio button, and 

leave Parameter Type set to Family Parameter.

Figure 7.64

Name and  
instance settings

Figure 7.65

Parameter attached 
to dimension

Figure 7.66

Adding a parameter



Editing Forms  ■   215

	 4.	 Click OK to close the Parameter Properties dialog box. The new Depth parameter 

appears in the Family Types dialog box along with the previously created Width 

parameter. Click OK again to close the dialog box.

	 5.	 To attach the Depth parameter to the dimension, select the vertical dimension (currently 

20´ or 7 m), and open the Label list on the Options bar. Select the Depth parameter. All 

Length parameters will be available in this drop-down list regardless of which method 

was used to create them. Only Length parameters will be listed because they are the 

only type of parameter that can be attached to a linear dimension. The Depth parame-

ter is now attached to the vertical dimension and appears as part of the dimension text.

	 6.	 Save the file as Dimensional Parameters.rvt, and continue with the file open to the 

following steps.

Testing Dimensional Parameters

Testing dimensional parameters in Revit is a very important step when building families. 

To test the dimensional parameters, the Family Types dialog box will be used to “flex” 

the model. Flexing the model in Revit means assigning new parameter values and observ-

ing that the changes to the model are as expected. It is easier to confirm that the behav-

ior is correct before proceeding any further. If the behavior is not as expected, it will be 

easier to make changes and fix the error before moving on.

	 1.	 Continue with (or open) the Dimensional Parameters.rvt file from the preceding sec-

tion. Click the Family Types tool to open the Family Types dialog box, and arrange 

the screen similar to what is shown in Figure 7.67 so that you can see both the dialog 

box and the shape and dimensions. If this is not possible, close the dialog box and 

pan the shape to allow a clear view, and then reopen the Family Types dialog box.
Figure 7.67

Screen layout for 
flexing parameters
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	 2.	 In the Value column beside the Width parameter in the Family Types dialog box, 

highlight the Width value (currently 30´ or 10 m), and change it; then click Apply at 

the bottom of the dialog box. The shape should update to reflect the new dimension 

value. Perform the same type of change to the Depth parameter, and verify that the 

model updates to reflect the change.

	 3.	 Set both parameters back to their original values (optional), and click OK. If the 

shape did not update as expected, verify that the dimension is associated with the 

desired edge of the shape. If necessary, the dimension could be deleted and a new 

dimension created to replace it. The parameter will still be available to be attached  

to the dimension and will not need to be re-created.

	 4.	 Select the rectangular shape only, and choose Create Form from the ribbon. (If the 

dimensions are included in the selection set, the Create Form button will not be avail-

able.) Choose Finish Mass from the ribbon, and open the default 3D view from the 

QAT. If the mass does not display, use the Zoom Extents (ZE) command to bring the 

mass into view. Remember the display settings, from earlier in the chapter, that con-

trol mass elements if you still are unable to view the mass.

	 5.	 Select the mass, and in the Properties palette, you will see the Width and Depth param-

eters. Change the value of the parameters in the Properties palette (Figure 7.68), and the 

mass should update to reflect the new dimensions.

The mass should have updated but may not have responded as expected. The parameter-

controlled dimensions were created using the 2D cross section shape, or profile, of the 

mass form. The mass form extrusion, as with all mass forms, now also has a bottom and 

top cross section shape, and each can be manipulated independently of the other. To 

force the mass to retain its original box shape, select the mass family in the graphics area, 

and choose Edit In-Place from the ribbon. Once in the form editor, hover over the form, 

press Tab until the entire form highlights, and then select the form. In the ribbon on the 

Figure 7.68
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modified mass
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Form Element panel, as shown in Figure 7.69, choose 

Lock Profiles to lock the shape of the form cross sections 

together so that the form maintains a rectangular shape. 

Then select Finish Mass from the ribbon, and retest the 

parameters in the Properties palette.

To unlock the profiles use Edit In-Place, select the form,  

and click the closed padlock icon that appears above the form  

(Figure 7.70).

When creating dimensions that will have their values 

controlled by parameters, the subelement selection—

whether vertex, edge, or surface—will control the dimen-

sional changes. When placing the dimensions on the 

three-dimensional form, ensure that the desired subelement is being dimensioned. The 

subelement selected when the dimension is created will be the subelement that moves 

when the dimension value is modified.

Vertex, edge, and surface dimensions will each generate different changes to the 

mass. By changing the dimensional parameter values, you are stretching, pushing, and 

pulling the form in the same way as you would be by using the 3D Control object. The 

subelement selection when stretching determined the results of the stretch, and the 

same is true using parameters. When adding dimensions to the form, ensure that you 

are dimensioning to the appropriate vertex, edge, or surface (Figure 7.71) in order to get 

the desired result.

A Height parameter with a default setting of 10´ (3.3 m) has been added to a dimen-

sion in the same mass family used earlier. The profiles have been unlocked. Figure 7.72 

demonstrates the different results when changing the height from 10´ (3.3 m) to 15´ (5 m) 

using dimensions that were added to an edge, a surface, and a vertex.

Figure 7.70

Modified mass with 
an icon showing 
that it’s locked

Figure 7.71

Subelements 
selected when 
dimensioning: left, 
edge; center, vertex; 
right, surface

	 2.	 In the Value column beside the Width parameter in the Family Types dialog box, 

highlight the Width value (currently 30´ or 10 m), and change it; then click Apply at 

the bottom of the dialog box. The shape should update to reflect the new dimension 

value. Perform the same type of change to the Depth parameter, and verify that the 

model updates to reflect the change.

	 3.	 Set both parameters back to their original values (optional), and click OK. If the 

shape did not update as expected, verify that the dimension is associated with the 

desired edge of the shape. If necessary, the dimension could be deleted and a new 

dimension created to replace it. The parameter will still be available to be attached  

to the dimension and will not need to be re-created.

	 4.	 Select the rectangular shape only, and choose Create Form from the ribbon. (If the 

dimensions are included in the selection set, the Create Form button will not be avail-

able.) Choose Finish Mass from the ribbon, and open the default 3D view from the 

QAT. If the mass does not display, use the Zoom Extents (ZE) command to bring the 

mass into view. Remember the display settings, from earlier in the chapter, that con-

trol mass elements if you still are unable to view the mass.

	 5.	 Select the mass, and in the Properties palette, you will see the Width and Depth param-

eters. Change the value of the parameters in the Properties palette (Figure 7.68), and the 

mass should update to reflect the new dimensions.

The mass should have updated but may not have responded as expected. The parameter-

controlled dimensions were created using the 2D cross section shape, or profile, of the 

mass form. The mass form extrusion, as with all mass forms, now also has a bottom and 

top cross section shape, and each can be manipulated independently of the other. To 

force the mass to retain its original box shape, select the mass family in the graphics area, 

and choose Edit In-Place from the ribbon. Once in the form editor, hover over the form, 

press Tab until the entire form highlights, and then select the form. In the ribbon on the 

Figure 7.69

Lock Profiles 
 command
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Original mass

Surface changed

Edge changed

Vertex changed

Loadable Mass Families
Loadable, or external, mass families are created outside the project environment and 

loaded into a project for use. This is the preferred method of creating mass families 

that are either going to be duplicated within a single project or are going to be used in 

multiple projects. Creating the family outside the project environment also allows you 

to update the mass model outside the project where the file performance may be faster. 

Once the loadable family has been modified, it can be reloaded into the project, or proj-

ects, and all instances of that family will update to reflect the updated model. This will 

not be the behavior when you are copying an in-place mass family that you created using 

the techniques earlier in this chapter. If there is a chance that the mass may be duplicated, 

creating the mass as a loadable family is strongly encouraged.

All of the techniques introduced during the in-place family portion of this chapter will 

apply to loadable families. The only changes are the user interface and the conceptual 

mass environment, which has additional display capabilities not available in a project 

environment.

The default Revit installation creates two conceptual mass templates. One is provided 

(Mass.rft) for creating loadable mass families, and one template (Adaptive Component.rft) 

is provided for creating loadable mass or generic model families. The adaptive component 

template creates families primarily to be inserted into other loadable mass families or 

into in-place mass families.

Figure 7.72
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eter changes
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Creating a Loadable Family
To create a loadable mass family, open the application menu, and choose New ➔ Conceptual 

Mass. This will open a list of templates used for creating loadable mass families.

You can also create a loadable mass family from the Recent Files window by selecting 

New Conceptual Mass from the Families area and then choosing the desired template. 

The default template location is as follows:

C:\Documents and Settings\All Users\Application Data\...

Autodesk\RAC 2011\Imperial Templates\Conceptual Mass

You can create customized mass family templates by starting with one of the provided 

templates, making any needed changes, and saving the file using the .rfa file extension. 

This is the only extension available for saving a family in Revit. Once the file has been 

saved, the file extension can be changed to .rft, and the file can be placed in the family 

templates folder. The file will then be available for selection when you are creating a new 

loadable mass family.

The new family file opens in the default 3D view. One level and two reference planes 

are included in the template and are visible in three-dimensional views (Figure 7.73). 

These references will be visible only in the Family Editor environment and not in the 

project environment once the family has been loaded into a project.

You can use levels in conceptual mass families as work planes and also for adjusting 

the height of the conceptual mass while in the Family Editor. The levels created in the 

mass will not interact with or be available for use in a project file. If the family is being 

created to match levels in a project, the levels will have to be created in the family file 

with the matching height settings.

	 1.	 Click the application menu, and select New ➔ Conceptual Mass. Select Mass.rft from 

the list.

Figure 7.73

Conceptual mass 
design environment 
and the same with 
planes highlighted
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	 2.	 Create two additional levels in the mass family file. Using the South Elevation view, 

start the Level tool from the Home tab, and add two levels. The level lines will auto-

matically align with the existing lower level when you hover near the ends. The two 

new levels will be placed at 60´ (20 m) and at 120´ (40 m). The default level, Level 1, 

will remain at its current location.

These levels will be used to sketch the cross section shapes for our mass family and 

also to control the height of the cross section shapes once the form is created.

	 3.	 In the Level 1 Floor Plan view, sketch the elliptical shape shown in Figure 7.74 using 

model lines and the Ellipse tool from the Draw panel on the Home tab. The horizon-

tal, major axis will have a radius of 120´ (40 m), and the vertical, minor axis will be 

60´ (20 m).

	 4.	 In the Level 2 Floor Plan view, sketch a circle with a radius of 60´ (20 m); this circle 

will be centered on the ellipse below.

	 5.	 Then on the Level 3 Floor Plan view, sketch another ellipse with a horizontal radius 

of 60´ (20 m) and a vertical axis of 30´ (10 m). This ellipse will be centered on the two 

sketch shapes already created.

	 6.	 After creating the three cross section shapes, open the default 3D view (Figure 7.75). 

You will see the two new levels and the three shapes created in the previous steps. 

Select the three shapes, and then choose Create Form from the Form panel.

	 7.	 To better see what the form is composed of, select the form or any part of the form, 

and enable X-Ray mode by picking the X-Ray tool from the Form Element panel, as 

shown in Figure 7.76. X-Ray mode displays the form and the underlying elements 

that the form is composed of. This mode allows for easier editing of the form and 

also allows a means to align and lock shapes to levels using their automatically cre-

ated reference points. If there is a 3D Control visible, select a blank area of the screen 

to clear the face previously selected. This mode is also available for in-place mass 

families.

Figure 7.74

The Ellipse tool  
and the ellipse  

on Level 1
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	 8.	 Using the Align tool (Figure 7.77), from the Modify panel, 

align and lock the cross section shapes on Levels 2 and 3 to 

their respective levels. The cross section shape on Level 1 will 

automatically be locked to the Level 1 plane, but the other 

two levels will not automatically lock to the levels they were 

created on.

	 9.	 After starting the Align tool, pick Level 2 as the first pick point, and then select the 

reference point at the center of the circular cross section shape sketched on Level 2 

(Figure 7.78). Click the open padlock icon to lock the shape to Level 2. Perform the 

same steps to align, and lock the elliptical shaped created on Level 3 to the Level 3 

plane.

Figure 7.75

The default 3D  
view and the newly 
created form

Figure 7.76

The form viewed 
using the X-Ray tool

Figure 7.77

Align tool
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	10.	 After both shapes are locked to their planes, cancel the Align tool by clicking Modify 

at the left end of the ribbon.

	11.	 Flex the model to make sure that the shapes move with the levels as expected: Pick 

one of the levels, and in the Properties palette, change the Elevation setting. Then 

click Apply. As the elevation of the levels is changed, the shapes should move up and 

down (remaining locked to the levels), and the form should adjust as well. If the 

shapes do not remain locked to the levels, repeat the Align tool again, and ensure 

that the shape is locked to the level. Click the Undo tool from the QAT to restore the 

Elevation setting.

	12.	 When a form requires significant changes, you can 

select the form and choose Dissolve from the Modify 

tab Form Element panel, as shown in Figure 7.79. 

This will deconstruct the form back to the current 

component cross section shapes. There will be one 

reference point left on each cross section that can be 

deleted. The form could then be easily reconstructed 

using the shapes.

	13.	 If you tested the Dissolve tool, use the Undo tool to bring the form back. The family 

is complete: save the family file, naming the file Core building Shape.rfa, and keep it 

open. The family name that you use will appear in the Project Browser once you have 

loaded the mass family into a project. As with in-place mass families, logical names 

will be easier to work with later when selection and editing is necessary.

Using a Loadable Family in a Project
Now that the family is complete; let’s load it into a new project file:

	 1.	 From the application menu, choose New ➔ Project. Click OK to use the default  

template.

	 2.	 The new project will open in the Level 1 Floor Plan view by default. This is the view 

you will use to place the mass family. Save the project with the name of Building A. 

Figure 7.78
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Figure 7.79
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Switch the active view to the conceptual mass family that was previously saved. 

This can be done on the View tab by using the Switch Windows tool in the Windows 

panel. Select a view of the conceptual mass family by locating the family name in 

the list; the specific view will not matter. Alternately, you could cycle through open 

views and files by pressing Ctrl+Tab.

	 3.	 Once the mass family is in the active view, choose Load Into Project from the Family 

Editor panel.

If the family and the newly created project are the only Revit files open, even if there 

are multiple views of the same file, the family will be automatically loaded into the 

open project, and the active view will be changed to that project. If there are multiple 

other files open, you will see a selection window where you can select the project, 

multiple projects, or other families into which to load the family. If a pop-up dialog 

box opens, select the project named Building A. Families can also be loaded into a 

project directly from the project by selecting Load Family and then navigating to 

the family file. You may also see the message alerting you that Show Mass has been 

enabled. Click OK to proceed.

	 4.	 The Place Mass command is automatically activated when Load Into Project is initi-

ated from the family file.

If the Load Family command is used from the project to load the family, the Place Mass com-

mand will need to be activated manually, and the correct family will need to be chosen from 

the Type Selector.

To place the mass family on a work plane, and not on a face, select Place On Work 

Plane on the Placement panel in the ribbon.

	 5.	 Click a point roughly centered in the view to place an instance of the conceptual 

mass family, and then activate the default 3D view to view the mass family.

Editing a Loadable Family
When mass families are created as loadable families, and not as in-place families, editing 

of the family can be done only in the family file and not in the project.

	 1.	 To edit the loadable mass family, the family file needs to be opened, modifications need 

to be made, and then the family needs to be reloaded into the project where any changes 

will update all instances of the conceptual mass family. To quickly open the file for edit-

ing, select the family, and choose Edit Family from the Mode panel in the ribbon.

	 2.	 This opens the family in the Conceptual Mass Family Editor, and you can now 

manipulate the form. Activate the default 3D view, select Level 3, and in the Proper-

ties palette change Elevation to 300´ (100 m), as shown in Figure 7.80.
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	 3.	 Click Apply in the Properties palette, 

and the form should update, as shown  

in Figure 7.81.

	 4.	 Save the family file. The family could 

be loaded into the project at this point, 

and the conceptual mass family would 

be updated in the project file, but the 

changes would not be saved in the fam-

ily file.

	 5.	 Select Load Into Project on the ribbon. If 

the selection window opens, choose the 

building A project file, and click OK.

The dialog box shown in Figure 7.82 

alerts you that the family already exists 

in this project file. If the family is 

reloaded, it will be updated in the proj-

ect file, and all instances of the family 

will be updated. There are three choices 

within this dialog box:

Overwrite the existing version  ​This will replace the current version of the family in 

the project that it is being loaded into.

Figure 7.80
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Figure 7.81
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Overwrite the existing version and its parameter values  If you select the override 

option, the parameter values of the existing family are overridden by the parameter 

values of the family you are loading. If you do not select this option, then any fam-

ily types in the family fi le not currently in the project fi le will be loaded. Any family 

types that already exist in the project fi le will be ignored.

Cancel  This will not reload the family into the project fi le, and no changes 

will be made to the family in the project.

 6. Choose Overwrite The Existing Version. The conceptual mass family already 

placed in the project file updates to reflect the dimensional change made in 

the Family Editor (Figure 7.83).

 7. Save the file, and continue working through the next exercises.

Face-Based Modeling
Mass families can be used to quickly build conceptual design models by 

selecting the faces of the mass and then creating model objects directly from 

the geometry of the face. Here are the Model By Face objects:

CU R TA I N S YS T E M S

Curtain systems are similar to curtain walls but can be created only •	

by face. Curtain system family types can be created, modified, and 

saved.

Curtain systems are controlled by the face object that was used to •	

create it and cannot be edited independently of the face.

WA L L S

Typical project wall family types can be created by using faces to model complex •	

geometry not possible with the Wall command.

Vertical walls can be edited independently of the face once created.•	

FLO O R S

Typical project f loor families are available to be placed on mass floors.•	

Floors can be edited independently of the face once created.•	

R O O FS

Typical project roof families are available to be modeled on mass faces.•	

Roof sketches cannot be edited independently of the face.•	

Figure 7.83

The updated family

 This will not reload the family into the project fi le, and no changes 

 6. Choose Overwrite The Existing Version. The conceptual mass family already 

placed in the project file updates to reflect the dimensional change made in 

selecting the faces of the mass and then creating model objects directly from 
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M ass  Floors  

A mass floor is created directly from the shape of the mass by selecting the mass and •	

then selecting which floors are to be created. Mass floors are used for scheduling, for 

area calculations, and as the host objects when creating floors by face.

All of these objects can be updated so that they still follow the shape of the face after 

the conceptual mass object has been changed. The update is not automatic but is accom-

plished by the Update To Face tool. Certain changes will be discarded when updating the 

model object to the face; for example, wall profile edits will be discarded.

You will add some levels to your project file. Mass floors are created on levels in the 

project file. To create mass floors, levels must be present in the project.

	 1.	 Open the Building A file that you used in the preceding section on loadable families, 

and activate the South Elevation view. Select the existing Level 2, and change its 

elevation to 15´ (5 m).

	 2.	 You can use the Array tool here. Select Level 2 again if needed, and start the Array 

tool (Figure 7.84); in the Options bar, choose Linear, and deselect the Group And 

Associate option to make the levels easier to work with once they are arrayed. Set 

Move To as 2nd and the total Number to 20.

	 3.	 In the drawing window, pick the selected Level 2, move the pointer straight up, and 

then type 15´ (5 m).

	 4.	 Save the file. The resulting array should appear as shown in Figure 7.85; leave the file 

open because you’ll continue with it in the next section. Creating the levels using the 

Array command did not create story levels, but the levels will still be available to the 

Mass Floors tool.

Figure 7.84
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Figure 7.85

Finished array
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Adding Mass Floors
The next step is to create the mass floors. The mass floors are created using the existing 

levels of the project. A selection window allows the selection of all or only certain levels 

when adding mass floors to the conceptual mass. Mass floor elements are planar and do 

not display a thickness. For final building modeling, they will be used as the faces from 

which to create Model By Face floors.

Still in your Building A file, select the conceptual mass, and pick Mass Floors from the 

Model panel of the Modify | Mass tab on the ribbon.

In the Mass Floors selection dialog box (Figure 7.86), select Level 1, scroll down, and 

while holding the Shift key down select level 20 (Level 21 will be the roof level so a mass 

floor is not needed). Select any check box next 

to one of the highlighted levels, and the check 

will appear in all 20 selected levels. Choose OK 

at the bottom of the dialog box to create mass 

floors at each of the levels selected in the dialog 

box, and then open the default 3D view to see 

the mass floors, as shown in Figure 7.87.

At each selected level, a mass floor has been 

created that follows the shape of the mass fam-

ily; because of the shape of the family, the mass 

floors may appear to be twisted or sloped. 

Adjust the 3D view to better visualize the mass 

floors using the Nav Cube or by holding down 

the Shift key, holding down the middle mouse button,  

and moving the mouse.

Save the file, and continue working through the next 

exercises.

Modeling Tools
The Model By Face tools are located on the Massing & Site 

tab in the Model By Face panel (Figure 7.88). Unlike the 

mass floors created earlier, using the tools available on the 

Model By Face panel creates Revit model elements. The 

model elements will be linked to the faces from which 

they were created and can be updated to reflect any future 

changes made to the mass family. During preliminary 

design, this is a very fast method of putting together a pre-

sentation model for design analysis and review. Once the 

model elements have been added to the mass, Show Mass 

is disabled, leaving only the actual model elements visible.

Figure 7.86
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Figure 7.87
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Figure 7.88
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Floor

The Floor By Face tool requires mass fl oors in order to create the fl oor objects.

Continuing in the working fi le from the end of the “Adding Mass Floors” section, start 

the Floor By Face tool. On the Options bar, set Offset to 12˝ (300 mm). A positive offset 

will offset the sketch edge of the fl oor inward, while a negative offset will offset the fl oor 

sketch edge outward. The inside offset would allow room for 

exterior curtain systems or walls. You can edit the fl oor sketch 

manually as well by using the standard Edit Boundary tool. (See 

Chapter 3, “Modeling,” for more information on fl oors.)

Verify that Select Multiple is activated in the Multiple 

Selection panel on the ribbon, and then use a window or cross-

ing window to select all of the mass fl oors. Finish the fl oors by 

selecting Create Floors from the same Multiple Selection panel.

You can select the type of fl oor before creating the fl oors by 

face or you can change the type after. The Floor Family type 

can be left set to Floor Generic 12˝ (Floor Generic 300 mm) 

in the Properties palette. Zoom in, if necessary, on the 

mass model, verify that the fl oor objects are now created, 

and display the 12˝ (300 mm) thickness, as shown in 

Figure 7.89.

Save the fi le, and continue working through the 

next exercises.

Walls

The Wall By Face tool will use the actual faces of the conceptual mass as the basis for the 

wall. There is no need to create an intermediate object as was needed by the Floor By 

Face tool.

 1. Select the Wall By Face tool from the Model By Face panel. Verify that the Model By 

Face button is active in the Draw panel (Figure 7.90). This is the default setting. This 

tool can also be activated directly from the Wall tool on the Home tab.

 2. On the Options bar, set Location Line to Wall Centerline.

 3. Verify that Basic Wall Generic – 8˝ (Basic Wall – 200 mm) is the current wall type in 

the Properties palette.

 4. Select the near-side vertical curving face, as shown in Figure 7.91. The wall will be 

created automatically once the face is selected. The tool remains active, and you 

could select additional faces if desired. Select Modify at the left end of the ribbon to 

cancel the Wall By Face tool.

 5. Save the file, and continue working through the next exercises.

Figure 7.89

Completed Floors By Face

sketch edge outward. The inside offset would allow room for 

exterior curtain systems or walls. You can edit the fl oor sketch 

manually as well by using the standard Edit Boundary tool. (See 

Selection panel on the ribbon, and then use a window or cross-

ing window to select all of the mass fl oors. Finish the fl oors by 

selecting Create Floors from the same Multiple Selection panel.

You can select the type of fl oor before creating the fl oors by 

face or you can change the type after. The Floor Family type 

can be left set to Floor Generic 12˝ (Floor Generic 300 mm) 

Figure 7.89
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Curtain System

The Curtain System By Face tool will use the actual faces of the conceptual mass as the 

basis for the curtain system. There is no need to create an intermediate object as was 

needed by the Floor By Face tool.

Orbit the 3D view around so that you can see the far side of the conceptual mass, and 

then select the Curtain System By Face tool from the Model By Face panel.

The Select Multiple option will be active by default but can be deselected if desired. 

The Curtain System By Face tool allows you to create a selection of faces before creating 

the curtain system. Faces can be selected one by one, without the need to hold the Ctrl 

key, or they can be selected using window or crossing window selection methods. If a face 

is selected inadvertently, it can be removed from the selection set by Shift-clicking it once 

again. There is also a tool in the panel to clear the entire selection set (Clear Selection) 

and begin selecting faces again.

Curtain System 5´ × 10´ (Curtain System 1500 × 3000) is the default curtain system 

family type and is listed in the Type Selector at the top of the Properties palette. Curtain 

System family types can be created and edited as needed similar to Curtain Wall family 

types.

Select the near vertical face of the conceptual mass (Figure 7.92), and then choose 

Create System from the Multiple Selection panel.

Save the file, and continue working through the next exercises.

Figure 7.91

Face selection and  
a finished wall
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Roof

The Roof By Face tool has the same selection options noted for Curtain Systems. The 

Roof By Face tool makes use of typical roof family types available through the standard 

roof command.

	 1.	 Select the Roof By Face tool from the Model By Face panel. Select Multiple will be  

the active selection option in the Multiple Selection panel.

	 2.	 On the Options bar (Figure 7.93), set Offset to 8˝ (200 mm) by using a positive  

offset. The sketch edge of the roof will be offset 8˝ inward.

	 3.	 Choose Create Roof from the Multiple Select to create the roof object, as shown in 

Figure 7.94.

Figure 7.92

Left: face selection; 
right, finished  

curtain system

Figure 7.93

Options bar

Figure 7.94

Face selection and 
finished roof
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 4. On the Massing and Site tab’s Conceptual Mass panel, click the Show Mass tool; this 

will turn off the display of the conceptual mass and show only the model elements 

(Figure 7.95).

 5. Save the file, and continue working through the next exercises.

Updating Model Elements
Model elements that have been created based on the faces of a conceptual mass 

family can be updated as necessary. When edits are made to the mass family and 

the family is loaded back into the project, the model elements can be updated to 

represent any changes.

 1. To make changes to the mass family, select Show Mass from the Conceptual 

Mass panel. This will make the conceptual mass family visible on the screen 

and selectable.

 2. Select the mass family. Using the Tab key will allow you to cycle through 

the elements available on the screen. Hover over an edge of the mass fam-

ily, press Tab until the family is highlighted, and then left pick. You can 

check the status bar at the bottom-left corner of the Revit screen to 

ensure that the mass family is highlighted.

 3. Once the mass family is selected, choose Edit Family from the rib-

bon and, if prompted, Yes from the pop-up dialog box.

 4. Open the default 3D view in the Family Editor, select Level 2, and 

change its elevation to 150´ (50 m). When the change is complete, choose Load Into 

Project from the ribbon. (Remember, the save is needed only if you want to save the 

changes to the original family file in addition to the project file.) Select Overwrite 

Existing Version (see Figure 7.96).

 5. Use a crossing window—right to left dragging—to select the conceptual mass family 

and all of the model elements. Use the Filter tool from the ribbon or from the lower-

right corner of the Revit window to filter the selection.

 6. In the Filter dialog box (Figure 7.97), deselect all check boxes except for the model 

geometry—this will leave Curtain Systems, Floors, Roofs, and Walls selected—then 

click OK.

 7. From the ribbon, choose Update To Face, which will update all the selected model 

elements created using the Model By Face commands.

There is quite a bit of remodeling taking place, so the fi nal result will take a few sec-

onds to complete (Figure 7.98).

Figure 7.95

Finished model

Model elements that have been created based on the faces of a conceptual mass 

family can be updated as necessary. When edits are made to the mass family and 

the family is loaded back into the project, the model elements can be updated to 

 1. To make changes to the mass family, select Show Mass from the Conceptual 

Mass panel. This will make the conceptual mass family visible on the screen 

 2. Select the mass family. Using the Tab key will allow you to cycle through 

the elements available on the screen. Hover over an edge of the mass fam-

ily, press Tab until the family is highlighted, and then left pick. You can 
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Figure 7.96

Updated conceptual mass

Figure 7.97

Filter dialog box

Figure 7.98

Updated model

Creating Mass Families from Imported Geometry
Using previously created three-dimensional models from other applications can be a very 

fast method of creating mass building studies. Imported geometry can be used to create 

face based models, mass fl oors, and schedules. This is the same capability as masses that 

were created originally within Revit. The imported geometry mass models can also be 

created as in-place families or as loadable, or external, families.

To use the imported geometry as a conceptual mass object in Revit, the model object 

needs to be imported into a conceptual mass family. If the fi le is not imported directly 

into a family, either loadable or in-place, then the expected tools will not be available.

To start, you must create a new mass family. Once the new family is created, you can 

import the external model. The tools to create a new loadable family are available on the 

application menu by selecting New ➔ Conceptual Mass Family. The Mass.rft template will 

be one of the two listed by default.

On the Insert tab’s Import panel, select Import CAD (Figure 7.99). The imported fi le 

cannot be linked into a conceptual mass family; even though the Link CAD tool is active, 

the external fi le will be imported.
Figure 7.99

Import CAD tool
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Navigate to the location that the file has been saved in. Set the color and positioning 

and level as desired for the model, and then click Open. The external file is then loaded 

into the conceptual mass family file.

For additional information on importing and linking CAD files, see Chapter 10, “Working with 

Other Files.”

Save the conceptual mass family and then load the family into a project. Once loaded 

into the project, the model can be used to generate mass floors, floors, walls, curtain sys-

tems, and roofs.

Note that the imported CAD file is imported into the mass family and not linked. If 

updates are made to the original CAD file and the file is reimported into the family file 

and reloaded into the project, the Update To Face command will not function because 

the mass faces of the model will have changed. These are the file formats supported for 

import:

DWG•	

DXY•	

DGN•	

SAT•	

SKP•	





C hap te r 8

Groups

Each project  has design elements that are repeated or reused: a hotel has 

guest rooms, medical facilities have exam rooms, and so on. It isn’t practical to model 

each and every one of these as unique elements. Not only is it inefficient to do so, but 

it increases the likelihood for errors and omissions. Groups provide yet another way to 

manage repetition within your building models.

This chapter will cover the following:

Group organization■■

Creating and editing a group■■

Placing a group■■

Special changes to a group■■

Saving, loading, and reloading groups■■

Practical considerations■■
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Group Organization
Groups provide you with a way to combine component and system families into a coher-

ent repeatable named entity. Easily identifiable examples are a hotel room, apartment 

unit, or hospital patient room. Groups are also useful to help create consistent annotation 

and documentation.

A Revit component family provides a reliable and efficient way to manage repetition as long 

as the elements you need to manage are not system families (hosts), such as walls, floors, or 

ceilings. System families are excluded from the scope of component families (as discussed 

in Chapter 6, “Introduction to Families”). A component (loadable) family will provide better 

results when considering pure file performance. Groups excel when using a component fam-

ily isn’t possible.

There is a bit of a paradox, however, because Revit treats model elements differently than 

annotation elements. Model elements appear in nearly all views automatically. Annota-

tion elements do not, on the other hand, appear in all views by design. Annotations 

appear only in the views they are deliberately placed within. Each view has a purpose, and 

the annotation that is included helps serve this purpose. This segregation and behavior 

means that a group cannot include both model and annotation elements. For this reason, 

there are three kinds of groups: Model, Detail, and Attached Detail.

Model groups  ​These are reserved for model elements only, such as walls, doors, windows, 

floors, model lines, rooms, and other 3D elements that are visible in all views.

Detail groups  ​These contain only the annotation elements that are view-specific such as 

tags, symbols, dimensions, text, filled regions, detail components, and detail lines.

Attached Detail groups  ​These are Detail groups that have an inherent relationship with a 

Model group. These are created when you use the Create Group tool with both model and 

annotation elements selected.

Groups have their own branch at the bottom of the listed 

nodes within the Project Browser (see Figure 8.1). Detail groups 

appear first in the list followed by Model groups. Each Attached 

Detail group, if any exist, is listed and nested beneath its own 

related Model group.

Creating and Editing a Group
Creating a group is as easy as going to the Home tab, selecting the Model panel, clicking 

the Model Group button, and selecting the Create Group tool in the drop-down menu 

(see Figure 8.2). You can start with nothing selected in advance or carefully select every-

thing you want to include in the group first. Regardless of the approach you take, Revit 

Figure 8.1

Groups listed in the 
Project Browser
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will ask you to name your group. Choosing a descriptive name is helpful later when you 

are working with other people and they have only the names listed in the Project Browser 

to help them decide which to use. Please don’t use names like Group 1 or Group 2 because 

they aren’t very effective.

When you start without a selection set, Revit will 

prompt you to choose which kind of group you’d like 

make (see Figure 8.3). Starting with a selection set will 

change the ribbon to a contextual tab (Modify | Multi-

Select) and will display a new Create Group button 

(see Figure 8.4). Once you click Create Group in the 

Create panel, Revit will offer you one of two different 

dialog boxes depending upon whether your selection 

set includes model elements, annotation elements, 

or a combination of both. You also have an option 

to open the Group Editor as soon as the group is 

defined. It is most useful when you start without 

a selection fi rst. You might 

fi nd it useful when you 

realize that you’ve neglected 

to include something or 

need to remove something 

that is part of your selection set.

If you elect to use the Group Editor immediately, 

then you’ll fi nd that the interface changes a little. A 

slight color change, reminiscent of the beige tracing paper 

many of us have used for sketching, is applied to the view. Revit 

also provides an Edit Group toolbar, which appears within the 

drawing area just below the Options bar (see Figure 8.5). It has 

the following tools: Add, Remove, Attach, Finish, and Cancel. The toolbar is a panel that 

can be returned to the ribbon if you prefer. Just click the small control in the upper-right 

corner.

Add  Click this tool to add new elements that are already present in the model to your 

group. You can also create new elements while in the Group Editor, and these new ele-

ments are added to the group. You don’t have to add them with this tool.

Remove  Click this tool to remove elements from your group. This does not delete them 

from the project; the removed element is left in place but is no longer part of the group. 

If you really want to remove the element from the project as well as from the group, then 

you need to delete the element instead while in the Group Editor.

Figure 8.2

Model Group but-
ton’s Create Group 
command

Figure 8.3

The Create Group 
dialog box when no 
selection is previ-
ously set

Figure 8.4

Click the Create 
Group button. The 
Create Group dialog 
box then differs 
based on what you 
had previously 
selected.that is part of your selection set.

If you elect to use the Group Editor immediately, 

Figure 8.5

Group Editor 
toolbar tools
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Attach  ​Click this tool to attach a Detail group to your Model group. This feature doesn’t 

apply when editing a Detail group, so you’ll find it is disabled. If you select this tool when 

there are no Detail groups to attach, you’ll be prompted to create one and then to add/

remove or create new elements to include in the group.

Finish and Cancel  ​Click these tools when you are either done editing the group or decide 

to abandon your work during the Group Editor session.

When you finish creating or editing a group, it remains selected, and an origin icon 

appears (see Figure 8.6). This is located at the center of the overall extent of the group 

initially, but you can move it to another location as well as rotate it if necessary. You just 

click the icon control grips to reposition it. Click the X or Y grip to rotate, and where the 

X and Y lines meet, click to move the origin location. This serves to define a common 

point and rotation for this group and any other that might get exchanged for it later. 

Imagine a king-bed hotel room design that might be swapped out for queen-bed configu-

ration. If these two rooms did not share the same origin location, you wouldn’t be able to 

swap one for the other without having them move out of position.

Placing a Group
There are three ways to place a group:

On the Home tab’s Model panel, click the Model Group drop-down. Choose from Place •	

Model Group, Create Group, and Load As Group Into Open Projects (see Figure 8.7).

You can right-click a group in the Project Browser and select Create Instance (refer to •	

Figure 8.8).

You can just drag and drop the group from the Project Browser.•	

Figure 8.6

The group origin 
icon appears on 

your new group but 
can be moved to a 

new location.
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Regardless of the method you choose, you place a 

group the same way you place a component family—by 

clicking the appropriate location in the drawing area. The 

group’s origin is at your mouse pointer’s tip to help you 

place it accurately. If you see a group in the view and want 

to place another just like it, you can also take advantage of 

the Create Similar tool via the context (right-click) menu  

or via the Create Similar button on the Modify tab 

that appears when you select the existing group.

The third option listed under the Model Group 

tool—Load As Group Into Open Projects—is a bit 

obscure. This tool is intended to provide a way to cre-

ate repetitive design elements outside the project in a 

separate project file, each in its own “sandbox” so to 

speak. Let’s say you created a design for a typical hotel 

room in a separate project file. You use this option 

to place this new design in the hotel building project file, but instead of individual ele-

ments, it is created as a group that can be placed repeatedly. It can be edited externally and 

reloaded, and it can be edited locally, choosing to abandon the external original. It can 

also be altered internally and then saved to a separate file. 

Special Changes to a Group
Earlier we described the simple add and remove functions for editing a group. Two addi-

tional features, called Exclude and Move To Project, provide a different kind of control 

over the elements of a group.

Using the Exclude Tool
The Exclude feature allows you to create a complete assembly that represents the worst/

best-case scenario of a design. Take a classroom, for example. You can create a desk and 

chair arrangement that satisfies all but a few room conditions. For the few rooms where a 

desk or chair won’t work, you can use the Exclude Elements feature to remove them from 

a specific group instance or groups. These excluded elements won’t appear in the model 

or be included in schedules.

To exclude elements, you first need to select the element (or elements) you want to 

exclude. To do this, place your mouse pointer over it and press the Tab key to cause Revit 

to highlight it apart from the rest of the group. An icon appears to 

let you quickly exclude elements. You can also use the context (right-

click) menu, as shown in Figure 8.9.

Figure 8.7

Model Group  
button tools

Figure 8.8

Context menu’s Cre-
ate Instance option

Figure 8.9

Context menu’s 
Exclude option
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When your project is using worksets and you select a group or single element, Revit 

displays the Make Element Editable icon instead. You need to click that to borrow the ele-

ment so you can see and then click the Exclude icon. It is a little faster to just make your 

selection and use the context menu instead; just choose Exclude. It’s faster because Revit 

will also make the elements editable for you. This is particularly useful when you have 

multiple elements selected.

Once an element is excluded, it is easy to restore it. Just hover over the location where 

an element used to be, and you’ll see that it highlights as if it were still there (it is still 

there technically). You need to use the Tab key to select 

it and then click the Icon that appears. Alternatively, 

you can use the same context (right-click) menu tech-

nique to access Restore Excluded Member. The icon 

and the context menu are both visible in Figure 8.10.

Using Move to Project
As you work with groups and the project’s design evolves, it wouldn’t be surprising to 

us if you decide that something doesn’t belong in a particular group instance. Move To 

Project is available only from the context (right-click) menu (Figure 8.11). To move ele-

ments out of a group instance and into the project, hover over the element and use the 

Tab key to highlight it. Right-click and select Move To Project. The selected element(s) 

are still part of the group instance but are excluded. Revit adds a new entity in the same 

place that is not part of the group; it has been moved to 

the project. This allows you to deal with some variation 

by changing this new element. If you choose to abandon 

the change later, the group still has the original member, 

and you can use the Restore Excluded Member tool. 

Other copies of the group are unaffected by the action.

Removing Elements
As you work on your project and remove elements from groups, there are two more ques-

tions to consider. Do you want to remove the element from just the group, or do you want 

to remove the element from the group and the project too?

Removing an element from the group  ​This isn’t a named tool; it’s a desired result. In this 

case, you don’t want the element in the group, but you do want to keep it in the project 

and even in its current location. To accomplish this, you need to edit the group, use 

Remove, and then finish the group. The element will remain in place, but it is no longer 

part of the group’s definition (refer to Figure 8.12).

Removing an element from the group and the project  ​This means you don’t want the ele-

ment at all, not in the group and not in its current location as part of the project, outside 

Figure 8.10

Restore Excluded 
Member context 

menu choice

Figure 8.11

Context menu’s 
Move To Project



Special Changes to a Group  ■   241

of the group. This has nothing to do with removing it from other locations in the project 

that are not using groups, only in the context of a group and the elements it contains. 

To take this approach, you need to edit the group, select the element(s), and use Delete 

instead. This will remove the element from the group as well as in any other copies of the 

group. The element is also no longer present in the model either (refer to Figure 8.13).

Figure 8.12

The chair is 
removed from the 
group but still part 
of the project.

Figure 8.13

The chair is 
removed from all 
groups and not 
present in the proj-
ect; independent 
chairs are still part 
of the project.
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Saving, Loading, and Reloading Groups
Groups are defi ned inside a project fi le, and most are created within the context of your 

active project. As mentioned earlier, it is possible to create a group in a separate project 

fi le and then load it into a project to use as needed. You can choose to save a group to an 

external fi le so that it can be altered by someone else or shared with another project. If you 

work on a group outside the project in its own fi le (it also uses the RVT fi le format), you 

can load and, if necessary, reload it into your project. These three concepts are called sav-

ing, loading as a group, and reloading.

Saving  The Save feature will save a group as a Revit project fi le (.rvt). This will allow you 

to share it with other projects and to edit the group in its own fi le. The fi le will not be a 

group or require you to edit a group as you would in the project it came from. The pri-

mary method to save a group is found on the application menu; select Save As ➔ Library ➔ 

Group. If you prefer the context menu, right-click the group name in the Project Browser 

instead and choose Save Group (refer to Figure 8.14).

Revit will choose to use the group’s name as the name for 

the new RVT fi le. In fact, the value you’ll see for File Name 

in the Save Group dialog box is Same As Group Name. You 

can browse through the groups listed in the Group To Save 

drop-down. If you have attached details associated 

with your group, the check box for Include Attached 

Detail Groups As Views will generate a view that can 

show them when the new project fi le is created. This 

is subtle but necessary since attached details are vis-

ible only in the views you intentionally add them to.

You will briefl y see the group open in a view but close 

quickly as Revit creates the new fi le from the group, 

opens it, and then fi nishes the process with a save and close. If you want to work on the 

group or let someone else know it is ready, you just need to open the fi le like any other 

project fi le.

Loading  The Load feature starts with the Load From Library panel on the Insert tab 

on the ribbon. Click the Load As Group button to open the Load File As Group dialog 

box. You need to browse to the folder in which your project fi le (group) is located. Three 

options—Include Attached Details, Include Levels, and Include Grids—are displayed as 

check boxes to use if necessary. Assuming this external fi le is meant to be subservient to 

the project fi le you are loading it into, the Include Levels and Include Grids options are 

probably not necessary. It makes sense to include attached details if there are any.

If you use this feature to load a fi le that is already in your project fi le, you’ll get a warning 

message (see Figure 8.15). Revit is just trying to protect your existing work. You may also 

Figure 8.14

Context menu 
technique to save 

a group

Revit will choose to use the group’s name as the name for 

the new RVT fi le. In fact, the value you’ll see for File Name 

in the Save Group dialog box is Same As Group Name. You 

can browse through the groups listed in the Group To Save 
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see a message about duplicate types. This means that you have content in the external file 

that is using the same family name and type names. Revit will just reuse those that are 

already in the current project in order  

to protect them from any differences that  

may exist in the external file.

Reloading  ​Maybe it is obvious, but 

you can reload a file using the previous 

feature if you just select a file that you 

previously saved as a group. There is 

also a deliberate method available when 

you use the context menu on the group name in the Project Browser. Keep in mind that 

reloading a group will generate similar warning messages, as mentioned in the previous 

section.

Linking  ​You use the Link tool when you decide that an external linked file will serve your 

needs better than a group. Groups provide a higher level of interaction between walls that 

are and are not part of the group than linked files. With groups, put more simply, walls 

clean up with other walls and look better. This means that performance can suffer. If this 

kind of issue isn’t as important to you, then a linked file might be a better choice.

When you select a group, you’ll find 

that the Link button will appear on the 

contextual tab Modify | Model Groups 

on the ribbon. It is on the Group panel. 

When you click Link, Revit will dis-

play the Convert To Link dialog box, 

as shown in Figure 8.16. You have two 

choices: Replace With a New Project 

File and Replace With an Existing 

Project File. The first choice is similar 

to Save As Group because you have to create a file to use as  

your link. If you already saved a group as a file, then you can  

use the second choice. You do have a third choice; you can  

choose to cancel.

After Revit completes the command, you’ll find that the 

group you selected to create the link has been replaced with 

a linked file instead. The Project Browser will show a linked 

file, as shown in Figure 8.17. It is important to understand 

that only the selected group(s) will be replaced with the 

linked file. You’ll have to remove and replace the other groups 

Figure 8.15

Warning about 
duplicate types

Figure 8.16

The Convert To Link 
dialog box

Figure 8.17

Project Browser lists 
a linked file now.
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or use the Link tool on them as well; then you repeat the command but use the second 

choice to replace with an existing project file (the one you already used/created).

Bind  ​The Bind tool allows you to reverse a decision to create a link from a group, by let-

ting you turn the link back into a group instead. It also allows you to choose to convert 

a linked file into a group even if you didn’t use the Link tool before. The process starts 

with the selection of a linked file. When you have at least one linked file selected, you’ll 

find the Bind Link button on the ribbon’s Link panel. Revit displays the Bind Link 

Options dialog box (see Figure 8.18) to let you define how the link should be reassembled 

into a group. If you happen to choose a link that shares its name with a group already, 

then you’ll encounter the Duplicate Group Names dialog box, as shown in Figure 8.19. 

If you bind all of the linked files, you’ll get another message asking whether you want 

to remove the link completely or keep it around, just in case you need it again later (see 

Figure 8.20).

Practical Considerations
In past years and versions, seasoned users habitually avoided the group feature because 

it was often either unreliable or too quirky. This was unfortunate. In recent releases, the 

Revit product team has devoted quite a bit of research and effort to rectify this situation. 

Groups are still a bit quirky, and this section delves into some slightly arcane things you 

should know.

Figure 8.18

Bind Link Options dialog box

Figure 8.19

Warning about duplicate group names

Figure 8.20

Warning that all 
instances of linked 

file have been 
removed



Practical Considerations  ■   245

Getting Rid of a Group
If you use groups, it is pretty likely that eventually you’ll decide that you don’t need one 

anymore. At the very least, you’ll decide that you don’t need one in a specific location. 

You can ungroup and delete a group. In each case, you affect only the selected group or 

groups. If you want to completely eliminate a group, select it in the Project Browser and 

use the context menu option Select All Instances ➔ In the Project; then either press the 

Delete key or click the Delete button on the ribbon. When there are no more groups of 

that type present in the model, you find that selecting the group in the Project Browser 

and using the context menu again will provide the option to delete the group. This will 

eliminate it from the project completely. Any unused groups should be removed to reduce 

their impact on the project file size and performance.

Keep in mind that the Purge Unused tool can help remove unused groups quickly. Just make 

sure you click the Uncheck All button before you cavalierly use Purge Unused. If something 

isn’t used now, it doesn’t mean that you won’t want to use it later. Too often users purge 

things they don’t realize they’ll need sooner rather than later.

Complexity
As with anything, the more complicated you choose to make something, the more dif-

ficult it becomes for all concerned, including Revit. A group that includes everything 

on an entire floor of your building is much more likely to become a problem for you 

and the project team than more discreet groups used to compile the same entire floor’s 

design. Seek to build smaller reusable groups that focus on the aspect of the design that 

really differentiates one solution from another. For example, a multifamily apartment 

project might have a pretty consistent unit design, while the kitchen and bathroom con-

figurations are where variety becomes apparent. The units might be best described using 

groups that don’t include the bathroom and kitchen elements. Use additional groups for 

the bathroom and kitchen concepts. This means a bit more planning, but the groups will 

be much more likely to work well for you.

Nesting
You might consider rereading the previous section about complexity; nevertheless, the 

fact remains that you can nest one group inside another. This approach to using groups 

provides yet another way to manage repetition despite the obvious complexity it implies. 

A hotel room unit plan can include a nested group for the bathroom configuration. One 

designer can adjust the bathroom group design while another is focused on some other 

aspect of the room or project. The nested group is still altered by editing the original 

either within the host or where it is placed elsewhere on its own.
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Mirroring
Mirroring groups isn’t recommended. Model groups are fairly tolerant when you mirror 

them. Attached Detail groups, however, aren’t very stable when applied to a mirrored 

group. In particular, dimensions may not reference the same part of an element or gener-

ate error messages. Mirroring some model elements in the group may not be appropriate; 

for example, furniture, equipment, or plumbing fixtures may have specific right or left 

versions. It is more predictable to create a mirrored version to ensure that groups are as 

effective as possible.

Worksharing
When you create a group that has elements assigned to more than one workset, Revit will 

reassign them to the active workset. For this reason, it is a good habit to establish a group 

workset or worksets to help manage them apart from other workset items. If you choose 

to use Ungroup later, the elements will remain assigned to the workset to which the group 

was assigned.

Level to Level
Groups don’t tolerate different floor-to-floor elevation changes well. It isn’t a good idea 

to constrain walls to a Top Level setting other than Unconnected. If you choose to do 

so, Revit won’t object until a level elevation changes, and you’ll 

be presented with a fairly scary dialog box, shown in Figure 8.21. 

Your choices at this point are Fix Groups and Cancel. Choosing Fix 

Groups will present you with another dialog box (Figure 8.22). You 

can choose to ungroup the inconsistent groups, create new group 

types, or cancel.

The Ungroup choice defeats the purpose of using the group 

in the first place. The second choice, creating a new group 

based on the variance Revit is concerned with, at least provides 

a solution that lets you continue to use groups. The last choice, 

canceling, means you’ve let Revit scare you away for now.

File Size
File size is a bit of a distraction. People tend to get overly con-

cerned about Revit files when compared with other CAD files 

because by comparison they seem much bigger. In a simple experiment, we created two 

separate files that had just four walls in each, and we eliminated everything else Revit 

would let us remove by using the Purge Unused tool. The first file with four walls came 

in at 696 KB. We created a total of 10 sets of four walls for a total of 40 walls, and this file 

came in at 744 KB, an increase of 48 KB.

Figure 8.21
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Figure 8.22
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dialog box
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For groups we used another set of four walls that we used to create a group. This file 

came in at 720 KB. This resulted in a difference of 24 KB to create and have one instance 

of a group. We created nine more instances of the group to replicate the same 40 walls we 

used in the file without groups. The resulting file with 10 instances of one group to reach 

the same total of 40 walls came in at 748 KB, just 4 KB larger than the file with the same 

number of walls but no groups.

Even placing 90 more copies of the group for a total of 400 walls increased the file size 

only by 356 KB (file size 1104 KB). This translates to a little less than 1 KB for each wall. 

Our conclusion is that file size isn’t as serious a concern with groups as is the way that 

Revit ponders the existence of a group when elements are changed.

Revit must evaluate all the instances of a group whenever an element that touches a 

single instance of the group is altered. Changing a single wall that touches a member of a 

group will likely take longer to process than for relationships that don’t involve a group. 

This isn’t an argument to cast groups aside. It is something to consider as you choose to 

take advantage of groups.
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Rendering

There are several  points in your project when you will want to represent 

your building model with real-world materials, texture, and lighting. To do this in Revit, 

you are going to create renderings from your 3D views. The Revit platform uses the men-

tal ray render engine as a renderer, which in turn allows you to create realistic renderings 

from within the software. This chapter will cover how you can generate images directly 

within Revit. This allows you to keep working on the design while you create presenta-

tion images for your clients.

Rendering can be a very complicated and time-consuming process because you 

want to develop an image that is visually accurate and appealing. It is not uncommon 

for firms to employ visualization experts that utilize a toolbox full of tools to produce 

photorealistic renderings. In this chapter, the objective is to provide an overview of the 

tools to enable you to produce appealing images.

In this chapter, we will cover the following:

Rendering workflow■■

Setting the background■■

Adding and adjusting material■■

Real-time rendering■■
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Rendering Workflow
Rendering can be a complicated and time-consuming task. How you approach this pro-

cess can either reduce or increase your rendering tasks and efforts. When creating ren-

derings, the general workflow is as follows:

	 1.	 Create and position cameras.

	 2.	 Add and adjust lights.

	 3.	 Add and adjust materials.

	 4.	 Add entourage.

During this process, there are some general guidelines to follow to facilitate rendering:

L ights   

Turn off lights you are not using. This will speed up the rendering process.•	

G eometry    

To create a rendering, you need to be in a 3D view.•	

Crop the 3D view to show only what you need to see. The more elements that are  •	

displayed, the more elements that have to be processed.

Adding entourage such as people, trees, and so on, can improve the appearance of  •	

a rendering.

M aterials     

Materials need to be applied to all surfaces.•	

R endering      

To test lighting, materials, exposure, and so on, use the Region option. This renders a •	

small area rather than your entire view.

Use the Draft render option to quickly create test renderings.•	

Consider the resolution of your output. If you are printing to a 300 dpi printer, ren-•	

dering to a file at 600 dpi requires more time with no improvements in print quality.

Adding entourage is a very straightforward process just like adding doors, walls, and so on. 

As a result, this book does not cover adding individual entourage elements.

Exterior Rendering: Day
In this next section, you will create an exterior rendering. You will do this by creating 

and positioning a camera, cropping a view, and adjusting the rendering settings. Exterior 

renderings are generally easier and faster to create, so that’s a good starting place. 
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Exterior renderings are generally simpler because you are working with only one light. 

The following exercise will walk you through a simplified process for rendering:

	 1.	 Open the source file rac_basic_sample_project.rvt, which was installed with Revit 

Architecture 2011 and can be found in c:\Program Files\Autodesk\Revit Architecture  

201\Program\Samples. You are using this model because it has materials assigned and 

will give you an opportunity to explore the rendering settings rather than focusing 

on the model geometry.

	 2.	 Save the file as Rendering09.rvt.

	 3.	 The Site floor plan has the crop region enabled, which will make placing the camera 

more difficult. You need to turn it off for camera placement. In the Properties palette, 

scroll down to the Extents section, and deselect the Crop View check box.

	 4.	 The next step is to create a 3D view for your rendering. 

You can use a default 3D view or create a perspective 

(camera) view. Switch to the Site floor plan view.

	 5.	 On the View tab’s Create panel, click the 3D View 

drop-down, and select Camera (Figure 9.1).

	 6.	 Using Figure 9.2 as a reference, click to place the camera 

location or where you would be standing. Then click to 

place the target location or where you would be looking.

With the camera placed, a new 3D view is created. In 

your view, use the blue dots on the crop region to dis-

play only the model geometry, similar to what’s shown 

in Figure 9.3. You want to make sure that you minimize 

as much of the view as possible because the image size 

and/or resolution of a rendered image has a predictable 

effect on render time. Now that you have your view cre-

ated, let’s jump right in.

	 7.	 On the View tab’s Graphics panel, click Render. This 

opens the Rendering dialog box (Figure 9.4). Another 

way you can start the render process is by clicking the 

Rendering icon (teapot) on the View Control bar.

	 8.	 Make sure the Lighting Scheme drop-down is  

set to Exterior: Sun Only.

	 9.	 To the right of the Sun Setting field, click the Browse button. This will open the Sun 

Settings dialog box.

	10.	 In the Sun Settings dialog box, set the Solar Study radio button to Single Day, as 

shown in Figure 9.5.

Figure 9.1

3D View drop-
down with Camera 
selected

Figure 9.2

Locating the camera 
and target locations

Target location

Camera location
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	11.	 For Presets, click <In-session, Single Day>.

	12.	 Click the Browse button to the right of the location. This will take you to the Loca-

tion Weather And Site dialog box. Set the Define Location By option to Default City 

List, and then set City to Orlando, FL (Figure 9.6). Click OK to close this dialog box.
Figure 9.3

Camera view of the 
sample project

Figure 9.4

The Rendering  
dialog box

Figure 9.5

Sun Settings dialog box

Figure 9.6

Location Weather And Site dialog box
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	13.	 Back in the Sun Settings dialog box, set Date to 6/1/2010 and set Time to 10:00 AM 

and 4:00 PM. Select the Ground Plane At Level check box, and set the level to Level 1.

	14.	 Click the Save Settings button and name the settings Orlando, Fl 6.01.10, 10am.

	15.	 Click OK to close the Sun Settings dialog box.

The Quality drop-down is where you will determine the actual quality of your render-

ing. The lower you set the quality, the faster the rendering is produced. Revit provides 

seven preset options for quality, as described in Table 9.1. These preset options dictate 

how good the quality of your rendering will be and how long it will take to render. A 

number of factors will determine the quality of your renderings, including lighting, 

materials, and the selected render quality settings. Generally speaking, images that will 

be presented to clients will generally be rendered at a medium level or higher. Draft and 

low settings are more ideally suited to provide a quick check of the lighting, materials, 

and overall composition of the scene before rendering at a higher setting. The Region 

check box above the Quality drop-down is used to specifically render a user-defined sec-

tion of the scene. Use this when you want to check an area of the scene with a Best or 

better quality setting to check the scene lighting or a material more accurately without 

having to render the entire scene.

Q u a l it  y R e l a ti  v e  

R e nd  e r in  g  S p e e d

D e s c r i p ti  o n 

Draft Fastest Poorest quality, fastest rendering. Many artifacts. Used for test-
ing settings and to get the general idea of what the image will 
look like.

Low Fast Better quality than Draft with fewer artifacts. 
Medium Medium Normally provides an image that can be used in presentations. 

Image quality can still be improved upon.
High Slow Render quality can be used for presentation. Very few artifacts. 

Slow.
Best Slowest High-quality images with minimal artifacts. Slowest render-

ing times.
Custom Varies Uses settings specified by the user in the Render Quality Set-

tings dialog box. Render times will vary depending on the 
custom settings.

Edit Varies Allows you to define a new view-specific custom rendering 
settings.

Changing the rendering quality settings to a higher level does not necessarily mean a 

higher-quality image. As you are trying to refine your render settings, utilize lower render 

quality settings, or create a region when using a higher Quality setting. Each time you 

increase the render quality one level, you increase the rendering time two, three, or even 

four times. It is recommended that you use a combination of the Draft and Region check 

boxes until you are ready for your final renderings.

Table 9.1

Render quality  
settings
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Render Quality Settings

One of the nice features of rendering in Revit is that you do not need to perform a 

great deal of customization in order to get good-quality renderings. When setting the 

render quality settings, you also need to think about the image output and resolution 

(Figure 9.7). As we previously discussed, an image can be simply saved to the project and 

can be rendered to a specific resolution. Keep in mind that the 

image size or resolution setting has a predictable effect on the 

rendering time. Generally speaking, if you double the image 

resolution from 150 dpi (dots per inch) to 300 dpi without 

changing any other setting, the average render time increases 

2.7 times. Double the resolution again, from 150 dpi to 600 dpi, and the average render 

time is increased by 2.7 × 2.7 times, or about 7.3 times. When defining the view area to 

render, it is also important to check the image size. Usually, the larger the image area, the 

slower the rendering.

Under Output Settings, for Resolution you have two options:

Screen  ​When this option is selected, Revit will calculate the screen resolution based upon 

the defined view area to render. It will include the width and height in pixels as well as in 

an uncompressed image file size.

Printer  ​When this option is selected, the user is required to specify the dpi to use when 

printing the image. It will include the image width and height as well as the uncom-

pressed image file size.

In the next few steps, you will adjust the exposure control settings. As you would do in 

photography, you will have to control your exposure in your renderings. Elements such as 

exposure value and saturation can be controlled. Table 9.2 describes the exposure control 

settings.

S e ttin    g D e s c r i p ti  o n

Exposure Value Overall brightness of the image. Values can be set between –6 (brighter) and 16 (darker).
Highlights Controls the level of the highlights (brightest area) in the image.
Mid Tones Controls the level of the midtone (between highlights and shadows) in the image.
Shadows Controls the level of the shadows (darkest area) in the image.
White Point Controls the temperature of the image. You can make the image look warmer (more 

orange) or colder (more blue).
Saturation Allows you to increase or decrease the intensity of the colors.

Now let’s further refine the rendering.

	16.	 In the Rendering dialog box, click the Adjust Exposure button.

	17.	 Set the Adjust Exposure dialog box as follows:

Exposure 14
White Point 7000
Saturation 1.25
Shadows 0.4

Figure 9.7

Rendered image 
output settings

Table 9.2

Exposure  
control settings 
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	18.	 Click OK to close the Adjust Exposure dialog box.

	19.	 Deselect Region in the Rendering dialog box, and change the Setting list under Qual-

ity to High.

	20.	 Click Render to see your final image (Figure 9.8).

Exposure settings are very touchy. A small change can result in major changes in your 

rendering.

Now that you have a nice rendering, Revit provides you with two options for saving 

your image, which can be found in the Image section of the Rendering dialog box:

Save to Project  ​Save the image in a project view. Rendered images will be displayed in the 

Project Browser under Views (All) ➔Renderings.

Export  ​Save the image to a file. Revit can save the file to the following formats: BMP, JPEG, 

JPG, PNG, and TIFF.

To save a rendered image as a project view, in the Rendering dialog box, click Save To 

Project in the Image section. In the Save To Project dialog box, enter a name for the ren-

dered view, and click OK. The rendered imaged can now be dropped onto a sheet.

To save a rendered image to a file, follow these steps:

	 1.	 In the Rendering dialog box, click Export in the Image section.

	 2.	 In the Save Image dialog box, for the Save In location, navigate to the desired location 

where you want to store the save rendered image.

	 3.	 For Filename, enter the name of the image file.

	 4.	 Click Save.

Figure 9.8

Finished rendering
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Lighting
Lighting is an important factor in bringing your design to life. Revit allows you to create 

lights that mimic natural light, artificial light, or both, to illuminate the project. Revit 

provides three main light types that you can draw upon:

Sun System lights  ​Natural light. Sun System lights allow you to specify the position of 

the sun. You can use this for your sun paths, solar studies, walk-throughs, and rendered 

images. 

Standard lights  ​Artificial light. Standard lights create artificial light that has a uniform 

displacement and intensity when cast from the fixture. The light source in the lighting 

fixture family is defined in the Family Editor. (Lighting families are not covered in  

this book.)

Photometric lights  ​Artificial light that mimics natural light. Photometric lights utilize 

real-world data to control the lighting parameters such as hotspot, falloff, and so on, 

rather than just having light coming out at the same intensity. The light source in the 

lighting fixture family is defined in the Family Editor and is not covered in this text.

Light families that were created in a previous version of Revit (pre 2009) will need to be man-

ually upgraded. Open these fixtures in the Family Editor and then load them into Revit.

When setting up lights within a project for rendering, it can be very useful to see the 

pattern of light for each light source in the view. By default, light sources are not dis-

played in the view (Figure 9.9). To display light sources, you need to open the Visibility/

Graphic Overrides dialog box. In the Model Categories tab’s Lighting Fixtures category, 

select the Light Source check box (Figure 9.10). Just like other model categories, you 

change the displayed color or the light sources within the Object Styles dialog box. 

Clicking OK to close the Visibility/Graphic Overrides dialog box will cause the light 

sources to be displayed (Figure 9.11).
Figure 9.9

Light sources not 
shown in the view



Rendering Workflow  ■   257

We have already touched on a few of the settings in the Rendering dialog box for light-

ing, and we will go into a little more detail here. When setting up your rendering options, 

the first step is to choose between Exterior and Interior 

schemes. With each scheme, you can pick from three options 

(Figure 9.12):

Sun Only•	

Sun And Artificial•	

Artificial Only (When this option is selected, Revit will calculate only the lights that •	

are included in the selected option.)

Figure 9.10

Visibility/Graphics 
Overrides dialog 
box with light 
sources enabled

Figure 9.11

Light sources  
shown in the view

Figure 9.12

Lighting  
Scheme options
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If you choose a scheme that uses the sun, you can then access the Sun Settings dialog 

box (Figure 9.13) by clicking the Browse button  to the right of Sun Setting.

Grouping Lights

When you are rendering, Revit will calculate lighting for every light source you have in 

your project, regardless of the location. For that reason, you want to use the Artificial 

Lights dialog box to manage your individual lights. Depending on 

the number of lights in your project, this can dramatically improve 

your lighting performance.

The Artificial Lights dialog box (Figure 9.14) is broken up into 

two areas. The left side of the dialog box lists all the lights in the 

project. In this list, you can control what lights are on and off and 

control the dimming of the lights. The right side contains two 

groups: Fixture Options to add or remove lights to a group and 

Group Options for creating and managing groups.

As you can see in Figure 9.14, you have several lights throughout 

the project. You need to organize these lights in order to improve 

rendering performance and better manage your scenes. In the 

following steps, you will walk through creating the three new 

groups—Kitchen Strip Lights, Kitchen Can Lights, Bedroom Lights—and then you will 

move your light fixtures into these groups.

	 1.	 In the Rendering dialog box, click the Artificial Lights button. If the Artificial Lights 

button is grayed out, then your lighting scheme does not include artificial lights.

	 2.	 In the Artificial Lights dialog box, click New under Group Options to create a new 

group.

	 3.	 Name the group Kitchen Recessed Lights.

	 4.	 Repeat steps 2 and 3 to create groups for Kitchen Can Lights and Bedroom Lights.

Figure 9.13

Sun Settings  
dialog box

Figure 9.14

Artificial Lights  
dialog box
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Now that you have created your groups, you can start moving the ungrouped lights 

into their respective groups:

 1. Open a project view that displays the light fixtures you want to assign to a light 

group. This is typically going to be a plan view. The 3D perspective view will not 

work for this operation.

 2. Select the light fixtures.

 3. On the Options bar (Figure 9.15), set Light Group to the desired group to move the 

selected lights into.

 4. Revit will then prompt you with a dialog box let-

ting you know that “You are about to move all 

selected lights into a new light group: Light Group 

Name.” At the prompt, click OK to move the lights.

To remove lights from a light group, with the lights selected, select None on the Options 

bar for Light Group. At the prompt, click OK.

Another method for adding and removing lights to a light group is using the Artifi cial 

Lights button in the Rendering dialog box while in a 3D view.

 1. In the Artificial Lights dialog box, select the lighting fixtures under Ungrouped Lights.

 2. In the Fixture Options section, click Move To Group.

 3. In the Lights Group dialog box, select the light group where you want to place the lights.

 4. At the prompt, click OK to move the lights.

The main drawback to using this method is you may not be able to determine which 

light you are selecting. For example, in Figure 9.14, lights numbered 24 through 27 are 

table lamps used in several different rooms. Although you have a light name, you do not 

know the location. So if you are trying to complete a rendering in one room, you may 

inadvertently place a light in the wrong light group. To remove lights from a light group, 

you follow the same steps but choose lights from the Grouped Lights list and then click 

Remove From Group.

The fi nal way you can add or remove light in 

a light group is by using the Light Group Editor. 

In a project view (such as a refl ected ceiling plan), select the light fi x-

ture. Then, on the Options bar, set Light Group to Edit (Figure 9.16).

If you select a light that is not part of a light group, then the Edit button  will not 

be available. You can, however, add that light into a light group.

If you select multiple lights that are part of different light groups, then the Edit button 

will not be available. You will have to edit your selection set to only select lights in a com-

mon light group.

Figure 9.15

When light fixtures 
are selected, the 
Options bar pro-
vides a method to 
assign them to a 
light group.

Figure 9.16

Reflected ceiling 
plan in Light Group: 
Edit mode

In a project view (such as a refl ected ceiling plan), select the light fi x-
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Editing Lights in Groups

Once Revit is in the Light Group: Edit mode, the Light Group panel (Figure 9.17) is active 

and will appear below the Options bar.

Light fixtures that are not assigned to a light group display normally.•	

Light fixtures that are associated with the active light group are displayed in green.•	

Light fixtures that belong in another light group and model elements are displayed  •	

at halftone.

To add light fixtures to a group, click the Add button in the Light Group panel. Select 

each light fixture that you want to add to the group. When you select and add a light 

fixture, Revit will display that fixture as green, indicating that it has been added to the 

group. To remove a fixture from a group, click the Remove button, select the fixture or 

fixtures, and then click Finish.

If necessary, you can open other project views to add or remove light fixtures to light groups.

Using Groups to Control Lights

Now that you have created your light groups, you have the ability to more efficiently 

manage your lights. In the next example, we will demonstrate how to turn on and  

off lights.

Figure 9.18 shows the 3D scene and the Artificial Lights dialog box. The arrows indi-

cate which lights are assigned to which light group. If you want to turn off a group of 

lights, you simply need to deselect the check box next to the group name. Selecting the 

check box turns the lights on. If you want to turn individual lights on or off, then dese-

lecting or selecting the check box will accomplish that.

Figure 9.17

When editing a 
light group, use the 
Light Group panel’s 

floating toolbar 
to add or remove 

lights from the light 
group.

Figure 9.18

Artificial Lights  
dialog box
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The next option to the right of the light name is the Dimming field. You are able to 

enter a value between 0 and 1 to indicate the amount of dimming. A value of 1 means 

that the light is on with no dimming. A value of 0 means that the light is completely off.

Setting the Background
You are almost done. You need to review and adjust a few more settings in the Rendering 

dialog box, so let’s look at the Background option. One of the new features in Revit 2011 

is the ability to render with a background image. This allows you to create a custom 

background. In this section, we will discuss how you can control the background of your 

rendering. 

To define a custom background, from the View tab’s 

Render panel, click the Style pull-down in the Background 

section. You have three options styles for creating a back-

ground (Figure 9.19):

Sky  ​When using a sky, you can select several options from 

the pull-down. Then you can adjust the Haze level with the slider. Sky options are based 

on actual colors that are physically correct. When the scene time (2 PM, 8 PM, 3 AM) 

changes, the sky color will change to accurately reflect the sky conditions at that time of 

the day. Figure 9.20 shows a rendering using the Sky: Few Clouds option.

Color  ​You can also use a simple color as the background. Click the color swatch to select 

a different color. Figure 9.21 shows a rendering using the color option.

Figure 9.19

Background  
Style options

Figure 9.20

Rendered image 
using the Sky: Few 
Clouds option
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Image  ​The last option is to specify an image. You will need to select a .bmp, .jpg, .png, or 

.tiff file. After selecting the image, you will be able to adjust the image scale and the off-

set. Figure 9.22 shows a rendering using an image of a sky background.

To specify an image for the background, in the Rendering dialog box, set Style 

under Background to Image (Figure 9.19). Click the Customize Image button. In the 

Background Image dialog box, click the Image button (Figure 9.23). Navigate to the loca-

tion where you store your image file, select the image, and click Open. In the Background 

Image dialog box, specify the scale and offset, and click OK.

With the background settings, you can quickly and easily add a custom background to 

your rendered image.

Figure 9.21

Rendered image 
using the Color 

option

Figure 9.22

Rendered image using the Image option

Figure 9.23

Background Image dialog box
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Adding and Adjusting Material
With your lights set, you can now move to adjusting materials, the third phase in your 

rendering workflow. Revit ships with a library of materials specifically for creating archi-

tectural renderings. You can also modify this library to create new materials to meet your 

specific project needs. Materials are what you use to define the appearance and character-

istics of your model. You use materials to define the following:

Color that displays in a shaded project view•	

Color and pattern that displays on the surface of an element•	

Color and fill pattern that displays when the element is cut•	

Render appearance that displays in a rendered image and in a realistic view•	

Data about the materials description, manufacturer, cost, and keynotes•	

Structural information about the material•	

Revit provides several different methods for applying materials to building elements. 

Materials can be assigned to Revit elements as type or instance properties when you 

place them in your building project or when you are creating or editing families. Some 

elements such as walls, floors, and ceilings need to have materials applied when you are 

defining the layers of those assemblies. 

Before you get into placing or replacing materials in your building project, let’s 

explore the Materials dialog box. To open the Materials dialog box (Figure 9.24), click the 

Materials button on the Manage tab’s Settings panel.
Figure 9.24

Materials dialog box
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The Materials dialog box provides you with the means to search your current materi-

als and to create and edit existing materials. The materials included in Revit are based 

upon the ProMaterials library from mental ray. The dialog box is broken up into two 

main parts. The left side allows you to search, create, rename, and delete materials. To 

search for materials by name, use the search field at the top. The right side allows you to 

define shader rules and settings that define a specific material. This is broken up into four 

tabs and includes graphic properties, rendering appearance properties, identity values, 

and physical characteristics.

As you define new materials in Revit, you will notice that the shader rules and settings 

can vary depending on the type of material you are trying to define. Figure 9.25 shows 

the Render Appearance settings for Stainless Steel and Concrete.

To assign or replace a material in your project, the first thing to do is search the exist-

ing library to see whether you are lucky enough to find a material that will suit your 

needs. Although there is a large collections of materials to choose from, chances are you 

are going to have to modify or create new materials in your project. The next steps will 

walk you through the process of modifying/creating a new material. In the following 

example, you are going to create a new teak wood material:

	 1.	 On the Manage tab’s Settings panel, click Materials.

	 2.	 From the list on the left side of the dialog box, select the Wood – Cherry material.

	 3.	 At the bottom left side, click the Duplicate button .

	 4.	 Revit will display a dialog box asking you to provide a new material name. Enter 

Wood – Teak, and click OK.

	 5.	 On the left side of the dialog box, select the new Wood – Teak material.

Figure 9.25

Render Appearance 
settings for Stain-

less Steel (left) and 
Concrete (right)
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	 6.	 On the right side of the dialog box, click  

the Render Appearance tab (Figure 9.26).  

You are not going to make any changes at  

this time on the Graphics tab.

In the Render Appearance dialog box, 

Revit is reporting that the Wood – Teak 

material has a Render Appearance Based 

On: Cherry – Solid Stained Light No Gloss. 

Because you are trying to create a teak 

wood material, you need to change this.

	 7.	 Click the Replace button. This takes you 

to the Render Appearance Library dialog 

box (Figure 9.27).

	 8.	 On the left side of the Render Appearance Library dialog box, select the Wood Cat-

egory. On the right side, select the material Teak – Natural Polished. Click OK to 

return to the Materials dialog box.

	 9.	 If you click the Swatch Shape drop-down (Figure 9.28), you are able to change the 

scene in which the material will be previewed on the Render Appearance tab.

	10.	 Click OK to close the Materials dialog box.

Figure 9.26

Render Appearance 
tab for the newly 
created Wood – 
Teak material

Figure 9.27

The Render Appear-
ance Library dialog 
box displays the 
predefined  
ProMaterials that 
ship with Revit.
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Swatch Shape changer 
drop-down button

Assigning a Material to an Element
Now that you have created a new material, you need to assign it to an element in your 

model. In the sample project file, you will assign the newly created Wood – Teak material 

to the countertop located in the kitchen.

	 1.	 Open the source file rac_basic_sample_project.rvt, which you can find in c:\Program 

Files\Autodesk\Revit Architecture 201\

Program\Samples (was installed with Revit 

Architecture 2011).

	 2.	 Save the file as materials.rvt.

	 3.	 Switch to the Level 2 floor plan view.

	 4.	 Zoom into the kitchen area in the center 

of the building.

	 5.	 Select the Table-Dining CUSTOM table. 

If you are having trouble selecting the 

countertop, remember to use the Tab key 

to cycle through the elements your cursor 

is hovering over.

	 6.	 On the Properties palette, select Edit Type.

	 7.	 In the Type Properties dialog box  

(Figure 9.29), go to the Materials And 

Finishes section, and click the Browse 

button for Top Material. This will take  

you to the Materials dialog box.

Figure 9.28

Swatch Shape  
drop-down

Figure 9.29

Click Browse to choose a new countertop  
material
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 8. In the Materials dialog box, scroll or search for the material Wood Teak, and select it.

 9. Click OK to close the Materials dialog box. Notice that the countertop material has 

been changed to Wood – Teak.

 10. Click OK to close the Type Properties dialog box.

Applying a Material with the Paint Tool
Another method you can use to apply a material to an element is the Paint tool. This allows 

you to “paint” a material to the selected face of an element or family. The Paint tool can be 

very handy early in the design phase when you are not overly concerned about the layers of 

an element and just want to see a down-and-dirty fi nish. Elements that you can paint are 

walls, roofs, massing, fl oors, and families. To paint a surface, follow these steps: 

 1. On the Modify tab’s Geometry panel, click 

the Paint tool .

 2. On the Modify | Paint tab’s Element panel 

(Figure 9.30), select the material you want 

to apply from the Material drop-down.

 3. Move the cursor to the face of an element 

and highlight it. If you have trouble select-

ing the face of the element, remember to use 

the Tab key to cycle through the various ele-

ments or faces. Also keep an eye on the sta-

tus bar, which will indicate whether you have 

already painted a face.

 4. Click to paint the material to the face.

aD D I N G E N TO u r aG E

With your materials in place, it’s time for the last step in the rendering workfl ow you started 

at the start of the chapter: You can add entourage to your building project. Entourage can 

include such things as landscaping, people, cars, signs, and offi  ce items. Entourage elements 

are placed like other components. When added to your model, they can provide scale and 

add a more realistic eff ect.

Adding entourage is a very straightforward process like adding doors, walls, and so on. 

As a result, we will not be covering adding individual entourage elements.

Figure 9.30

Modify | Paint tab’s 
Element panel
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at the start of the chapter: You can add entourage to your building project. Entourage can 

include such things as landscaping, people, cars, signs, and offi  ce items. Entourage elements 

are placed like other components. When added to your model, they can provide scale and 

add a more realistic eff ect.

Adding entourage is a very straightforward process like adding doors, walls, and so on. 

As a result, we will not be covering adding individual entourage elements.
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Real-Time Rendering
One of the new features in Revit 2011 is the addition of real-time rendering. You now 

have two more visual styles: Constant Colors, which gives a constant color to your model 

giving greater clarity, and Realistic Materials (Figure 9.31), which lets you turn on sur-

face textures in the model without having to render. Decals also show in this visual style, 

again without rendering.

To utilize the Realistic visual style, on the View Control bar at the bottom of the draw-

ing area, click the Visual Style icon and select the Realistic option (Figure 9.32). 
Figure 9.31

Example of  
Realistic visual style

Figure 9.32

View Control bar 
visual style options
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Working with Other Files

Although Revit Architecture  is entirely capable of working 

as a stand-alone platform that can be used to bring a project from conceptual design 

through construction documentation, there are many times where interacting with 

other file formats will be necessary or advantageous.

Working with other Revit models, CAD files, or raster images will routinely be required 

on many projects. Revit has functions for linking, importing, and exporting multiple 

file formats. Revit project files can be linked into one another for modeling and schedul-

ing purposes or can be permanently combined. CAD files can be linked in and used as 

a background to begin a new project, for site plans, or to be used as final construction 

details. Raster images can be used for project or company logos, for on-screen display, or 

for use in photorealistic renderings.

We’ll cover the following in this chapter:

Linking Revit models■■

Controlling display■■

Working with CAD files■■

Exporting DWF files■■

Using raster files■■
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Linking Revit Models
Revit project .rvt files, also referred to as Revit files, are commonly linked together to 

form a complete BIM model of the building project. Architectural designers will link the 

Revit Structure and Revit MEP models into the architectural project model to help coor-

dinate the design and review model changes. Architectural models will often be linked 

together on large projects to form one complete architectural building model. Once mod-

els are linked together, issue documents can be produced from one master file, as well as 

schedules and sheet lists, that includes the host file and any linked files if desired.

In addition to project coordination, a Revit project file linked into a host Revit project 

file can be used when generating schedules, checking for model interferences, and creat-

ing views of the assembled building model. Also, the linked file can be monitored so that 

the user is alerted to any changes that have been made in the linked file. When creating 

final documentation, elements contained in the linked file may be intelligently tagged in 

the host file.

The Link Revit tool (Figure 10.1) on the Link panel in the Insert tab, allows .rvt 

project files to be loaded into the current .rvt project file. 

Once the Link Revit tool is selected, the Import/Link RVT 

dialog box opens. Figure 10.2 shows all of the lower flyouts 

expanded.

The top portion of the Import/Link RVT dialog box offers typical Microsoft Windows 

control and navigation options. The left portion of the dialog box contains a Places list 

where frequently visited folders can be accessed. The lower portion of the dialog box, 

shown expanded, has option settings that will control the Revit files being linked.

Figure 10.1

Link Revit tool

Figure 10.2

Import/Link 
RVT dialog box 

expanded
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These are the Positioning options in the Import/Link RVT dialog box:

Auto – Center to Center  This option aligns the geometric centers of both the linked fi le 

and the host fi le. The alignment occurs in all three coordinates, X, Y, and Z.

Auto – Origin to Origin  This option aligns the 0,0,0 base points of both fi les. This is the 

most commonly selected method.

Auto – By Shared Coordinates  If the project uses shared coordinates, this option will 

align the linked fi le with the shared coordinate system and maintain the relative positions of 

the two fi les. This is useful for assembling sites and campus and condominium types of 

projects.

Manual – Origin  The origin of the linked fi le will be located at the cursor and will be 

placed at the insertion point selected in the host fi le.

Manual – Base Point  The base point of the AutoCAD fi le will be located at the crosshairs 

and will be placed at the insertion point selected in the host fi le.

Manual – Center  The fi le will be centered on the cursor and will be placed at the insertion 

point selected in the host fi le.

If the file being linked into the host model was saved in an earlier version of Revit software, 

a project upgrade notification dialog box will display. The linked file will be temporarily 

upgraded to match the release of the current software. This message will be displayed each 

time the file is linked in. The linked file will need to be opened and saved in the current for-

mat to eliminate this message permanently.

A linked Revit fi le may be selected and edited 

only as one object (Figure 10.3). Individual ele-

ments of the linked fi le may not be edited or 

moved within the linked fi le. Editing of the link 

is limited to display, properties, location, and 

orientation. Once the fi le has been linked into the 

host, it can be moved and rotated as necessary. 

Linked fi les may also be copied, which will create 

an additional instance of the linked fi le. 

To ensure that the linked fi le is not later acci-

dentally moved, select the linked fi le, and choose 

the Pin tool  on the Modify panel to lock the 

fi le in place.

Individual elements within the linked fi le can 

be selected using the Tab key to highlight the 

individual elements prior to selecting the element 

Figure 10.3

Linked Revit file 
selected
Linked Revit file 
selected
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(see Figure 10.4). The properties of the selected element can be viewed in the Properties 

dialog box but they can’t be altered and will appear gray (Figure 10.5).

To convert a linked Revit file from a link to an import, you use the Bind Links com-

mand. Select the linked Revit model, and choose Bind Link from the Link panel in the 

ribbon.

This command will convert the linked Revit model to a model group within the 

host file. Once the command is chosen, the Bind Link Options dialog box will open 

(Figure 10.6). Three options are available within the Bind Link command.

Include Attached Details  ​This option will include any detail groups that exist in the 

linked file and create matching detail groups in the host file. This option is the only 

option selected by default.

Include Levels  ​This option creates additional uniquely named levels in addition to any 

levels already present in the host file.

Include Grids  ​This option creates additional uniquely 

named grids in addition to any grids already present in 

the host file.

Binding a large Revit model may take quite a bit of 

time. Revit will display a warning alerting you to the 

potential time involved and ask you to consider link-

ing. Select Continue to bind the link.

Figure 10.4

Individual grid element selected

Figure 10.5

Properties of selected element

Figure 10.6

Bind Link Options 
dialog box
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Controlling Display
The display of linked Revit models can be controlled from within the host file. Changes 

to the display of the linked models made within the host file will not alter the linked files 

but will only affect how the linked files display within the host file.

Visibility/Graphic Overrides
Once a Revit file is linked into a host, opening the Visibility/Graphics Overrides dialog 

box (this will be referred to as Visibility/Graphics) will activate an additional tab named, 

appropriately, Revit Links, as shown in Figure 10.7.

Open Visibility/Graphics 

by using the button in the 

Properties palette (Figure 10.8) 

or by pressing VV or VG on the 

keyboard.

Each linked Revit file will 

have a line showing the filename. 

The line with the filename is 

considered the primary, or par-

ent. You can expand this line by 

clicking the plus sign to the left of the filename to 

show the instances of the linked file, also known 

as children. Any changes to the visibility settings of 

the parent will translate to all children unless the 

child file has been overridden. There will be one 

instance shown after a Revit file is linked into a host. If the linked file is linked in again 

or copied within the model, additional child line items will appear, one for each instance 

of the linked file (see Figure 10.7). This chapter will focus on the settings as they apply 

to the primary linked file, but the majority of the settings may be applied individually to 

each instance.

To apply display changes only to one instance of the linked file, click the Not Over-

ridden text in the Display Settings column beside that instance, and then click the Not 

Overridden button (Figure 10.9) that appears. Note there will be one instance automati-

cally listed for the initial link even though it has not been duplicated. The display settings 

can be made at the parent level 

or the instance level, but it may 

be slightly easier to make the 

changes at the parent level.

Figure 10.7

Revit Links tab and 
a linked file with 
multiple instances

Figure 10.8

Visibility/Graphics 
Overrides palette 
button

Figure 10.9

Not Overridden 
instance button
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When you click the Not Overridden button 

shown in Figure 10.9, a dialog box named RVT 

Link Display Settings (Figure 10.10) will open 

offering the Override Display Settings For This 

Instance check box. Once this is selected, the set-

tings changed will apply only to the particular 

instance selected.

In Visibility/Graphics, at the parent link level, 

clicking the By Host View button (Figure 10.11) will display four additional tabs for con-

trolling the display of the linked file.

Basics•	

Model Categories•	

Annotation Categories•	

Import Categories•	

Visibility/Graphics Basics Tab

The Basics tab shows three options (Figure 10.12) for displaying the linked file:  

By Host View, By Linked View, and Custom.

By H ost  V iew 

The default Visibility/Graphics setting for the linked Revit file will be By Host View. The 

By Host View setting will use the same display settings as the Model Categories tab 

(Figure 10.13) in the host file so that the same elements will be displayed in the link as in 

the host. For example, if the Walls check mark is cleared so that walls do not display in the 

host file, the walls in the link file will also not display. With the exception of the Visibility 

check box and the Halftone check box on the Revit Links tab, the entire display is con-

trolled on the Model Categories tab.

Note annotations contained in the linked Revit file will not display using By Host View.

Figure 10.10

Instance check box

Figure 10.11

By Host View button

Figure 10.12

Display options

Figure 10.13

Model 
 Categories tab
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The model category settings controlled using By Host View are as follows:

Visibility•	

Line•	

Weight•	

Color•	

Pattern•	

Pattern•	

Visible•	

Color•	

Pattern•	

Halftone•	

Transparency•	

Detail Level•	

By L in  k ed  V iew 

Choosing the By Linked View setting allows the user to select a view from the linked file 

(Figure 10.14) and displays the settings from that view in a view in the host file. The view 

selected can be any view in the linked file regardless of level as long as the view selected is 

the same type as the view in the host 

file. For example, a floor plan or plan 

view in the linked file will display in 

a floor plan or plan view in the host 

file, and a ceiling plan view from the 

linked file will display in any ceiling 

plan view in the host file.

The By Linked View setting will 

display the annotations from the 

linked file so that it can be used as a reference or for printing. Callout tags and bubble 

heads from the linked file will not display in the host regardless of which display settings 

are chosen. The callouts and bubble heads from the linked file will reference views and 

sheets that exist in the linked file and not in the host file, which would cause misleading 

and erroneous references. Sections and elevations can be added directly in the host file 

using standard view commands, and then the display of the linked model can be adjusted 

to meet the needs of the view.

Expand the Linked View list box to see a list of views in the linked file that can be dis-

played in the current view. These views will display the linked file using the same settings 

as were used in the linked file.

Figure 10.14

Linked View set-
tings in RVT Link 
Display Settings 
dialog box
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Custom 

Using the Custom setting (Figure 10.15) will give you the most complete control of 

the display of the linked file. The display of the linked file can be adjusted as needed to 

meet the needs of the view in the host 

file. Individual model, annotation, and 

linked categories can be changed, and 

the display of individual worksets can be 

toggled on or off.

Note that these settings will alter the 

display of the linked file only and not 

affect any elements native to the host file.

Many of the settings available on the 

Basics tab will be dependent on the linked 

view chosen in the Linked View list box. 

The View Filters and Color Fill options 

will be based on the current status of 

the linked view from the linked file. The 

color fill or filter must be active in that view in the linked file in order to be able to dis-

play that view in the host file.

The Custom option allows you to set these values:

Linked View  ​This will determine what options are available. This setting allows the view 

from the linked file to be displayed in the host using all settings, filters, and color fills 

from the linked view.

View Filters  ​If the view filter is active in the current view, this setting will control whether 

any host file view filter, view filter from the linked file, or no filter is used to alter the dis-

play of the linked file.

View Range  ​This controls whether the view range of the host view or the view range from 

the linked view is used to display the linked file.

Phase  ​This allows you to select the phase currently set in the host view properties or any 

phase available in the linked file for control of the display of the linked file.

Phase Filter  ​This allows you to select the phase filter currently set in the host view or any 

phase filter available in the linked file for control of the display of the linked file.

Detail Level  ​Coarse, Medium, or Fine can be set for the linked file view, as well as By 

Linked View and By Host View.

Discipline  ​By Host View, By Linked View, or any standard discipline setting can be 

selected, including the following:

Architectural•	

Structural•	

Mechanical•	

Figure 10.15

Custom options  
on Basics tab

Electrical•	

Coordination•	
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Color Fill  ​Color fills active in either the linked file view or the host file view can be applied 

to the linked file view using this setting. Note that color fills need to be created and active 

to apply this setting.

Object Styles  ​Object Styles from the linked file or from the host file can be assigned to 

the linked file using this setting.

Nested Links  ​When the linked file has other Revit linked files nested within it, this set-

ting controls whether the view settings of the linked file (By Parent Link) are displayed or 

the view settings of the nested link (By Linked View) are displayed.

Visibility/Graphics Categories Tabs

You can use the Model, Annotation, and Imported Categories tabs to tailor the display of 

the elements within the linked file using similar commands as those that exist in the host 

file views under Visibility/Graphics Overrides. Refer to Chapter 3, “Modeling,” for addi-

tional information about these settings.

On the Basics tab, select the Custom option; the categories tabs cannot be used to 

adjust the link display unless you are using the Custom setting.

The list box at the top center of the dialog box is set to By Host View by default. You 

can choose from three possible options:

By Host View  ​Matches the settings used in the Visibility/Graphics settings of the host view.

By Linked View  ​Matches the settings used in the Visibility/Graphics settings of the linked 

view. This setting will be available only if there is a view selected on the Basics tab in the 

Linked View list.

Custom  ​Allows full control of each setting within the categories list. Elements within 

the linked file will respond to the settings selected here and override the view Visibility/

Graphic settings.

Worksets

If the linked file is a worksharing-enabled file, an additional tab 

will be displayed named Worksets (Figure 10.16). Two settings 

are available in the list box at the top of the dialog box, By Host 

View and Custom.

By Host View  ​Worksets in the linked file that have identical 

names to worksets in the host file will assume the on/off dis-

play setting of the host view. If no identical name exists, the  

elements in the linked workset will be set to display.

Custom  ​This allows independent on/off display control of the 

elements on that workset in the linked file.

Figure 10.16

Visibility/Graphics 
Worksets tab
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Managing Links
Linked files are automatically reloaded when the host file is reopened, which ensures that 

the linked file displayed is the most recent version. If the linked file is not found when 

opening the host file, Revit will display an error message warning that a linked file was 

not found (Figure 10.17).

Note that linked Revit files will not 

display if the reference is unresolved, 

while CAD and DWF linked files will 

display as they were last shown in the 

host file.

When working on a Revit project, 

it will be necessary to sometimes 

manage links using the tools avail-

able in the Manage Links dialog box. 

These tools allow the user to control 

reloading, unloading, removing, and 

repathing of the linked file.

You can open the Manage Links dialog box from the Manage tab on the Manage 

Project panel. It is also available on the Insert tab’s Link panel. Three tabs are available in 

the Manage Links dialog box:

CAD Formats•	

Revit•	

DWF Markups•	

Managing Revit Links

On the Revit tab (Figure 10.18), the name of each linked Revit file will be shown. Each 

column shows information about the linked file, and selecting the filename in the Linked 

File column will allow you to make changes to the file. Some columns report information 

only, while others can be selected to make changes to the linked file’s behavior, as shown 

in Table 10.1.

N a m e P u r p o s e U s e

Linked File Filename. Select the filename to make 
changes to the link settings for  
that link.

Status Identifies whether file is currently 
loaded into the project.

Read-only setting that will display 
Loaded, Unloaded, or Not Found. 
Not found indicates an unresolved 
reference. The saved path column 
can be used to repath the link.

Figure 10.17

Unresolved Refer-
ences dialog box

Table 10.1

Manage Links  
column functions
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N a m e P u r p o s e U s e

Reference Type Overlay or Attachment will be 
listed. Overlay is the default type. 
When a file is linked into another 
as an overlay, the linked file will 
show only in the host file and not 
in any subsequent hosts of the 
current host.

Clicking Overlay in this column 
will allow the link to be toggled 
between Overlay and Attachment.

Position Not Saved Shows whether the file’s coor-
dinates have been saved in the 
shared coordinate system. This 
check box indicates that changes 
to the linked file coordinate system 
have been made but not saved 
back to the file.

Read-only.

Saved Path Displays the path where the linked 
file was found.

Read-only.

Path Type Path type listing. The default type 
is Relative.

Clicking in the Path Type listing will 
allow the path type to be toggled 
between Relative and Absolute.

Local Alias Displays the path of the work-
shared linked file.

If the linked file is a local copy of a 
central file, the path of the local file 
will be displayed here. The path of 
the central file will be displayed in 
the saved path column.

Figure 10.18

Manage Links dia-
log box Revit tab
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Here are the actions of the various buttons at the bottom of the Manage Links  

dialog box:

Remove  ​Removes the link, and any association to it, from the host file. Note this com-

mand cannot be undone, and the file would have to be linked in again if it was needed.

Unload  ​Unloads the link from the host file but maintains the link association.

Reload  ​Reloads linked files. The files may need to be updated so that the most current 

linked file is displayed or a linked file that has been unloaded is reloaded. Linked files 

automatically reload only when you open the host file. If any changes have been saved to 

the linked file, they will not display in the host file until the linked file is reloaded.

Reload From  ​Used to restore links that are unresolved. Navigate to the new location of 

the linked file, and select the file.

Save Positions  ​Allows user to save positions to the selected linked file. If the linked file is 

moved and the positions are not saved the file will revert to its last saved positions when 

reopened.

Manage Worksets  ​Opens the Manage Worksets dialog box. Worksets can be manually 

opened or closed in the Worksets dialog box. Worksets that are not opened do not display 

and are not loaded into the current session. This will improve computer performance by 

reducing the size of the working model memory footprint.

Managing CAD and DWF Links

In addition to the commands listed earlier, linked CAD files have two additional com-

mands available in the Manage Links dialog box:

Preserve Graphic Overrides  ​This box is selected by default. When selected, any changes 

made to the graphic display of the linked CAD file are saved when the file is saved and 

subsequently reopened.

Import  ​The linked CAD file is converted from a link to an import and is imported into 

the host file.

The DWF Markup tab has two additional commands that affect markup DWF files:

Save Markups  ​Saves any changes made to the DWF markup file in Revit to the DWF file 

for review in Autodesk Design Review.

Located In  ​Shows the sheet or sheets that a DWF linked file is linked to. Linked DWF files 

can be linked to more than one view.

Tagging Linked Revit Models
Beginning with this release of Revit, certain elements within linked files can be tagged. 

This allows you to generate fully coordinated documentation models from a single file 



Controlling Display  ■   281

created from individual linked files. Most linked model element tags and symbols can be 

placed in the host file with the exception of the following types:

Keynote tags•	

Room tags•	

Area tags•	

Space tags•	

Zone tags•	

Beam system tags•	

Floor span symbols•	

Path reinforcement span symbols•	

Area reinforcement span symbols•	

Tagging elements is accomplished using the Tag By Category command or the Tag All 

command. When using the Tag All command, select the Include Elements From Linked 

Files check box to tag elements from the linked file. The process of adding tags will be the 

same as adding tags for elements that exist directly in the host file.

The different behavior will appear when elements in the linked file are deleted and 

have been previously tagged in the host file. Tags that read information from elements 

directly in the host file will always be up-to-date. If the properties of the element they 

are tagging are changed, the tag will update; and if the element that they are tagging is 

deleted from the model, they will be deleted automatically (see Table 10.2). Tags hosted 

by elements in linked files will behave differently than tags hosted by elements in the host 

file dependent upon what the status of the linked file is and what types of changes were 

made to the linked tagged element.

A c ti  o n T a g  B e h a v i o r R e p a i r  P r o c e d u r e

Properties of the linked elements 
are changed in the linked file.

Tags automatically update when 
linked file is reloaded.

None required.

Linked element is deleted from 
the linked file.

When file is reloaded, a warn-
ing message is displayed (Fig-
ure 10.19). Tags display question 
marks indicating that they have 
become orphaned. Orphaned 
tags displaying a question mark 
will print and not automatically 
be prevented from printing.

Use the Reconcile Hosting com-
mand to review and repair the 
orphaned tags.

Linked file is unloaded from the 
host file or unresolved.

Tags do not display in the  
host file.

Upon reloading the unloaded 
link, the tags reappear and dis-
play the correct information.

Linked file is removed from host 
or deleted from host.

Tags are deleted from host file. Tags will need to be reapplied 
to the elements once the file is 
relinked into the host.

Table 10.2

Linked tag  
behaviors
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Reconcile Hosting Command

Once a warning has been displayed alerting you to the fact that an element is missing from 

the linked file, start the Reconcile Hosting (Figure 10.20) command from the Collaborate 

tab’s Coordination panel.

The Reconcile Hosting browser (Figure 10.21) is a modal window that allows you to 

work on the model while keeping the browser open and accessible. The browser displays 

the number of orphaned elements, the linked filename 

that the missing elements are reported from, the cat-

egory of tag that is missing, and the individual lines for 

each orphaned tag.

There are three options buttons at the top of 

the browser:

Graphics  ​The Graphics option (Figure 10.22) 

provides tools to change the line weight, line 

color, and line pattern of the orphaned tags to 

make them easier to view on the screen.

Sort  ​The list of orphaned tags can be sorted by 

link and then by category, or they can be sorted 

by category and then by link.

Show  ​After selecting an orphaned tag or tags 

from the Reconcile Hosting browser, selecting 

Show will zoom the view to be centered around 

the orphaned tags (Figure 10.23).

Orphaned tags can be deleted either individually or as a group 

and, if appropriate, can be relinked to a different object individually. 

Right-clicking the linked filename in the Reconcile Hosting browser 

or right-clicking the tag category will offer a Delete command to 

remove all the orphaned tags at one time.

Right-clicking one individual orphaned tag will allow the user 

either to delete the tag or to select a new host (Figure 10.24).  If Pick 

Figure 10.19

Missing element 
warning

Figure 10.20

Reconcile Hosting 
command

Figure 10.21

Reconcile Hosting 
browser

Figure 10.22

Graphics settings

Figure 10.23

Result of Show
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Host is chosen, you will be able to select a new host. The host must be the same Revit cat-

egory as the previously deleted host in order to select a new host.

Multiple individual orphaned items can be selected by choosing one item, then press-

ing the Shift key, and selecting an additional item in the list. Not only will the two items 

be selected, but all the items in between will be selected. Regardless of how multiple items 

are selected, the only option is to delete the tags.

Working with CAD Files
Revit supports the import and export of CAD file formats (listed in Table 10.3) for a vari-

ety of uses in both 2D and 3D formats. Files can be imported for use in site plan views, as 

backgrounds for beginning a model, for detail drawings, or for use in three-dimensional 

massing models for massing studies and element creation.

F o r m a t I m p o r t E x p o r t

DWG All Versions 2000, 2004, 2007, 2010
DXF All Versions 2000, 2004, 2007, 2010
DGN Version 7 Version 7
SAT Version 6 Version 6
SKP All Versions

DWG Files
Revit Architecture offers many tools for working with .DWG files. These tools are avail-

able regardless of what application was used to create the files originally. Many CAD 

applications and other BIM applications create file formats not listed above by default. 

These applications may have the capability of creating .DWG files. DWG files would pro-

vide an easy method of bringing in files from various other applications.

Linking or Importing DWG

All the CAD files listed earlier can be linked into the Revit model or imported into the 

Revit model. Linking is generally the preferred approach because it is easier to remove 

the file and not leave any unwanted artifacts or element types behind. In addition, linked 

files will be updated if the linked file changes. Regardless of which method is selected, the 

conversion of line weights is identical.

Choose Link CAD or Import CAD on the Insert tab’s Link or Import panel (Figure 10.25). 

The dialog box that opens has the same positioning settings as outlined in the “Linking 

Revit Models” section earlier in this chapter. 

Figure 10.24

Right-click options

Table 10.3

File formats  
supported
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Choose the type of file to load from the Files Of Type list:

DWG – AutoCAD-based products•	

DXF – AutoCAD exchange format•	

DGN – MicroStation files•	

SAT – Standard ACIS text•	

SKP – SketchUp•	

Selecting the Current View Only check mark will limit the display of the linked or 

imported CAD file to the view that was active when the file was brought into the project 

file. If this box is not selected, the CAD file will be visible in all views, including 3D views 

and elevations. This will require the user to manage the display of the CAD file in many 

views. Selecting this check box will produce a much cleaner Revit project environment 

and eliminate the need to change the display settings in all of the other views in the host 

project so that the linked or imported file will not display.

Your choices for the Colors setting are as follows:

Black And White  ​This option will make the import appear the same as default Revit 

objects and discard the colors from the import. This is the preferred method of linking 

and importing for printing purposes.

Preserve  ​This option retains the colors from the imported file and displays those colors 

in the Revit project.

Invert  ​This option inverts the colors of the imported file. This may be helpful for some 

files if they were originally created with colors that displayed well on a dark background 

but are difficult to see on the default light Revit background.

For the Layers setting, you can choose from these options:

All  ​This loads all the layers of the imported file regardless of their current state.

Visible  ​This loads only the layers currently visible in the imported file.

Specify  ​Once the import/link is started, a list box will appear allowing the user to choose 

the specific layers to load. This is the most efficient method of loading the file but may 

require the user to be familiar with the file.

Figure 10.25

CAD-specific  
settings
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Under Import Units, these values are available:

Auto-Detect  ​This reads the units of the import/link file and adjusts the file scale to match 

the current Revit project. This usually works well with recent DWG files but may not with 

older DWG files and DGN files.

Units  ​Choose the unit that the CAD file was drawn in.

Custom Factor  ​Set a scale factor to be applied upon loading the CAD file.

The Place At setting assigns the import/link file to a specific level of the Revit project. 

The Orient To View setting aligns the import or link with the current view.

I mport     S ettings      :  L ine   W eights    

Line weights of imported DWG and DXF files are controlled by a customizable text file. 

This file can be adapted for various files received from different consultants or internal 

files. The files can be saved and made active whenever necessary in order to automatically 

change the line weights of the objects in the linked or imported DWG or DXF file. In 

addition, the version that the DWG file was created in will affect the import line weights, 

as seen in Table 10.4.

 

F i l e  t y p e

S o u r c e  F i l e  

P l o t  T y p e

I n s e r ti  o n 

M e t h o d

 

R e v it   Lin   e  W e i g h t

DWG STB (Named Plot Styles) Link Line weight by AutoCAD layer line weight.

Object line weight overrides are retained.
DWG STB (Named Plot Styles) Import Line weight by AutoCAD layer line weight.

Object line weight overrides are retained.
DWG STB (Named Plot Styles) Exploded Line weight by AutoCAD layer line weight.

Object line weight overrides are dis-
carded, and the objects revert to the  
layer line weight.

DWG CTB (Color Table Plot Styles) Link Line weight by AutoCAD layer color.

Object line weight overrides are  
discarded.

Object color overrides are discarded.
DWG CTB (Color Table Plot Styles) Import Line weight by AutoCAD layer color.

Object line weight overrides are retained.

Object color overrides are discarded.
DWG CTB (Color Table Plot Styles) Exploded Line weight by AutoCAD layer color.

Object line weight overrides are dis-
carded, and the objects revert to the layer 
color line weight.

Object color overrides are discarded.
DXF Release 12 All Object line weight by color.
DXF R2000 & Newer All Object line weight by color.

Object line weight overrides are retained.

Table 10.4

Imported DWG/ 
DXF line weight  
conversion
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You can access the import line weight settings on the Insert tab’s Import panel. The 

small dialog box launcher arrow (Figure 10.26) at the bottom-right corner of the panel 

will open the Import Line Weights dialog box (Figure 10.27).

The left column lists 255 AutoCAD colors and will convert 

the lines, polylines, arc, circles, and so on, of that color or the 

layer line weight to the Revit line weight chosen in the right 

column. The line weights are controlled in the standard Revit Line Weights dialog box 

(accessed via the Manage tab’s Additional Settings button).

At the top right of the Import Line Weights dialog box are two buttons. The Load but-

ton will allow you to load a previously saved file to make those settings active, and Save 

As will allow you to save the current settings for future use. Common custom file uses are 

for internal detail drawings or to match the standards of a repeat client. Five preconfig-

ured import standards ship with the program:

importlineweights-dwg-AIA.txt

importlineweights-dwg-BS1192.txt

importlineweights-dwg-CP83.txt

importlineweights-dwg-default.txt

importlineweights-dwg-ISO13567.txt

Any import standard that is set as active, or created, will remain active until another is 

set active.

Fonts  

TrueType fonts will be displayed in Revit using the same font as the original text as long 

as the font exists on the host computer. For SHX fonts, Revit will display text in a linked 

file as closely as it can when the DWG file is inserted into the Revit file. For imported files, 

Figure 10.26

Insert panel  
and arrow

Figure 10.27

Import Line  
Weights dialog box
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Revit will automatically create a text family type and assign a font to the imported text. 

To control the fonts of SHX based text being imported into Revit, edit the Shxfontmap.txt 

file. This file is located in the Data folder of the Revit installation directory.

Here is an example of two additional lines added to the file:

Txt.shx    Arial

Romans.shx   Arial

The SHX font name and its extension are listed in the left column, and after a tab, the 

Windows TrueType font name is listed in the right column. Edit the file, and save the 

changes. Revit does not need to be restarted; the file is read during each import or link.

D isplay    Control    

The display of imported or linked DWG files is controlled using the Visibility/Graphics 

Override display settings. The Imported Categories tab (Figure 10.28) displays all linked 

and imported CAD files in the current 

project. Each file can be expanded to 

display a list of layers, or levels. The file 

can be set to display or not by selecting 

the check box to the left of the filename, 

or they can be set to display differently 

by overriding the settings for Projection/

Surface. Similar to other elements in Revit, 

the line weight, color, and line patterns 

can be changed per view.

Exporting DWG

The capability to customize the export of 

.DWG files offers multiple benefits to Revit 

users. Often you will be involved with 

either consultants or clients that prefer a .DWG file as a working file or as a part of the 

deliverable package. The options below allow you to customize the exported file to meet 

the receiver’s standards.

L ine   W eights      and   Colors  

Similar to the controls available when importing DWG files, exported files can be cus-

tomized to mimic an existing CAD standard using text files to control the object category 

to layer export settings.

You can access the export settings by clicking the application menu and selecting 

Export ➔ Options ➔ Export Layers DWG/DXF. This opens the Export Layers dialog box. 

This dialog box (Figure 10.29) lists all the categories and subcategories in the Revit file as 

well as a category for any DWG imports that have been added to the file.

Figure 10.28

Import categories
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The left column lists all the categories and subcategories available from the Revit file. 

This includes all objects from Revit Architecture, Revit Structure, and Revit MEP. In 

addition, any imported DWG files will be listed with each layer having its own subcat-

egory line.

Edit Layer Names in the left column, and type a color ID number (1–255) in the right 

column. Do this for both the projection lines and the cut lines. Export settings can be 

saved using the Save As button at the top right of the dialog box. The Load button will 

load previously saved export files, and the Standards button will offer a list of predefined 

standard export files. Once an export standard is created, click OK at the bottom of the 

Export Layers dialog box.

Views, sheets, or both can be exported to DWG or DXF files. From the application 

menu, choose Export ➔CAD Formats and then the desired file type (Figure 10.30).

Figure 10.29

Export Layers  
dialog box

Figure 10.30

Export ➔ CAD  
Formats menu
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The Export CAD Formats dialog box opens, as shown in Figure 10.31. The left panel 

has a preview of the exported file, and the right panel allows you to select what views or 

sheets will be exported. The default setting in the Export list box is Current View/Sheet 

Only and will export a single view, or sheet, to a DWG file.

Opening the Export list box allows the user to select In Session View/Sheet Set for 

export (Figure 10.32). This will allow additional options and settings to control the export 

of views and sheets (Figure 10.33).
Figure 10.31

Export CAD Formats 
dialog box

Figure 10.32

In Session View/Sheet Set

Figure 10.33

Selection options
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From the Show In List drop-down list, choose the types of views, sheets, or a combina-

tion of both that you want to see displayed in the panel options:

Views In The Set  ​Displays all views in a previously saved set

Sheets In The Set  ​Displays all sheets in a previously saved set

All Views And Sheets In The Set  ​Displays all views and sheets in a previously saved set

Views In The Model  ​Displays all views in the project

Sheets In The Model  ​Displays all sheets in the project

All Views And Sheets In The Model  ​Displays all views and sheets in the project

Choose one of the options, and the panel below the options will fill in with views and/

or sheets (Figure 10.34). You can select Check All or Check None using the selection but-

tons, or you can select views or sheets individu-

ally to add or remove them from the selection.

Once you have selected a set of sheets to be 

exported, you can group the selection set into a 

new set. (This is optional but can save time when 

the same set of views will be exported repeatedly 

during a project.) The New Set button is high-

lighted in Figure 10.34. Type a name for the set to 

save the selection for future use. Some common 

uses are to save all plan sets, all elevations, full 

sets, and so on.

Once the set is named, you must select Save 

Settings at the bottom of the dialog box to final-

ize the set. After saving the set, it will be avail-

able for selection in the Export list box for this 

and for future exports. The set appears as shown 

in Figure 10.35.

After the views and sheets have been selected, 

choose Next at the bottom of the Export dialog 

box. The Export CAD Formats dialog box (Figure 10.36) allows you to provide a name 

for the exported file, a prefix to the filename for multiple files, and where the exported 

files are to be saved.

The Naming options are as follows:

Automatic – Long (Specify Prefix)  ​Manually specify a prefix in the File Name/Prefix field 

or accept the default, which uses this format: 

Revit Sheet/View: Project Name-View Type-View Name

(The prefix name cannot be blank.)

Figure 10.34

Sheet/view  
selection

Figure 10.35

Saved selection set
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Automatic – Short  ​Revit Architecture determines the name of the file automatically. The 

format is as follows: 

Revit Sheet: Sheet Name or Revit View: View Type-View Name 

Manual  ​This is available only when exporting Current View/Sheet Only export settings. 

The complete filename can be typed manually.

There is a choice of which DWG format the files will be exported 

using. Versions 2010, 2007, 2004, and 2000 are supported. Choose the 

appropriate format from the Files Of Type list box. DWG files are always 

forward compatible, meaning that an older-format DWG file can be 

opened in a newer software release, but an older software version will 

not open a DWG file saved in a newer format.

Also at the bottom of the dialog box is a check box to have DWG files 

inserted on sheets as Xrefs. This option creates more files because the 

output will generate page setup files in addition to the DWG files. What 

works best may be a decision for the firm receiving the files. Upon click-

ing OK, the files are exported to the chosen folder.

Additional export settings are available on the DWG Properties tab at 

the top of the screen (Figure 10.37).

Figure 10.36

Export CAD  
Formats dialog box

Figure 10.37

DWG Properties tab
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3D E xporting      

When a 3D view or model view is exported, a 3D model will be created in the DWG file, and 

the settings noted in Table 10.5 will be available. When plan views, section, elevation, 

and so on are exported 2D DWG files will be created.

S e ttin    g O p ti  o n R e s u l t

Layers And Properties Category properties BYLAYER, 
overrides BYENTITY

All objects of the category are placed on the 
same layer. Elements with display overrides 
on them are also placed on the same layer 
but with overrides by object.

All properties BYLAYER no  
overrides

All objects placed on the same layer with 
properties set to BYLAYER.

All properties BYLAYER, new  
layers for overrides

All properties BYLAYER, overridden objects 
placed on a new layer.

Colors Index Color Objects will be exported to DWG and will 
use the Index Colors. Object and layer colors 
will be based on the closest Index Color and 
may not exactly match.

True Color Objects will be exported using True Color 
and will match the Revit object color exactly.

Linetype Scaling Scaled Linetype Definitions This option exports linetypes based on the 
previously scaled by view scale. This option 
preserves graphical intent.

Modelspace (PSLTSCALE = 0) Sets the LTSCALE parameter to view scale 
and the PSLTSCALE variable to 0.

Paperspace (PSLTSCALE = 1) Sets both LTSCALE and PSLTSCALE to 1.

Coordinate  
System Basis

Project Internal This will export the DWG files based on the 
Revit origin and match that to the DWG origin.

Shared Will export the geometry based on the 
active shared coordinate system. This is only 
accurate for views that do not export from 
sheet views.

Drawing Unit Inch 
Foot 
Meter 
Centimeter 
Millimeter

Sets the default unit of measurement for the 
DWG file.

Text Treatment Maintain Visual Fidelity Text will appear exactly as exported but will 
lose bulleting and numbered list functionality.

Maintain Functional Fidelity Text appearance may vary, but functionality 
will be retained.

Solids (3D Views Only) Available for 3D views only.

Export as polymesh Exports geometry as polymeshes.

Export as ACIS Solids Exports geometry as ACIS solids unless 
geometry is already a polymesh. (Toposur-
faces are an example.)

Export Rooms And  
Areas As Polylines

Rooms and areas will be exported onto a 
single layer each as closed polylines.

Table 10.5

DWG Properties
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Importing and Exporting DGN Files
DGN files can be linked, imported, and exported like DWG and DXF files. Unlike DWG/

DXF files, no customization settings are available when importing a DGN file; there are 

customization settings available when exporting a Revit model to DGN to control the 

output.

DGN files will link to Revit and display exactly as they were displayed in MicroStation 

except for the color overrides chosen during the link process. Imported DGN files will display 

exactly as displayed in MicroStation except the line weights will be lost during the import.

Most 3D elements from DGN are supported for Revit linking and importing with the 

exception of cones, B spline surfaces, and smart solids.

Exporting a DGN file from a Revit file allows the user to choose various level and tem-

plate settings that will help tailor the DGN file to the end user’s needs.

The View/Sheet Set tab (Figure 10.38) offers the same selection and saving options as 

explained in the “Exporting DWG” section earlier in this chapter. Refer to that section 

for an explanation of how to save sets for future use.

The DGN Properties tab (Figure 10.39) will let the user customize the output to match 

an existing standard or a client standard.
Figure 10.38

Export CAD For-
mat’s View/Sheet 
Set tab

Figure 10.39

DGN Properties tab
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To set the level color and level names for the export, click the Layer Settings button. 

The left column of the dialog box lists all the categories and subcategories available from 

the Revit file. This includes all objects from Revit Architecture, Revit Structure, and Revit 

MEP. In addition, any imported CAD files will be listed, with each level having its own 

subcategory line.

Edit Level Numbers in the left column, and type a color ID number (1–255) in the 

right column. Do this for both the projection lines and the cut lines. You can export set-

tings using the Save As button at the top right of the dialog box. The Load button will load 

previously saved export settings files and the Standard button will offer a list of predefined 

export settings files. Selection sets that you have saved for DWG/DXF export and any that 

have been saved for DGN export will be available for selection. Once an export standard 

is created, click OK at the bottom of the Export Layers dialog box.

To enable a DGN template (a MicroStation seed file), select the Enable DGN Template 

check box, and then click the button to the far right of the list box to browse for a suit-

able DGN template file. Select Next at the bottom of the dialog box to start the export 

process. DGN files are saved one view or sheet to a file in the selected folder.

Exporting DWF Files
DWF and DWFx files (Drawing Web Format; see Table 10.6) can be used to share designs 

with clients, consultants, or anyone else who would need access to the design informa-

tion and project data. Both DWF and DWFx files can be exported in 2D or 3D formats 

depending on what the intended use is for the file. 2D DWF files can be used to review 

design data, to perform quantity takeoffs (requires additional software, such as QTO), 

and to function as backgrounds in CAD designs or to plot the design set remotely, even to 

scale if desired. Parameters and properties associated with model elements can also be 

included in the file. 3D DWFs can be used for presentations and model review. Design 

Review, which installs along with Revit and is available as a download from Autodesk, 

will display both types of DWF and DWFx files. In addition, the Microsoft XPS viewer will 

display DWFx 2D files. The XPS viewer is included with Windows Vista and Windows 7 

and is available for download for Windows XP.

DWFx files are slightly larger because of their support of the XPS viewer.

F i l e  T y p e Vi  e w e r

DWF Design Review Viewer: Full 2D and 3D support, pass-
word protection, parameter information

DWFx Design Review Viewer: Full 2D and 3D support, pass-
word protection, parameter information

XPS Viewer: Parameter information support,  
no 3D support, no password support

Table 10.6

DWF Format  
Comparison
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The export command for DWF files is available by choosing the application menu and 

selecting Export ➔ DWF/DWFx (Figure 10.40). The type of view or views that you select 

for export will determine the type of DWF 

file that is exported. Any 2D views will be 

exported as 2D DWF files or views within a 

file, while any 3D views will be exported as 

3D DWF files or 3D views within a DWF file. 

Both types of views can exist within one file.

The DWF Export Settings dialog box is 

shown open to the Views/Sheet Set tab (see Figure 10.41). The View/Sheet Set tab has the same 

capabilities and functions as the tab does in the CAD export commands. It also will share the 

same saved sets as the CAD file export. Please refer to that section for additional information.

The DWF Properties tab (Figure 10.42) will control how the DWF file 

is exported including what is placed in the file during import, what the 

quality level is, whether properties are exported in addition to the geom-

etry and annotations, and how rooms and areas are exported.

Element Properties  ​Controls whether element properties (parameters) are 

included in the export. This includes both type and instance properties.

Rooms And Areas In A Separate Boundary Layer  ​Exports room and area 

boundaries to a separate layer. This allows the room and area data to be 

more easily viewed separate from the file geometry.

Figure 10.40

Exporting  
DWF/DWFx

Figure 10.41

DWF Export Set-
tings dialog box

Figure 10.42

DWF properties
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Use Standard Format  ​Exports images as PNG files.

Use Compressed Raster Format  ​Exports images in compressed .jpg format. This will typi-

cally produce a smaller file size.

Print Setup  ​This opens the standard Revit Print dialog boxes where you can set the print-

ing preferences. This information, sheet size, placement, center, and so on, is embedded 

in the DWF file and will be available to the recipient so that the sheets can be printed 

exactly as expected, if the user printing the files has the equivalent plotter.

The Project Information tab displays the standard project information dialog box that 

is also available from the Manage tab in the ribbon. You can make changes to project 

information in this dialog box as part of the export process if you need to.

Any changes made on this Project Information tab will also change the project information 

on the Manage tab and not be restricted to the DWF export.

Saving DWF Settings

At the bottom of all three tabs in the DWF Export Settings dialog box is the option to save 

settings. Clicking this button saves any settings you have selected during the export setup 

process and exits the export command. The settings are retained exactly as they were cho-

sen. They include sheet and view choices, DWF properties, and project information.

When you click Next, the Save To Target Folder dialog box opens (Figure 10.43), allow-

ing you to save the file to the desired directory and additionally control the type of file cre-

ated and also whether the file is a single sheet or view per file or a combined set of sheets 

and views per file. Click the OK button to proceed with the export process.
Figure 10.43

Save To  
Target folder
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Options available in the Export DWF – Save to Target Folder dialog box are as follows:

Files Of Type  ​Choose either DWF or DWFx. See Table 10.6 for additional information.

Naming  ​There are three possible naming schemes:

Automatic – Long (Specify Prefix)  ​Defaults to the project name and then appends the 

view name to the project name. This allows you to type a specific filename to replace 

the project name and then appends the name of the first view exported to the typed 

filename.

Automatic – Short  ​Uses the view or sheet name from the Revit project.

Manual (Specify file name)  ​Allows you to type a specific filename.

Combine Selected Views And Sheets Into A Single File  ​When selected, this produces a single 

file that has all the views and sheets selected for export included in it. When deselected, 

the export creates a single file per view or sheet selected for export.

Linking DWF

When used in conjunction with Autodesk Design Review, Revit-exported DWF files can 

be linked back into a Revit project and allow the user to track markups and revisions to 

the project sheets without the need to use paper. The process is to export the sheet files 

to DWF and then add any markups and notes in Design Review. The DWF file is then 

linked back into the Revit project file from which it was exported, and the DWF sheets 

are automatically placed on the correct sheet as an import symbol. Once linked into the 

project, any markups and notes can be reviewed, commented on, and reexported for fur-

ther review.

Using Raster Files
Raster files can be incorporated into Revit project files and also into Revit family files, 

such as title blocks. Multiple file formats are supported: BMP, JPEG, PNG, and TIFF. The 

raster file will be included in the Revit project file once inserted and will not need to be 

sent separately when sharing the project file or any titleblock family files.

Import the image using the Image command on the Insert tab’s Import panel. 

Navigate to the folder that contains the image, and select the image. Upon clicking OK, 

you are returned to the Revit project. The image will be centered on the cursor, and you 

will need to click to place the image. Once the image is placed, you can adjust the size of 

the image by first selecting the image and then grip editing by dragging the corners or by 

selecting the image and changing the properties in the Properties palette.
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To remove all instances of an image, use Manage Images on the Insert tab’s Import 

panel, select the image from the list, and choose Delete. This will delete all instances of 

the image.

Images can be copied within a project using the standard Revit Copy command. If an 

image has been copied and only a single instance needs to be deleted, open a view that 

displays that image, select the image and use the Delete key, or right-click and choose 

Delete. Any other instances that exist in the project will remain. To fully remove an 

image from the project, either individually delete all instances or use the Manage Images 

command.



C hap te r 11

Rooms and Areas

In this chapter,  we will discuss creating rooms and areas in Revit  

Architecture.

You create rooms to extract information from the model, add user-defined informa-

tion, or automatically calculate spaces about the building model. The room element is a 

nongraphic element in the model that represents a defined space in the model. You also 

use rooms to create schedules such as a room finish schedule. 

You use areas to create area calculations. Rooms and areas are not interchangeable, so 

if you want to create an area calculation, you need to create an area calculation, create an 

area plan, and add an area schedule. In this chapter, we will cover the following:

Rooms■■

Areas■■
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Rooms
In this section, we will begin by defining rooms and showing you how to create a room 

schedule. The rooms will define spaces in your project such as offices, hallways, confer-

ence rooms, and so on. You can assign data to the room elements, such as the room name, 

number, finish data, and so on. You can then use this information to generate room 

schedules, generate reports, and perform calculations. You can also tag the room to dis-

play information such as the room name, number, and square footage. 

Rooms are model elements like doors, walls, and windows, but you can add rooms to 

the model graphically in a plan view or create them in a schedule view. When you create 

rooms in a schedule, you are creating unplaced rooms. This is not the same as using the 

Room tool in a plan view. One reason to create rooms in a schedule view is to predefine 

a listing of the rooms you need in a building program. As you lay out your building pro-

gram and add rooms to the plans, you can use all the predefined information.

When you place rooms, you need to associate them with a bound space. A space is bound 

when three or more walls or room separation lines enclose that space. Revit provides you 

with options to specify whether a wall is bounding or nonbounding. You might use this 

option if you do not want half-height walls or moveable partitions to divide a space. Room 

separation lines allow you to subdivide a room into two or more different areas.

In this exercise, you will define several rooms and then use room separation lines to 

further define the room:

	 1.	 Open the source file rac_advanced_sample_project.rvt, which can be found in  

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples (which was 

installed with Revit Architecture 2011). You are using this model because it has  

different elements that you can use, such as furniture, to explore the Visibility/

Graphics settings.

	 2.	 Save the file as Add_rooms.rvt.

	 3.	 In the Project Browser, make the 02 – Floor floor plan view active.

	 4.	 On the Home tab’s Room & Area panel, click the upper portion of the Room button. 

The Room button is a split button, with the top portion for creating a room and the 

lower portion for creating either a room or a room separation line.

When placing a room, you have a number of options to consider in the ribbon and 

Options bar (Figure 11.1). Most of the options on the ribbon should be familiar to 

you from working with other tools. 

Figure 11.1

Modify | Place Room 
tab and Options bar 

for placing a room
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The ribbon has two options:

Highlight Boundaries  ​This button highlights all options that can be used as a bound-

ary for rooms.

Tag On Placement  ​When selected, this button adds a room tag to the rooms as they 

are added to the project. If this option is not selected, then room tags will not be 

added when rooms are added to the project.

Use the Highlight Boundaries option when you want to quickly see what the room bound-

ary options are on the plan drawing. This can help you determine whether you need to use 

room separation lines to further divide an area.

The options on the Options bar are as follows:

Upper Limit and Offset  ​These define the upper boundary of the room.

Tag Orientation  ​When Tag On Placement is selected, this option sets the orientation 

of the tag to either horizontal or vertical.

Leader  ​This adds a leader to your tags.

Room  ​This provides a listing of rooms that have not yet been placed in the model. 

If there are no unplaced rooms in the model, then the only choice displayed will be 

New, which will create a new room.

	 5.	 In the Modify | Place Room tab’s Tag panel, activate 

the Tag On Placement option. You will use the default 

settings on the Options bar.

	 6.	 Move your mouse pointer over the southeast room. 

This is the room with the door tagged 202. Notice 

that there is an X in the room; the room tag is being 

displayed, and the outline of the room boundary is 

highlighted (Figure 11.2).

	 7.	 Click in the space to create the room and its tag.

To change the properties of a room, you need to select 

it. You can accomplish this a couple of ways. The 

first method is to move your mouse pointer within 

the room until you mouse pointer finds the X. The 

second method is to move your mouse pointer to the 

edge of a boundary wall, press the Tab key, watch the status bar until the room is 

selected, and then click the mouse. The room is then selected, and you can edit the 

parameters of the room.

Figure 11.2

The X appears when 
you are placing  
a room.
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	 8.	 In the Properties palette, name the room Instruction, and assign the room  

number 202.

While the Room tool is active, existing rooms will be highlighted in blue on the 

screen. This is a visual cue to indicate which spaces have not been assigned rooms. 

Notice that when you place rooms, Revit will automatically attempt to align tags. 

You might have also noticed that Revit will automatically number each room 

sequentially. Although it is a simple process to renumber rooms, you can save your-

self some time if you plan your placement of rooms to allow Revit to number the 

rooms for you.

	 9.	 Repeat steps 7 and 8 to create rooms for the corridor, stairway, and rooms shown in 

Figure 11.3.

Room Separation Lines
In Revit, you have the ability to create spaces that you can use to define rooms with-

out using walls. You can do this using room separators. You can also use the Room 

Separation Line tool to further divide a space if necessary. In the next example, you  

will use the Room Separation Line tool to define an existing space.

	 1.	 If you completed the previous section, continue using that file. Otherwise, open 

the source file rac_advanced_sample_project.rvt, which can be found in c:\Program 

Files\Autodesk\Revit Architecture 201\Program\Samples (installed with Revit Archi-

tecture 2011).

	 2.	 Save the file as Room_Separation.rvt.

	 3.	 Open the floor plan 01 – Entry Level.

	 4.	 Zoom into the southwest corner of the building to the room labeled Instruction with 

a room number of 218.

Figure 11.3

Adding rooms  
as indicated
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You want to subdivide this room into two different spaces based upon usage. 

Although you could use drafting lines to divide the space, you want to use the 

Room Separation Line tool for scheduling purposes and to ascertain its area.

 5. On the Home tab’s Room & Area panel, click 

the lower portion of the Room split button, and 

select Room Separation Line.

 6. Draw a room separation line along grid line I 

(Figure 11.4).

 7. Press Esc twice to end the Room Separation 

Line tool.

Notice that the previously defi ned room has not 

been split into two rooms. The original room 

has been constrained in size, and the other side 

of the room separation line is a space without 

a room. What you need to do now is add a sec-

ond room above the room separation line, as 

shown in Figure 11.5.

 8. Click the Room button.

 9. Place a room above the Instruction room 218.

 10. Name the room Instruction with a room num-

ber of 218A.

 11. Rename room 218 to 218B, and change the name 

to Lab.

Room Schedules
As you add rooms to your model, you will want to 

create a room schedule to organize and display this 

information. In this section, you are going to cre-

ate a basic room schedule. In Chapter 12, “Tags, 

Schedules, and Keynotes,” we will cover schedules in 

more detail. 

 1. If you completed the previous section, continue 

using that file. Otherwise, open the source file 

rac_advanced_sample_project.rvt, which can 

be found in c:\Program Files\Autodesk\Revit 

Architecture 201\Program\Samples (installed with 

Revit Architecture 2011).

Figure 11.4

Sketching a room 
separation line 
along grid line I

Room separation line

Figure 11.5

Completed subdi-
vided room
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	 2.	 Save the file as Room_Schedule.rvt.

	 3.	 Click the View tab, go to the Create panel, click the Schedule drop-down, and select 

Schedule/Quantities.

	 4.	 In the New Schedule dialog box, select Rooms from the category list. Make sure the 

name is set to Room Schedule. The Schedule Building Components radio button 

should be selected. The Phase should be set to New Construction, as shown in  

Figure 11.6.

	 5.	 Click the OK button to close the New Schedule dialog box and open the Schedule 

Properties dialog.

	 6.	 On the Fields tab, add the following items in order from the Available Fields section 

to the Scheduled Fields section, as shown in Figure 11.7. (Select the field and click the 

Add button, or double-click the field to add it to the Scheduled Fields section.)

Name•	

Number•	

Base Finish•	

Floor Finish•	

Wall Finish•	

Ceiling Finish•	

Department•	

Comments•	

	 7.	 Click the Sorting/Grouping tab, and set Sort By to Number.

	 8.	 Click OK to close the Schedule Properties dialog. A schedule will be created, as 

shown in Figure 11.8.

Figure 11.6

New Schedule  
dialog box
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Now that you have a basic room schedule, you can add, edit, or delete values for the 

various fields. This can be very time-consuming, since Revit permits you to edit only one 

field at a time. 

Figure 11.7

Adding fields to the 
room schedule

Figure 11.8

Room schedule
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Key Schedules for Rooms

As you work on your building project, you are going to find that some of your schedules, 

such as rooms, doors, and windows, will contain a great deal of information. Depending 

on the size of your project, this could be from a few dozen rooms to several hundred. 

Rather than having to manually enter information such as wall and floor finish for each 

room separately, it would be much easier if you could find a method to automatically fill 

in this information. Using key schedules, you can create a list of styles that you predefine 

to use in your schedules. 

For example, you may have a project with finishes that apply to many of the rooms or 

many different doors that share the same type of hardware. Rather than assigning this 

information to each individual element, you can use key schedules to automatically fill in 

the fields.

In the following example, you will create a key schedule to aid in assigning finishes to 

the rooms in the example project:

	 1.	 If you completed the previous section, continue using that file. Otherwise, open 

the source file rac_advanced_sample_project.rvt, which can be found in c:\Program 

Files\Autodesk\Revit Architecture 201\Program\Samples (installed with Revit Archi-

tecture 2011).

	 2.	 Save the file as Room_Key_Schedule.rvt.

	 3.	 Click the View tab, go to the Create panel, click the Schedule drop-down, and click 

Schedule/Quantities.

	 4.	 In the New Schedule dialog box, select Rooms from the Category list.

	 5.	 Set Name to Room Style Schedule. The Schedule Keys radio button should be 

selected, and set Key Name to Room Style, as shown in Figure 11.9.

	 6.	 Click OK to close the New Schedule dialog box. The Schedule Properties dialog  

box will open.

In the Schedule Properties dialog box, the key name is automatically added to the 

Scheduled Fields field. You need to add the fields that you want to predefine in the 

style.
Figure 11.9

New Schedule dia-
log box for creating 

a room key schedule
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	 7.	 On the Fields tab, add the following items in order from the Available Fields section, 

as shown in Figure 11.10. Select a field and click the Add button, or double-click the 

field to add it to the Scheduled Fields section.

Base Finish•	

Floor Finish•	

Wall Finish•	

Ceiling Finish•	

	 8.	 Click OK to close the Schedule Properties dialog box.

	 9.	 On the Modify Schedule/Quantities ribbon tab’s 

Rows panel, click the New button to create a new row.

In each row you are going to create new values. 

Specifically, you are going to create rows for several of 

the rooms and then apply the finishes associated with 

each room type.

	10.	 Using Figure 11.11 as a reference, create rows and key values for the room names 

Instruction, Men, and Women. The key schedule will open, and it will look similar 

to a component schedule (Figure 11.11).

	11.	 Fill in the appropriate information for each of 

the key values.

Now that you have created your key schedule, 

you need to apply it to your room schedule.

	12.	 In the Project Browser, open the room sched-

ule that you created earlier in this section, 

open one of your own room schedules, or create a new schedule.

	13.	 In the Properties palette, click the Edit button to the right of Fields.

	14.	 In the Available Fields list, locate the Room Style field 

that you created in step 6. Select the field and click the 

Add button, or double-click the field to add it to the 

Scheduled Fields section (see Figure 11.12).

	15.	 Click OK to close the Schedule Properties dialog box.

	16.	 In the schedule, locate room number 104, Instruction. 

In the Room Style cell for room 104, click in the cell 

(Figure 11.13), and select Instruction.

Figure 11.10

Schedule properties 
for key schedule

Figure 11.11

Room style  
schedule

Figure 11.12

Add the key named 
Room Style to the 
room schedule
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Notice that, after changing the Room Style cell from none to Instruction, the cells for 

Base Finish, Floor Finish, Wall Finish, and Ceiling Finish are automatically filled. If you 

were to return to the key schedule and edit the values in there, the room schedule would 

automatically update.

The one main drawback to using a key schedule is that once you apply a key value to a 

schedule row, you will not be able to modify any of the fields defined in the key schedule. 

For example, in the previous example of room 104, when you apply the key value, you 

will not be able to edit the wall finish.

Areas
You use area plans to show different spatial relationship–based area schemes and levels in 

the model. You can create multiple area plans for every area scheme and level. In the fol-

lowing steps, you will create an area plan:

	 1.	 If you completed the previous section, continue using that file. Otherwise, open 

the source file rac_advanced_sample_project.rvt, which can be found in c:\Program 

Files\Autodesk\Revit Architecture 201\Program\Samples (installed with Revit Archi-

tecture 2011).

	 2.	 Save the file as Area_Plan.rvt.

	 3.	 On the Home tab’s Room & Area panel, click the Area button drop-down, and click 

Area Plan.

	 4.	 In the New Area Plan dialog box, choose Gross Building from the Type Selector.

	 5.	 Choose 02 – Floor for the area plan view.

	 6.	 Click OK to close the New Area Plan dialog box.

Figure 11.13

Selecting a room 
key style (top) 

populates the room 
finish information 

(bottom).
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 7. A dialog box will open asking whether you want Revit to automatically create area 

boundary lines to be associated with all external walls. Click Yes to have the 

area boundaries automatically created.

A new gross building area plan is cre-

ated. The fl oor plan will have a purple 

boundary around the exterior walls.

 8. On the Home tab’s Room & Area panel, 

click the Legend button.

 9. Place the legend in the upper-right cor-

ner of the view, as shown in Figure 11.14.

 10. In the Choose Space Type And Color 

Scheme dialog box, set Space Type to 

Areas (Gross Building), and set Color 

Scheme to Gross Building Area.

 11. Click OK to close the Choose Space Type 

And Color Scheme dialog box.

In the next few steps, you will adjust the 

color scheme legend.

 12. Select the legend. On the Modify | Color 

Fill Legends tab’s Scheme panel, click the Edit Scheme button. This will open the Edit 

Color Scheme dialog box (Figure 11.15).

Figure 11.14

Preliminary area 
plan with legendplan with legend

Figure 11.15

Edit Color Scheme 
dialog box
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In the Edit Color Scheme dialog box, you can adjust or create new color schemes. In 

the next example, you are going to change the color scheme to be based on the area 

of the room rather than the name.

	13.	 In the Color drop-down, select Area. The Colors Not Preserved box dialog box will 

open. This dialog box is warning you that any changes you make will not preserve 

your color scheme.

	14.	 Click OK to accept the warning.

	15.	 Click the By Range radio button. This will allow you to create a color scheme based 

on an area.

You now have a color scheme that will color by area elements based upon their area. 

In this example, you have two colors, one for areas that are smaller than 20 m2 and 

one for rooms greater than 20 m2. Let’s add a third option that will color areas that 

are less than 200 m2, areas that are between 200 m2 and 400 m2, and finally areas 

that are greater than 400 m2.

	15.	 Click in one of the rows, and then click the green + to add a new value.

Revit automatically creates a new value for you. The color scheme will now show 

three options. You can now make changes to the legend caption, color, and fill 

patterns.

	16.	 Using Figure 11.16 as a reference, in the last (third) row change the At Least option  

to 400 m2. In the second row, change the At Least option to 200 m2.

	17.	 Click OK to return to the model. It should look like Figure 11.17.
Figure 11.16

By range area edit 
color scheme
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Identifying Rentable Areas
Now that you have defined the gross areas, you can move on to calculating the rentable 

areas. You are going to follow the same procedures to create a rentable area as you did for 

creating a gross area plan. The main difference between creating a gross area plan vs. a 

rentable area plan is that Revit will draw an area boundary on the inside of the exterior 

walls for a rentable area, whereas with the gross area, the lines were drawn on the outside 

of the exterior walls.

	 1.	 If you completed the previous section, continue using that file. Otherwise, open the 

source file rac_advanced_sample_project.rvt, which can be found on in c:\Program 

Files\Autodesk\Revit Architecture 201\Program\Samples (installed with Revit Archi-

tecture 2011).

	 2.	 Save the file as Rentable_Plan.rvt.

	 3.	 On the Home tab’s Room & Area panel, click the Area button drop-down, and click 

Area Plan.

	 4.	 In the New Area Plan dialog box, choose Rentable from the Type Selector, and 

choose 02 – Floor for the area plan view. Click OK to close the dialog box.

Figure 11.17

Finished area plan
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	 5.	 A dialog box will open asking whether you want Revit to automatically create area 

boundary lines to be associated with all external walls. Click Yes to have the area 

boundaries automatically created.

A new rentable building area plan is created. The floor plan will have a purple 

boundary around the exterior walls.

	 6.	 On the Home tab’s Room & Area panel, click the Legend button. The Choose Space 

Type And Color Scheme dialog box will open.

	 7.	 Place the legend in the upper-right corner of the view. Set Space Type to Areas (Rent-

able), and set Color Scheme to Rentable Area. Click OK to close the dialog box.

In the next few steps, you are going to modify the area that Revit automatically cre-

ated. In this example, you want to make sure you are not going to calculate com-

mon spaces within the building such as the stair cores. You are going to use the Area 

Boundary Line tool to define these spaces. This tool works very similar to the Room 

Separation Line tool.

	 8.	 From the Home tab’s Room & Area panel, click the Area button drop-down, and 

click Area Boundary Line.

	 9.	 Using Figure 11.18 as a reference, define boundaries around the grayed-out spaces 

using the Area Boundary Line tool.

In the next step, you need to create areas for the new spaces that you created in the 

step that you just created.
Figure 11.18

Defining boundar-
ies around the  

common spaces in 
your project
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	10.	 From the Home tab’s Room & Area panel, click the Area button drop-down, and 

click Area.

	11.	 Using Figure 11.18 as a reference, create an area for each of the grayed-out spaces.

In the next step, you need to create an area for the rentable space.

	12.	 From the Home tab’s Room & Area panel, click the Area button drop-down, and 

click Area.

	13.	 Using Figure 11.18 as a reference, create an area that is outside one of the gray areas. 

This is going to be the rentable space. Select this area.

	14.	 In the Properties palette, make sure that Area Type 

is set to Floor Area, as shown in Figure 11.19.

Just like the gross area plan, you can edit the rent-

able area legend to alter the rentable area plan to suit 

your needs. 

Whether you are creating gross building or rentable 

area plans, you can schedule these area plans.

Figure 11.19

Defining the  
area type for a 
selected area
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Tags, Schedules, and Keynotes

In this chapter,  we will discuss using tags to label building elements 

in your projects, using schedules to view and examine your project, and using text to 

annotate it. Tags are 2D symbols with unique properties used to represent each building 

element. A tag works by pulling parameters from an element. Tags are also dynamic; as 

the building is updated and values change, the information in the tag will be updated 

automatically.

Schedules provide another view in which you can examine and edit your building 

project. Schedules provide you with a listing of parameters for the elements in your 

building project. The schedules are dynamic and allow you to make changes to data 

stored in element parameters, calculate values, or even alter model geometry. Schedules 

are a very powerful tool often overlooked by new users.

In this chapter, we’ll talk about the following:

Tags■■

Schedules■■

Keynotes■■



316  ■   Chapter 12 : Tags, Schedules, and Keynotes

Tags
Tags are annotation elements, and they have some of the same characteristics as annota-

tions. Tags are view-specific. When you place a tag in one view, that tag will not be visible 

in any other views. When you place a tag, it will automatically try to align with other tags 

in the view. Tags will also scale with the view.

Revit includes a number of predefined tags, but not all tags are loaded automatically in 

the default template. You can load additional tags, and Revit provides the ability to cus-

tomize the tag to display any element parameter required. Figure 12.1 shows some of the 

different types of predefined tags.

Window tag

Furniture tag

Wall tag

Room tag

Door tag

Loading Tags
Out of the box, Revit ships with several predefined tag annotation families. You can cus-

tomize these tags to meet your specific graphical needs. Depending on the template, your 

project may need to have additional tags loaded. To load new tags, follow these steps:

	 1.	 On the Annotate tab’s Tag panel, click the panel drop-down, and choose Loaded Tags.

The Tags dialog box will now be displayed (Figure 12.2). The left Category column 

lists the various Revit element categories. The right Loaded Tags column lists any 

of the loaded tags in your project. At the bottom-left corner of the dialog box you’ll 

see a Show Categories From All Disciplines check box. By default, the Category col-

umn will display only Revit Architecture element categories. By selecting the Show 

Figure 12.1

Different  
usages of tags
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Categories From All Disciplines check box, the Category column will display all the 

element categories for Architecture, Structural, and MEP elements.

	 2.	 Click the Load button to select addi-

tional tags to load.

	 3.	 Navigate to your Revit library, and 

begin by selecting your tag families. 

You can select multiple tag files by 

holding either the Shift or Ctrl key 

while selecting the families.

	 4.	 When you are finished selecting 

tags, click the Open button, and 

then click the OK button in the  

Tags dialog box.

Using Tags
For some elements such as doors and windows, when you place the element, there is an 

option to automatically place a tag. You just click Tag On Placement on the Modify | 

Place Door or Modify | Place Window tab to automatically tag the element (Figure 12.3). 

For other elements such as walls and furniture, you can place a tag only after the wall or 

furniture has been placed. In the next steps, we will walk through tagging elements.

You can find the tools to place tags on the Annotate tab’s Tag Panel (Figure 12.4). You 

are provided with seven tagging options. 

Tag All (Tag All Not Tagged)  ​If you have multiple elements in a view that do not have tags, Tag 

All allows you to apply tags to untagged elements in one operation.

Tag By Category  ​This allows you to tag elements by category or type.

Multi-Category  ​This allows you to tag elements across different family types.

Material Tag  ​This identifies the type of material used for an element or a layer of  

an element.

View Reference  ​This displays the sheet and detail number of a view that 

has been split by a matchline. Note that this tool is active only in views 

with dependent view relationships.

Area Tag  ​This displays the total area within an area boundary.

Room Tag  ​This displays the name and number of a room.

Figure 12.2

Tags dialog box

Figure 12.3

Click Tag On  
Placement on the  
Modify | Place Door/
Window tab to auto-
matically tag the 
element.

Figure 12.4

Tagging options
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Tag by Category

The Tab By Category option allows you to tag elements either by category or by type.  

To place tags using the Tag By Category tool, follow these steps:

	 1.	 Open a view in which you want to tag elements.

	 2.	 On the Annotate tab’s Tag panel, click Tag By Category.

	 3.	 On the Options bar, set the Orientation value of the tag to either Horizontal or  

Vertical, and set the desired leader options.

	 4.	 Move your mouse pointer over an element to tag. Revit will provide a preview of  

the tag and tag value. Click to place the tag.

Tag All (Tag All Not Tagged)

As you work on your building project, you will find that it can be very time-consuming 

to individually tag each element in the project. The Tag All tool enables you to apply tags 

to all untagged element in a view in a single operation. It is a great tool to make sure that 

you have tagged all the elements in a view. The main drawback to this tool is that you 

have little control over the placement of the tags.

To place tags using the Tag All tool, follow these steps:

	 1.	 Open a view in which you want to tag elements.

	 2.	 On the Annotate tab’s Tag panel, click the Tag All button. The Tag All Not Tagged 

dialog box (Figure 12.5) will be displayed. This dialog box provides several options:

You can tag all objects in the current view.•	

You can tag only the selected objects in the current view.•	

You can tag elements in linked files.•	

You can add a leader to the tag.•	

You can specify the orientation of the tag.•	
Figure 12.5

Selecting door tags 
in the Tag All Not 

Tagged dialog box
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Specify what elements to tag.

To tag all visible elements in the current view that do not have tags, select the •	

radio button All Objects In Current View.

To tag only the elements you have selected, select Only Selected Objects In Cur-•	

rent View. To use this option, you must first select the objects prior to initiating 

the Tag All tool.

	 3.	 If you have multiple tag styles loaded, you have the ability to select the tag style.

	 4.	 Select the tag categories to use. In Figure 12.5, we have multiple tag categories to 

choose from (room, wall, and doors). You may decide that you want to tag only walls 

and doors. To select just these categories, press the Shift or Ctrl key while selecting 

categories.

	 5.	 Set the Leader and Orientation options.

	 6.	 Click OK to place the tags.

Material Tag

In the previous example, the Tag All tool reads the instance or type description of an ele-

ment and generates a tag. The Material Tag tool allows you to generate a tag based upon 

the type of material used for either an element or a layer of an element. This tool pulls 

the tag information from the Description line in the material definition (Figure 12.6). 

For example, if you are tagging a wall by material (Figure 12.7), you will be able to tag the 

materials used in the wall assembly. This allows you to tag the brick, sheathing, and studs 

separately.
Figure 12.6

Material description 
example
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To place tags using the Tag By Material tool, follow these steps:

	 1.	 Open a view in which you want to tag elements.

	 2.	 Click the Annotate tab’s Tag panel, and click Material Tag.

The Options bar provides several options that you can set, such as Horizontal or 

Vertical tag orientation. You can also create a leader to the tag.

	 3.	 Move your mouse pointer over the material to highlight the element. Revit will  

provide a preview of the tag for the element your mouse pointer is over.

If your material tag is displaying a question mark (as in Figure 12.7), the material 

description is not being read. First, make sure that the view detail level is set to either 

Medium or Fine. If it is set to Course, the material is not visible, and the tag will not 

display. Next, check the Description field of the Identity tab for the element’s mate-

rial (shown in Figure 12.6). Or double-click the question mark, and you can manu-

ally type in a material description.

	 4.	 To place the tag, click the element. If you elected to create a leader, then you will need 

to click again to place the leader before the tag is created.

Schedules
As previously mentioned, Revit is a database, and it provides you with the ability to 

view your data in different forms. Sometimes that means looking at the geometry in a 

plan, section, detail, or 3D view. You also have the ability to look at your building project 

through a schedule. Schedules allow you to view information about your building proj-

ect in a tabular display of information. Figure 12.8 shows an example of a door schedule 

that is dynamically updated as changes are made to the model. The information from the 

schedule is read from the element properties in the project. Information can be displayed 

for each item or type and can include such information as size, material, finish, fire rat-

ing, cost, level, description, comments, and so on. If this information is changed in the 

model, the schedule automatically updates. If you change the information in the sched-

ule, the model is updated.

Figure 12.7

Tag By Material 
example with 

a blank material 
definition
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Schedules can be created at any stage of a project, and the data in the schedule can be 

filtered and sorted to suit your needs. As the project progresses, changes to the project will 

be instantly reflected in the schedules. You can also change the format of the schedule 

when you place it on a sheet.

Revit has seven types of schedules:

Schedules  ​These are the most common schedule you will create. They can be used 

to extract quantities from the model. Some examples are door, window, and room 

schedules.

Key schedules  ​These schedules list styles that you predefine for use in schedules. An 

example is a room schedule, where there might be some finishes that apply to many 

rooms. Key schedules make it easy to automatically fill in fields in the schedule rather 

than entering data in each field of the schedule.

Material takeoffs  ​These schedules list all the materials and subcomponents of Revit fami-

lies and allow for a more comprehensive level of detail for each assembly.

Annotation or note block schedules  ​These schedules list the notes that are applied to ele-

ments and assemblies and list the annotation symbols used in the project.

Revision schedules  ​These schedules list revisions in the project.

View lists  ​These schedules list all the views in the Project Browser and their properties.

Drawing lists  ​These schedules list all the sheets in the project.

Creating a Component Schedule
The following steps describe how to create a basic schedule in Revit. In this particular 

schedule, you are going to create a basic window schedule.

	 1.	 Open the source file rac_basic_sample_project.rvt, which was installed with Revit 

Architecture 2011 and can be found here:

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples

Figure 12.8

Door schedule 
example
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	 2.	 Save the file as Scheduling12.rvt.

	 3.	 Click the View tab’s Create panel, click the Schedule drop-down, and click  

Schedules/Quantities to open the New Schedule dialog box.

The New Schedule dialog box (Figure 12.9) displays the various categories of build-

ing elements in the Category list. By default, it will display elements specific to Revit 

Architecture. Selecting the Show Categories From All Disciplines option will display ele-

ment categories from Revit Structure and Revit MEP as well.

You select the desired category to create  

a schedule. For example, to create a window 

schedule, you can select Window from the Cat-

egory list. When you select a category, the cat-

egory name is displayed in the Name text field.

You should select the Schedule Building 

Components radio button to create a schedule 

of the building elements. The Phase drop-

down is where you can set up the phase of the 

construction.

For this example, select Windows from the category list; then click the OK but-

ton to close the New Schedule dialog box and open the Schedule Properties dialog box 

(Figure 12.10). This dialog box provides the options for specifying the information that 

will be included in the schedule and how it should be displayed. There are five tabs to 

manage this:

Fields  ​This tab allows you to select parameters that will be used in your schedule. This 

tab will determine which fields will actually be reported in the schedule. Select the field 

in the left column, and click the Add button. Note that the field’s order will determine 

the column order in the schedule. The top field will be the far-left column in the sched-

ule, and so on.

Filter  ​The Filter tab allows you to narrow your schedule and show only specific informa-

tion by filtering the schedule. In this chapter’s example, you will filter your walls based on 

their function. You only want to schedule the exterior walls and therefore not show the 

interior ones.

Sorting/Grouping  ​This is where you will work on controlling how the information is 

organized. For example, you have a multilevel project and want to create a door schedule 

for the entire project. You can sort and group the schedule so that the doors are grouped 

by level and sorted by their mark number.

Formatting  ​The Formatting tab controls the individual field’s behavior. You can, for 

example, decide to change the actual name displayed in the schedule.

Appearance  ​This last tab controls how the schedule will look once placed on a sheet. It 

doesn’t affect how the view displays, only how the final prints look.

Figure 12.9

New Schedule  
dialog box



Schedules  ■   323

On the Fields tab, add the following to your schedule (Figure 12.10):

	 1.	 In the Available Fields list, select Mark.

	 2.	 Click the Add ➔ button to add Mark to the Scheduled Fields (In Order) list. You can 

also double-click the parameter to add it to the Scheduled Fields (In Order) list.

	 3.	 Repeat steps 1 and 2 but add Type, Width, Height, and Level.

	 4.	 On the Sorting/Grouping tab, you will be sort-

ing by Mark number, as shown in  

Figure 12.11. Switch to that tab, and set the 

options as follows:

Set Sort By to Mark.•	

Select Ascending to sort the Mark number •	

by ascending order.

Make sure that Header is not selected. This •	

will place the Mark number on top of the 

column.

Make sure that Footer is not selected.•	

Select Grand Total, and then select Counts •	

And Totals. This will give you an overall 

count and totals for all doors used in  

the project.

	 5.	 Click OK, and you will be taken to a view of the 

schedule (Figure 12.12). Save the file for use in 

the following sections.

Figure 12.10

Schedule Properties 
dialog box

Figure 12.11

Schedule Properties 
dialog box, Sorting 
and Grouping tab

Figure 12.12

Sample door  
schedule
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Modifying a Component Schedule
Once you’ve created your schedule, you often need to either refine the fields in the sched-

ule or add information to it. To modify a schedule, first access the necessary options by 

doing one of the following:

When in a schedule view: from the Properties palette, select any of the five schedule •	

tabs under Other.

When in a sheet view: select the schedule, right-click and select Edit Schedule, and •	

then right-click anywhere and select View Properties.

You are then presented with the Instance Properties dialog box. This is where you  

can set the proper phase and phase filter for the schedule or access any of the five tabs  

by clicking the corresponding Edit button.

Exporting Schedules
You can export schedules to various formats to facilitate communications with other  

parties. To export a schedule, follow these steps:

	 1.	 Go to the schedule view you want to export.

	 2.	 Click the application menu, and choose Export ➔ Reports ➔ Schedule.

	 3.	 Browse to the desired folder, enter a name, and click the Save button. Schedules 

export as delimited text files (.txt) that can be later opened in spreadsheet programs 

such as Microsoft Excel.

	 4.	 In the export schedule under Schedule Appearance, select Multiple Rows; then select 

Export Group Headers, Footers And Blank Lines to keep the look of the schedule  

the same.

	 5.	 In the Output options, select Tab as the field delimiter and the quotes (‘) as the text 

qualifiers.

	 6.	 Click OK.

Material Takeoff
Using Revit, you can quantify specific materials. Quantifying material is slightly different 

from a component schedule because it lists a specific material and some of its properties 

along with the component’s properties. In this example, you will list the Gypsum Wall 

Board material from your example file. You are going to continue using Scheduling12.rvt 

that you created in the previous example. If you are just starting from this point, open 

the source file rac_basic_sample_project.rvt, which was installed with Revit Architecture 

2011 and can be found here:

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples
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Save the file as Scheduling12.rvt, and then follow these steps:

	 1.	 Go to the View tab’s Create panel, click Schedule, and click Material Takeoffs.

	 2.	 In the New Material Takeoff dialog box, select Wall as the category. Click OK.

	 3.	 In the Material Takeoff Prop-

erties dialog box, add the fol-

lowing fields (Figure 12.13):

Function•	

Family and Type•	

Material: Name•	

Material: Area•	

Material: Cost•	

	 4.	 On the Filter tab, set the  

Filter By fields to Material: 

Name, equals, and Finishes – 

Interior – Gypsum Wall  

Board (as shown in  

Figure 12.14).

	 5.	 On the Sorting/Grouping tab 

(Figure 12.15), set the options 

as follows:

Set Sort By to Function.•	

Select Footer, and select •	

Totals Only.

Select Blank Line.•	

Select Grand Totals,  •	

and select Totals Only.

Select Itemize Every  •	

Instance.

	 6.	 On the Formatting tab, select 

Material: Area, and select Cal-

culate Totals.

	 7.	 Click OK and save the file. 

Figure 12.16 shows the takeoff 

schedule. 

Figure 12.13

Field listing for 
material takeoff 
example

Figure 12.14

Filtering for Gypsum 
Wall Board material

Figure 12.15

Sorting/Grouping 
tab for material 
takeoff example



326  ■   Chapter 12 : Tags, Schedules, and Keynotes

You now have a list of all the walls that contain the Gypsum Wall Board material and 

the associated area. The last step will be to add a cost and multiply that cost by the area to 

have a total cost:

	 1.	 In the Properties palette, click the Fields Edit  

button.

	 2.	 Click the Calculated Value button to create  

the formula. Enter Total Cost as the name  

(Figure 12.17).

	 3.	 Select the Formula radio button.

	 4.	 Set Discipline to Common.

	 5.	 Set Type to Currency.

	 6.	 Insert (Material: Area / 1 SF) * Material: Cost in  

the Formula field.

	 7.	 Click OK.

In the next step, you need to divide the Material: 

Area value by a single unit (1 SF) to allow Revit 

to multiply the values. Revit can only multiply the 

same value type or numbers.

	 8.	 On the Formatting tab, select Total Cost, and 

select Calculate Totals.

	 9.	 Click Field Format, and deselect Use Project  

Settings.

	10.	 Change the Unit Symbol field to $ (Figure 12.18).

	11.	 Click OK in each dialog box. This will bring you 

back to your schedule.

Figure 12.16

Wall material  
takeoff schedule

Figure 12.17

Creating a calculated value

Figure 12.18

Changing field format
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	12.	 In any of the empty fields under the Material: Cost column, type the value 1.25 for 

the cost. Since all walls are using the same material, it will fill in all the values auto-

matically. Revit will then multiply the area by the cost and give you a total per func-

tion and a grand total for the project (Figure 12.19).

	13.	 Save the file for use in the next section.

Keynotes
Keynotes are annotation tags that allow you to apply a specific numbering to elements 

in your building project. Unlike a note created using a text tool, keynotes are an alpha-

numeric descriptor for elements in your projects. They are shorthand descriptions for 

describing an element. Why would you use keynotes? Keynotes help ensure consistency 

in your document set.

Figure 12.20 shows the same detail using both keynotes and text notes to call out ele-

ments of your building project. Because text notes are created by each user, in a docu-

ment set there is a chance for deviation in the descriptions. Keynoting prevents that, as 

long as the correct keynote is assigned to the element. Using keynotes with a keynote leg-

end requires less room in your details than typical drawing notes. When used effectively, 

keynoting can simplify your annotation process.

Figure 12.19

Completed wall 
takeoff schedule
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Keynote Text File
A keynote parameter needs to be assigned to your model elements, detail components, 

and materials in order for the keynote system to tag properly. This keynote parameter 

will then reference the more detailed description in a keynote text file (Figure 12.21),  

so, you must first associate your project with this keynote text file.

Figure 12.20

Detail with (top) 
keynotes and (bot-
tom) the text notes
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You are going to continue using Scheduling12.rvt that you created earlier in the chapter. 

If you are just starting from this point, open the source file rac_basic_sample_project.rvt, 

which was installed with Revit Architecture 2011 and can be found here:

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples

Save the file as Scheduling12kn.rvt. To associate 

the keynotes text file, follow these steps:

	 1.	 Click the Annotate tab’s Tag panel drop-

down, and select Keynoting Settings. This 

opens the Keynoting Settings dialog box 

(Figure 12.22).

	 2.	 Make sure that you have a keynote text file 

associated with the project. If you do not, 

click the Browse button, and navigate to the 

following location:

C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2011\

Imperial Library\RevitKeynotes_Imperial_2004.txt

	 3.	 If you have a specific keynoting file you are using for a project, you will make 

changes to the Path Type field, setting it to Absolute or Relative.

	 4.	 For Numbering Method, select By Keynote.

The Keynoting Settings dialog box provides you with the following options:

Full Path  ​Displays the entire path of the keynote file.

Saved Path  ​Displays the filename of the loaded keynote file.

View  ​Opens the Keynotes dialog box so that you can view the contents of the keynote file.

Absolute (Path Type)  ​Identifies a specific folder located on your local computer or a net-

work server. The path is stored in the Uniform Naming Convention (UNC) format such 

as \\servername\share\folder\folder\keynote.txt.

Figure 12.21

Partial view of the 
keynote text file

Figure 12.22

Accessing the Key-
noting Settings 
dialog box
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Relative (Path Type)  ​Looks for the keynote file where the project file or central model is 

located. If the file is moved to a new location, Revit Architecture expects to find the key-

note file in this new folder location as well.

At Library Locations (Path Type)  ​Looks for the keynote file in the location of the stand-

alone installation or network deployment specified.

By Keynote (Numbering Method)  ​Specifies that the actual keynote number is used in the 

tag (Figure 12.23), in the 16-division CSI format.

By Sheet (Numbering Method)  ​Numbers keynotes according to their order of creation on 

a particular sheet (Figure 12.24). With this system, it is possible that the same keynote 

could be a different number on a different sheet. Note that when this method is used, the 

value for the keynotes will be displayed only when the view that the keynotes were cre-

ated on is placed on a sheet.
Figure 12.23

Imperial keynotes, 
numbered by note

Figure 12.24

By Sheet keynotes
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Assigning Keynotes
Now that you have assigned a keynote file to your project, you can assign keynotes  

to your model elements, detail components, and materials. This is the most time- 

consuming part of using keynotes, because you have to assign a value to the Keynote 

Type parameter for each type (element, detail 

component, material) that you want to key-

note in your project if this has not already 

been done to families in your Revit content 

library. The Keynote parameter is a type 

parameter. To assign a keynote to an element, 

follow these steps:

	 1.	 Select the element, and edit the type 

properties.

	 2.	 Click the browse button  in the  

Keynote field (Figure 12.25).

	 3.	 This takes you to the Keynotes dialog 

box (Figure 12.26). Select the appropri-

ate keynote for the element you have 

selected.

	 4.	 Click OK to close the Keynotes  

dialog box.

	 5.	 Click OK to apply the selected keynote to the element type properties.

Creating Keynotes
To create a keynote, you are going to follow the same gen-

eral guidelines that you use when placing tags. With key-

notes, though, you have three options:

Element  ​When you select an element, the keynote 

assigned to the type properties is used. If you select an 

element that does not have a keynote assigned to it, the 

Keynote Listing dialog box is displayed, allowing you to 

assign a keynote.

Material  ​When you select an element, the keynote 

assigned to the material that was assigned to the selected 

element is used. If you select a material that does not have 

Figure 12.25

Type properties  
for a door

Figure 12.26

View of the keynote 
text file within Revit
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a keynote assigned to it, the Keynote Listing dialog box is displayed, allowing you to 

assign a keynote.

User  ​When you select an element, the Keynote Listing dialog box is displayed, allowing 

you to assign a keynote. This occurs even if the element already has a keynote assigned to 

the type property.

As you work on keynoting, you may decide that you need to switch from By Keynote 

to By Sheet, or vice versa. This is not a problem as long as you remember that Revit will 

allow you to use only one method at a time per project. To change the numbering method, 

open the Keynoting Settings dialog box, and change the numbering method to the 

desired method.

Keynoting Legend
The last piece of the keynoting tool that we need to cover is the keynoting legend. This 

will provide the legend for all of your keynotes. To create a keynote legend, on the View 

tab’s Create panel, click Legends and then Keynote Legend. The New Keynote Legend 

dialog box will appear asking you to name the legend. Provide a unique name for the  

legend, and then click OK.

You are then taken to the Keynote Legend Properties dialog box. Revit has taken care 

of setting all the properties for the legend with one exception. You have the ability to 

specify whether you want to filter keynotes by sheet (Figure 12.27). Selecting this option 

will place all your keynotes into a single legend that you can place on multiple sheets. 

When you place the legend on a sheet, only those keynotes that appear on the sheet will 

be shown in the legend.
Figure 12.27

Filtering keynotes  
in the Keynote 

Legend Properties 
dialog box
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Customizing the Keynote File
To customize a keynote file, you just have to edit a tab-delimited text (.txt) file. Although 

you can use Notepad or a similar text editor, I actually prefer to use Microsoft Excel 

(Figure 12.28). The formatting of the file is much easier to work with in Excel than in 

Notepad or a similar product.

Open RevitKeynote_Imperial.txt (or RevitKeynote_Metric.txt). You can find this file 

in the root directory of your Revit content library:

C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2011\

Imperial Library\RevitKeynotes_Imperial_2004.txt

[C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2011\

Metric Library\RevitKeynotes_metric_2004.txt]

The keynote file is broken up into three columns. The first column is the keynote 

number for each keynote. The second column is the actual keynote. The third column is 

the reference section that the keynote falls under.

In Figure 12.28, refer to keynote 02220.B1. This is the keynote for “Disconnect And 

Seal Existing Utilities.” The third column entry for this entry is “2220.” This means that 

this keynote falls under section 2220 Site Demolition.

It is recommended that if you are going to add new entries to the keynote text file that 

you place them in front of the entries provided by Autodesk. In Figure 12.29, we have 

added four new rows. The first row creates a new User Notes division. Rows 2 through 4 

are new keynotes.

Figure 12.28

Keynote file opened 
in Excel for editing



334  ■   Chapter 12 : Tags, Schedules, and Keynotes

Whether using Microsoft Excel or a text editor, make sure that you save the file as a 

.txt file in a tab- delimited file format. After you have made your edits and saved the file, 

reassociate it with your project or template, and you can use those new definitions.

Figure 12.29

User-modified  
keynote file
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Detailing

This chapter concentrates  on detailing functions such as detail 

components and detail lines. We’ll also cover how to create a typical details library so 

that you can systematically develop, store, and reuse your Revit drafting views in a stan-

dardized fashion. Since drafting views have no connection to the model, they can be 

saved and inserted from project to project.

In this chapter, we’ll examine the following:

Detail and drafting views■■

Component symbol fundamentals■■

Detailing tools■■

Creating and managing detail libraries■■



336  ■   Chapter 13 : Detailing

Detail and Drafting Views
Detail views are those that are directly cut from the model and show modeled elements, 

whether it is a section or an elevation or a plan view. Within those views, you must con-

figure the display accordingly, and you most likely will add 2D elements to complete the 

section or detail. Drafting views, on the other hand, have no connection to the model. 

The elements used in these views are completely 2D (see Figure 13.1) and are essentially 

like doing 2D CAD in AutoCAD or MicroStation. In fact, once you get proficient in using 

Revit detailing, you will find that it can be as fast as or faster to do than if you are work-

ing in comparable 2D programs.

In both of these view types, 

you can add additional non-

modeled elements such as detail 

lines, filled regions, and detail 

components in order to finish it.

This prompts the question, 

how much should be modeled 

and how much should be done 

with 2D elements? You will 

quickly find as you learn this 

process that not everything can 

be modeled and that great care 

needs to be given in choosing 

how much is appropriate in any particular situation. Otherwise, you will find your fee get-

ting burned up quickly on elements that do not make a big difference to the overall model.

Since detail views are actual cuts through the model, they can easily change as the 

design process continues, which can be very disconcerting. You think you have finished 

a detail view and then come back a few weeks later only to find modeled elements have 

moved and the whole view needs to be reworked. If you have placed drafting elements 

into the view, they probably did not move with the modeled elements and so must be 

repositioned. Drafting views, on the other hand, have no modeled elements, so this prob-

lem does not occur.

One important way to keep the modeled elements together with view-specific detail 

components is to actually embed the 2D components into the model family. That is a 

more advanced way to approach detailing. Another way to avoid this situation is to use 

the Freeze Drawing extension. If you have a subscription contract with Autodesk, you can 

download the extensions for free from the Autodesk website. The Freeze Drawing exten-

sion turns a detail view into a drafting view, so it is independent of the model. The view 

is actually exported to AutoCAD in the background and then reimported as a drafting 

view. If you want to create a typical detail, you will find that this function will work well 

for you. The downside is that the detail view is divorced from the model, and any updates 

to the model will not be reflected in it.

Figure 13.1

Drafting view of a 
curtain wall jamb
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This is a very important point to consider. It is easy to get into the final phases of design, 

when schedules are tight and you have lots of detailing to finish. You start quickly creat-

ing drafting views and then realize they do not reflect what the model looks like. It could 

take considerable time to adjust the model, so why not just let that go and do a quick 

drafting view? That is a slippery slope, since the more you do it like that, the more your 

model loses its integrity. So, you must be very mindful of the mix of modeled and detail 

items and strive for consistency.

What tools are available for this task of creating finished views? The following sections 

will walk you through the basics and introduce you to the way this process works and to 

those tools you will be using time and again as you work to complete your projects.

Component Symbol Fundamentals
Revit Architecture comes with a full library of useful 2D components, and you can create 

your own as well. As you do more and more projects, you can and should build a library 

of symbols that conform to your company standards that can then be used over and over 

again. Managing and categorizing them for easy use should be a priority for you.

Detail Components
Detail components are 2D representations of modeled elements, such as concrete masonry 

units in sections that can be used in your detailing views. The components appear only 

in the view in which they are placed. Revit Architecture ships with a large library of detail 

components that can be loaded into your project as required. In Figure 13.2, you can see 

a finished slip joint at metal panel/plaster plan detail. The panel head joint detail item is 

copied and shown at the bottom of the figure. 
Figure 13.2

The slip joint at 
metal panel/plaster 
plan detail
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What detail components are you able to use in this detail?

The panel head joint•	

The gypsum sheathing•	

The slip joint•	

The 6˝ interior studs•	

Added to that are some detail lines, the batt insulation, dimensions, and text. With 

that, you will have the entire detail completed and ready for insertion onto your sheet. In 

the following sections of this chapter, you will examine these items more closely.

The components are classified in the CSI format so that you can easily browse to your 

exact component in the detail component libraries. Within the particular folder, you will 

find component families for Top, Side, and Sectional views of the element. These elements 

can be used in detail views cut from the model as well as in your drafting views. As an 

example, let’s load a CMU block module into a project by doing the following:

	 1.	 From the book’s companion download files (available at www.sybex.com/go/ 

introducingrevit2011), open Dataset 1301_begin, and browse to section 1 if it’s  

not there already. You will see two generic modeled wall elements: one wood and  

one CMU.

	 2.	 On the Load From Library panel of the Insert tab, click Load Family.

	 2.	 Click Detail Components in the Imperial (or Metric) Library.

	 3.	 Click Div 04-Masonry.

	 4.	 Within the Masonry folder, select the 042200-Concrete Unit Masonry folder.

	 5.	 Double-click the Fluted CMU-8 Flutes-Section family, and it will be loaded into the 

project (see Figure 13.3).

Figure 13.3

Loading a masonry 
detail component 
from the Imperial 

Library
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F I N D I N G D E TaI L CO m p O N E N T S

Components that do not exist in the shipped libraries can be created, and you can also fi nd 

many of them on the Web in such places as the Autodesk Seek site or a particular manufac-

turer’s site. More and more manufacturers are seeing the benefi t of creating full libraries of 

their products, so be sure to look for them. There’s no reason to re-create the wheel.

Now that the detail component has been loaded into your 

project, let’s examine the basic process of inserting the compo-

nent into a detail. As you have been learning, Revit families can 

have any number of specifi c types. In the case of the Fluted CMU 

family just loaded, there are 13 different types already created 

within the family, depicting different widths of CMU wall. You 

can add more types if required. In the current example, you are 

adding the component to an 8˝ masonry wall, so you will use an 

8˝×8˝×16˝ type.

To add a component to your view, do the following:

 1. On the Detail panel of the Annotate tab, click Detail Com-

ponent in the Component drop-down. The Type Selector 

in the Properties palette will list all the loaded components 

(see Figure 13.4).

 2. In the list, highlight the 8˝×8˝×16˝ type, and drag it onto 

your model

 3. Place the component over the modeled wall element.

 4. Lock the component into place by closing the blue padlocks 

(see Figure 13.5).

After you place components into your detail, you can move 

them either to the front or to the back of the view (called set-

ting the draw order) so that they will display correctly in the 

detail. To alter the draw order of a particular component, high-

light it and, on the Arrange tab, select which way, frontward or 

backward, you want to move it.

That is the basic approach to loading and placing a compo-

nent into your project.

F I N D I N G D E TaI L CO m p O N E N T S

Components that do not exist in the shipped libraries can be created, and you can also fi nd 

many of them on the Web in such places as the Autodesk Seek site or a particular manufac-

turer’s site. More and more manufacturers are seeing the benefi t of creating full libraries of 

their products, so be sure to look for them. There’s no reason to re-create the wheel.

Figure 13.4

Selecting a compo-
nent from the Type 
Selector

Figure 13.5

Adding the compo-
nent over the mod-
eled wall

After you place components into your detail, you can move 

them either to the front or to the back of the view (called set-

) so that they will display correctly in the 

detail. To alter the draw order of a particular component, high-

light it and, on the Arrange tab, select which way, frontward or 

That is the basic approach to loading and placing a compo-

Adding the compo-
nent over the mod-
eled wall
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Repeating Details
Repeating details are very useful and can save considerable amounts of time and effort 

if used appropriately. A repeating detail, as its name infers, uses a single component and 

repeats it along a linear path at a defined spacing. Masonry block walls are a good example 

of how this can be used to create a detail. The masonry block unit is specified along with 

the vertical spacing of the block. Best practice is to identify any repetitive elements that 

you will be using frequently in your details and turn them into a repeating detail.

To add a new repeating detail to your project, the general procedure is as follows:

	 1.	 On the Annotate tab’s Detail panel, click the Component drop-down, and choose 

Repeating Detail Component.

	 2.	 Select a detail component from the Type Selector in the Properties palette. 

	 3.	 Click Edit Type.

	 4.	 Specify the component in the Detail parameter.

	 5.	 Specify the Layout type.

	 6.	 Specify the Spacing value for the repeating pattern.

	 7.	 Click OK to exit.

If no type exists, you will need to make one. So, let’s create one in the following exer-

cise. To make a new CMU block a Repeating Detail type, do the following:

	 1.	 Open Dataset 1302.rvt, and go to section 1.

	 2.	 On the Annotate tab’s Detail panel, click the Component drop-down, and choose 

Repeating Detail Component.

	 3.	 Click Edit Type in the Properties palette and then Duplicate in the Type Properties 

dialog box.

	 4.	 Name the new repeating detail CMU 8×8×16 Split Face, and click OK.

	 5.	 In the Type Properties dialog box, select 

Flute CMU-8 Flutes-Section: 8˝×8˝×16 .̋ 

Your Type Properties dialog box should 

look like Figure 13.6.

	 6.	 Back in section 1, you can now draw an 

instance of the CMU repeating detail. 

Click to place the first block; then move 

your mouse pointer and click at the end 

of the repeated units. Your detail should 

look something like Figure 13.7.
Figure 13.6

Type Properties dialog box for a Repeating 
Detail type
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Repeating detail

Block unit

Generic wall family

You will use three different types of component symbols for your detailing needs: 

detail components, repeating details, and legend components. The tools are located on 

the Detail panel of the Annotate tab. These are not to be confused with the Component 

tool that is on the Home tab. That tool inserts three-dimensional modeled elements such 

as furniture and trees into the project.

Legend Components
Legend component symbols are 2D representations that depict an annotation or modeled 

element in your project. Examples of this type of element are north arrows, scale bars, 

and wall types (see Figure 13.8). Regardless of the scale of the particular view you are 

working on, the symbols will maintain the same 

size when printed. They are scale independent. 

For an actual example of a legend, see Chapter 2, 

“Views.”

Legend components, as the name indicates, are 

symbols used for creating legends. Virtually all 

projects require one. Suppose you want to create a 

graphical legend of door types that you have added 

to your project. If you use an instance of the actual 

family as a symbol, that element will be counted as 

being part of the project when scheduled.

Of course, you do not want that counted 

because it is not really part of the building you  

Figure 13.7

Repeating details

Figure 13.8

Wall types in eleva-
tion used as legend 
components
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are designing. So when you create a legend instead of using a real wall segment, you drag 

a legend component symbol of the family into the legend. Once you have placed it, you 

can configure it to show a plan or elevation view, and it can be shown in coarse, medium, 

or fine mode.

Legends are the only graphic views that can be placed onto multiple sheets. Annota-

tion symbols, materials, phasing graphics, line styles, and model items like doors, detail, 

and model groups all can have legend symbols. Creating one is a fairly straightforward 

thing to do.

Follow these steps to make a component legend:

	 1.	 On the View tab of the ribbon, click the Legends icon, and select Legend from the 

drop-down list.

	 2.	 Give the legend a name, and give it a scale.

	 3.	 Click the Component drop-down on the Annotate tab.

	 4.	 Select Legend Component from the drop-down list.

	 5.	 On the Options bar, highlight the symbol you want from the drop-down list in the 

family Type Selector (see Figure 13.9).

	 6.	 Select the view type to display—Plan, Section, or Elevation—depending on the  

symbol type.

	 7.	 Specify a length on the Options bar for the legend symbol.

	 8.	 Place the component in the view.

	 9.	 Add any other detail or group components to the view.

	10.	 Create descriptive text next to each item.

	11.	 Drag the legend view onto a sheet.

Figure 13.9

The Legend compo-
nent’s Options bar
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Those are the basics for component symbols. Of course, as you learned previously, 

you can create detail groups that allow you to assemble and associate a set of detail com-

ponents that you will use more than once in your project. Once the group is created and 

named, you can locate them in the Group area at the bottom of the Project Browser for 

easy insertion by dragging them into your views. For more information, refer to Chapter 8, 

“Groups.”

The next section will introduce you to more of the detailing tools that Revit 

Architecture provides so you create great-looking and accurate details.

Embedding Detail Components in Modeling Families
As you progress in learning Revit Architecture, you will want to create your models in such 

a way that the views derived from the cut sections and elevations are as complete as possible 

without adding a lot of view-specific 2D entities such as lines and detail components. It is 

the most efficient way to proceed with your virtual design since you will not have to then 

manage all those detached entities as the model flexes during the design process. You will 

find that having to constantly edit and relocate elements is a time-consuming task.

One important way to accomplish this goal is to embed your detail components into 

the modeled families. What do we mean by that? This is a way to keep the detail elements 

with the modeled elements as they move during the design process. Design development 

phase can see your model changing constantly and dramatically.

Let’s take a look at the example of a 2×6 wood bearing 

wall in a section view and how this cut of the wall was 

developed in order to display this way (see Figure 13.10). 

This will give you a better understanding of some of 

the more advanced techniques you need to learn to be a 

power user of Revit.

In this example, you will add detail components into 

the wall family type so that the top and bottom plates are 

automatically shown when you cut the section. First, you 

go to the profile family to create a profile with an added 

detail component inserted into it. Then, you go to the wall 

definition and apply that profile as a sweep. It is a two-step 

process that sounds more onerous than it actually is.

The general procedure to complete this process is as 

follows. First you create the required profile for the 2×6 

flat stud plate.

	 1.	 Start a new project or work with an existing project.

	 2.	 On the application menu, choose New ➔ Family.

	 3.	 Choose Profile as the template type, and then click Open.

Figure 13.10

Wood-bearing wall 
type with embed-
ded profiles for top 
and bottom wood 
plates and bolts
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	 4.	 On the Insert tab’s Load From Library panel, click the Load Family icon.

	 5.	 In the Imperial Library section, select Detail Components, and then browse to the 

Div 06-Wood And Plastic folder.

	 6.	 Browse and select 061100 – Wood Framing, and then choose Nominal Cut Lumber – 

Section.

	 7.	 Click Open, and then select the 2×6 component. Click OK to exit.

	 8.	 Go to the Ref. Level plan and zoom extents so you see the reference lines.

	 9.	 On the Home tab’s Detail panel, click Detail Component, and then place the 2×6 

component at the intersection of the reference planes.

Now that you have inserted the component, you will place and lock profile lines 

around it.

	10.	 Select the 2×6 component, and rotate it 90°.

	11.	 Center the 2×6 component on the vertical reference plane.

	12.	 Align the bottom line of the 2×6 with the horizontal reference plane.

	13.	 On the Home tab’s Detail panel, select the Line tool. Now draw profile lines at the 

exterior edges of the 2×6 component by using the Rectangle tool from the Draw 

panel. Lock them to the component by closing the blue padlocks.

	14.	 Select the detail component, and then click Visibility Settings on the Visibility panel 

of the Modify | Detail Items tab. Deselect Coarse by deselecting the box, and then 

click OK.

	15.	 On the application menu, click Save, and save the profile file as 2x6 Plate.

	16.	 Click Load Into Project on the Family Editor panel of the Modify tab, and load the 

profile into your project file.

The profile with the embedded detail component is now complete and ready to be used 

in the wood wall family. As you can see, the process is not too difficult to accomplish.

In the final part of the process, you will add the profile you just created with the 

embedded component into the wall family definition as a sweep.

	 1.	 On the Build panel of the Home tab, click Wall from the Wall drop-down.

	 2.	 In the Properties palette, change the wall type to Generic 6 ,̋ and click Edit Type.

	 3.	 Click the Edit button in the Structure Value field.

	 4.	 Click the Preview button in the Edit Assembly dialog box.

	 5.	 In the View list, choose Section: Modify Type Attributes in order to get a sectional 

view of the wall.

	 6.	 Click the Sweeps button, and then click the Add button in the Wall Sweeps dialog box.

	 7.	 Select 2×6 Plate for the profile name in the Profile field.
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	 8.	 Finally, change the offset value to –3 .̋ Click Apply. You should see the profile at the 

bottom of the wall in the section preview.

	 9.	 Click OK until you exit all the dialog boxes.

The basic procedure is now competed. Did you get all the way through it? Now let’s 

take a look at an instance of the wall. Go to a plan view, draw a wall segment, and create 

a section through it. Remember that you set the Visibility so that the component does not 

show in Coarse detail level, so make sure the section is in Medium or Fine mode. Move 

the wall in the section, and notice that the bottom plate moves with it. That is just what 

you were trying to accomplish.

Now that you have completed that, for added practice return to the wall definition fam-

ily and add two top plates to the wall definition in the same manner as you have just done.

This is just one example of how using embedded components can make your modeling 

life much easier. Did you also notice in Figure 13.10 that there is a bolt into the concrete? 

That is another detail component that was added to the profile. Can you add that one into 

your wall definition too?

Now that you have an idea of how to use component elements, let’s next explore the 

major detailing tools that you will be using as you work in Revit Architecture.

Detailing Tools
Detail lines are those that you use for basic 2D drawing purposes. You use them to com-

plete detail views and, of course, for most of your drafting view lines. Detail lines can add 

important information that might not be necessary to model. As opposed to model lines, 

which appear in all views, detail lines are view-specific. One warning to consider is that 

overusing 2D linework rather than modeling elements means that your 3D model will 

correspondingly lose its integrity. Too much “faking” by using 2D linework because you 

are rushed for time or do not know how to model an element is not a good practice.

By default Revit comes with a set of existing line styles. Some of these types cannot be 

removed; you can identify these easily because they have brackets around their names. 

You can also create new line types easily. Best practice is to create a set of line styles that 

corresponds to your company’s standards and add the set to your template file.

Drawing Detail Lines
To add linework to your detail, do the following:

	 1.	 On the Detail panel of the Annotate tab, click the Detail Line tool (or use the short-

cut DL).

	 2.	 After the Modify | Place Detail Lines tab appears, select a line style from the Line 

Style panel (see Figure 13.11).

	 3.	 Select a line tool from the Draw panel such as a Rectangle, Arc, or Spline.

	 4.	 Sketch the line as required.
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The Pick Line option is important to use when you are doing linework because it 

allows you to draw by selecting existing geometry or linework, which can save consider-

able time and effort as you work.

Use this mode by selecting the green line with the mouse pointer that is in the Draw 

panel. You then select an existing line or edge in the view, and it will be duplicated, but 

with the line type that you have selected from the Type browser.

Temporary dimensions aid you in placing the linework (see Figure 13.12). As you draw 

the line, drag the cursor in the direction you want to draw, and start typing. That will 

allow you to specify the exact length of the line you are drawing within the temporary 

dimension box.

That is basically how lines are placed in the project. Next you’ll learn how to edit them 

after they are in the view.

Editing Detail Lines
Once you start adding lines in your views to create geometry, you will need to edit them 

in many ways such as by moving, copying, and trimming. Those commands are located 

Figure 13.11

Modify | Place Detail 
Lines tab

Figure 13.12

Ribbon, tool tip,  
and temporary 

dimensions while 
drawing lines
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on the Modify panel of the Modify tab. The Modify commands work for some modeled 

elements as well. For instance, you can trim two walls together or two structural beams 

together. Figure 13.13 shows a spline before and after its geometry has been edited. First 

you highlight the line, which will show grips in blue that can be dragged to new positions. 

In this case, the open circles can be dragged to alter the spline angles. The fi lled blue grips 

at either end will extend the spline segment. Of course, different line types will have dif-

ferent grips or snap points that can be dragged.

That was not too diffi cult, was it? Now let’s see how to create a new line 

style for your project. Creating a new line style is not a diffi cult task. 

The more important task is to develop a good system of line defi ni-

tions. Perhaps you use the National CAD Standards AIA layering 

system in AutoCAD. You can re-create the same names in Revit for easy translation of 

details back and forth between Revit and AutoCAD. To create new line styles, you specify 

several parameters: a line weight, a line color, and a line pattern.

To edit an existing line style or add a new one, do the following:

 1. Click Additional Settings on the Manage tab.

 2. Click Line Styles in the drop-down menu to access the Line Styles 

dialog box.

 3. Either edit the existing line style (the weight, color, or pattern), or click the New but-

ton to create a new line type (see Figure 13.14).

The next section takes a look at plotting issues related to line widths that might need 

adjusting depending upon your plotter type.

Figure 13.13

Editing the spline by 
dragging the blue 
open grip

In this case, the open circles can be dragged to alter the spline angles. The fi lled blue grips 

at either end will extend the spline segment. Of course, different line types will have dif-

That was not too diffi cult, was it? Now let’s see how to create a new line 

system in AutoCAD. You can re-create the same names in Revit for easy translation of 

details back and forth between Revit and AutoCAD. To create new line styles, you specify 

 2. Click Line Styles in the drop-down menu to access the Line Styles 

New location

Figure 13.14

Creating a new line 
type via the Line 
Styles dialog box
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Line Weight Plotting

As you have seen, each line style has an associated line weight assigned to it. For different 

view scales, the weight can be adjusted so you can control the look of your plotted output 

better. This will take some experimentation on your part since it depends a lot on which 

brand of plotter you are using to plot your project. All the plotters act a little bit differ-

ently, necessitating some adjustment to these val-

ues. Model line weights, perspective line weights, 

and annotation line weights can all be controlled 

in this way.

The Line Weights dialog box (see Figure 13.15) 

is opened by going to the Manage tab, then by 

clicking Line Weights on the Additional Settings 

drop-down on the Settings panel. Once you are in 

the dialog box, you can adjust the values in three 

tabs: Model Line Weights, Perspective Line Weights, 

and Annotation Line Weights. In the Model Line 

Weights tab, if you click the Add or Delete buttons 

you can also add or delete new scales to the list that 

might not be there by default, or which you might 

want to remove.

Line Patterns

Many line patterns are already created for you to use, and you probably will not need to 

create new ones too often. Open the Line Patterns dialog box by going to the Manage 

tab’s Settings panel. In the Additional Settings drop-down, select Line Patterns. Each pat-

tern is a set of dots, dashes, and spaces with specified lengths (see Figure 13.16). You can 

edit the existing patterns and create new patterns that you might require as needed.

Figure 13.15

The Line Weights 
dialog box

Figure 13.16

The Line Patterns 
dialog box
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Overriding Lines with the Linework Tool
The line styles that you have learned to use for detailing lines in your 2D drafting views 

also have an important function to play for lines of detail views that contain modeled 

elements. Using the Linework tool, you can quickly override any line that is displayed 

in order to emphasize or possibly deemphasize it in some way. With the Linework tool, 

you can override the line style of most model lines if they do not display as you prefer. 

The override is applied only for the current view that you are working in even though 

the modeled element may show up in other views. You might want to emphasize a line by 

making it heavier, or you might want to make it invisible and not seen. You can do this 

with the Linework tool.

You can fi nd the Linework tool on the Modify tab in the View panel. To edit a line 

using the Linework tool, simply select a line type from the Line Styles drop-down list, 

and then select a line in the view that you want to change. Be aware, though, that the 

Linework tool does not work on detail components, dimensions lines, models lines, or 

detail lines.

B E C ar E Fu L u S I N G T h E LI N E WO r K TO O L

In practice, the Linework tool can be quite fi nicky and unpredictable. You will fi nd quite 

often that once you change a particular line with the Linework tool, you will come back a 

few days later and fi nd it has reverted to its original. Also, getting your modeled elements to 

display correctly can be quite challenging. Display issues take up a considerable amount of 

time while you are working on a project, and it can be very tempting to just use the Linework 

tool to correct those issues. Best practice is to minimize that usage and to work diligently to 

resolve your display issues in other ways.

Representing Insulation
Surely insulation is not something that is readily modeled, so the task falls to 2D detail-

ing in most cases. The Insulation family has two parameters: Insulation Width and 

Insulation Bulge To Width Ratio. As with most other Revit families, you can create dif-

ferent types by varying these parameters (see Figure 13.17). Once placed into your proj-

ect, you can stretch or compact the instance by moving 

the grips at each end.

The general approach to adding insulation to your 

detail is as follows:

 1. Select the Insulation tool from the Detail panel on 

the Annotate tab.

B E C ar E Fu L u S I N G T h E LI N E WO r K TO O L

In practice, the Linework tool can be quite fi nicky and unpredictable. You will fi nd quite 

often that once you change a particular line with the Linework tool, you will come back a 

few days later and fi nd it has reverted to its original. Also, getting your modeled elements to 

display correctly can be quite challenging. Display issues take up a considerable amount of 

time while you are working on a project, and it can be very tempting to just use the Linework 

tool to correct those issues. Best practice is to minimize that usage and to work diligently to 

resolve your display issues in other ways.

Figure 13.17

Three types of 
Insulation

Width = 3½˝, Bulge = 2.0

Width = 3½˝, Bulge = 4.0

Width = 8˝, Bulge = 4.0
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	 2.	 On the Options bar, set the following:

The width•	

An offset distance for placement•	

Whether the insulation is to be drawn to the center, near side, or far side•	

	 3.	 Simply click at the starting point and then at an end point to draw the instance of 

insulation.

Filled Regions
Filled regions are hatch patterns that can be added to your details. A continuous bound-

ary of lines is sketched and then filled with a pattern of your choosing. The boundary 

lines for the filled region can be invisible or any combination of line types. For instance, 

if you were creating an earth hatched area, you might want the top boundary line to rep-

resent the finish grade, so you would make it a solid line, while the other boundary lines 

remain invisible (see Figure 13.18). By default Revit comes with a set of defined patterns. 

You can add to this set by importing pattern files from AutoCAD or by creating your own 

patterns.

Wide line

Invisible lines
Here is the general process for creating a filled region in a detail view:

	 1.	 On the Annotate tab’s Detail panel, click Filled Region on the Region drop-down.

	 2.	 Use the Draw tools on the Create Filled Region Boundary tab to create your region 

boundary.

(Use Invisible Lines for your boundary where you do not want to see them in the 

final pattern.)

	 3.	 Click the green check mark in the Mode panel to finish the geometry.

	 4.	 Highlight the geometry, and then in the Properties palette’s Type Selector select an 

existing fill type for the bounded region.

Figure 13.18

Earth hatching 
added to detail
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If the pattern that you want to use does not exist, you can create your own. Filled 

regions are just another Revit family, and different types can be created. To create an 

Earth fi ll type, do the following:

 1. On the Annotate tab, click Filled Region on the Region drop-down.

 2. On the Properties palette, click Edit Type.

 3. In the Type Properties dialog box, click Duplicate.

 4. Give the new fill pattern the name Earth Hatch.

 5. In the Type Properties dialog box, click the Fill Pattern Value box.

 6. Select Earth in the list of patterns in the Fill Patterns dialog box, and then click OK.

 7. Give the pattern a line weight and color, and specify whether it should be transparent 

or opaque.

 8. Click OK, and the new pattern is complete and ready for use in your filled regions.

But what if the fi ll pattern does not exist? 

New patterns can be created. With the Simple 

option, you defi ne an angle and line spacing 

and whether the pattern will be parallel lines 

or a crosshatch pattern. Or you can import 

patterns from the AutoCAD acad.pat fi le. To 

add a new fi ll pattern, do the following:

 1. On the Manage tab, click Fill Patterns in 

the Additional Settings drop-down.

 2. In the Fill Patterns dialog box (see Fig-

ure 13.19), click the New button.

 3. In the New Pattern dialog box, select the Simple or Custom option.

 4. Define the values for the Simple option or import a pattern for the Custom option.

 5. Click OK, and exit the dialog boxes.

W h Y D O N ’ T mY D E TaI L S LO O K LI K E I  WaN T T h E m TO?

Display issues are a constant concern when you are creating your construction documents. 

You will discover as you learn to model that a good amount of your time (and fee) is spent 

getting the detail views that you have derived from the model to appear correctly. It can be a 

very frustrating task. At times there is just no way to get it to look the way you want it to look.

The Masking Regions tool allows you to hide problem areas. You can leave it that way, or 

you can draw over the masking region with 2D lines in order to “fake” what you think you 

should be showing. It is not good practice, though, to overdo faking the detail view. You 

Figure 13.19

Selecting or 
creating a new 
fill pattern
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Display issues are a constant concern when you are creating your construction documents. 

You will discover as you learn to model that a good amount of your time (and fee) is spent 

getting the detail views that you have derived from the model to appear correctly. It can be a 

very frustrating task. At times there is just no way to get it to look the way you want it to look.

The Masking Regions tool allows you to hide problem areas. You can leave it that way, or 

you can draw over the masking region with 2D lines in order to “fake” what you think you 

should be showing. It is not good practice, though, to overdo faking the detail view. You 

CONTINUES
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need to concentrate on maintaining the integrity of the model as much as possible. Remem-

ber that your plan, section, and elevation views are derived from the model. As you fake 

more and more on your details, you are giving up on the integrity of the model. Eventually 

this will lead to disaster because your model becomes a false representation of the design.

Masking Regions
Masking regions are a special variety of fi lled region used to hide problem areas (see 

Figure 13.20). Masking regions can be used to mask detail elements or modeled elements. 

To add a masking region, do the following:

 1. On the Annotate tab, click Masking Region on the Region drop-down.

 2. In Sketch mode, draw the boundary of the masking region. Boundary lines can be of 

any line type desired. Closed boundaries can be added within the outer boundary to 

further refine the masked area.

 3. Complete the masking region by clicking the green check mark in the Mode panel.

After completion, you can highlight the region and adjust its boundaries by dragging 

the blue grips.

No discussion of detailing would be complete without learning how to add text notes, 

so let’s take a look at how this tool is used in Revit Architecture.

Masking region

Adding Text
In Chapter 4, “Constraints and Dimensions,” you already learned the basics of how 

dimensioning can be added. In Chapter 12, “Tags, Schedules, and Keynotes,” you learned 

how to apply tags to elements and how those tags can then be scheduled as necessary to 

Figure 13.20

Masking region cov-
ering a portion of 

the detail

need to concentrate on maintaining the integrity of the model as much as possible. Remem-

ber that your plan, section, and elevation views are derived from the model. As you fake 

more and more on your details, you are giving up on the integrity of the model. Eventually 

this will lead to disaster because your model becomes a false representation of the design.

W h Y D O N ’ T mY D E TaI L S LO O K LI K E I  WaN T T h E m TO?  (CONTINUED)
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help document your project. Best practice is to tag elements as much as possible in any 

view that needs to be documented. This gives you the maximum flexibility since the tag 

value changes automatically when the type of element is updated. But there are many 

situations where you must use text notes; see Figure 13.21 which has a mix of tags and 

text notes.

In this section, you will learn about the mechanics of the Text tool in Revit Architec-

ture. The text function comes with full formatting capabilities (see Figure 13.22), includ-

ing the following:

Leader segments can be added as one line, two lines, or a curved line.•	

The leader location in relation to the note has six different options.•	

Notes can be aligned left, center, and right.•	

Lists are supported in the •	

notation—bullets and 

numbering.

Word wrapping is  •	

supported.

Text can be boxed.•	

Spelling can be checked and •	

corrected.

Find-and-replace can be done on the body of the note.•	

Text like other detailing elements is view-specific except in dependant views. Now that 

you see some of the capabilities of the Text tool, you’ll learn how to add a note to your view.

Adding a Text Note to Your View

Adding a notation is not at all difficult, and it is very dynamic in that the tool stays active 

while you rotate or move the note. To add a text notation to a view, first click the Text tool 

on the Text panel of the Annotate tab, or click the Text icon on the Quick Access toolbar. 

Figure 13.21

Some annotations 
are tags, and  
some are text.

Figure 13.22

The Modify | Text  
Notes tab

Leader segments

Leader location

Note alignment Listing
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Create a leader fi rst if you need one. There are quite a few leader placement options so 

that you can add the leader to the top, middle, or bottom of the note. The last pick for the 

leader line placement (or the fi rst pick if there is no leader) will set the upper left-hand 

corner of the text box. Once the box is established, you can write the text string into the 

box. After you complete the text, click outside the box somewhere in the drawing area to 

complete the insertion.

When you highlight the text note, several controls become available (see Figure 13.23). 

The text box can be dragged to a new position. It can also be rotated. The blue solid grips 

will stretch the note box. When you do that, the text inside 

the box will wrap as necessary to fi t the new box size, as long 

as you have not added hard returns into the text string. There 

is also a leader segmentation grip so you can make two lined 

leader segments and control their lengths.

If you need to edit the text string, simply highlight the text 

note and then click into the text area, which becomes active. 

You make your changes to the text string and then exit by 

clicking outside in the drawing area.

Creating and Editing Text Styles

Revit Architecture ships with a large set of standard Windows TrueType fonts. You will 

fi nd it necessary to make many different types of text styles since very few are there by 

default. In the following exercise, you’ll make 

a new style for 1/8˝ text notes using a Times 

New Roman font (see Figure 13.24).

 1. On the Annotate tab, click the small 

arrow on the bottom right of the Text 

panel. That will display the Text Type 

Properties dialog box.

 2. Click Duplicate, and then name the new 

text style: 1⁄8˝ Times New Roman.

 3. Click OK to return to the Type Proper-

ties dialog box.

 4. Set the options as follows:

Background Transparent
Leader Arrowhead Arrow Filled 20 Degree
Text Font Times New Roman
Text Size 1⁄8˝

 5. Click OK to finish.

Figure 13.23

Text note with text 
box editing features 

displayed
The text box can be dragged to a new position. It can also be rotated. The blue solid grips 

Stretch note boStretch note bo

Leader segmentation

Drag note

Rotate notRotate note

Figure 13.24

Text Type Properties dialog box
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To edit text styles, just select the Text tool, and in the Properties palette select the type 

you want to edit. Select Edit Type, and make the corrections. Click OK, and the change is 

complete.

Preparing General Notes

General notes are the big text item that you usually will face in a project. Yes, there are 

plenty of small notations on plans and details, but they do not compare to your general 

notes, which are usually a sheet or two at the front of your document set. These take 

all the formatting capabilities you’d expect from a full-blown word processor such as 

Microsoft Word. We will offer two approaches for adding general notes.

Most general note sets consist of specific sections. One good approach to preparing 

and reusing them is to make each general note section in its own drafting view. Within 

the drafting view, create the section text in one text box. That way, you can control the 

formatting more easily. Drag the sections onto the sheet as needed. From job to job, dif-

ferent sections can be taken on or off the sheet as they are required.

As you will see in the next section on detail libraries, you will be able to import the 

sheet of notes, or any individual drafting view, into your new projects. You might even 

consider keeping a specific Revit file with all your general notes there so you can easily 

manage them and access them on new projects.

There is another approach to preparing and managing general notes on a sheet. If you 

have a subscription to Autodesk, you will find a general notes creator in the extensions. 

Microsoft Word documents with full formatting can be imported. The tool then manages 

the notes in rows and columns of your choosing, making the tedious layout work on the 

sheet easier to handle.

Creating and Managing Detail Libraries
The discussion of drafting views cannot be complete without investigating how these 

details can be managed as a set of typical details. How can you use your current details in 

Revit? Do they all need to be redrawn? The answer is that with some preparation, you can 

import your current set of 2D details directly into drafting views. If you are transitioning 

from 2D AutoCAD or MicroStation, you probably already have a set of typical details, 

and you will not want to redraw them again. As you begin your company’s transforma-

tion into the BIM process, you might want to put off this task. Consider what might be a 

good implementation timeline for implementing portions of your new BIM system.

Your drafting staff will learn this new technology at differing speeds, so it is necessary 

to keep work for them in AutoCAD until they can improve their skills in Revit. It can be 

quite overwhelming to try to transition your whole drafting system at one time. Once you 

build up experience with the new modeling workflow, you will want to have the whole 

project in Revit, typical details and all.
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You can take three approaches:

Leave the typical details in AutoCAD:•	

Create a blended construction document set for your project, with some work •	

done in Revit while the typical detail sheets remain in AutoCAD.

One downside is that you need to plot the project from two platforms, so you •	

will need to maintain two title sheets.

Import the details into Revit as blocks without exploding them:•	

In this case, you will do any drafting corrections and additions to the blocks in •	

AutoCAD.

The details will be linked into the Revit file so that they automatically update to •	

reflect those changes.

This has the advantage that you will then be able to plot your entire project in •	

Revit. The sheets will also have a similar look to them.

Create the details from scratch in Revit:•	

Though initially more time-consuming to complete, this approach is direct and •	

eliminates the need to touch up the details that have been imported.

Selectively prepare typical details using the Freeze Drawing tools to show the •	

actual conditions you encounter, using the modeled elements as your guide.

When you first import the detail, it is still a block, and an import filter is used to map 

the AutoCAD layer names to the line styles in Revit. After insertion, you can partially or 

fully explode the block in the drafting view in order to work on it. The importation pro-

cess, though, has several issues that you will want to consider so you can create an accu-

rate, clean detail once you have completed it:

Line styles are created in Revit with the name of the AutoCAD layer if there is no •	

corresponding line type that already exists.

Hatch patterns become fill patterns, but the names of the patterns end up being long •	

and odd sounding.

Partial or full exploding of the imported details. If you partially explode the detail, •	

elements such as hatch patterns and nested blocks in the original detail will not be 

exploded. If you fully explode the detail, the hatch patterns become individual line 

segments. So many small lines can create performance issues.

Leaders lose their arrows.•	

Special AutoCAD characters are not supported.•	

It is best practice not to explode the DWGs in the production files. Rather, explode •	

and clean up AutoCAD detail DWGs in a separate throwaway file first and then 

bring them into the project file. That will keep your production file clean of 

unwanted line style, hatch pattern, and text style definitions.
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Once you start building up a set of typical detail drafting views in Revit, you will need 

a way to import and export them from your projects. The Save To Library and Insert 

From File tools accomplish these tasks and will be discussed in the following sections. 

These tools work only for views that have no modeled elements in them. 

Saving to a Library
The Save To Library tool allows you to save 

families, groups, and drafting views from 

your project. Let’s step through the general 

process of saving a drafting view:

	 1.	 Click Save As on the application menu 

and then Library and then View.

	 2.	 In the Save Views dialog box (see Fig-

ure 13.25), select the box next to the 

sheet or view names you want to export.

	 3.	 Browse to the folder where you want to 

store the view.

	 4.	 Click Save. This process will create a 

new RVT file.

Note that when you select an entire sheet 

to export, each drafting view is separately 

created as well.

Inserting from a File
The Insert From File tool is the reverse pro-

cess of exporting the detail. Details can be 

inserted from any other Revit file where they 

may reside. You can choose a whole sheet or 

an individual view to import. The general 

process to insert the detail is as follows:

	 1.	 Click Insert From File on the Insert tab, 

and then click Insert Views From File.

	 2.	 Browse to the folder, and then select the 

RVT file.

	 3.	 Select the sheet or views that are listed 

in the Insert Views dialog box (see Fig-

ure 13.26) that you want to insert.

	 4.	 Click OK.

Figure 13.25

Saving drafting 
views and sheets 
with the Save To 
Library option

Figure 13.26

Inserting draft-
ing views with the 
Insert From File 
option
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It is really as simple as that. One good approach is to create a Revit project file that 

contains only your typical detail sheets and drafting views. On each of the sheets, various 

details will have reference bubbles pointing to details on other sheets. You can reference 

those to the other sheets so that if the drawing numbers change in your project, those 

references will automatically update.



C hap te r 14

Sheets

This chapter  will walk you through the process of creating, managing, and 

printing sheets. In our industry, sheets are still the end result of a project. They need to 

be signed and stamped as legal documents and therefore are a very important part of the 

process.

You will also learn how to organize sheets. This will help you keep your Revit project 

better organized so that the whole team can function within your organization in a 

timely manner.

In this chapter, we’ll cover the following:

About titleblocks and sheets■■

Setting up sheets■■

Organizing sheets■■

Exporting sheets and DWF■■
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About Titleblocks and Sheets
When it comes time to print your drawings in Revit, you need to create sheets. These are 

the individual pages in your construction document set. On these sheets you will drop 

views such as plans, elevations, sections, details, and so on. You will have one sheet for 

each construction document page, but you can have multiple project views or schedules 

on each sheet view. It is important to note, though, that once you place a view (plan, 

section, detail, schedule, and so on) on your sheet, you can’t place that view on another 

sheet.

To help define your sheets, you will want to create a titleblock. Titleblocks define the 

size and appearance of a drawing sheet. Titleblocks are families; you use the Family 

Editor to create them. In the titleblock you can specify the sheet size, add borders or 

logos, and add intelligent labels to control the display of information.

Revit includes several titleblock families that can be used to create custom titleblocks 

to suit your project needs. Your organization probably already has existing titleblocks 

from other CAD programs that you want to continue to leverage. In this chapter, we will 

walk you through the steps of creating a new titleblock and using existing CAD data as 

an underlayment to speed the titleblock creation process.

Creating a Titleblock
The titleblock is the template for the sheets. Table 14.1 describes the various Revit  

elements that are used to define the titleblock.

E l e m e nt  / T o o l D e s c r i p ti  o n

Family types Allows you to define different properties of the family. For example, 
you might have one titleblock family that contains different 
types for the different titleblock sizes and usage.

Lines Used to create the border and lines that divide the titleblock into 
different areas.

Symbols 2D drawing symbols such as a north arrow or a company logo 
that has been created with Revit geometry.

Masking region Used to mask or hide a region in the family.
Filled region Used to create a 2D view–specific graphic. 
Dimensions Used to show and control distances between the various title-

block elements.
Text Adds text to the titleblock. Text can be modified only when in 

the Family Editor.
Reference lines Used as reference geometry and can be used to align other title-

block elements. Does not print.
Labels Data field that is used to display specific parameters when the 

titleblock is loaded into the project. Unlike text, a label will 
change as the project parameter associated with it changes. 
Typical label parameters are Project Name, Project Number, 
Sheet Name, Sheet Number, and Scale.

Images Allows you to place an image such as your company logo into 
the titleblock.

Table 14.1

Titleblock elements 
and tools
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In this exercise, you will create a very basic titleblock using CAD geometry as an 

underlay:

	 1.	 Go to the application menu, and choose 

New ➔ Family (Figure 14.1).

	 2.	 Open the Titleblocks folder.

	 3.	 Select D – 36 × 24 (A3 metric.rft), and 

then click Open.

The Family Editor is now opened. In the 

drawing area, you are presented with a blank canvas with the exception of four lines 

that represent the extents of your 36˝ × 24˝ sheet (420 × 297). In the next sequence 

of steps, you will import the CAD file of your company titleblock to use as your 

underlay. 

	 4.	 On the Insert tab’s Import panel, click Import CAD.

	 5.	 Browse to the source file Titleblock.dwg, available from this book’s web page  

(www.sybex.com/go/introducingrevit2011), as shown in Figure 14.2.

	 6.	 In the Import CAD Formats dialog box, set Import Units to Inch, and click Open.

Now that you have imported the CAD file (Figure 14.3), you can trace the CAD lines 

using Revit lines. This will create the framework of your titleblock.

Figure 14.1

Creating a  
new family

Figure 14.2

Import CAD Formats 
dialog box

Figure 14.3

Titleblock with 
imported CAD file
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	 7.	 On the Home tab’s Detail panel, click the Line tool.

	 8.	 On the Modify | Place Line tab’s Draw panel, click the Pick  

Lines tool .

	 9.	 Select each of the lines in the CAD file to create Revit lines.

Once you have created your Revit lines, you have your framework of your titleblock, 

and you can start adding text to identify the different sections. In the next steps, you will 

use the Text tool to create static information to display infor-

mation such as the identifier for the Date, Plot Scale, CKD BY, 

File Number, and other fields (Figure 14.4). Later you will use 

labels to provide the display parameter information for the 

previously listed fields.

If you did not complete the previous steps, you can open 

the Titleblock Add Text.rfa family to continue with this 

section.

	 1.	 On the Home tab’s Text panel, click the Text tool.

	 2.	 In the Properties palette, click the Edit Type button. You are going to create a new 

text type.

	 3.	 In the Type Properties dialog box, click the Duplicate button.

	 4.	 Name the new text type 1/16˝ Arial (1.5mm Arial).

	 5.	 Change the text size to 1/16˝ (1.5mm).

	 6.	 Click OK to close the Type Properties dialog box.

	 7.	 Using Figure 14.4 as a reference, you will create Revit text for each text item. Select  

a left attachment point and a right attachment point for text insertion.

	 8.	 Make sure that the horizontal alignment on the Modify | Place Text tab’s Format 

panel is set to Left.

	 9.	 Add text for the field descriptions. Use Figure 14.4 as a reference or create text for the 

cyan color text in the imported CAD file.

When creating a titleblock, it may also be necessary to import an image file of your 

company or client logos. Revit provides you with a simple means for handling this task.

	 1.	 On the Insert tab’s Import panel, click Image. This will open the Import Image  

dialog box. 

	 2.	 Navigate to the files from the book’s companion page (www.sybex.com/go/ 

introducingrevit2011), and open CompanyLogo.jpg.

	 3.	 Place this logo in the top-right box in your titleblock.

	 4.	 Repeat steps 1–3, and load ProjectLogo.jpg. Place this just below the project title.

Figure 14.4

Using the Text tool 
to create static text
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Limit the number of images that you import into your project. Revit provides a means for 

managing imported images. You can manage images from the Insert tab’s Import panel 

by clicking the Manage Images button. The Manage Images dialog box lists all the images 

used in the project including any rendered images. Using this dialog box is the only way you 

can delete an image from the project. Selecting and deleting an image in a view does not 

remove the image from the project, only from that view.

Now that you have created your field description text, you can use the Label tool to fill 

out the information. You use labels to read information from the project and automati-

cally display that information. These are some examples of data that you can use for dis-

play information:

Project name•	

Sheet name•	

Sheet number•	

Scale•	

If you did not complete the previous steps, you can open the Titleblock Add Label.rfa 

family to continue with this section.

	 1.	 On the Home tab’s Text panel, click the Label tool.

	 2.	 In the Properties palette, click the Edit Type button. You are going to create a label type.

	 3.	 In the Type Properties dialog box, click the Duplicate button.

	 4.	 Name the new label style 1/16˝ Arial (1.5mm Arial).

	 5.	 Change the text size to 1/16˝ Arial (1.5mm).

	 6.	 Click OK to close the Type Properties dialog box.

	 7.	 Create another text style call 5/16˝ Arial Bold (8mm Arial Bold) following steps 2–6.

In the next steps, you’ll cre-

ate a label that will populate 

your titleblock with the 

sheet number.

	 8.	 Click a point for the location 

for the sheet number. This 

will cause the Edit Label 

dialog box to open (Fig-

ure 14.5).

	 9.	 In the Category Parameters 

section, click the Sheet 

Number parameter.

Figure 14.5

Steps for creating a 
label for a titleblock

Third, edit options.Second, add it to the list.First, select the parameter.
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	10.	 Click the Add Parameter(s) To Label icon to add it to the Label Parameters list.

	11.	 Click OK to close the Edit Label dialog box.

	12.	 In the Properties palette, set Horizontal Alignment to Center.

	13.	 Move the label you just created to properly position it.

In the Edit Label dialog box, you can add more than one parameter to a single label. Sheet 

Number is a good example where you need to utilize only a single parameter. Project Loca-

tion, which could consist of a street address, city, state, ZIP code, and phone number, is a 

good example where you could utilize multiple parameters.

In the next steps, you will use the 1/16˝ Arial (1.5mm Arial) label to create a label for 

the view scale.

	14.	 On the Home tab’s Text panel, click the Label tool.

	15.	 In the Properties palette, make the 1/16˝ Arial (1.5mm Arial) label.

	16.	 Locate the SCALE: description field in the titleblock, and click below that. This is 

where you will display the name of the person checking the sheets. The Edit Label 

dialog box will open.

	17.	 In the Category Parameters section, click SCALE parameter.

	18.	 Click the Add Parameter(s) To Label icon to add it to the Label Parameters list.

	19.	 Click OK to close the Edit Label dialog box.

	20.	 In the Properties palette, set Horizontal Alignment to Left.

	21.	 Move the label you just created to properly position it.

When you load the titleblock into our project and create a sheet, if you have only one view 

on the sheet, the scale of that view will be displayed. If you have multiple views in a sheet, 

the Scale parameter will display As Indicated.

When you create a titleblock, you may need to display information in which Revit does 

not have a predefined parameter in the Category Parameters list, as shown in Figure 14.5. 

An example of this might be CONTRACT NO. Now you could populate the titleblock 

with the contract number by using the Text tool, but in the next example, you are going 

to use the Label tool. This will enable you to populate this information by filling out the 

Project Information fields. This information can be modified within a project by select-

ing the Manage tab’s Settings panel and clicking Project Information. In the next steps, 

you will create the CONTRACT NO label.
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Shared Parameters and Titleblocks

To accomplish this, you need to create something called a shared parameter. Shared 

parameters are parameters that you can create to add to your families or project and 

then share that parameter data with other families or projects. These shared parameters 

will allow you to add specific information that is not already defined in the family file or 

project template. We are just going to skim the surface of shared parameters. Consult the 

online help for more information on using shared parameters.

The first thing you need to do is to create a shared parameter file:

	 1.	 On the Manage tab’s Settings panel, click Shared Parameters. This will open the Edit 

Shared Parameters dialog box (Figure 14.6).

	 2.	 Click the Create button to create a new shared parameter file.

	 3.	 In the Create A Shared Parameter File dialog box, specify a filename and location to 

which to save your file.

	 4.	 In the lower-right corner of the dialog 

box, under Groups, click the New button.

	 5.	 In the New Parameter group, specify 

Titleblock.

	 6.	 On the middle-right side of the dialog 

box, under Parameters, click the New 

button.

	 7.	 In the Parameter Properties dialog box, 

enter the following information:

Name: Contract Number•	

Discipline: Common•	

Type of Parameter: Text•	

	 8.	 Click OK twice to close the Parameter Properties and Edit Shared Parameters dialog 

boxes.

Now that you’ve created your shared parameter for the contract number, you need to 

tie that to your label. Often it is easier to copy an existing label and modify the copy. We 

will demonstrate that method:

	 1.	 Locate the Plot Scale label that you created in the previous steps, and select it.

	 2.	 On the Modify | Label tab’s Modify panel, click the Copy button.

	 3.	 Select the start and end points (Figure 14.7).

Figure 14.6

Edit Shared Param-
eters dialog box
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End Point

Start Point

	 4.	 To edit a label, select it, and click Edit Label from the Properties palette.

	 5.	 In the Edit Label dialog box, remove Scale by selecting it and clicking the red arrow 

pointing left.

Because the Category Parameters section does not have a Contract Number param-

eter, you need to create this parameter.

	 6.	 At the bottom of the Category Parameters section, click the Add Parameter button.

	 7.	 In the Parameter Properties dialog box, click the Select button. This will allow you to 

select a shared parameter.

	 8.	 In the Shared Parameters dialog box, in the Parameter group make sure that Title-

block is selected.

	 9.	 Under Parameters, make sure that Contract Number is selected.

	10.	 Click OK twice to close the Parameter Properties and Shared Parameters dialog 

boxes. Notice that in the Category Parameters section, Contract Number has been 

added.

	11.	 In the Category Parameters section, click the Contract Number parameter.

	12.	 Click the Add Parameter(s) To Label icon to add it to the Label Parameters list.

	13.	 Click OK to close the Edit Label dialog box.

Figure 14.7

Copying the label
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At this point you can change properties such as the justification for the labels and their 

positioning. One last thing to consider is the width of the label. When the information is 

larger than the width of the label, Revit will automatically wrap it and add a line below. 

To control the width, simply select the label and drag the blue dots on each side to the 

appropriate location.

You can experiment with adding additional text, images, or labels to the titleblock. 

When you are done using the CAD file as a background, it is very important that you 

remove that from the family. Leaving the CAD geometry in the Revit family just increases 

the file sizes and will require you to make additional visibility changes to hide the imported 

file. To delete the imported CAD file, follow these steps:

	 1.	 Select the imported CAD file. Since you have Revit geometry on top of an imported 

CAD file, selecting might be difficult. Remember to use the Tab key to cycle through 

elements that your mouse pointer is hovering over.

	 2.	 With the imported CAD file selected, hit the Delete key.

	 3.	 Save the titleblock using the name Titleblock SP.rfa.

Loading and Testing a Titleblock

Now that you have created the titleblock with a shared parameter, you need to load it into 

a project for testing. You will start by opening, loading your titleblock family, and setting 

up the shared parameters to populate the titleblock labels.

	 1.	 Open the Advanced Sample Project that ships with Revit. You could also open any 

project that has sheets already created.

	 2.	 Load Titleblock SP.rfa into the project:

If you did not complete the previous steps, you can load the •	 Titleblock SP.rfa 

family. From the Insert tab’s Load From Library panel, click the Load Family 

button. Navigate to the files from the book’s web page (www.sybex.com/go/ 

introducingrevit2011), and open the Titleblock SP.rfa family.

If you have been following along, save the titleblock with the name •	 Titleblock 

SP.rfa. On the Home tab’s Family Editor panel, click Load Into Project. If you 

have multiple projects or families open, make sure you select Advanced Sample 

Project. 

	 3.	 Working in the Advanced Sample Project, in the Project Browser under Sheets (All), 

double-click sheet A1 – Floor Plan. This will open the sheet in the drawing window.

	 4.	 Select the titleblock, and then in the Properties palette change the type to Titleblock 

SP. When you do this, the floor plan will no longer fit inside the titleblock.

	 5.	 Select the view in the titleblock.

	 6.	 In the Properties palette, change View Scale to 1 : 200.
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In the next steps, you will make sure that the project is pointing to the correct shared 

parameter file that you created earlier and then tie those shared parameters to the project.

	 1.	 From the Manage tab’s Settings panel, click Shared Parameters. This will open the 

Edit Shared Parameters dialog box (Figure 14.8).

	 2.	 Click the Browse button, navigate to the files from the book’s web page (www.sybex 

.com/go/introducingrevit2011), and open the C14-SP.txt file.

	 3.	 Click OK to close the Edit Shared Parameter dialog box.

	 4.	 You will now tie the shared parameters to your project parameters. On the Manage 

tab’s Settings panel, click Project Parameters. This opens the Project Parameters dia-

log box (Figure 14.9), which lists all the project-specific parameters that are available 

to elements within the project.

	 5.	 Click the Add button. This will open the Parameter Properties dialog box (Fig-

ure 14.10) where you can define project parameters that are specific to the project.

Figure 14.8

Edit Shared Param-
eters dialog box

Figure 14.9

Project Parameters 
dialog box after you 

have added your 
shared parameters
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	 6.	 Under Parameter Type, click the Shared Parameter radio button, and hit the Select 

button. This takes you to the Shared Parameters dialog box where you can select 

which shared parameters you want to use to create a project parameter.

	 7.	 Select the Contract Number parameter, and click OK to close the Shared Parameters 

dialog box.

	 8.	 In the Parameter Properties dialog box, set the following:

Set Group Parameter Under to Other.•	

Select the Instance radio button.•	

Under Categories, select Project Information.•	

	 9.	 Click OK to close the Parameters Properties dialog box. In the 

previous step, you set the Contract Number parameter to dis-

play in the Other parameter group, you set the Contract Num-

ber parameter to be an Instance parameter, and you assigned 

the Contract Number parameter to be associated with the Proj-

ect Information category.

	10.	 Repeat steps 5–9 for Issue Date, Plot Date, and Project Title.

	11.	 Click OK to close the Project Parameters dialog box.

The new parameters can now be used to populate your title-

block. To add data to these parameters, you need to open the Project 

Information dialog box (Figure 14.11). You can do this by going to 

the Manage tab’s Settings panel and clicking the Project Information 

button .

Figure 14.10

Using the Parameter 
Properties dialog 
box to create our 
shared parameter

Figure 14.11

Project Information 
dialog box
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Placing a Revision Schedule
Now that you have a basic titleblock framework complete, you can further enhance it by 

including a revision schedule. Revit provides you with some flexibility in regards to the 

information you display.

The revision schedule is placed directly within the titleblock. It behaves exactly like a 

regular schedule and will read the revision and sheet issue information from the project.

The first thing you need to do is create a revision schedule:

	 1.	 Open the Titleblock RS.rfa family from among the downloads that accompany this 

book (from www.sybex.com/go/introducingrevit2011).

	 2.	 In your titleblock family, from the View tab’s Create panel, click the Revision Sched-

ule button. This will open Revision Properties dialog box (Figure 14.12).

The first tab, Fields, allows you to select the fields that you want to use in your revi-

sion schedule. This example will use the following:

Revision Number•	

Revision Description•	

Revision Date•	

Issued by•	

On the right side of the dialog box under Scheduled Fields (In Order), you have an 

extra field called Revision Sequence. You need to remove this from the schedule.

	 3.	 Select the Revision Sequence field. Then, in the top middle of the dialog box, click 

the <--Remove button. This will remove the Revision Sequence field from the sched-

ule.

	 4.	 Select the Issued By field in the Available Fields listing, and then click the Add--> 

button.

Figure 14.12

Revision fields
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	 5.	 Click the Sorting/Grouping 

tab. Here, you can use param-

eters to sort/group your 

schedules. In this example, 

you will sort by revision num-

ber to keep your revisions 

organized. As shown in Fig-

ure 14.13, in the drop-down 

field next to Sort By, select 

Revision Number.

	 6.	 At the bottom of the dialog 

box, select the Itemize Every 

Instance check box. This will 

ensure that all instances of an 

element in individual rows 

are displayed.

	 7.	 The next tab is the Format-

ting tab (Figure 14.14). This 

allows you to replace the 

default name for the column 

header.

This schedule will be labeled 

as a revision schedule, so you 

can remove the word Revision 

from all three fields. Edit the Heading field and the Alignment drop-down for each 

field, as shown in the following list:

Fields Heading Alignment
Revision Number Rev Left
Revision Description Descrip Center
Revision Date Date Right
Issued by IB Right

The next tab is the Appearance tab (Figure 14.15). This allows you to change the 

display of your revision schedule. In this example, you are going to turn off the grid 

lines and outlines of the schedule and use bold for the body text.

	 8.	 In the Graphics section of the dialog box, deselect the Grid Lines check box; this will 

prevent grid lines from being drawn. Also deselect the Outline check box.

Figure 14.14

Revision formatting

Figure 14.13

Revision Proper-
ties: Sorting/
Grouping tab
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	 9.	 In the Text section of the dialog box, to the right of Body Text, select the Bold box.

	10.	 Change the Header Text and Body Text sizes to 7/64 .̋ This will ensure that the revi-

sion schedule rows fit with the titleblock revision schedule geometry.

	11.	 Click OK to close the Revision Properties dialog box. You will then be taken to a 

view of the revision schedule. Because you are working with a titleblock family in the 

Family Editor, there will be no information to display.

	12.	 Close the Revision Schedule view.

You have made some basic changes to your revision 

schedule including changing the fields that are dis-

played, how the information will be sorted, the for-

matting of the data, and how the schedule will look. 

You can now place the revision schedule on the sheet.

	13.	 In the Project Browser, expand the View (All).

	14.	 Under Schedules, select and drag the revision schedule 

from the Project Browser onto the sheet.

	15.	 Click and place the revision schedule just below your 

company logo.

	16.	 Select the revision schedule. On the Options bar, in 

the Rotation On Sheet drop-down, select 90 Degrees 

Counterclockwise.

	17.	 Use Figure 14.16 as a reference to move the schedule.

	18.	 You will notice that the revision schedule won’t snap 

to anything, so you will need to approximate the 

placement. Start by placing the left side. Remember 

Figure 14.15

Using the Appear-
ance tab to adjust 

the appearance  
of the revision 

schedule

Figure 14.16

Revision schedule 
placed in the  
titleblock
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that you can nudge it. To adjust the widths of the columns, select the revision sched-

ule (Figure 14.17) and drag the blue triangles at the top of the schedule to align with 

the grid lines in the titleblock.

	19.	 You also need to define the overall height of the revision schedule. Drag the blue 

dot up to meet the bottom of the revision schedule area in the titleblock. This 

will define the bottom boundary.

You have finished with your creation of the titleblock. You can now save the family 

by going to the application menu and selecting Save As ➔Family. Navigate to a loca-

tion where you plan on storing your company-created families (this is typically a net-

work drive). Name the file D – 36x24.rfa [A3 420 x 297.rfa].

Setting Up Sheets
In this section, you’ll look at how to create new sheets and how the page setup works. 

You’ll learn to manage sheets to keep a project organized and easy enough for all 

team members to follow.

	 1.	 Open the source file rac_basic_sample_project.rvt, which can be found on in 

c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples, which was 

installed with Revit Architecture 2011.

	 2.	 Save the file and called it CreateSheets14.rvt.

Creating New Sheets
To first create a new sheet, you need to load the titleblock. Revit provides multiple 

methods for loading families into a project. One of the easiest is to drag the family 

into Revit from Windows Explorer. You can also use the Load Family tool.

	 3.	 From the Insert tab’s Load From Library panel, click the Load Family button.

	 4.	 From the chapter’s companion files, open the E1 30 x 42 Horizontal.rfa  

(or A0 metric.rfa) family.

	 5.	 Adding a sheet can be done in several ways. Use one of these two methods:

On the View tab’s Sheet Composition panel, click the Sheet button.•	

In the Project Browser, scroll down and right-click Sheets (All), and select  •	

New Sheet.

Either of these actions will open the New Sheet dialog box, where you can select  

the titleblock you are going to be using. Make sure that E1 30 × 42 Horizontal : E1  

30 × 42 Horizontal [A0 metric] is selected. (In either method, if you don’t see the 

titleblock, then you will need to load. Click Load and resume with step 4.)

	 6.	 Click OK in the New Sheet dialog to create a new sheet.

Figure 14.17
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	 7.	 The first sheet is now created and displayed in the drawing window. Notice that 

Revit automatically gave the sheet a default name and number. Chances are this is 

not what you want to use. To modify that information, right-click the sheet in the 

Project Browser, and select Rename. This will open the Sheet Title dialog box where 

you can change the sheet name and number.

	 8.	 Change the sheet number to A100; change the sheet name to Overall First Floor Plan.

In the next step, you are going to close the Sheet Title dialog box. Prior to doing this, in 

the drawing window and Project Browser, notice the current sheet name and num-

ber. When you click OK, Revit will rename everything for you automatically.

	 9.	 Click OK to close the Sheet Title dialog box.

	10.	 Repeat steps 3–7, creating another sheet:

Sheet number: •	 A101

Sheet name: •	 Overall Second Floor Plan

Now let’s update the Project Name value. Revit Architecture again provides you with 

multiple methods to accomplish this. The first method is to click the Project Information 

button on the Settings panel of the Manage tab. An alternate method is to select the title-

block and then click the Project Name value; this allows you to directly edit the text.

Using either of those methods, change the following information:

Project Name: •	 Stanley Office Building

Project Number: •	 100.5698 AB JX

Date: •	 June 10, 2010

Drawn By & Checked By: •	 Your Name

Owner: •	 Green Development

Now go to the Manage tab’s Setting panel and click Open Project Information; verify the 

value for Project Name (Figure 14.18). That confirms that the information is bidirectional.
Figure 14.18
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Adding Views on the Sheets
The next task is to place views on sheets, for which Revit provides two methods. The first 

process is actually really simple: drag and drop a view from the Project Bowser on to the 

sheet.

	 1.	 In the Project Browser, make sheet A 100 – Level 1 – Floor Plan active.

	 2.	 Under Floor Plans, drag the Level 1 floor plan onto the sheet.

	 3.	 Once your mouse pointer is in the drawing window, you can release the left mouse 

button. Your cursor will change to a preview of the extents of the view. You use this 

as a reference. Locate where you would like to place the sheet within the titleblock 

and click.

The second method is just as easy:

	 1.	 In the Project Browser, make sheet A101 – Overall Second Floor Plan active.

	 2.	 On the View tab’s Sheet Composition panel, click the View button. This opens the 

Views dialog box (Figure 14.19).

	 3.	 Within the dialog box, select the Floor Plan:  

Level 2 view.

	 4.	 Click the Add View to Sheet button.

	 5.	 Using the extent of the view as a reference, place the 

view on the sheet.

Notice that Revit automatically creates a viewport 

with a view title and fills the value for Scale in the 

titleblock.

Since your view was set at 1⁄8˝ = 1´- 0 ,̋ Revit automati-

cally sized the view appropriately, but if you needed to 

use a different one, there are several ways you can change the view after placement:

You can go back to the Floor Plan: Level 1 and change the scale directly in the view.•	

You can right-click the Floor Plan: Level 1 view in the Project Browser and in the •	

properties change the View Scale value.

You can right-click the view on the sheet and select Activate View. You will still be •	

working in the context of the sheet, but you will work as if you were back to the Floor 

Plan: Level 1 view, giving you access to the scale. (To return to the sheet, right-click 

again and select Deactivate View.)

To change the location of the view title, simply select it and drag it. If you have more 

than one view on the sheet, the view title will snap to the other ones for an easier alignment.

To change the length of the line in the view title, you need to select the viewport, not 

the view title. You will then see blue dots at each end of the view title. 

Figure 14.19
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Adjusting the Crop Region
In this section, we’ll discuss crop regions. Crop regions define the boundaries of a project 

view. For example, in Figure 14.20 two elevation views are shown. The top view does not 

have a crop region defined, and view extents are defined by the geometry in the model. 

The bottom view, however, has had a crop region defined so that you limit and define 

how much of the view will be displayed. In the following section, you’ll create two new 

views for your building elevations and then drop elevation views on the sheets. Then use 

the crop region function to alter the extents of the view.

	 1.	 From the View tab’s Sheet Composition panel, click the Sheet button.

	 2.	 In the New Sheet dialog box, make sure that the E1 30 × 42 Horizontal : E1 30 × 42 

Horizontal [A0 metric] is selected.

	 3.	 Rename the new sheet Exterior Elevations.

	 4.	 Change the sheet number to A200.

	 5.	 Repeat steps 1–4 creating sheet number A201, and also name it Exterior Elevations.

	 6.	 Make sheet number A200 active.

	 7.	 Add the West and East elevations (building elevations) to the sheet, placing the West 

elevation above the East.

Notice in Figure 14.20 that the West elevation (top) extents are much greater than 

those of the East elevation (bottom). You will use the crop region function to alter 

the extents of the West elevation view so those they are similar to those of the East 

elevation view.

	 8.	 Select the top view (West elevation). You need to make some changes to the model 

view; rather than switching to the West elevation view, you will make this view active 

on the sheet. This will allow you to make changes and use the East elevation and 

titleblock as references.

	 9.	 Right-click and select Activate View. You can also make the view active by clicking 

the Activate View button from the Viewport panel on the Modify | Viewports tab.

	10.	 In the Properties palette under Extents, select the check boxes for Crop View, Crop 

Region Visible, and Annotation Crop. Crop region can also be turned on and off by 

clicking the Show Crop Region button on the View Control bar.

Figure 14.20
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Figure 14.21 shows an example of a crop region with the model and annotation 

crop regions on. Crop regions have two main components:

Model crop  ​Crops model elements, detail elements, section boxes, and scope boxes 

at the model crop boundary. Visible crop boundaries of other related views are also 

cropped at the model crop boundary.

Annotation crop  ​Crops annotation elements when they touch any portion of the 

annotation element. For example, if you have a tag and the annotation crop is cross-

ing that tag, then the tag information will not be displayed. This is done to prevent 

partial annotations.

Annotation
crop boundary

Annotation crop
drag control

Model crop
boundary

Model crop
drag control

Break lines

	11.	 To adjust the crop region, drag the blue control grips until the West elevation has 

similar extents to the East elevation. If you want to specify an explicit size for the 

crop region, then click the Size Crop button on the Crop panel on the Modify | View 

tab. This provides you with options to control the width and height of the model 

crop and to adjust the annotation crop offsets from the model crop.

	12.	 When you are done, right-click in the drawing area, and select Deactivate View.

	13.	 Adjust the view title so it is appropriate for the new view extents.

	14.	 Make sheet number A201 active. Add the North and South elevations (building ele-

vations) to the sheet, placing the North elevation above the South. Adjust the model 

crop and view title as needed.

The crop region won’t print by default.

Figure 14.21

Crop region control
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Aligning Views on the Sheets
In this section, we’ll discuss aligning views on sheets. You can continue to use the 

model from the previous section; or open the source file rac_basic_sample_project.rvt, 

which can be found on in c:\Program Files\Autodesk\Revit Architecture 201\Program\

Samples, which was installed with Revit Architecture 2011. Save the file and call it 

CreateSheets14.rvt. Create a new sheet and name it A100.

You are now going to add guide grids to the sheets to align views on different sheets so 

they appear in the same location from sheet to sheet.

	 1.	 From the View tab’s Sheet Composition panel, click the Guide Grid button. This will 

open the Guide Grid Name dialog box.

	 2.	 Enter Plans for the guide grid name, and click OK to close the Guide Grid Name  

dialog box (Figure 14.22).

Revit will allow you to create multiple guide grids in a project. So, you may want to 

create several guide grids for plans, sections, details, and so on. Guide grids can be 

shared between sheets, and once created, they are an instance property for the sheet.

	 3.	 Click and drag the extent controls (blue dots) to resize the guide control to fit within 

the view area of the titleblock.

With the grid in place, you can now use the Move tool to reposition your views. Crop 

regions and datums (such as elevations and grid lines) can be used as reference points 

to be moved into alignment with the guide grid lines. 

Figure 14.22
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By default the guide grid spacing is set to 1 .̋ For these purposes, you can increase the 

spacing of the grids to help you align views on other sheets. If you change the guide 

grid space to 6 ,̋ you will have an easier time.

	 4.	 Select the guide grid.

When trying to select the guide grid, you won’t be able to click one of the grid lines. Instead, 

move your mouse pointer to the extents of the guide grid, and hit your Tab key to cycle 

through the possible selection. When the status bar indicates that you have preselected a 

guide grid, click the mouse button to select.

	 5.	 In the Properties palette, set the Guide Spacing to 6 ,̋ and hit the Apply button at the 

bottom of the palette.

	 6.	 Select the floor plan viewport, and click the Move button from the Modify | Viewports 

tab’s Modify panel.

	 7.	 For the basepoint, select the intersection of grid lines 5 and D.

	 8.	 For the move endpoint, select a guide grid location. Use Figure 14.23 as a reference.

	 9.	 Make sheet A101 active.

	10.	 In the Properties palette for the sheet, scroll to the bottom of the list. Under Other, 

set the Guide Grid option to Floor Plan. The sheet will now display the guide grid.

	11.	 Again, select the viewport, and click the Move button from the Modify | Viewports 

tab’s Modify panel. Repeat steps 7 and 8.
Figure 14.23
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Organizing Sheets
As your building project develops, you are going to be creating many different views 

for plans, sections, elevations, details, schedules, and so on. These views will then be 

dropped on the sheet. Revit makes it possible for you to organize your sheets in a logical 

manner—for example, by type (Floor Plan, Elevations, and so on). This helps once again 

to keep your project well organized. In this section, you can use one of your own project 

files or follow along using the source file rac_basic_sample_project.rvt, which can be 

found on in c:\Program Files\Autodesk\Revit Architecture 201\Program\Samples, which 

was installed with Revit Architecture 2011. Save the file and called it OrganizeSheets14.rvt.

To organize the sheets, you will need to use a project parameter:

	 1.	 On the Manage tab’s Settings panel, click the Project Parameters button.

	 2.	 In the Project Parameters dialog box, click Add to create a new one.

	 3.	 In the Parameter Properties dialog box (Figure 14.24), set the values as follows, and 

then click OK twice to close the dialog boxes:

Parameter Type: Project Parameter•	

Parameter Data | Name: Sheet Classification•	

Parameter Data | Discipline: Common•	

Parameter Data | Type of Parameter: Text•	

Parameter Data | Group Parameter Under: Identity Data•	

Parameter Data: Instance radio button•	

Categories: Sheets•	

	 4.	 In the Project Browser, click sheet A100 to highlight it.

	 5.	 In the Properties palette under the Identity Data section, you will see your newly cre-

ated parameter called Sheet Classification. Enter Floor Plan as the value, and click 

OK (Figure 14.25).
Figure 14.24
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S E LE C T I N G V I E WS aN D S h E E T S

You can also select multiple views at the same time (for 

example, all the elevations) by using Ctrl or Shift, and 

then you can type in the sheet classifi cation. Revit may 

not always provide you with the visual feedback that 

you are editing this parameter.

It normally is easier if you select one sheet, such as a 

detail sheet, and set the sheet classifi cation. Then select 

all the remaining detail sheets, and rather than typing 

Detail, select Detail Sheets in the drop-down box to 

apply that setting to all the selected sheets.

Now that you’ve identifi ed the view, you need to set the Project Browser to display that 

new level of organization.

 1. In the Project Browser, right-click Sheets 

(All), and select Type Properties.

 2. In the Type Properties dialog box, 

change the Type (All) to Drawn By. 

You need to do that because you can’t 

duplicate the All type.

 3. Click Duplicate, and enter Sheets 

Classification (Figure 14.26).

 4. Click the Edit button to the right of 

folders.

 5. In the Browser Organization Properties 

dialog box, set the following:

Set Group By to Sheet Classification.•	

Set Then By to <None>.•	

Set Sort By to Sheet Number.•	

Select the Sort By: Ascending radio •	

button (Figure 14.27).

 6. Click OK twice.

Figure 14.25

Setting the Sheet 
Classification 
parameter

S E LE C T I N G V I E WS aN D S h E E T S

You can also select multiple views at the same time (for 

example, all the elevations) by using Ctrl or Shift, and 

then you can type in the sheet classifi cation. Revit may 

not always provide you with the visual feedback that 

you are editing this parameter.

It normally is easier if you select one sheet, such as a 

detail sheet, and set the sheet classifi cation. Then select 

all the remaining detail sheets, and rather than typing 

Detail, select Detail Sheets in the drop-down box to 

apply that setting to all the selected sheets.

Figure 14.26
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Now all sheets are stored under the right Sheet Classification 

except for 3D views. Notice that all the sheets that do not have 

the Sheet Classification set yet are stored under ??? (Figure 14.28). 

Simply set the Sheet Classification value for the remaining sheets.

Building a Sheet List
Before you move to printing, you will create a sheet list to place on 

the title page:

	 1.	 On the View tab’s Create panel, click the Schedules drop-

down button, and select Sheet List. This will open the Sheet 

List Properties dialog box.

	 2.	 In the Sheet List Properties dialog box under the Fields tab,  

add two fields to the Scheduled Fields list (Figure 14.29):  

Sheet Number and Sheet Name.

	 3.	 Under the Sorting/Grouping tab (Figure 14.30), do the following:

Set Sort By to Sheet Number.•	

Select Grand Total, and set it to Count And Totals.•	

Make sure Itemize Every Instance is selected.•	

Figure 14.28
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	 4.	 Click OK to close the Sheet List Properties dialog box. The schedule now displays the 

list of the sheets sorted by number and shows a total of sheets.

	 5.	 Create a new sheet called Sheet A000 - Title Page.

	 6.	 Drag the schedule called Sheet List from Schedule/Quantities in the Project Browser 

into the drawing sheet (Figure 14.31).

Exporting Sheets and DWF
Although Revit provides many great tools for modeling in 3D, in the end you are still cre-

ating 2D sheets to review, print, sign, and seal. In a perfect world, you could print sheets 

on paper and not have to worry about the cost or environmental issues related to using 

paper. To reduce waste and improve communications, Autodesk has provided the Design 

Web Format (DWF) file format. With DWF files, you can export 3D models and sheets in 

a lightweight file format that can be read and marked up in a free application. DWF files 

are a great way of communicating your designs to your clients or even other consultants. 

They are lightweight, easy to work with, and really reliable.

DWF files let you share design information securely and easily. Using the DWF format, 

you can avoid unintended changes to project files, and you can share project files with 

clients and others who do not have Revit Architecture. DWF files are significantly smaller 

than the original RVT files, making them easy to send by email or post to a website.

DWFx files contain the same information as a DWF file but can be opened and printed 

using the free Microsoft XPS viewer.

To view a DWF, the other party will need DWF Viewer Design Review, which can be down-

loaded from the Autodesk website (www.autodesk.com).

A great use for DWF files is to review projects. They can be used to mark up the 

project without using a single sheet of paper. Once the files get marked up by a project 

Figure 14.31
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manager, they can then be relinked into Revit for an easy workflow. Markups will appear 

exactly on top of the proper sheet. To create a DWF, follow these steps:

	 1.	 Choose the application menu, and select Export ➔ DWF/DWFx. This will open the 

DWF Export Settings – Views/Settings dialog box (Figure 14.32). The left side of the 

dialog box shows a preview of the selected sheet, while the right side allows you to 

manage the export settings.

The first step is to select what you want to print. Generally speaking, you will export 

sheets rather than views. Your sheets will contain all the relevant views. If you were 

to export sheets and views, each view that has been placed on a sheet would be a 

duplicate. Your building project also probably contains many views that are used to 

help construct your building project and that were never intended to be used in your 

construction documents. 

	 2.	 In the DWF Export Settings – Views / Settings dialog box, on the View/Sheet Set tab, 

click the Export drop-down. Select <In Session View/Sheet Set>.

	 3.	 Under Show In List, select Sheets In The Model. This will display all the current 

sheets that have been created in the model. 

	 4.	 You can click the Check All button to select all the sheets, or you can individually 

select them by simply selecting the Include check box for each required sheet. (Click-

ing a column header will allow you to sort the sheets using that header.) Click the 

Check All button.

The DWF Properties tab (Figure 14.33) allows you to manage the level of information 

that will be embedded into the DWF. Under Export Object Data, the Element Properties 

check box will allow the recipient to see the instance and type properties of the elements 

Figure 14.32
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in the exported views. The Rooms And Areas In A Separate Boundary Layer check box 

exports the room and area properties to a layer separate from the geometry. This allows 

you to view individual rooms and room data when you are exporting a project or a view 

for use with facility management software.

The Graphic Settings option allows you to select which graphic format to use when 

exporting images. The Use Standard Format radio button exports images as PNG files; 

the Use Compressed Raster Format option exports images using a compressed JPG 

format.

The Print Setup button allows you to control print settings. The print settings 

(Figure 14.34) are similar to those used by other Windows applications.
Figure 14.33
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The Project Information tab allows you to make changes without having to go back to 

the project (Figure 14.35). This is handy if you need to adjust a check or issued date.

When you have made all the adjustments to the DWF Export Settings, click the Next 

button to continue the export. You will be prompted with the Export DWF dialog box 

(Figure 14.36).

Figure 14.35
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Browse to a location and give the file a name. The default is the project name. The 

naming can be as follows:

Automatic—long (specify prefix)  ​Manually specify a prefix in the File Name/Prefix field 

or accept the default, which uses this format: Revit Sheet/View: Project Name-View Type-

View Name.

Automatic—short  ​This format is Revit Sheet: Sheet Name or Revit View: View Type- 

View Name.

The Combine Selected Views And Sheets Into A Single Dwf File check box allows you 

to create either individual DWF files or a multisheet DWF file. If you have only one proj-

ect manager review the set, then you can select the option. On the other hand, if you plan 

on having multiple reviewers, you’re better off deselecting it so that all those people can 

access the files at the same time (which is impossible to do with only one file).

You can also create sets to be able to easily retrieve sheets later. To do so, click the New Set 

button at the top left of the list of sheets, give the set a name, and follow the previous steps 

to complete your selection. Then click OK to save the set in the project.





C hap te r 15

Design Options

When working  with multiple design alternatives, it can be frustrating to 

wait for a decision and then have to apply that decision to the progressing documenta-

tion. When using traditional CAD software, there are no specialized tools when you are 

dealing with design options. Fortunately, you get a purpose-built tool within the Revit 

platform called design options. With this toolset, you can start design alternative(s) at 

any time and apply the chosen design direction directly to the model—all views, tags, 

and schedules are coordinated instantly.

This chapter covers the following topics:

Design options terminology■■

Setting up design options■■

Editing design options■■

Applying design options to views and accepting the primary■■

Tags and annotation in design options■■
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Design Options Terminology
During the design process, you work on the design of a building with a particular out-

come in mind and use the model to flesh out the ideas that everyone involved has for 

the building. At some point, you will need to explore (or be asked to create) alternative 

solutions to part of the building. It is at this point that design options become important. 

Before we go further, it is helpful to understand some of the terminology used in relation 

to design options:

Main model  ​The main model encompasses the Revit model without any variations or 

alternatives. Before any design options are created, everything is part of the main model.

Design option set  ​The option set is a collection of alternatives that address a particular 

design issue. A design option set uses a portion or area within the project where alterna-

tives are being considered.

Design option  ​A design option is one possible solution to the design issue. Each design 

option set will have at least one option. To be useful, you should have two or more show-

ing alternatives. Each design option is specific to the issue addressed in the option set. 

You can have only one primary option (defined in a moment) per set.

Dedicated view  ​You can dedicate a view to a specific design option for each design option 

set using the Design Options tab in the Visibility/Graphics dialog box. When this view 

is active or added to a sheet, the options you have dedicated are always shown along with 

the main model.

Primary option  ​The primary option is the one favored by you or your client in the option 

set and shares a closer relationship to the main model than secondary options. Typically, 

the primary option is the one most likely to be accepted in the final design. Elements in 

the main model can reference elements in the primary option, and vice versa. By default, 

each view inside Revit is set to display both the main model and the primary option.

Secondary option  ​The secondary option is another possible alternative to the primary 

option within the same option set. You can have one or more secondary option(s) within 

a design option set. Elements in the secondary option can reference elements in the main 

model; however, elements in the main model cannot reference elements in the secondary 

option.

Automatic display  ​When design options are enabled, each view displays the main model 

and the primary option, if no options are being edited. By default, the visibility of a 

design option is set to automatic, which shows the primary option, and the visibility can 

be adjusted to show secondary options by going to the Visibility/Graphic Overrides dia-

log box. You can control the visibility of design options within the model for the follow-

ing views: plan, elevation, 3D, and drafting. If you are editing an option, the view displays 

the main model and the option you are editing.
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To be clear, we are not talking about wholesale design changes to the entire model (in 

other words, a design with a large circular footprint vs. a design with a large rectangular 

footprint). Completely different building design solutions are better represented in dif-

ferent Revit model files. Instead, we are talking about design options to parts/portions 

within the overall design. The following are some examples:

Alternative entry designs•	

Interior departmental plan layouts•	

Furniture design/layout•	

Exterior façades•	

Predefined, repeatable layout configurations•	

Quantify metrics/values with schedules•	

Roof configurations•	

Figure 15.1 shows examples of two design options within the building’s exterior cur-

tain wall.

In other CAD systems, having multiple design options means having multiple files or one 

file with multiple copies of the same geometry. A change to one does not mean the others 

change. Inconsistencies are inherent in this type of process, and errors are common. Revit 

addresses this issue by allowing you to develop and document multiple design options simul-

taneously as the rest of the design moves forward. Revit can synchronize these alternatives 

with the design once a decision has been made on which to keep and which should be 

removed, and the project can move forward without the need for manual intervention.

Figure 15.1

Two design options 
for a curtain wall
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Setting Up Design Options
You can access the design options in one of two ways. You can select the Manage tab and 

click Design Options (see Figure 15.2), or, new in Revit 2011, you can click the Design 

Options button in the Status bar along the bottom of the screen.

When creating design options, you begin by defining an 

option set. An option set is a “grouping” of options. It is good 

practice to keep your option sets isolated to a specific task or 

area within the model. An option contains the model data/

objects that show each alternative or competing design option/

scheme.

To get you started, you will create two new option sets in this section. In the Option 

Set area, click New. In the Option area, click New and then New again to add a second 

option. Repeat these steps to create a second option set that contains two options (see 

Figure 15.3).

Within each area you can rename the options sets to something more descriptive. To 

do this, highlight the option set or option, and choose Rename from the appropriate sec-

tion. In Figure 15.4, the Design Options 

dialog box shows the design options 

renamed with two option sets called First 

Floor and Main Entry East. Within each 

option set are multiple alternative design 

options of differing configurations. In 

the Main Entry East set, you will be 

exploring two schemes; Single Door w/ 

Sidelights is the primary option, and 

Double Door is a secondary option. You 

can have multiple options under each 

option set, but only one entry within 

each option set can be considered the 

primary, or top, choice until a decision 

has been made to eliminate the others.

The default names of design option sets are Option Set 1, Option Set 2, and so on. You will 

find it easier to rename these from the start to something more descriptive. Unfortunately, 

you cannot simply select the option set from the “white area” of the dialog box. To rename, 

you will need to select your option set, click the Rename button in the Option Set section on 

the right, and rename it in the Rename box.

Figure 15.2
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Editing Design Options
Now that you have the design option sets and design options created, 

it is time to create and/or add elements to each set. To do this, select 

the design option that you want to modify, and click Edit Selected  

in the Design Options dialog box.

Click the Close button to edit the design option.

You will know that you are editing a design option in one of two ways:

The first way is graphically. In the plan, elevation, 3D, and drafting views, the exist-•	

ing geometry that is part of the main model will be displayed as ghosted.

In the Status bar, the white area will show the name of the design option that is being •	

edited (see Figure 15.5).

At this point, you can go back to designing with 

standard Revit elements that best show the design 

option you are trying to convey. When this design 

option is at a point where you want to stop editing, you must open the Design Options 

dialog box and click Finish Editing. You can edit or make adjustments to a design option 

at any time by returning to the Design Options dialog box.

More often than not, you will find that you want to move back 

and forth between multiple option sets. While you are editing the 

selected option set, the Status bar next to the Design Options button 

shows the other options available in the drop-down menu (see Figure 15.6). By chang-

ing from one option to another, any geometry that was created in the previously selected 

Figure 15.4

Renaming the 
option to First Floor 
and Main Entry East

Figure 15.5

Status bar showing 
the design option 
currently being 
edited
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option that does not exist within the newly selected option will not be shown. These 

design options are independent of each other, and the geometry exists only within the 

individual options themselves.

If you are done editing a design option or just want to get back to working with the main 

model, you can choose Main Model from the Status bar’s Design Options drop-down menu. 

This is the same as opening the full Design Options dialog box, clicking Finish Editing, and 

then clicking Close.

On the Status bar when a design option is being edited, you will notice a small Active 

Only check box (see Figure 15.6). When this is selected, any geometry within the main 

model is ignored while picking or windowing. With 

the Active Only box deselected, the main model will 

still be ghosted, and all the geometry within it can 

now be selected.

If you are in the main model, the Status bar’s 

Design Options area will show an Exclude Options 

check box instead. This plays a similar role to Active Only except in reverse; within the 

main model with this selected, Revit will ignore any design options displayed from acciden-

tally being selected. Deselecting this will allow you to select objects with a design option.

When at least one or more design option sets are 

created, the Status bar’s Design Options area adds 

another useful item, Add To Set (see Figure 15.7). This is ghosted unless you have at least 

one or more objects selected.

A common use in deselecting the Active Only 

check box and clicking the Add To Set button on 

the Status bar is when there are objects that you 

would like to copy from the main model to include in one or more design options. As an 

example, let’s take a furniture layout that was originally done in the main model and now 

consider different layout configurations. The steps to set this up are as follows:

	 1.	 Create a new design option set.

	 2.	 Create as many design options as needed to show the different layouts.

	 3.	 Close the Design Options dialog box.

	 4.	 Select the furniture to move from the main model (making use of picking, window-

ing, and/or filters), and place it within one or more of the design options created 

earlier. To do this, with the objects selected, click the Design Options status bar’s 

Add To Set button. In the Add To Design Option Set dialog box (see Figure 15.8), 

choose which design option set this should be part of and which design option (one 

or more) you want to move the selected objects into.

Figure 15.6

Changing design 
options

Figure 15.7

Design Options 
 Add To Set

Add To Set
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This step will remove the geometry from the main model and place it 

within one or more design options as selected.

	 5.	 If geometry already exists that you want to move into a design option set, 

take advantage of the features that Revit offers to pick, select, and filter, 

including the Exclude Options and Active Only check boxes on the Status 

bar. Use the Paste options on the Modify ribbon (such as Paste Aligned) as 

needed as well.

Applying Design Options to Views and 
Accepting the Primary
Now that you understand and have created design options sets and defined the design 

options, it is time you take this knowledge and show it graphically in different views. 

Once you’ve decided which design option you want to keep, you will merge this into the 

main model by accepting the primary.

You will be using the floor plan in this example. Keep in mind that the process for 

working with all views and showing the different design options is similar. Within the 

floor plan that you want to work with, you will visually see the main model as well as 

the primary design options by default. You will set up the views to show the other design 

options by first duplicating the view as many times as you need to match the number of 

design options you want to show.

	 1.	 In the Project Browser, select the floor plan that you want to work with, right-click, 

and choose Duplicate (to duplicate just the floor plan) or Duplicate With Detailing 

(to include a copy of the annotation). Take a moment to rename the view to help you 

better understand which design option 

this is going to relate to.

	 2.	 Next use the Visibility/Graphics (VG) 

to change each view from showing the 

Automatic value or Primary option and 

showing a specific design option. On the 

Design Options tab (see Figure 15.9), you 

will see each of your design option sets 

listed and a drop-down that allows you to 

select a particular design option.

	 3.	 Select the appropriate design option, and 

repeat the process for each option. This 

will then display the main model plus the 

selected option. Figure 15.10 shows two 

examples of the main model with differ-

ent design options.

Figure 15.8

Add To Design 
Option Set  
dialog box

Figure 15.9

Design Options  
Visibility/Graphics
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	 4.	 Repeating this process, you can create the required presentation drawings showing 

multiple design options, plans, schedules, and 3D views and place them on sheets for 

presentation.

You can also use shade and shadows to better illustrate graphically the impact that the deci-

sion has on the project.

To tell schedules which design option to display, you cannot use the shortcut 

key VG; rather, open the properties, and on the Visibility/Graphics Overrides line 

under Graphics, click Edit (Figure 15.11). Then select the appropriate design option 

(Figure 15.12).

Figure 15.10

Floor plans with 
alternative design 

options
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When you’ve decided which design options to proceed with, you should set that choice 

as the primary option. If it is currently a secondary option,  you can elevate it to the pri-

mary option status in the Design Options dialog box. First select the design option, and 

then click Make Primary in the Option area (shown earlier in Figure 15.4). Once you’ve 

designated the desired choice for the project as the primary option, select the design option; 

the choice of Accept Primary will now be available. Clicking this will remove the objects 

within from the design option, place them within 

the main model, and coordinate them through the 

documentation set. The design option set and any 

design options within it will now be deleted (with a 

warning, shown in Figure 15.13).

Figure 15.11

Displaying design 
options by editing 
the Visibility/Graph-
ics properties of a 
schedule

Figure 15.12

Schedule design 
options

Figure 15.13

Warning from 
Accept Primary 
command
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Additionally, once you do this, you’ll see an option to delete any now-unused views. 

This will help you keep a clean Project Browser. Repeat these steps as the project pro-

gresses for each design option set.

Tags and Annotation in Design Options
It is straightforward to add room tags after the design options are created. Although it 

does not always happen in that order, it does illustrate what Revit is ultimately looking for. 

So, in this section, you will start with the methodology that Revit prefers  and then learn 

how to proceed when you already have rooms created when you create design options.

If the rooms are created before you introduce design options, keep these two tips  

in mind:

Be sure to use the Duplicate With Detailing option to create the views. That way,  •	

the room tags are already shown in each view.

When adding elements to the first option, be sure to select the room tags. That way, •	

they (and the room boundaries) will not be part of the main model. If you miss one 

(or more), there will be some confusion when you create the second option. Other-

wise, everything else works the same.

After design options are created, keep these things in mind regarding tags:

Make sure you are •	 not editing any design option. Start with the view that shows 

your Design Option 1 and the main model. Add the first room tag to the plan (this 

is assuming that the first room is the same in both designs). Edit the room number 

to the desired number. This establishes a pattern for Revit to follow. Now proceed by 

tagging all the rooms that are the same in both design options.

Next, use the Edit Selected button for your first design option. Now add room tags to •	

the rooms created by the walls in Design Option 1. At this point, you should have the 

plan tagged. Everything looks good. But this is where it gets tricky. End editing the 

first option, and return to the main model. Open the view for Design Option 2. Place 

a room tag in one of the rooms that is the same in both options. It should pick up 

the number you gave it in the Design Option 1 view. Because it is the same “room,” 

it wasn’t tagged. You can proceed to tag all the rooms that are the same in both 

options. If you accidentally tag a room that overlaps with a room in Design Option 1, 

you will get a warning. Don’t panic. Just delete the tag you just placed. When you get 

the warning that says it can be ignored, don’t ignore it!

When you’re ready to tag the rooms formed by walls in Design Option 2, use the Edit •	

Selected option, and add tags within the view. The same warning will show up if you 

attempt to tag a room that is not part of the design option (in other words, it is the 

same in both options). You will be able to renumber the tags in a design option to 

follow the numbering scheme of the main model.
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So, when you think about it, it really makes sense. If you want to tag a room common 

to both design options, do it in the main model when not editing a design option. When 

you want to tag a room created by a design option, do it while editing that design option. 

This is what Revit is expecting.

For the numbering of room tags, the last value used influences the pattern of the next val-

ues. For example,  if you started with Room 101, the next room would be 102, and so on, 

unless you manually changed a value and then started the next room tag. This is useful 

when trying to match the numbering scheme of the main model. Also, when working with 

design options, you can have “duplicate” numbers provided they are not in the main model. 

Because the two design options cannot coexist in the same option, Revit does not see them 

as duplicated.

Here are some more considerations related to including rooms in options:

Rooms can be placed in each design option independently. The room bounding areas •	

and room separation lines in that option, in the main model, and in primary options 

of other option sets define the boundary. Revit ignores walls and room separation 

lines in secondary options of other option sets.

To assign different room properties, such as occupancy, in different options, the •	

room must be included in that option.

If the shape, size, or location of a room varies in different options of one option set, •	

then the room must be included in that option set.

If the shape, size, or location of a room varies when you switch among different •	

options of two or more option sets, then you must divide the room with room sepa-

ration lines into rooms, each of which varies in only one option set, and then put 

each room into the appropriate option set.

If the shape, size, or location of the room is the same in different options and you •	

want properties assigned to the room to be the same for all options, keep the room in 

the main model.

If you place a room in an area that already has a room assigned to it, you will get the •	

following error: Option Conflict.

Tagging doors and windows is a bit different. The tags for these elements are visible 

and editable whether or not you are editing a design option. In other words, they are not 

part of any design option. This is why when you select objects and try to add them to a 

design option, if you have included door and window tags (and some other elements as 

well), you receive a warning.

Using annotation tools (such as Text, Detail Lines, Regions, Detail Groups, and 

Insulation), you can interact with the design options and views. While editing a design 
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option, you can place an annotation, and although it may seem like you are adding this  

to the design option itself, Revit is actually placing this in the active view in the main 

model and not as part of the design option.

Dimensions behave like the previous annotation elements. Where they differ is that 

when the design option displayed within the view is changed, dimensions that are associ-

ated to geometry within that design option will no longer be displayed unless that design 

option is visible within the view.
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Phases

When it comes to  phasing, it is very difficult to keep track of what part 

will remain and what part will be demolished. In traditional file-based CAD systems, it 

is a logistics and training nightmare to keep things working smoothly. Fortunately, Revit 

has phasing tools specifically for this purpose. With this tool set, you can use phases 

applied to the elements and components in the model, and all views and schedules are 

coordinated instantly.

This chapter covers the following topics:

Phase tools■■

Phases■■

Infill elements■■

Demolishing elements■■

Rendering and existing phases■■
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Phasing Tools
When working with phasing-related data, if one phase could be finished and become the 

“existing” before the next phase work begins, that would be ideal. But more often than not, 

you will find yourself working on multiple phases all at the same time. In a traditional CAD 

platform, this causes you to keep multiple copies of multiple files and in most cases track 

these files manually. If one file changes, that change would have to be manually propagated 

to the “copied” files. Not only that, but add company naming standards, external reference 

structures, multiple floors, multiple buildings, submittal requirements (for example, mul-

tiple buildings but a single submittal), and more to the mix. In short, it’s a lot of work.

Within the Revit platform, you can use the phasing-related tools. If you have been fol-

lowing along with the examples in the book or if you’ve used Revit prior to this, you may 

not have even realized that you were already taking advantage of some of the phasing-

related tools. Figure 16.1 shows an example of a multiple-phase project and the progression 

of an original warehouse that was converted and expanded to office space (Figure 16.2), 

and later a new upfit that was done to open up the interior layout (see Figure 16.3).
Figure 16.1

Existing warehouse 
footprint

Figure 16.2

Warehouse expan-
sion to office space 

(note existing struc-
ture ghosted on the 

bottom left)



Phasing Tools  ■   403

You can find the phasing-related tools on the Manage tab. Click the Phases button, and 

you are offered a dialog box with three tabs. The first tab, Project Phases (Figure 16.4), 

allows you to create as many new phases as you need for this project, give them a descrip-

tion, and arrange the order from past to future. You also have the ability to combine 

phases.

The Phase Filters tab allows you to control what is visible in a view based on its 

selected phase assignment (Figure 16.5). 

Figure 16.3

Office space new 
owner upfit (note 
removal of previous 
walls and elements 
displayed with 
dashes)

Figure 16.4

Project Phases  
tab with options
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Phase filters control the display settings for the four Graphic Overrides states: New, 

Existing, Demolished, and Temporary. For each state, the filter can apply one of three 

settings in the drop-down:

By Category  ​This will display elements using the default style settings from the Manage ➔ 

Settings ➔ Object Styles dialog or from any graphic overrides that may have be applied to 

the view.

Overridden  ​This will use the override settings as defined on the Phasing Graphic Over-

rides tab.

Not Displayed  ​This will not display any matching elements within the view.

For phase filters, you can edit the existing as well as create your own. We will focus  

on taking advantage of the ones provided out of the box in the templates, which use the 

following phase filters:

Show All  ​Will display New, Existing, Demolished, and Temporary elements in the cur-

rent phase. Elements that have been demolished in prior phases will not be shown. This 

filter cannot be deleted.

Show Complete  ​Will display New and Existing together.

Show Demo + New  ​Will display New and Demolished elements.

Show New  ​Will display New elements.

Show Previous + Demo  ​Will display Existing and Demolished elements.

Show Previous + New  ​Will display New and Existing elements.

Show Previous Phase  ​Will display Existing elements.

Figure 16.5

Phase Filters 
tab with default 

options. These allow 
you to control what 

is displayed in  
the view.
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The Graphic Overrides tab provides four states (Figure 16.6) that can be used to 

describe and graphically convey an element at any point in time. Although you can edit 

some of their properties, you are unable to delete from or add to the ones provided in this 

list. The four states are as follows:

Demolished  ​These are elements created in an earlier phase and demolished within the 

current phase.

Existing  ​Relative to the active phase, these are elements created in a phase previous to the 

one you are currently working in.

New  ​These are elements created within the current phase.

Temporary  ​This is used for elements that are created and demolished within the same 

phase.

Phases
Phases provide the ability to represent key periods in time for the life of the proj-

ect. In the out-of-the-box templates, two phases exist by default: Existing and New 

Construction. The default current phase is New Construction. This means that every-

thing created is assigned to this phase until it is either demolished using the Demolish 

tool or reassigned to another phase.

You can create as many phases as necessary and assign building elements to these 

phases. Every element in Revit exists within a time period defined by two phasing param-

eters. These are the phase in which an element is created in and the phase in which it is 

demolished. The Phase Demolished parameter can be set to None, which is the default for 

Figure 16.6

Graphic Overrides 
tab: Allows you to 
control the appear-
ance of a phase 
representation in a 
view, based on its 
phase assignment. 
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any new element that is created. Figure 16.7 shows that the wall was created in Phase 2011 

and is not currently set for demolition during any of the planned project phases.

You can also create duplicate views and assign different phases and phase filters to 

these views.

Assigning a Phase to a View and Element
Each project view has both a phase and a phase filter to control visibility. Because phasing 

visibility settings are view-specific, you can create phased views with pre-assigned phase 

filters in your template as a starting point for the project. Figure 16.8 shows the location 

of the phasing properties for the view.

When elements are first created and components 

placed, their Phase property matches that of the current 

view in which they are created or placed in. This is use-

ful when you have a project with phases already defined 

and now need to add elements or components within 

the view, select the view with the appropriate phase set-

ting, and create or place as needed. 

You will find elements or components in the project 

where the phasing needs to be adjusted at some point. 

This could be because someone unfamiliar with the 

project phasing setup comes in to assist on the project, because of components or ele-

ments that are now going to be part of the project sooner/later than originally planned, 

or because of another reason. To make the phasing 

property change, you will need to select the element(s) 

or component(s) and in the Properties palette change 

the phasing designation (see Figure 16.9). Making this 

change will instantly update the project model and 

visually change to match the graphic designations, as 

defined earlier.

Figure 16.7

Element Properties 
palette’s Phasing 

properties

Figure 16.8

View Properties 
palette’s Phasing 

properties

Figure 16.9

Properties palette 
showing the View 

Phasing properties
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Phase Properties of Schedules
You can filter and phase a schedule just like you can for a view; you can find this in the 

element properties of the schedule. Assign the Phase and Phase Filter properties. When 

you create a new schedule, set the Phase property 

to match the desired report. In Figure 16.10, we 

have assigned the door schedule to display the 2011 

Construction phase information.

In your multiple-phase project, you can create 

duplicate views of the schedule to keep the same 

formatting and assign different phases and filters as 

desired to display your information. In Figure 16.11, 

you can see a door schedule for the 1994 Phase and 

how this compares to the 2011 Phase of the project. 

To duplicate the schedule, in the Project Browser, 

right-click the door schedule, and choose Duplicate 

View ➔ Duplicate. This will create a copy of the 

schedule, which you can rename and set the appro-

priate phase and phase filter for.

When naming your schedules, you will find it helpful to include the name of the phase in 

the View Name box, for example, Door Schedule for 1994 Phase and Door Schedule for 2011 

Phase. Doing this will make it easier for you and others on the project to know what the 

schedule is reporting without having to check the view properties.

Phase-Specific Room Boundaries
All rooms are phase-specific in a project. When you add a room to a plan view or create a 

room by adding a row to a room schedule, the room is automatically assigned the speci-

fied phase of the view.

As the project progresses, you can report room areas for different phases. Also, the 

same room name and number can exist in the same or different locations of the model, 

provided they are in different phases. It is recommended that you do not switch the phase 

in the same plan view but rather make duplicate plan views with dedicated phases.

You can make edits to room-bounding elements in one phase without affecting other 

phases. For example, you can delete room-bounding walls in one phase and, provided 

Figure 16.10

Schedule Properties 
palette’s Phasing 
properties

Figure 16.11

Door schedule 
showing two sepa-
rate phases in the 
project
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those walls do not exist in other phases, not impact the room boundaries defined in other 

phases. Revit ignores any “room-bounding” elements that do not exist in the active phase 

in which you are working.

Rooms become part of the phase as you place them in the view. In Figure 16.12 you are 

looking at the existing phase, First Floor.

Compare Figure 16.12 with Figure 16.13, and notice that room tags occupying the same 

space can have different names. You can also have the same room numbers in a different 

phase in the same or different locations.
Figure 16.12

Existing phase, First 
Floor plan

Figure 16.13

New phase, First 
Floor plan
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Infill Elements
Infill elements occur when a hosted element and its host do not have the same values for 

Phase Created and Phase Demolished. In the first image in Figure 16.14, you see a previ-

ous phase that contains a wall and 

a door. In the second image, which 

is a later phase, the door has been 

demolished, a window has been 

placed in the same location, and 

Revit infills the wall where the 

door is being removed. When Revit 

places an infill, you cannot drag, 

move, mirror, rotate, copy, or paste 

the element.

Take note when an item is demolished and an infill placed, that infill will behave just 

like the host elements in that you can place a new element within or overlapping that area.

Also keep in mind that infill elements for roofs and floors project down from the top 

face, and infill elements for ceilings project up from the bottom face.

You can find an example of a phased project among the files you downloaded at the book’s 

companion web page (www.sybex.com/go/introducingrevit2011). Look for 16_Project_

With_Phases.rvt.

Figure 16.14

Revit infill of the 
wall when existing 
door is demolished 
and a new window 
is placed in the view
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Infill Elements for Earlier Phases
If you place an insert into a host in a phase later than the host’s creation phase, Revit cre-

ates an infill element for earlier phases.

Where you have an existing shell drawn for your project, place a door or window in 

the exterior with the view phase set to a future phase (Figure 16.15). Open a view with an 

earlier phase, and you will find an infill element in the area where the door or window 

will be created in the future.

Figure 16.15

Revit infill added to 
the host object in an 

earlier phase of the 
project
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Demolishing Elements
We have referred to the use of the Demolish tool used with phasing. To use this tool, 

you model the existing project using elements and tools outlined in the book as normal, 

including the elements that you want to demolish. You do this because the demolition 

work isn’t really a phase per se but more a parameter of an element.

When the modeling is completed, you are ready to indicate what will be demolished. 

To do this, follow these steps:

	 1.	 Open a view that has the element you want to demolish.

	 2.	 Click the Demolish button, as shown on the Manage tab’s Phasing panel.

	 3.	 Select the elements that are to be demolished.

If only part of a wall is to be demolished, select Modify ➔ Split to break the wall as necessary. 

Then demo the appropriate part. Notice that if you demo a wall that contains a door or a 

window, the door or window is demolished as well.

Figure 16.16 shows a project underway using phases: an older phase is half-toned per 

the phase filter, while the demolition is dashed in blue.

Figure 16.16

Using the  
Demolish tool
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Rendering and Existing Phases
When rendering in Revit, the phase that elements are assigned to can affect the final ren-

dered output. A common occurrence is when you are displaying elements from an earlier 

phase in the view of a newer phase. This is based on the phase filter, which can override 

existing objects to display using an alternative material (the default override is the Phase – 

Exist material) from the one assigned to the object. By default, some of the phase filters use 

the Overridden value (see Figure 16.17).

Figure 16.18 shows what happens when the phase filter is set to Show All. To render the 

view without the phase filter, you can temporarily change the Phase Filter setting to None 

for the view and then render. This will use the default materials that were applied to the 

objects, as shown in Figure 16.19.

Figure 16.17

Phase filter’s Show 
All settings

Figure 16.18

Rendered image 
with the phase filter 

set to Show All
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You can find an example of rendering a phased project among the files you downloaded 

at the book’s companion web page (www.sybex.com/go/introducingrevit2011). Look for 

16_Rendering_With_Phases.rvt.

Figure 16.19

Rendered image 
with the phase filter 
set to None
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Creating Families

In Chapter 6,  “Introduction to Families,” we discussed the broader role 

that families play in Revit. A single chapter cannot do this subject true justice. This 

entire book—even perhaps several books—could be consumed with the vagaries of 

creating families, if you consider the full scope of the work you do. This chapter serves, 

as the book’s title suggests, as your introduction to creating Revit families. It will delve 

into the concepts and features that you need to appreciate in order to modify existing 

families as well as create your own. This chapter will follow this path:

Preparing to create a family■■

Examining the tool chest■■

The bigger picture and advanced concepts■■

Dissecting some practical examples■■
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Preparing to Create a Family
You can consider a family to be a smaller representation of the complexities of a project. 

Like a project, a family has unique requirements, and the choices you make during early 

design discussions can have a considerable impact later when the family is being used 

in the project. It is often easier to create a family for yourself because you have all the 

answers (in an ideal world). When you are responsible for making them for other users, 

it can be just as tricky to find out what they really want as it is for you to figure out what 

your client really wants for their project.

When you create a family, you need to consider how it will be used and what it should 

look like. You are trying to both create a meaningful representation of a real object as 

well as improve the way a project is designed, documented, and ultimately built. The 

process will likely challenge your understanding of the components you include in the 

buildings you design. It is also very easy to be lulled into thinking that every family you 

create must be highly parametric. However, it is reasonable to create a simple version or 

a placeholder initially and then refine it as the project matures. You might just replace it 

entirely with a specific manufacturer’s family when one is available.

The process to create a family can be reduced to the simple relationship that exists 

with our own bodies. In the Family Editor environment, certain terms can be compared 

with Revit elements:

Bones = Reference planes and reference lines•	

Muscle = Dimensions, constraints, and parameters•	

Skin = The visible part of your family—solid and void forms as well as lines and •	

regions

You and Revit are the “brains” of the operation. You tell Revit what you want the fam-

ily to do, and Revit delivers the information to the muscle. The bones follow the instruc-

tions of the muscle. Skin has no choice but to follow the bones it is attached to, as long as 

the family isn’t involved in a skiing accident.

You need to consider several things before you start creating a family from scratch. 

Since Revit is organized according to categories, you will need to start there. Then it is 

necessary to decide whether your family needs to be hosted by system families. A family 

can be placed by a single “pick” (a door) or by two “picks” (a plywood detail component). 

You need to choose which makes the most sense for your family. Once you’ve made these 

decisions, you can start working inside the family.

Modify Existing or Start from Scratch
Initially, the most common way a Revit user gets acquainted with families is by edit-

ing something in the stock library. They might need a door or window in another size, 

so they just create a new type, change a few parameters, and go back to what they were 
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doing. It is very easy and quick—that is, until they can’t find what they need. Even when 

a perfect version isn’t available, they might be able to make some minor changes to some-

thing that is reasonably close. In this case, it makes sense to edit an existing family as well 

but save it to a different filename. There is a point, however, where editing an existing 

family is a complete waste of time. If you think it will take 20 minutes just to understand 

how a family was put together, then you should probably consider starting with a fresh 

template. This is where the learning curve gets a bit steeper.

Apart from editing something you already have, starting from scratch offers you  

nearly complete freedom. You don’t have to contend with existing decisions or habits. 

You are the boss (at least to some extent, like if you care about standards and 

such). You start to design your family with a template, and choosing a tem-

plate is the first of several decisions you must make.

Choosing a Category
All elements in Revit are organized into specific categories according to their 

role; you have model elements such as doors, walls, and windows, and you 

have annotation elements such as tags, detail components, symbols, grids, and 

levels, to name just a few. When you start creating a family, your first decision 

is to figure out which category you need. That shouldn’t be too hard. When 

what you want to make doesn’t fit neatly into a category, you can choose the 

catchall category Generic Models, as shown in Figure 17.1.

There is another catchall called Specialty Equipment, but this category 

does not provide a Cut representation, whereas Generic Models does, as 

shown in Figure 17.2. If you need a Cut representation for your family, be 

careful to choose Generic Models.

Figure 17.1

Family category and 
parameter choices

Figure 17.2

Object Styles’  
Cut line weight
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To choose your family template, there are two ways to access the template: the Recent 

Files window and the application menu. The Recent Files window offers you the following 

choices: Open, New, Conceptual Mass, and Web Library. When you use the application 

menu and choose New, the following options are offered: Project, Family, Conceptual 

Mass, Title Block, and Annotation Symbol. Each of these is a family as far as Revit is con-

cerned, but their templates are segregated into separate folders. Clicking one of the listed 

options will open the corresponding folder and offer you templates to choose from. There 

are many templates, and a little separation can help. Since Revit is organized around cate-

gories, you have to make the correct choice to get started properly. If you make a mistake, 

you can still change it later, but it is best to start well.

To create a new room tag, start by clicking the application menu and selecting New ➔ 

Annotation Symbol. Then choose the room tag.rft family template, and click Open. To 

create a new furniture family, start by clicking the application menu and selecting New ➔ 

Family. Then choose the furniture.rft family template, and click Open.

You probably noticed that Revit offers two templates with furniture in the name: furniture 

.rft and furniture systems.rft. They exist because it is quite common to provide sum-

maries of discreet furniture items such as chairs and tables apart from system furniture such 

as those made by Haworth or Steelcase, for example. This intentional separation makes it 

very easy to provide schedules that have a bias for one or the other.

If you decide that you need to change the category of the family after you’ve made your 

selection, it isn’t the end of the road; just take these steps: open the family and click the 

Home tab, go to the Properties palette, and click Family Category And Parameters; then 

choose the new category you need, and click OK.

Catch-all  ​Sometimes it is not easy to choose. Are you making an awning family for a 

front entrance? If you are making the brackets for this awning as a family that will sup-

port a roof, you may struggle with the category choices. Should it be Structural Framing, 

Specialty Equipment, or just Generic Models? Structural families bring with them analy-

sis implications. There may be no implications if you don’t include analytical lines (or 

aren’t using Revit Structure), but then you aren’t creating anything that helps an engineer 

using Revit Structure. But that might be OK if you really don’t have any training in struc-

tural design. Your family can be an excellent placeholder until something gets properly 

sized or designed.

Generic Models  ​This is a catchall category that has both a Cut and Projection line 

weight representation in views. If you need your component to provide both a Cut and 

Projection line weight, then Generic Models is your choice. If that isn’t desirable, then 

Specialty Equipment is a better choice because it does not have a Cut line weight.
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Specialty Equipment  This too is a catchall category that has only a Projection line 

weight representation in views. If you need your component to provide both a Cut and 

Projection line weight, then Generic Models is your choice. If that isn’t desirable, then 

Specialty Equipment is a better choice because it doesn’t have a Cut line weight.

Level behavior  Does your family need to be constrained from a level to one above? Does 

it matter if your family just sits on a level? There are some families that provide two 

levels in the template (columns and structural columns, for example), while most others 

provide just one. In some cases, you must start with one of these and change to a more 

appropriate category just to get the extra level to manage your family’s behavior. This can 

also be considered as part of the next topic.

Are Hosted Families/Face-Based Required?
To host or not to host, paraphrasing the Bard, that is the question. This choice can be a 

bit murky, but the only time a family must absolutely be hosted is when you expect the 

family to alter the host in some way. If your family needs to cut a hole in a wall, roof, 

fl oor, or ceiling, then it either must be hosted by a host family 

or must use the face-based family template, as shown 

in Figure 17.3.

The language is a bit confusing 

too. We are referring to host or 

hosted, but the templates don’t 

mention the word host, just 

based: wall based, fl oor based, ceiling 

based, and so on. The terms host and based are 

interchangeable. People are more likely to understand the 

term host rather than based. We wouldn’t disagree if you suggested 

that the templates ought to be named with the term hosted instead of based.

Except when you need to alter a host, you do not have to choose to have your family 

hosted. If the family has no actual relationship with a building other than with a specifi c 

host, then it makes some sense to make the family hosted by that host, like a wall. Many 

objects in a building might normally be part of a wall like a light switch, power recep-

tacle, or thermostat, but even these items have been found on other surfaces than walls. 

For example, cabinetry might have receptacles or switches mounted on them. Therefore, 

choosing to make a light switch family wall based might actually be a hindrance at some 

point in a project. A similar classic example is a ceiling fan. These are often mounted to 

ceilings, but at times you’ll fi nd them attached to the underside of fl oor structure above 

beams and other structural elements. Therefore, a ceiling-based ceiling fan will eventu-

ally be rather inconvenient, as shown in Figure 17.4.

Figure 17.3

Floor-based Slab 
Depression family

or must use the face-based family template, as shown 

The language is a bit confusing 

: wall based, fl oor based, ceiling 

 and based are based are based

interchangeable. People are more likely to understand the 

. We wouldn’t disagree if you suggested 

Figure 17.3

Floor-based Slab 
Depression family
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This is where the face-based template becomes useful. This family has a host element, 

but it isn’t a wall, floor, ceiling, or roof. It is a “host” that can pretend to be whatever 

surface you want to believe it to be. Revit is equally willing to believe that your family 

is as at home attached to the underside of a beam as to the top of a table. You can create 

nonhosted families, and if you really need them to be hosted later, just nest them into a 

hosted template. That is much easier to do than remaking the family to not require  

a host.

Choosing a Placement Technique
If you examine the templates that exist in the folders provided with Revit, you will find a 

couple templates that include the description “line based,” as shown in Figure 17.5. These 

are different from hosted or based families. This description applies to how you use them 

in the project, specifically, how you place them. Most families are single-pick families, 

meaning that you click once to place them, whether on a face or just on the level like a 

desk or a chair. The line-based template allows you to create a family that is placed with 

two picks, very much like clicking a wall or sketching a line. For example, you could cre-

ate a family that represents decorative rafter tails on the exterior facade of your building, 

as shown in Figure 17.6. Another example might be a sunscreen louver system. To place 

either of these, the user would only need to click the start and end points. These families 

are not the easiest to make if you are just getting started. If you are patient, gain some 

experience with some project-inspired ideas, which can be quite useful.

Figure 17.4

Face-based and 
ceiling-based  

ceiling fan
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Level of Detail
The phrase level of detail (LOD) is emerging in the broader context of design and build-

ing information modeling (BIM). Organizations attempting to specify BIM are wrestling 

with defining LOD. How much detail is required, and when is it required? Also impor-

tant is to decide when there is too much or inappropriate detail. In the context of a build-

ing project, it is certainly an important topic. It is equally relevant for each family you 

Figure 17.5

The available line-
based templates

Figure 17.6

Rafter tails created 
using a line-based 
family template
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create and use. It isn’t hard to imagine that families that are too detailed or complex will 

ultimately have an impact in the project context too.

As you have already learned, Revit uses the Detail Level feature to allow you to display 

three different LOD in your views. These are simply referred to as coarse, medium, and 

fine. Each family you use and create can take advantage of each setting by choosing to 

display only the relevant information at the corresponding detail level. As you add fea-

tures to a family, you can decide which view orientation is relevant.

A detailed column does not need to show all the detail at the base in a plan view, usu-

ally preferring to show only the overall extent of the base, as shown in Figure 17.7. An 

elevation view might benefit from the more elaborate appearance of the column, but  

even that might be excessive if the scale used in the view is fairly coarse like 1⁄8˝ = 1´-0˝ or 
1⁄16˝ = 1´-0˝ (1:100 or 1:200). It might be better to use a combination of view orientation 

selection and detail level.

Subcategories

Each Model family has at least one subcategory called Hidden Lines that is used in 

conjunction with the Show Hidden Lines and Remove Hidden Lines tools. Many fami-

lies have several subcategories; doors, for example, have the following subcategories: 

Elevation Swing, Frame/Mullion, Glass, Hidden Lines, Opening, Panel, and Plan Swing. 

These are intended to provide additional control over how doors are presented to you in 

various views. The door’s subcategories (refer to Figure 17.8) are what come with Revit, 

but you can choose to create additional subcategories for your own content if you need 

similar control over them too.

Figure 17.7

Plan view of column 
showing less detail 

than the actual  
column base has in 

a 3D view
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T Y pI N G m aT T E r S

You need to be careful when adding subcategories. If too many diff erent people do this, you 

can end up with chaos such as diff erent spelling and words attempting to describe the same 

thing.

Parametric vs. Nonparametric
There is a natural tendency when people begin using Revit to gravitate toward creating 

fewer but highly parametric and fl exible families that represent what would have been 

many more components in their earlier product libraries. We fi nd it interesting that after 

several years of using Revit, the same people who took this approach are now gravitating 

toward more individual and simpler families. So-called super families can be harder for 

a novice to use and understand. They see many possible settings and are easily confused 

about what they can or should change. We’ve seen families that require an hour “lunch-

and-learn” session to explain how to use them. Although the feature is cool, the very prac-

tical problem of helping regular users be effi cient is important, probably more important 

than having super families. The average user might just be more productive returning 

Figure 17.8

Door subcategories

T Y pI N G m aT T E r S

You need to be careful when adding subcategories. If too many diff erent people do this, you 

can end up with chaos such as diff erent spelling and words attempting to describe the same 

thing.
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to the library to get another kind of family than trying to figure out how to make some 

changes in the single super family instead. It is a balancing act, and each firm and team 

will have to assess their strengths and weaknesses to find that elusive equilibrium.

Believe it or not, there are perfectly good reasons to make families that are not para-

metric at all. One size, one configuration, and that’s all you want. In early design, the 

hurry to get your ideas on paper and in front of your client can demand that you model 

just the individual family you need without taking more time to make it flexible. You can 

always return to the family later if it survives the various design meetings you have with 

your client. There are also products that have only a couple configurations, and it is just as 

easy to make two families as one. In particular are items that are oriented in one way but 

not offered in a mirrored configuration. You are probably better off with separate families 

so these special configurations aren’t misrepresented. Again, you are seeking a balance 

between parametric, flexible, and reusable families and the fast, efficient use of your time.

Examining the Tool Chest
The Family Editor features fewer tools than the regular project environment, but they 

are no less useful or powerful. This section will describe how these features factor into 

the families you make. Before we get into them, there are several parts of the interface 

that get a bit more attention in Revit than others. Some of these are no different in either 

the project or the family. Two are not used outside the Family Editor. It won’t be hard to 

remember them after you make a couple families.

Family Categories And Parameters  ​This dialog box allows you to change the category 

assignment for your family. This way, you can start with a family template and change 

your mind to some degree. You cannot change the mass category or change from the 

mass category. You will find that not all categories are offered to you either. If a category 

is missing, you can’t change your family to that category.

Family Types  ​This dialog box is the primary interface between you and the parameters 

you define to control your family. Once you associate a parameter/label with a dimen-

sion, it is a good habit to change the parameter with this dialog box. When the parameter 

value is locked (as shown in Figure 17.9), you cannot simply select the constrained geom-

etry and alter the dimension value as you can in a project. You will very likely open this 

dialog box as often as you use the Properties Palette in a project.
Figure 17.9

The lock feature to 
prevent changing 

parameters directly 
“in canvas”
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Make a keyboard shortcut! You can define a keyboard shortcut to open this dialog box.

Options bar  ​This location is no less important in the Family Editor than a project. If you 

have trouble remembering where the Options bar is, you are probably still struggling 

with Revit in general. This spot is dynamic, and you have to remember to look there 

when you work.

Type Selector  ​With 2011, the Type Selector is now part of the Properties palette. If you’re 

familiar with previous versions of Revit, that will take a little getting used to. It is in the 

same place in the project environment. Just remember, it is a frequent place for your cur-

sor to visit.

Properties palette  ​Also new to 2011, you’ll visit this dialog box as much in the Family 

Editor as a project except now you don’t have to open it all the time because it is normally 

open already. Revit is built around this dialog box, and the Family Editor is no different.

Visibility/Graphics  ​This is used in both the family and project environments. It is less 

intrusive in the Family Editor, but you will need to use it from time to time to manage 

what you see—or don’t see, for that matter. The keyboard shortcut for this (VG) is prob-

ably one you’ll remember the easiest.

Reference Planes and Lines: The “Bones”
These provide the structure a family needs to provide consistent flexible behavior.

Reference Planes

A reference plane (as shown in Figure 17.10) defines a work surface, so to speak. Imagine 

a sheet of glass under your feet. Now imagine a sheet of glass in front of you extend-

ing from the sheet beneath you up toward the sky. Each of these sheets of glass can be 

thought of as a work plane. All objects in Revit are based on a work plane that either you 

deliberately choose or Revit chooses in the absence of a decision by you.
Figure 17.10

Reference plane in 
use in an elevation 
and 3D view
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You need consider how your family should adjust. Do you want it to flex from the 

middle? Would it be better to increase in size from the left side instead? You need to place 

the reference planes, name them, and constrain them to allow the family to grow the way 

you intend. Like any element in Revit, reference planes have properties too. We’ll take a 

few minutes to explain how these properties affect the role that reference planes play in 

your families.

Wall   Closure 

The Wall Closure setting is used along with settings in your walls to define how far the 

finish layers of a wall should turn and enter the opening created by doors and windows. 

If your design involves a detail that wraps the opening with the finish, such as brick, for 

example, then this feature will be helpful. Revit allows for two planes to use this setting, 

one for the exterior finish and the other for the interior finish.

N ame 

It is a good habit to provide a unique name. It must be unique! You cannot use the same 

name twice in a project or family. The name appears at the “head of the reference plane. 

It must be named if you want to select it to define a work plane at another time. The posi-

tive direction of a solid is determined by the location of the “head” of a reference plane 

(as shown in Figure 17.11). The positive direction is to the right of the head for reference 

planes created by Autodesk in the Revit templates and any that are copies of them. For 

those that you sketch yourself, the positive direction is to the left of the head.

S cope  B ox

The Scope Box setting is irrelevant in the Family Editor and families. It is a project-only 

feature and plays no role in families.

Figure 17.11

Depicting the orien-
tation of reference 

planes and positive/
negative values for 

geometry depth
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I s  R eference    

The Is Reference value sets the priority that Revit will use in the project when you use the 

Dimension or Align tool with your family. Let’s say you have a door in a wall (as shown 

in Figure 17.12), and you’ve decided to make 

sure the door is 4´- 0˝ from the nearest wall. 

You need to add a dimension and lock it too.

When you decide to use a different door, 

Revit seems to know how to switch the doors 

yet maintain the same position, as shown in 

Figure 17.13. If you don’t add a specific locked 

dimension defining how this door should 

be positioned, Revit will assume the Center 

(Left/Right) reference plane will take precedence. The doors will be swapped, aligned 

with their common centerline.

Most stock content uses the Is Reference setting. The default setting for a new refer-

ence plane is the Weak reference option. 

Figure 17.14 shows the properties for the 

reference plane named Right in the imperial 

door family template. Providing a name for 

each reference plane will help you and others 

remember why it was created. Adding a name 

will also let you choose the reference plane 

from a list when you need to assign a differ-

ent work plane to a view when you are creat-

ing solids or voids. This is true for the project environment too.

In Figure 17.14, notice there is no name value assigned. Each 

reference plane can be Strong or Weak. You can choose Strong, 

Weak, Not A Reference, and specific names such as Right, Top, 

or Bottom. A strong reference has the highest priority for dimen-

sioning or snapping. A weak reference means you may need to 

use the Tab key feature in order to use it for your dimension. 

Zooming in and out also affects how Revit will see reference 

planes. Just remember that a strong reference gets Revit’s attention first when there are 

other lesser reference planes present.

By choosing one of the predefined names, you are establishing two things: a strong 

reference and a common reference plane for Revit to use when you want to switch fami-

lies. If you don’t want a reference plane to take on such a role, choose the Not A Reference 

option instead. If you want your reference plane to be unnamed and play a lesser role 

than other strong reference planes, choose Weak Reference.

Figure 17.12

You can manage a 
door’s location with 
a dimension and the 
Is Reference setting.

Figure 17.13

Exchanging a single 
door for a double, 
but the side posi-
tion is maintained.

Figure 17.14

Door family  
reference plane 
properties
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Revit can display grips (blue triangles) for parts of your family so you can stretch 

them manually within a project. This is true for parameters that are defined as instance 

parameters. When you make a reference plane and assign a strong or weak reference or 

other predefined named option (see the following list), Revit will display these grips (as 

shown in Figure 17.15). If you don’t see them, you just need to make sure that the refer-

ence plane is strong or weak and the dimension is associated with an instance parameter. 

When you assign a reference plane to “not a reference,” the grips will not be available.

Here’s a list of the predefined names you can use (no, you can’t add your own, sorry!):

Not a Reference•	

Strong Reference•	

Weak Reference•	

Left•	

Center (Left/Right)•	

Right•	

Front•	

Center (Front/Back)•	

Back•	

Bottom•	

Center (Elevation)•	

Top•	

D efines     O rigin   

Two reference planes that are not parallel in plan views can be used to define the origin of 

a family. One reference plane at an elevation can define a vertical (Z) origin.

There is a coordinate origin in a family as well. Be careful to avoid moving your origin, as 

defined by reference planes, from the actual coordinate origin in the family. Although Revit 

will let you see the project origin, it isn’t possible to see the coordinate origin of a family 

yet. You can find it if you import a DWG file that contains a line that starts at the origin. Just 

import the file using the positioning option: Auto – Origin to Origin. You can use this tech-

nique to ensure that content is at the real origin. Remember to remove the imported file 

when you are finished with it, though.

Figure 17.15

Grips appear in fam-
ilies using instance 

parameters and 
strong or weak Is 

Reference settings.
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Reference Lines

These were created specifi cally to resolve the angular constraints you need in families. 

Reference planes do not respect the spring point (intersection) of an angular relationship 

between them. This is because they don’t really have an endpoint; they have just a graphi-

cal control that lets you manage how much of the reference plane you see. Reference lines 

have actual endpoints and defi ne four work planes. You can see them in Figure 17.16. 

There is one vertical plane parallel to the line, one plane perpendicular to the line, and 

one perpendicular to each endpoint.

This makes it possible to create dependant relationships between the work planes 

of several reference lines. When these were fi rst introduced, one of Revit’s original 

designers, David Conant, demonstrated (at Autodesk University 2004) the 

concept using an articulated task lamp as inspiration, as shown in 

Figure 17.17. There are few examples of families using them in the stock 

library for Revit Architecture. In contrast, however, practically all the 

pipe and duct fi tting content for Revit MEP uses them extensively. They 

are also increasingly important in the new conceptual design environ-

ment (massing).

Defining Rules: The “Muscle”
You add dimensions in a project to provide important information to the person 

using your documents. When you create a family, the dimensions you add are there 

only to explain what your requirements are to Revit. The only time anyone will ever 

see them is when they choose to edit the family itself. Providing a properly dimen-

sioned drawing isn’t the intention. Rather, it is necessary to defi ne how 

the family should behave and what you want Revit to do. Dimensions 

can be constrained by using a lock (padlock icon), by using equality 

(EQ icon), and by assigning a parameter using a label. It is also pos-

sible to use the lock constraint when you use the Align tool. The lock 

and equality constraints work the same way they do in the project 

environment.

Locks

The use of the padlocks that appear next to the dimension values when a dimension 

string is selected can lock the dimension value so that Revit will maintain that value 

while others are permitted to change, as shown in Figure 17.18.

The padlock (as shown in Figure 17.19) also appears when using the Align command.

Figure 17.16

A reference line has 
four work planes 
you can use.

There is one vertical plane parallel to the line, one plane perpendicular to the line, and 

This makes it possible to create dependant relationships between the work planes 

of several reference lines. When these were fi rst introduced, one of Revit’s original 

Figure 17.17

Reference planes 
applied to articu-
lated task lamp

You add dimensions in a project to provide important information to the person 

using your documents. When you create a family, the dimensions you add are there 

only to explain what your requirements are to Revit. The only time anyone will ever 

see them is when they choose to edit the family itself. Providing a properly dimen-
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Judicious use of locking will ensure that you don’t over-constrain your project so you 

can avoid causing poor computer performance. In families, however, it is very important 

to avoid ambiguity, and therefore it is important to use constraints like these to explicitly 

tell Revit what to do.

Equality

This concept is a feature of dimensions that permit you to ensure referenced elements 

stay equally spaced relative to each other. There is a difference between equality as a con-

straint and the existence of equality as “EQ” on a dimension string. The icon shown in 

Figure 17.20 is the constraint. Figure 17.21 

shows the right-click option to display the 

text EQ instead of a dimension value. If you’d 

rather see the dimension value, just use the 

right-click option to turn off EQ display. Just 

don’t use the visible icon to do it. If you do, 

you will remove the constraint to be equal.

You should pay special attention 

to the anchor symbol (as shown in 

Figure 17.22) that will appear when 

a member of equality constrained 

elements are selected. This anchor 

will determine how the constraint 

is applied and therefore how the 

elements will stretch or flex.

This anchor can be dragged to the 

middle element so the three elements 

will flex equally from the middle. As 

pictured in Figure 17.22, these three 

reference planes will flex from the left 

side toward the right.

Figure 17.18

The padlocks appear when you select the 
dimension string.

Figure 17.19

The padlock icon appears while using the 
Align tool.

Figure 17.20

The equality con-
straint icon appears 

when you select a 
dimension string 

that references three 
or more elements.

Figure 17.21

You can display EQ 
or the actual dimen-

sion value.

Figure 17.22

The anchor symbol 
appears to help 
define how the 

equality constraint 
should flex the ref-

erence planes.
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Parameters

Parameters (also called labels when they are applied to dimensions) are the underly-

ing information of all objects. They are how you communicate with Revit. They are the 

height of a wall, the width of a door, the thickness of a counter, the material of a floor, the 

elevation of a level, and the scale of a view. Every piece of information you might want to 

supply, change, schedule, calculate, or study is a parameter.

These are the rules that you define and permit your users to alter once they are loaded 

into their projects. The other constraints we’ve described are locked behaviors that a user 

cannot alter when they use them in the project. The only way to change them is to edit 

the family and reload it. Labels and parameters provide your users with the flexibility 

they are used to with Revit.

T ype  and   I nstance     Parameters       

This should be a familiar concept by now, but just to be thorough, let’s discuss this con-

cept again briefly. All parameters in Revit apply to either the kind or “type” of object you 

are working with or the individual “instance” of the object. A wall style whose type is 8˝ 

(200 mm) Masonry has type parameters that affect every individual instance of the wall, 

while its instance parameters affect only a single wall instance. The thickness of the wall is 

a type parameter. Every instance of the wall will be the same thickness. The height of the 

wall is an instance parameter, so each wall can have a different height if necessary.

Parameters       

Parameters are broken down into these three roles: project, family, and shared. Either 

they are created in advance for you (system) by Autodesk or you create them yourself 

(user) as needed.

Project (encountered in a project environment)

System (type or instance)•	

User-defined (type or instance)•	

Family (encountered in a project or Family Editor environment)

System (type or instance)•	

User-defined (type or instance)•	

Shared (encountered in a project or Family Editor environment)

Project (type or instance)•	

Family (type or instance)•	

Shared parameters combine the nature of system and user-defined parameters. Shared 

parameters exist to allow you to tell Revit you are talking about the same information 
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whether it originates in a family or a project. They can be used to create a parameter in 

both a family and/or a project to allow the information assigned to them to be displayed 

in a schedule and/or tags.

Keep in mind that when you create a parameter from a shared parameter, there is no 

active link to the file they come from. Think of the shared parameter file as a diction-

ary that Revit uses to look up definitions of parameters. This definition is stored in your 

project and families afterward. When Revit encounters a parameter in a family within a 

project that also uses the parameter, it automatically knows they are using the same defi-

nition. This allows you to schedule and tag objects.

Parameters exist either because Revit made them for you (system) to use in advance 

or because you chose to make them yourself (user). You can’t change or alter a system 

parameter’s character or how it will work except to provide a different value for it. Every 

element in Revit has some system parameters. Here are some system parameter examples 

(with parameter names in quotes):

Wall “Top And Bottom Constraint”•	

Wall “Location Line”•	

Floor Object Layer “Thickness”•	

Casework “Manufacturer”•	

Window “Width”•	

Project “Name”•	

Project “Client Name”•	

View “View Scale”•	

You can create parameters yourself to control a family and to store information. It is 

important to appreciate that user-defined parameters that are created in a project can 

appear in that project’s schedules but not in tags. Those user-defined parameters created 

in a family cannot be used in schedules or tags unless they are created using a shared 

parameter definition. These are some user parameter examples (again with parameter 

names in quotes):

Room “Occupancy Classification”•	

Project “Issued Date”•	

Project “Issued Description”•	

Door “Undercut”•	

Door “Jamb Detail Type”•	

Window “Glazing Area”•	
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CO N S I S T E N C Y

Parameters in Revit’s system and component families as well as project parameters all use 

Title Case, meaning every word gets a capitalized fi rst letter. Some users prefer to use all 

uppercase for their parameters because that makes them look diff erent and therefore makes 

it more obvious which parameters belong to them. Still others prefer to use all lowercase for 

much the same reason and perhaps because they have some aversion to the Shift key. What-

ever you decide, please be consistent!

To create a parameter called Width, follow these steps:

 1. Create a new family using the Generic Model.rft family template.

 2. Click Family Types on the Home tab.

 3. Click Add in the Parameters frame.

 4. Supply the following information:

Name: Width•	

Discipline: Common (Architecture uses Common)•	

Type of Parameter: Length (default setting)•	

Group Parameter Under: Dimensions (default setting)•	

Type/Instance: Type•	

 5. Click OK when you’re finished. You now have a parameter listed under the dimen-

sion group.

The Reporting Parameter feature is available when you choose Instance instead of Type. This 

new feature, as of the 2011 release, provides access to information that wasn’t available to 

you in the past. For example, with a door family, you can use this feature to determine how 

thick the hosting wall is. With this knowledge, the family can then respond to alter the size of 

the frame accordingly as the hosting wall thickness changes or the door is placed in a variety 

of wall types. You wouldn’t put this feature in beginner territory, but seasoned family editors 

are quite happy with this development.

Dimensions

Every dimension you add to a family is effectively a rule. If the rule isn’t necessary, then 

the dimension isn’t needed. Adding another dimension just because it is good drafting 

practice will, more often than not, end up generating an error message telling you that 

doing so will over-constrain the family.

CO N S I S T E N C Y

Parameters in Revit’s system and component families as well as project parameters all use 

Title Case, meaning every word gets a capitalized fi rst letter. Some users prefer to use all 

uppercase for their parameters because that makes them look diff erent and therefore makes 

it more obvious which parameters belong to them. Still others prefer to use all lowercase for 

much the same reason and perhaps because they have some aversion to the Shift key. What-

ever you decide, please be consistent!
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It is important to realize that Revit is focused on the orthogonal relationship between 

elements when you attempt to constrain them with dimensions. When you want to define 

angular relationships, you need to make sure that those dimensions are really referenc-

ing the elements you intend them to reference. This means paying close attention to the 

information provided in tool tips and on the status bar to ensure the correct elements are 

referenced. If you aren’t careful, you will get strange results as you flex and test a family.

Automatic      S k etch  D imensions       

In addition to temporary and permanent dimensions, Revit has automatic sketch dimen-

sions. It creates them behind the scenes to locate everything you make in Revit. These are 

the glue or magic of the Revit Family Editor. If you don’t realize they exist or don’t under-

stand them, you’ll have a little harder time getting comfortable. They won’t be called 

into action until your family has at least one parameter label assigned to a dimension or 

the family uses an equality constraint. If those are present, when you add a line, solid, 

or void, they will start to appear. For solids and voids, they appear during sketch mode. 

Revit starts using them but you still won’t see them because the family templates all have 

them turned off. If you are diligent, they don’t need to be visible and they can clutter a 

view unnecessarily. It’s just important to understand that they exist and that you can 

verify they are helping you make your family.

To see sketch dimensions come to life, take the following steps:

	 1.	 Start a new family using the Generic Model.rft family template.

	 2.	 Add a new reference plane to the right of the existing Center (Left/Right) reference 

plane.

	 3.	 Add a dimension between the vertical reference planes.

	 4.	 Create a parameter called Width (this was outlined in the previous section).

	 5.	 Select the dimension string.

	 6.	 Click the Label: <none> field on the Options bar.

	 7.	 Choose the Width parameter from the list. This assigns it to the dimension.

	 8.	 Using Visibility/Graphics, turn on the Automatic Sketch Dimensions. They are on 

the Annotation Categories tab.

	 9.	 Sketch a model line somewhere between the reference planes. The dimensions that 

appear are the automatic sketch dimensions.

What are Automatic Sketch Dimensions doing? Revit uses them to infer your intent 

once you start using parameters and labeled dimensions or the equality constraint. If Revit 

does well, you get automatic obedience from your family with a minimum of effort. When 

it doesn’t, you get less predictable behavior. It is important to tell Revit what you want 

when this happens. Reviewing these automatic sketch dimensions can help you decide 

what other constraints or parameters you really need to add to eliminate any confusion.
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If you want to create an angular relationship between elements, consider using reference 

lines. You should also avoid drawing your lines directly on a reference plane. The automatic 

sketch dimensions may assume a relationship with the reference plane incorrectly. It is more 

reliable or predictable to sketch lines, those that are intended to be changed with labeled 

angular dimensions, away from reference planes entirely. Sketch them at an angle first, and 

constrain them at the angle second.

Creating What You See: The “Skin”
Assuming you’ve created “bones” (reference planes) and added some “muscle” (dimen-

sions and parameters) to your family, you are now ready to deal with adding what every-

one will see, the “skin” of your family. It isn’t absolutely required to build a family in this 

order (bones, then muscle, then skin). If you do it consistently, though, you should find 

that your families work correctly the first time, more often than if you don’t.

Geometry

The basic building blocks of a Revit family are solids and voids. They can be created 

using four distinct processes: extrusion, blend, revolve, and sweep. There are also a few 

different kinds of lines that can be used to convey the proper amount of information in 

each view.

Extrusion  ​A solid or void extrusion is a three-dimensional object that is described by 

first sketching a profile with lines forming a closed boundary and followed by provid-

ing a depth. A familiar example of an extrusion is a mullion for a curtain wall. They are 

extrusions made of aluminum, typically. They have a profile and are “extruded” to a 

depth/length. A solid extrusion is used to represent columns, the seat of a chair, or a door 

panel—virtually anything you need to make can be described with a solid extrusion in 

some fashion. A void extrusion is created exactly the same way except that a void is per-

mitted to cut a solid. A void can also explicitly cut one solid while not cutting another 

according to your demands. A family cannot exist as a void only. There must be some 

geometry that it can present in a project.

Blend  ​A blend solid or void is exactly the same concept as an extrusion except that you 

have two profiles, base and top. These profiles can be different shapes and sizes. They can 

be placed in different positions relative to each other. In this way, a leaning column or 

tapering table leg can be fashioned. Stacking tapering or twisting blends can create forms 

that you are beginning to see in more and more building forms.

Revolve  ​A solid or void revolve is also created using a profile, but instead of providing a 

depth, you provide a value for rotation around an axis that you must also sketch or pick. 

The combination of a profile and axis defines the shape and where that shape should 
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“spin” around the axis. Imagine a wine glass or a corner molding detail. A revolve also 

requires a work plane, for the axis, which should be created first.

Sweep  ​A solid or void sweep uses a profile, but instead of using an axis like a revolve, it 

needs a path to follow. Crown molding is a nice example of a sweep in action. You can 

sketch a path or pick the edges of other elements to describe a path and then either sketch 

a profile or use a separate profile family created at another time.

Swept Blend  ​As the name suggests, this form combines the features of the sweep with the 

blend. It uses a single segment path with a profile at each end. The resulting form changes 

from each profile as it is created along the path.

Lines

Several kinds of lines are available in the Family Editor. They each play an important role 

when creating your family.

Symbolic  ​These are similar in purpose and behavior as detail lines in a project. In the 

Family Editor, however, they are called symbolic because they are intended to provide 

a simpler graphical (symbolic) representation of a family that might be too complex to 

justify displaying the three-dimensional geometry at various scales. A highly detailed 

column base might print as muddy line work at coarse scales. If symbolic lines are used 

for this base instead, they can provide a simpler profile or plan representation and save 

the fullness of the 3D form for finer scales.

Symbolic lines appear only in views that are parallel to the view they are created in. A sym-

bolic line sketched in a Left elevation will also appear in the Right elevation. The same is 

true for Front and Back elevations. Carefully using the detail levels Coarse, Medium, and 

Fine and assigning these symbolic lines to them appropriately are key parts of making qual-

ity families. Symbolic line styles are provided for each object style that exists in the family 

template and for any that are added to the family. If a family is “cuttable” in the project 

environment, there are both Projection and Cut line styles to choose from.

Model  ​Model lines are equivalent to model lines in the project environment. A model 

line exists for each category and subcategory of the family you are using as well as a cut 

and projection version, assuming the family can be cut.

Lines  ​When you are creating a detail component, a profile, a tag, a title block, or any 

2D-only element, there is only one Line tool. This is because these are 2D elements, and 

there is no need to differentiate between Model and Symbolic, so they are just called Lines. 

It’s confusing a bit perhaps, but ideally it makes sense.

Analytical (RS)  ​These are a special feature reserved for structural component families. 

These are used to describe the path that loads take through a structural component. It 

is important to properly place these in order for third-party analysis tools to correctly 

evaluate them.
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You can use the Convert Lines tool if you decide that you should have used symbolic lines 

instead of model lines, or vice versa.

Family Visibility Controls
Just as important as creating the things you see is having some control over how or when 

they are displayed. Chapter 5, “Visibility Controls,” dealt with the wide range of control 

that Revit offers you while you’re working on a project. These items apply to families and 

set the stage for them to be used later in the project. Lines, solids, text (in annotation 

families), and labels all offer visibility control features.

Visible parameter  ​This parameter (as shown in Figure 17.23) 

has a check box and can also be connected to a Yes/No param-

eter (more about this part later). If you deselect the parameter, 

that element will not be visible in the project environment no 

matter what your user does to the family, short of editing and 

changing the family itself. This allows you to create line work 

or other geometry that might drive design intent but should not be visible itself. For 

example, this can be useful to define a clearance or conflict solid element that can be 

detected with Revit’s Interference Detection tool—detected but not seen.

Visibility  ​Each element has Visibility Graphics override options as well. You can find 

them within the Properties palette or simply by clicking the Visibility Settings button on 

the ribbon when the element is selected. 

Figure 17.24 shows the options you have 

within this dialog box.

Simply deselecting an option will prevent 

the element from being visible according 

to each condition. When combined with 

the model and symbolic lines, you have 

a great deal of control over the graphic 

display of your content.

Creating Forms (Solids/Voids)
As mentioned earlier, solids and voids are the visible part of your family; they’re the 

“skin” that everyone will see. These solid form tools are Extrusion, Blend, Revolve, 

Sweep, and Swept Blend as well as the void versions of them. They are found on the 

Home tab’s Forms panel, as shown in Figure 17.25. 

While editing, you use a variety of tools on the rib-

bon. To finish, you click the large green check mark, 

formally called Finish Edit Mode.

Figure 17.23

The Visible  
parameter

Figure 17.24

The Visibility Set-
tings dialog box

Figure 17.25

The Forms and 
Mode panels critical 
for creating forms

“spin” around the axis. Imagine a wine glass or a corner molding detail. A revolve also 

requires a work plane, for the axis, which should be created first.

Sweep  ​A solid or void sweep uses a profile, but instead of using an axis like a revolve, it 

needs a path to follow. Crown molding is a nice example of a sweep in action. You can 

sketch a path or pick the edges of other elements to describe a path and then either sketch 

a profile or use a separate profile family created at another time.

Swept Blend  ​As the name suggests, this form combines the features of the sweep with the 

blend. It uses a single segment path with a profile at each end. The resulting form changes 

from each profile as it is created along the path.

Lines

Several kinds of lines are available in the Family Editor. They each play an important role 

when creating your family.

Symbolic  ​These are similar in purpose and behavior as detail lines in a project. In the 

Family Editor, however, they are called symbolic because they are intended to provide 

a simpler graphical (symbolic) representation of a family that might be too complex to 

justify displaying the three-dimensional geometry at various scales. A highly detailed 

column base might print as muddy line work at coarse scales. If symbolic lines are used 

for this base instead, they can provide a simpler profile or plan representation and save 

the fullness of the 3D form for finer scales.

Symbolic lines appear only in views that are parallel to the view they are created in. A sym-

bolic line sketched in a Left elevation will also appear in the Right elevation. The same is 

true for Front and Back elevations. Carefully using the detail levels Coarse, Medium, and 

Fine and assigning these symbolic lines to them appropriately are key parts of making qual-

ity families. Symbolic line styles are provided for each object style that exists in the family 

template and for any that are added to the family. If a family is “cuttable” in the project 

environment, there are both Projection and Cut line styles to choose from.

Model  ​Model lines are equivalent to model lines in the project environment. A model 

line exists for each category and subcategory of the family you are using as well as a cut 

and projection version, assuming the family can be cut.

Lines  ​When you are creating a detail component, a profile, a tag, a title block, or any 

2D-only element, there is only one Line tool. This is because these are 2D elements, and 

there is no need to differentiate between Model and Symbolic, so they are just called Lines. 

It’s confusing a bit perhaps, but ideally it makes sense.

Analytical (RS)  ​These are a special feature reserved for structural component families. 

These are used to describe the path that loads take through a structural component. It 

is important to properly place these in order for third-party analysis tools to correctly 

evaluate them.
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Solid Extrusion

A solid extrusion uses a single sketched profile and a depth. To create a solid extrusion, 

follow these steps:

	 1.	 Choose the Home tab’s Forms panel, and click Extrusion.

	 2.	 Sketch a rectangle (or other shape) to define your sketch.

	 3.	 Click Finish Edit Mode to complete the extrusion.

Notice the Depth parameter on the Options bar prior to sketching; however, it is not active 

when you start sketching until you stop sketching. You can assign the depth via the Prop-

erties palette. You can disregard these options and simply associate the extrusion with 

a reference plane in an elevation view instead, dragging the visible grip of the solid until 

the reference plane is highlighted, releasing the grip, and then using the padlock icon that 

appears.

	 4.	 Open View Elevations: Front to assign the top of the extrusion to a reference plane 

(the finished result should look like Figure 17.26).

Blend

A solid blend consists of two sketches: a base, and top sketch. This is easy when you think 

in terms of plan orientation, but it’s less obvious when you are sketching in an elevation 

orientation. Regardless, just consider that a blend needs two sketches whether you think 

of them as base/top or front/back. Once the two sketches are defined, you need only to 

define the depth of the blend or, in other words, the offset between each sketched profile. 

To create a solid blend, follow these steps:

	 1.	 Click the Home tab’s Forms panel, and select Blend.

You are sketching the base profile at this time. The presence of the Edit Top button on the 

ribbon indicates this. You can’t draw the top first because you can’t switch to this mode until 

there is a valid sketch for the base.

	 2.	 Sketch a profile for the base.

	 3.	 Click Edit Top on the Mode panel.

	 4.	 Sketch a profile for the top.

	 5.	 Click Finish Edit Mode to complete the blend.

	 6.	 Open the view Elevations: Front to assign the top of the blend to a reference plane 

that should be created for it in advance. (The finished result should look something 

like Figure 17.27.)

Figure 17.26

The finished solid 
extrusion

Figure 17.27

The finished  
solid blend
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Revolve

A revolve requires three things: a work plane, axis line, and boundary line (profile). The 

work plane is needed to define the orientation of the form. The axis line defines where the 

profile will “spin” or revolve. The boundary line defines the shape you want to “spin” or 

revolve. To create a solid revolve, follow these steps:

	 1.	 Choose the Home tab’s Forms panel, and select Revolve.

	 2.	 Open the Elevations: Front view, and choose Set from the 

Work Plane panel to confirm the work plane is Center 

(Front/Back).

	 3.	 Use the AXIS Line tool from the Draw panel to sketch the 

axis on top of the Reference Plane Center (Left/Right).

	 4.	 Choose the Boundary Line tool to sketch half of the pro-

file (as shown in Figure 17.28).

	 5.	 Click Finish Edit Mode when you are done.

	 6.	 Select the revolve.

	 7.	 Change the Start and End Angle parameters (in the Properties palette). Notice  

the effect they have on the revolve form (the finished result should resemble  

Figure 17.29).

Your sketch must not cross beyond the axis; the sketch must be completely on one side of 

the axis. A sketch will produce a hollow revolve if it represents the “skin” of your shape. It will 

produce a solid if it just represents the outside profile or shape.

Sweep

A sweep is comprised of a path and a profile. You start with a path that you define by 

sketching lines or by picking the edges of other elements present in the family. You must 

finish the path and then start to create the profile. It can be defined by sketching with 

lines too, or you can choose to use an external profile family. The advantage of using an 

external family is that you can reuse them easily. It is more efficient since you can make 

the profile once and use it many times. To create a solid sweep, follow these steps:

	 1.	 Click the Home tab’s Forms panel, and select Sweep.

	 2.	 Click Sketch Path on the Sweep panel.

	 3.	 Open the Floor Plans: Ref. Level view, and sketch a rectangle.

Notice the origin of your path. This can be relocated to another segment or the begin-

ning/end of any segment. It is a good idea to place the origin on a straight segment that 

Figure 17.28

A profile to consider 
for your sketch

Figure 17.29

The finished solid 
revolve



440  ■   Chapter 17: Creating Families

is perpendicular to a view to make it easier to sketch a profile. You cannot change the 

origin after a profile is sketched, so make sure to set it correctly now.

	 4.	 Click Finish Edit Mode.

	 5.	 Click Edit Profile. When prompted to do so, select 

one of the elevation views offered to you. The views 

that are offered are parallel to the origin of your 

path, which is the small blue line with a red dot 

perpendicular to one segment of your path. If you 

sketch something like this profile, you’ll end up with 

what is shown here.

	 6.	 Click Finish Edit Mode when you are satisfied with 

your sketch path.

	 7.	 Open the Elevations: Front view.

	 8.	 Click Select Profile on the Sweep panel, and then click Edit Profile.

	 9.	 Sketch something like the profile shown in step 5.

	10.	 Click Finish Edit Mode when you are satisfied with your profile sketch.

	11.	 Click Finish Edit Mode to finish the sweep completely, as shown in Figure 17.30.
Figure 17.30

The finished  
solid sweep
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Swept Blend

This form requires a path just like the sweep, and it uses two profi les just like the blend; 

that’s why it’s called a swept blend. It is limited to one segment for the path, but it does 

allow the use of the Spline tool. The spline isn’t the best thing for documenting a design, 

but it does permit creating interesting forms. If you need a swept blend that has more 

than one path segment, you need to piece them together with multiple swept blend forms.

Follow these steps to create a modest swept blend:

 1. Click the Home tab’s Forms panel, and click Swept Blend.

 2. Open the Floor Plans: Ref. Level view, and click Sketch Path from the Swept 

Blend panel.

 3. Sketch an arc using the Start-End-Radius Arc tool.

 4. Click Finish Edit Mode; this completes the path.

 5. Click Select Profile 1 (the first pick point of your path).

 6. Click Edit Profile – Select 3D View: View 1 from the list; 

orient the view so you can see the work plane well.

 7. Sketch a small rectangular shape at the origin.

 8. Click Finish Edit Mode; this completes the first profile.

 9. Click Select Profile 2 (the second pick point of your path).

 10. Click Edit Profile; orient the view so you can see the work 

plane well.

 11. Sketch a larger rectangular shape at the origin.

 12. Click Finish Edit Mode; this completes the second profile

 13. Click Finish Edit Mode; this completes the swept blend 

(your result should look something like Figure 17.31).

Voids

Creating voids is exactly the same process as for solids. The difference is 

that voids can cut solid geometry. They will cut solids automatically if the solid(s) they 

intersect are already present. If a void is created fi rst, they will not cut a solid created 

afterward. If a void does not intersect a solid when its sketch is fi nished, it will not cut 

a solid when its shape or position are altered to cause it to intersect with a solid later. 

To resolve the relationships between solids and voids, Revit has the Cut Geometry and 

Uncut Geometry tools.

To experiment with a void extrusion, follow these steps:

 1. Click the Home tab’s Forms panel, and click Extrusion (the solid form first so you 

have something to cut).

Figure 17.31

The finished swept 
blend form

Creating voids is exactly the same process as for solids. The difference is 

that voids can cut solid geometry. They will cut solids automatically if the solid(s) they 

intersect are already present. If a void is created fi rst, they will not cut a solid created 
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	 2.	 Open the Floor Plans: Ref. Level view, and sketch a simple rectangular profile.

	 3.	 Click Finish Edit Mode.

	 4.	 Choose the Home tab’s Forms panel, and click Void Forms ➔ Void Extrusion.

	 5.	 Sketch a smaller rectangular profile that overlaps the solid form at one corner.

	 6.	 Click Finish Edit Mode – Open 3D View: View 1. Notice this void cuts the solid 

immediately. If you place your mouse pointer near the edge where the void cuts the 

solid, you should see that the void is still there.

	 7.	 Select the void.

	 8.	 Click Edit Extrusion on the Mode panel, and change the sketch a little (you can also 

drag the grips that appear at the edges of the void).

	 9.	 Click Finish Edit Mode to see the result.

When sketching voids, be careful not to place your sketch directly on the edge of a solid that 

is getting cut. If the finished sketch will result in a tiny sliver of geometry left on the solid, 

Revit may generate an error. It is better to extend a void beyond the edges of the solid it will 

cut. The portion of the sketch that passes through the solid is the “knife” edge. The other 

edges are extraneous. It might help to imagine a void to be the cutting blades of a router bit 

that is cutting the edge of a wooden plank. One side of the bit cuts the plank, while the other 

side spins harmlessly in space away from the edge of the wood.

To experiment with a void that does not cut immediately, follow these steps:

	 1.	 Click the Home tab’s Forms panel, and click Extrusion (the solid form first so you 

have something to cut).

	 2.	 Open the Floor Plans: Ref. Level view, and sketch a simple rectangular profile.

	 3.	 Click Finish Edit Mode.

	 4.	 Click the Home tab’s Forms panel, and select Void Forms ➔ Void Extrusion.

	 5.	 Sketch a smaller rectangular profile above the solid extrusion so that it won’t inter-

sect its volume.

	 6.	 Click Finish Edit Mode when done.

	 7.	 Select the void, and click and drag a grip control until it is far enough to intersect the 

existing solid. Notice this void does not cut the solids. Let’s pause to discuss the con-

cept of joining and cutting geometry.

A solid can be changed into a void, and a void can be changed into a solid via the Solid/

Void Parameter for the Solid/Void. When Join Geometry is used between solids, you can no 

longer change a solid to a void unless you use the Unjoin Geometry tool. A void cannot be 

changed into a solid if it is cutting a solid. Within the conceptual massing Family Editor envi-

ronment, Revit now also allows one solid to cut another solid.
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Joining and Cutting Geometry

Similar to their role in projects for walls and other elements, in the Family Editor Join 

Geometry, Unjoin Geometry, Cut Geometry, and Uncut Geometry permit you to define 

the relationship between intersecting solids and voids. With solids, Revit does not 

automatically create a line representing an intersection between them. You must use 

Join Geometry to tell Revit which solids should have this condition. Unjoin Geometry 

removes this relationship between solids.

Revit doesn’t join geometry automatically in an attempt to reduce the computational effort 

required when solids intersect. By using the tool, you are explicitly telling Revit which rela-

tionships matter more to you. Consider that if it isn’t discernable in most of the views of a 

project, it may not be important to join solids at all.

The Cut Geometry and Uncut Geometry tools are similar to the Join tools except they 

apply to the way that solids and voids interact. A void can cut one solid and not another 

intentionally. It isn’t obvious, but a void will remember that it is supposed to cut a solid 

that it doesn’t actually come into contact with. This means that you can use dimen-

sions and parameters to push and pull a void to cut or not cut a solid. Imagine a confer-

ence table that has a data port that can be lifted above the surface for access. You could 

model this in such a way that the void that cuts the tabletop intersects the table only 

when the data port is above the table. When the data port is beneath the surface, there 

is no hole indicated because the void no longer cuts the table top. There are many clever 

possibilities.

Continuing from the previous exercise, you can follow these steps to formally cut the 

geometry of the solid:

	 1.	 Click Geometry panel, and click Cut ➔ Cut Geometry (Modify ribbon).

	 2.	 Select the void.

	 3.	 Select the solid. Notice that the void now cuts the solid.

	 4.	 Select the void, and drag it entirely away from the solid so that it no longer intersects 

the solid. Notice that the solid is no longer cut.

	 5.	 Select the void, and drag it back into place. Notice that the solid is cut once again, as 

shown in Figure 17.32. Figure 17.32

Void cutting, not 
cutting, and then 
cutting again as 
the location of 
the void’s edge is 
changed
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Voids can be hard to select after they are cutting solids. Just select one of the solids, and 

the voids will appear. Now you can see the void more easily. Select the void you want to 

work with.

Assigning Materials to Families
There are two approaches to material assignment you can take when designing a family: 

defined internally (family) and defined in projects. It comes down to whether you want 

to define specific materials now or let the user decide later in the context of a project. 

For manufacturer-specific content, it may be important to preset materials to just those 

that are actually available. For all others, it is more efficient to make it easy for users to 

define the material in the project. It’s more efficient because you don’t waste time creating 

materials in the family that might very well not be used. Multiply this by the number of 

similar families you might need, and this can get quite time-consuming to keep all your 

content materially in sync.

By Category  ​If you assign forms to categories, you can avoid assigning a material in your 

family at all. The project you use the family in will determine how your family looks and 

renders automatically according to its category settings in Object Styles or Visibility/

Graphics.

Subcategories  ​The same is true for subcategories. If you take the time to map out a strat-

egy for subcategories, you can avoid assigning or creating material libraries for your fam-

ilies. This way, a project determines what your family looks and renders like as soon as 

you assign materials to the categories and subcategories you’ve defined. If your templates 

are already set up for this, it is even easier for your users to get to work.

By Parameters  ​Using parameters and assigning them to each solid element that needs a 

material assignment is probably the most versatile approach. You create a parameter and 

simply connect it to the solid. The family is loaded into a project, and its materials are 

defined in the project by editing the properties of the family. No time is required of you 

to create specific materials in the family itself, and it is completely flexible for the end 

user. When using material parameters, you need to create parameters and assign them to 

each solid in the family that needs a material assignment. There are two ways to define 

these parameters, via the Family Types dialog box (in advance) and while editing the 

properties of a solid (on the fly).

Solids that have had Join Geometry applied to them can share only one material assignment.

To create a Material parameter in advance, follow these steps:

	 1.	 Click Family Types on the Properties palette.
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	 2.	 Click Add from the Parameter frame, and add this parameter data:

Name: Table Leg Material•	

Discipline: Common (Architecture uses Common)•	

Type of Parameter: Material•	

Group parameter under: Materials and Finishes•	

Instance/Type: Type•	

	 3.	 Click OK to finish the parameter.

	 4.	 Select the solid to which you want to assign a material.

	 5.	 On the Properties palette, click the small square button on the far right of Material 

parameter row.

	 6.	 Choose the parameter you just created from the list.

	 7.	 Click OK to finish assigning the parameter to the solid.

To create a Material parameter on the fly, follow these steps:

	 1.	 Select the solid you want to assign a material to.

	 2.	 On the Properties palette, click the small square button on the far right of Material 

parameter row.

	 3.	 Click Add Parameter and add this parameter data:

Name: Your Material Name•	

Discipline: Common (Architecture uses Common)•	

Type of Parameter: Material•	

Group parameter under: Materials and Finishes•	

Instance/Type: Type•	

	 4.	 Click OK to finish parameter.

	 5.	 Choose your new parameter from the list.

	 6.	 Click OK to finish assigning the material to the solid.

Visibility and Yes/No Parameters
This is another equally effective way to manage what is visible in your family. Solids and 

lines can be assigned to parameters (a yes/no check box), which will let you turn them on 

and off when you add the family to your project. A nice example you can open and exam-

ine is the stock Revit Room Tag family. It uses this concept to show either a room area or 

volume or neither. As mentioned earlier, each element has a Visible parameter. If you use 

the little “sneaky” square button at the far right, you can connect its Visible parameter to 

a parameter instead.
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Follow these steps to associate a Yes/No parameter with your solid:

	 1.	 Create your parameter in advance as described earlier.

	 2.	 Select the solid that you’d like to assign to your new parameter.

	 3.	 On the Properties palette, click the small square button on 

the far right of the Visible parameter’s row.

	 4.	 Choose the parameter name, or create one now as described earlier.

	 5.	 Click OK to finish assigning the parameter.

You can control the application of Material and Yes/No parameters in advance by assign-

ing them in the family, or you can leave it up to the project team to decide what is needed. 

The beauty of using parameters to do these tasks is that it puts control in the hands of the 

project team. Your library of families will be a bit easier to manage because the project team 

is adjusting the things that make the families unique where it matters, the project.

The Bigger Picture and Advanced Concepts
There are several features—type catalogs, shared families, and shared parameters—that 

make the user experience better as well as making the process of creating families more 

efficient and capable. These features play an important role in the ever-present need for 

reasonable standards to help improve your workflow as well as to get an upper hand on 

your family’s libraries.

Types and Type Catalogs
Each family has one type initially, and it just uses the name of the family as its type name. 

When your family can represent several different types (think sizes or configurations), 

you can add more types. When you have many types, it can become a bit of a chore to 

check each size for accuracy. Revit provides the ability to create a catalog of types.

Type catalogs are simple text files that just require carefully defining each param-

eter that the catalog needs to set when the family is loaded into your project. When you 

choose to load one of these families, Revit will open a dialog box first that lists all the 

types that are available to choose from. When you choose more than one family that has 

a type catalog, you see a list of each family on the left, as shown in Figure 17.33. You just 

need to make your selections for each, and then click OK.
Figure 17.33

Type catalog sample 
with multiple fami-

lies selected
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S TaN Dar DS: N a m I N G YO u r Fa m I LY aN D T Y pE S

First, it is a good practice to create one type for each family so that it will be easier to update 

as you test and fl ex your family. As we just fi nished writing about types, “anything goes” 

should not be your motto, as tempting as it might be. Schedules might rely on the family 

name to help identify it meaningfully. Erratic naming habits will really start to show up in 

these schedules. People who use your families will also fi nd inconsistency frustrating, and 

that can lead to all sorts of other undesirable issues. We won’t presume to tell you exactly 

how to name your families, but we do encourage you to consider your process and create 

consistent habits that make everyone’s interaction with your family library as good an expe-

rience as possible.

t h e r e v i t fa M i lY s t Y le G u i D e

The Revit Family Style Guide was created by Autodesk to help defi ne standards for creat-

ing and managing content that will be posted at Autodesk’s Seek website: http://seek

.atodesk.com/. It also attempts to defi ne the many parameters that other disciplines need 

to have for Revit MEP and Structure. If you are going to get serious about Revit families, 

you’ll want to get this collection of documents and fi les.

The following list comes partially from the Revit Family Style Guide and off ers some 

advice to consider for naming your family:

Create unique names for each family.• 

Use natural language to name the family.• 

If possible, do not include the family category in the family name, unless the functional • 

type is the same as the category.

Capitalize the leading letters in each portion of the family name (Title Case).• 

Keep fi lenames as short as possible.• 

The following list also partially comes from the Revit Family Style Guide and off ers some 

advice for naming family types:

Do not include the family name or category in the type name.• 

Type names should mirror actual usage.• 

Type names should indicate the key diff erence between types and standard sizes.• 

When types are named by size, use dimensions only.• 

Type names should include units unless they represent nominal sizes.• 

Metric types should refl ect local standards; use “soft” metric unless nominal sizes.• 

Keep type names as short as possible.• 
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Keep type names as short as possible.• 
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Nested Families
This should be a familiar concept really; you nest drawings in CAD all the time except 

there it’s called referencing or external references (Xrefs). In Revit, you can create families 

as a “kit of parts” so you can minimize or eliminate redundant tasks and reuse these 

parts effectively, as shown in Figure 17.34. For example, you’ll soon tire of making door 

panels in every door family for your firm’s library, especially if you put the same panel in 

a half dozen other doors just because the frame is different.

You could also tire of making frames for the same reason. Windows offer many rea-

sons, as do casework families. There are examples of required nested behavior too, such 

as electrical families for switches and receptacles. These use a nested symbol family for 

the plan graphics and a box and plate solid 3D entities for elevation and 3D views.

It is also important to be careful how far you take nesting, because you can find your-

self making that “super family” we mentioned earlier as well as making a family that is 

quite large (file size) and sluggish for users to deal with. Most families can be quite effec-

tive with a single level of nesting. Complex families can require a few levels of nesting, but 

these will also perform poorly when loading and making changes. Experimentation and 

testing should always be done prior to turning them over to the team to start using on the 

project.

Shared Families
This is a single check box in each family with a fairly significant impact; just click the 

Family Category And Parameters button to see it (Figure 17.35). The Shared option also 

applies only to the family when it is nested into another family. When a family is nested 

and its host is loaded into a project, Revit loads only enough of the nested family to be 

able to display it or a symbol of it, not the real family. As a result, it does not appear in the 

Project Browser under the Families branch. When the nested family has its Shared option 

selected, then Revit loads it into the project in addition to its host family. As a result, this 

family is listed in the Project Browser under the Families branch. This means you can 

place the nested family alone as well as have it appear whenever its host family is placed. 

More important, since the actual family is loaded, it becomes possible to schedule the 

nested family as if it were an individual apart from its host. There are numerous interest-

ing possibilities available to you as a result.

Figure 17.34

Door panel  
“kit of parts”
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For example, a schedule can report 

how many cabinets you have in a proj-

ect. Using shared families, Revit can 

now also provide a schedule of cabinet 

doors and hardware. This might be an 

extreme example, but it could be quite effective for a 

firm that could use this level of detail. Hospitals have 

various types of suites that are repeated consider-

ably throughout a design. It is also possible to build a 

composite hospital room equipment family that nests 

each of the equipment families used.

It might not be as useful to schedule the compos-

ite room but it might be very useful to place them 

effectively and then schedule the individual pieces of 

equipment as if they had been put in each room indi-

vidually. With some clever use of parameters, many of the nested families that are most 

likely to shift around can be repositioned as needed. This is definitely on the verge of 

qualifying for “super family” status, but in some cases the effort is justified by the result.

Shared Parameters
Parameters exist for every family in Revit. Some are created by the software developers 

and designed to work without any extra effort on your part. Others are created by you 

as you develop or modify content. Parameters are part of projects and families. You can 

create project parameters that are assigned to specific categories. These can be included 

in schedules. These are an elegant way to include important information that applies to 

many families of one or more categories but don’t actually alter the physical family itself 

(think “information only”).

When you create families, you can define more parameters than what you find in each 

template. Many of these are just family parameters that only have a role inside the family 

to determine how big or small it should be and what should be visible. These parameters 

are available to you in the project, but you 

can’t schedule them or display their values in 

tags. When you need to do either, you need to 

plan for shared parameters (Figure 17.36).

Think of a shared parameter file as a dictionary, as shown in Figure 17.37. It contains 

definitions that you can make available to projects and families as you work in either 

environment. When you want a parameter to both change the physical nature of a fam-

ily and schedule it or tag it, you just need to create the shared parameter and assign it in 

the family. When you get back to your project, you add the same shared parameter to 

Figure 17.35

Click the Family  
Category And 
Parameters button 
to make a family 
shared.

Figure 17.36

Shared Parameters 
button on the  
Manage tab
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the project. This common definition helps Revit understand that the value it finds in the 

family and project are really the same information.

If you are going to be the go-to person for Revit families, then you’ll want to become 

familiar with shared parameters. You’ll also want to get hold of the Revit Family Style 

Guide we mentioned earlier.

Practical Matters
We should mention a couple items that are beyond just becoming familiar with clicking 

and picking tools: file size and complexity. It takes time to become really competent mak-

ing families. It is easy to make complex families, so to speak. Complexity isn’t a worthy 

goal, though. Creating really effective families that are not a burden on your projects or 

your co-workers is; and it is the result of careful craftsmanship.

File Size  ​Smaller is better. Most of the stock content varies from between 100 and 300 KB 

(as shown in Figure 17.38). Structural steel families are a bit bigger, but most of them also 

include a bit more complexity. The LH-Series Bar Joist family is a little more than 550 KB, 

but it has a nested family and uses an array to create the cross braces (as shown in 

Figure 17.39).

Figure 17.37

Selecting a shared 
parameter

Figure 17.38

The files sizes of 
some stock struc-

tural families
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It is perfectly reasonable to expect that some content may be a bit larger when the com-

plexity they have offers signifi cant benefi ts. But you should keep an eye on your fi le sizes 

primarily to make sure that none are arbitrarily large without justifi cation. For example, 

a nested family might be part of a door family that doesn’t actually use it anymore. We 

have seen instances where a Family Editor has tried a few different ideas, eventually set-

tled on a different approach, and never cleaned out the earlier nested components. This 

can cause a fi le’s size to be two or three times larger than necessary. One or two families 

like this won’t hurt your project, but hundreds of them with similar inconsistency will 

affect performance.

Complexity  As mentioned earlier, it is an asset that Revit can provide 

a high level of parametric capability. It is also a curse because you 

can abuse this power. You need to be mindful of complexity because 

users may be stymied by it, and projects may suffer for it. What are 

examples you might choose to avoid? Avoid using the Array feature 

with the Group And Associate option selected. You might also prefer 

to avoid using a great many parameters that are derived through 

sophisticated calculations. Each calculation will require a bit more 

work than a simpler family version will. There is no hard-and-

fast rule. This is where the artist and technician blend together 

and where family editing is as much art as science (refer to 

Figure 17.40).

Evaluation  Test! You must test your family both 

in the Family Editor and in a project. A family can 

work perfectly in the Family Editor, but a user can 

fi nd one circumstance in a project that doesn’t sup-

port your assumptions and you have to fi x it. The 

project also provides you with what the regular 

Revit user will experience when they try to use 

your family. Just as it is good advice not to proof 

your own writing, it is good advice to not proof 

(test) your own families. A couple other people will 

Figure 17.39

The Bar Joist family 
uses an array to cre-
ate the bracing you 
see (the “skin”).

Figure 17.40

A couple complex 
forms created with 
families

 As mentioned earlier, it is an asset that Revit can provide 

can abuse this power. You need to be mindful of complexity because 

with the Group And Associate option selected. You might also prefer 

forms created with 
families
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usually find things that you didn’t expect and save you the trouble of rushing around 

after users have started to put it in their project.

Dissecting Some Practical Examples
We have assembled a collection of exercises that provide some practical tasks. It is our 

hope that, once you’ve tried these, you’ll see opportunities to apply what you learn to 

other content you need in the future. You may even find yourself inclined to revisit some 

content you’ve already made. The following are the exercises:

Exercise 1: Creating a door with variable swing•	

Exercise 2: Nesting a variable swing (in a door family too)•	

Exercise 3: Modifying a room tag and shared parameter•	

Exercise 4: Modifying an existing column’s visibility and material settings•	

The first two exercises deal with providing an adjustable door swing for a door family. 

The first one just alters an individual family, while the second introduces the concept of 

nesting a family in another. It is a bit more complex, but it has the benefit of reusing one 

family to provide consistent results in many other families. The third example shows you 

how to create a room name abbreviation and apply it to your room tag family. The last 

example deals with a column family and shows you how to simplify what you see in a 

plan view vs. a 3D view.

Exercise 1: Creating a Door with Variable Swing Angle
A fair number of Revit users wonder whether a door can change the angle of the door panel. 

The stock content is fixed at 90 degrees or perpendicular to the wall. Some plan views need 

the doors to be able to decrease or increase this angle because either they interfere with 

another graphically or it is desirable to show how far the door will swing into an area. This 

exercise will take you through the necessary steps to modify the existing Single Flush.rfa 

door family found in the Imperial Library. The metric version is called m_Single Flush.rfa.

Preparation      

	 1.	 Open Single Flush.rfa.

	 2.	 Save the file: Provide a unique name to preserve the existing file.

	 3.	 In the Floor Plan view: Ground Floor, delete the symbolic line work (five lines, one 

arc, and four lines).

	 4.	 Add a new reference plane along the exterior face of the host wall.

	 5.	 Lock the padlock that appears when you sketch it.

	 6.	 Name the reference plane (Exterior Face) so it is easier to understand what it is for later.

	 7.	 Create three types for the host wall using three different values for thickness. This 

makes it easier to test for different wall thickness inside the Family Editor.
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	 8.	 Temporarily hide the host wall, opening cut, f lip controls, trim, and door panel sol-

ids. This makes it easier to sketch new symbolic lines and make sure constraints are 

correct.

Creating      the   S ymbolic      Panel  

	 1.	 Sketch a rectangle (representing the panel) using the symbolic line subcategory Panel 

[cut]. Start at the intersection of reference planes Right and Exterior Face (the new 

one you added), and sketch at a 45-degree angle to the left. Make the rectangle 3´-0˝ 

(900mm) long and 2˝ (50mm) thick.

	 2.	 Add Aligned dimensions between each parallel side of the rectangle; assign the 

Thickness parameter to the narrow dimension and the Width parameter to the long 

dimension.

	 3.	 Add Angular dimensions between each long line segment and the upper short per-

pendicular segment. Lock their angle at 90 degrees.

	 4.	 Repeat these steps for the other end, but only one (angular dimension) of them is 

necessary. Attempting to add both dimensions and locking them will generate an 

error message concerning over-constraining the sketch.

	 5.	 Add an Angular dimension between the exterior side of the panel and the reference 

plane Exterior Face.

	 6.	 Select this Angular dimension, and create a parameter for 

it. Name it 2D Swing, and assign it to the Graphics group. 

Select the Instance box. This will allow you to change the 

swing angle for doors individually. This is what your work 

should look like so far.

	 7.	 Flex your door: open Family Types, and change the 2D 

Swing parameter from 45 to 90 degrees. Change the door 

type to a different size. Make sure that it does not break. If 

the panel does not change correctly or generates any error 

messages, return to the previous steps and repeat until there 

are no errors.

Creating      the   S ymbolic      A rc

	 1.	 Hide the Panel symbolic lines to make it easier to sketch the arc.

	 2.	 Sketch the arc for the door swing using the symbolic line subcategory Plan Swing 

[projection]. Choose the Center-Ends-Arc tool, and place the arc center point at the 

intersection of the reference planes Right and Exterior Face (the new one you added). 

Place the first arc endpoint at the intersection of the reference planes Left and Exte-

rior Face. Place the second endpoint of the arc randomly above the first, something 

between 0 and 45 degrees.
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	 3.	 Select the arc, and drag the bottom endpoint down until it meets the other reference 

plane (unnamed). Doing this prevents the arc from becoming zero length if the door 

swing is set to zero degrees. The wall’s line weight will hide the arc for this door so it 

won’t be visible.

	 4.	 Add a Radial dimension to the arc, and assign it to the Width parameter.

	 5.	 Reset the temporarily hidden elements.

	 6.	 Select the arc and drag the upper endpoint up to meet the upper-inside corner of the 

symbolic lines for the panel. Your work should look like this now.

	 7.	 Flex/test the family again by changing the parameter setting for 2D Swing as well as 

choosing different door types to change the width and thickness parameters. If there are 

no errors to contend with, load the family into a project to test it in that environment.

Remember, the value you assign to the new 2D Swing parameter is the default value 

that Revit will use when you place the family; assign it accordingly. It is still possible 

for a user to break this swing if they place the door in a very thin wall, because the arc 

may become too short for Revit to show or create. It isn’t all that common for a door to 

be “closed,” however, which means it isn’t likely to be a real issue. Here’s what the door 

should look like in a project after you finish it.

Exercise 2: Nesting a Variable 2D Swing
Repeatedly taking the steps in exercise 1 for every door in your family library might feel a 

bit repetitive. Another strategy you can consider is to create a separate family that repre-

sents the 2D swing graphics. This separate family is then nested into your door families. 

It is only necessary to position the family and associate the parameters that allow for 
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width, thickness, and swing angle to the host family. This section will provide the outline 

for taking this approach.

Preparation      

	 1.	 Start a new family using the Generic Model.rft template file.

	 2.	 Save the file: name it 2D Swing.rfa (just a suggestion).

	 3.	 Change the category from Generic Models to Doors. Doing this eliminates the host 

wall that exists in the door template and provides the subcategories that are part of 

the door template.

	 4.	 Open the Object Styles dialog box from the Manage tab.

	 5.	 Click the New button in the Modify Subcategories frame.

	 6.	 Type the name Plan Swing, and click OK. It is important to type it the same way you 

typed it here in the instructions so that it will be the same as all the other door fami-

lies that use this object style. Just compare yours against the other door families in 

the Revit library.

A dding     the   B ones    (R eference      Planes    )

	 1.	 Add a vertical reference plane parallel and to the left of the existing vertical reference 

plane. Set it at 3´-0˝ (900 mm) from the existing vertical reference plane. Name it 

Left, and assign the IsReference parameter to Left and Apply.

	 2.	 Select the existing vertical reference plane. It is named Center (Left/Right). Change 

its name to Right, and reassign the IsReference parameter to Right. Notice that the 

check box is selected for Defines Origin, which is correct. The reference plane is also 

pinned. If you want to change the extent of the reference plane, you’ll have to unpin 

it first.

	 3.	 Select the horizontal reference plane, rename it to Front, and reassign the IsRefer-

ence parameter to Front. You’ll have to unpin it too if you want to change how long 

the reference plane is. It too defines the origin of the family.

A dding     S ome   M uscle   ( A dding     D imensions         and   Parameters        )

	 1.	 Place an Aligned dimension between the Left and Right reference planes.

	 2.	 If necessary, adjust the Left reference plane to ensure they are 3´-0˝ (900 mm) apart.

	 3.	 Assign the parameter Width to the dimension. The Width parameter is already avail-

able because Revit added it when you switched from the generic to door category.

Creating      the   D oor   Panel    ( A dding     S ome   S k in  and   S ome   M ore   M uscle  )

We should point out that the following steps are nearly the same as those we described in 

the previous exercise.
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	 1.	 Sketch a rectangle (representing the panel) using the symbolic line subcategory Panel 

[cut]. Start at the intersection of reference planes Right and Front, and sketch at a 

45-degree angle to the left. Make the rectangle 3´-0˝ (900 mm) long and 2˝ (50 mm) 

thick.

	 2.	 Add Aligned dimensions between each parallel side of the rectangle; assign the 

Thickness parameter to the narrow dimension and the Width parameter to the long 

dimension. These are also already available because you change from generic to door 

category.

	 3.	 Add Angular dimensions between each long line segment and the upper short per-

pendicular segment. Lock their angle at 90 degrees.

	 4.	 Repeat for the other end, but only one of them (angular dimension) is necessary. 

Attempting to add both dimensions and locking them will generate an error message 

that you are over-constraining the sketch.

	 5.	 Add an Angular dimension between the exterior side of the panel and the reference 

plane Exterior Face.

	 6.	 Select this Angular dimension, and create a parameter for it. Name it 2D Swing, and 

assign it to the Graphics group. Select the Instance box. This will allow you to change 

the swing angle for doors individually. This family should look like this now.

	 7.	 Flex your panel: in Family Types, change the 2D Swing parameter from 45 to 90 

degrees. Try some other angles greater and less than 90. Make sure that it does not 

break. If the panel does not change correctly or generates any error messages, repeat 

the previous steps until there are no errors.

T he  A rc  ( A dding     M ore   S k in  and   M uscle  )

	 1.	 Hide the Panel symbolic lines to make it easier to sketch the arc.
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	 2.	 Sketch the arc for the door swing using the Symbolic line subcategory Plan Swing 

[projection]. Choose the Center-Ends-Arc tool, and place the arc center point at the 

intersection of the reference planes Right and Front. Place the first arc endpoint at 

the intersection of the reference planes Left and Front. Place the second endpoint of 

the arc randomly above the first, a value between 0 and 45 degrees.

	 3.	 Sketch a symbolic line using the subcategory <Invisible Lines> from the intersection 

of reference planes Right and Front to the left just below the Front reference plane at 

a slight angle of 0.5 degrees.

	 4.	 Select the invisible line, and deselect the Visible property (this means it will not 

be visible in the project at all; if it’s selected, it will be visible when you hover your 

mouse pointer over the family but not visible otherwise).

	 5.	 Place an angular dimension between the reference plane Front and the new symbolic 

invisible line, and lock the dimension (angle should be 0.5 degrees).

	 6.	 Select the arc, and drag the bottom endpoint down until it meets the invisible line 

you just sketched.

Doing this prevents the arc from becoming zero length if the door swing is set to 0 degrees. 

The wall’s line weight will hide this tiny extension of the arc, so it won’t be visible.

	 7.	 Reset the temporarily hidden elements.

	 8.	 Select the arc and drag the upper endpoint up to meet the upper-exterior corner of 

the symbolic lines for the panel. The family should look like this now.

	 9.	 Flex/test the family again by changing the parameter setting for 2D Swing as well 

as choosing different door types to change the width and thickness parameters. If 
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there are no errors to contend with, load the family into a project to test it in that 

environment.

Be careful not to test the angle by trying 0 degrees or 90 degrees. When you nest the family 

into the host door, it will tolerate these values. The arc tends to distort the constraints if you 

use those values in the swing family itself. You could fuss with the family trying to resolve 

this only to find out later that once it is nested, it doesn’t matter.

N esting      the   2 D S wing    (preparation       )

	 1.	 Open Single Flush.rfa.

	 2.	 Save the file with a different name to preserve the original.

	 3.	 In the view Floor Plan: Ground Floor, delete the symbolic line work (five lines,  

one arc, and four lines).

	 4.	 Add a new reference plane along the Exterior face of the host wall.

	 5.	 Lock the padlock that appears when you sketch it.

	 6.	 Name the reference plane (Exterior Face) so it is easier to understand what it is  

for later.

	 7.	 Create three types for the host wall using three different values for thickness.  

This makes it easier to test for different wall thickness inside the Family Editor.

	 8.	 Temporarily hide the host wall, opening cut, f lip controls, trim, and door panel  

solids. This makes it easier to constrain the nested 2D Swing family.

Loading     the   Family    and   Placing    I t  (N esting     )

	 1.	 Load your 2D Swing family from the Insert tab’s Load From Library panel, select 

Load Family, and place it near the opening of the door.

	 2.	 Using the Align tool, align and lock the right side of the 2D Swing to the Right refer-

ence plane, and do the same for the base of the swing to the Exterior Face reference 

plane.

	 3.	 Select the 2D Swing family, and click the small gray button next to the Instance 

parameter 2D Swing on the Properties palette.

	 4.	 Use the Add Parameter button to create a new parameter called 2D Swing in the host 

family. Assign the parameter to the Graphics group, and select the Instance option. 

This allows you to change the swing of individual doors as required in the project.
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	 5.	 Click the Edit Type button to do the same task for the Width and Thickness param-

eters. These parameters are already present in the host family, so you only need to 

select the matching parameter name.

	 6.	 Reset the temporarily hidden elements, and test the family to make sure everything 

flexes properly.

	 7.	 Save the file and load it into a project to test it there.

Exercise 3: Modifying a Room Tag and Shared Parameter
This task is pretty minor editing for a family, but it gives you a chance to create a param-

eter to store a room name’s abbreviation. This is useful when a room is pretty small in 

a plan view and the tag and its full name tend to hide the room itself. This exercise will 

modify the existing room tag and show you how to create the necessary shared parameter 

as well as add it to your project to make it all work together.

To create the shared parameter, follow these steps:

	 1.	 On the Manage tab, click Shared Parameters.

	 2.	 If you get a message telling you that your shared parameter file doesn’t exist, this 

will open the Edit Shared Parameters dialog box; click Close. If you have a shared 

parameter file mapped already, you’ll just get the Edit Shared Parameter dialog box 

directly.

	 3.	 If you have another parameter you can do testing with, click Browse, or click Create 

to make a new one for this exercise only.

	 4.	 Choose a folder location and provide a name, such as RAC Intro SP. It will be a .txt-

formatted file.

	 5.	 Click New in the Groups frame.

	 6.	 Provide a new group name such as Room and Area Data.

	 7.	 Click New in the Parameters frame.

	 8.	 Provide a new name such as Abbreviation, use the Discipline: Common, and assign 

the Type Of Parameter: Text. If you make a mistake, it will be here; make sure you 

select Text!

	 9.	 Click OK (your parameter awaits you for use in the room tag family).

	10.	 Click OK in the Edit Shared Parameters dialog box.

Create the new room tag family and add the parameter:
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	 1.	 Open the stock family Room Tag.rfa from the Imperial library.

	 2.	 Save the file in another folder location as Room Tag Custom.rfa (just a suggestion).

	 3.	 Select the label for Room Name.

	 4.	 Create a copy of it, and place it above the existing one.

	 5.	 Click Edit Label, and then click the small Add Parameter button (bottom-left corner 

of the Edit Label dialog box).

	 6.	 Click Select (Shared Parameter is your only option offered).

	 7.	 Select the Abbreviation parameter (if you aren’t using a new shared parameter file, 

you may have to select a different group to see your Abbreviation parameter).

	 8.	 Click OK twice (first to select and second to apply).

	 9.	 Select Abbreviation from the list of available Category Parameters.

	10.	 Click the Add Parameters(S) To Label button (green arrow pointing to the right).

	11.	 Select row 1 (Name parameter), and click the Remove Parameter From Label button.

	12.	 Supply a sample abbreviation value Abbr.

	13.	 Click OK.

Create a Yes/No parameter to control the visibility of the Abbreviation label:

	 1.	 Select the Abbreviation label.

	 2.	 Click the Associate Parameter button for parameter: Visible (the little square gray 

button on the Properties palette).

	 3.	 Click Add Parameter.

	 4.	 Provide the following:

Name: •	 Show Abbreviation

Group Parameter Under: Graphics•	

Select: Type•	

	 5.	 Click OK.

Create a Yes/No parameter to control the visibility of Room Name label:

	 1.	 Select the Room Name label.

	 2.	 Click the Associate Parameter button for parameter: Visible (the little square gray 

button on the Properties palette).

	 3.	 Click Add Parameter.

	 4.	 Provide the following:

Name: Show Full Name•	

Group Parameter Under: Graphics•	
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Select: Type•	

	 5.	 Click OK.

Adjust the family types, and save the file:

	 1.	 Click Properties palette, and select Family Types (there are three types already).

	 2.	 Rename the existing types:

Rename Room Tag to •	 Full Name-Number.

Rename Room Tag with Area to •	 Full Name-Number-Area.

Rename Room Tag with Volume to •	 Full Name-Number-Volume.

	 3.	 Create three new types:

Short Name-Number•	

Short Name-Number-Area•	

Short Name-Number-Volume•	

	 4.	 Create a formula for Show Full Name: enter the following in the Formula column 

next to the parameter Show Full Name: not(Show Abbreviation).

	 5.	 For each type, change the values of each parameter so the result matches each type’s 

name (see example here for Short Name-Number-Area).

	 6.	 Click OK.

	 7.	 Move the Abbreviation label so that it sits directly on top of the Room Name label. 

The parameters assigned to their visible parameters will govern when they are sup-

posed to show up so they don’t compete with each other.

	 8.	 Save your work.

	 9.	 Click Load Into Project (if you don’t have a project open already, you’ll need to do 

that first).

	10.	 Apply the tag to rooms and experiment with various versions of the tag.

You notice that you can’t supply a value for abbreviation yet, though. That’s next!

Add the shared parameter Abbreviation to your project:

	 1.	 On the Manage tab, click Project Parameters.
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	 2.	 Click Add.

	 3.	 Click to Select Shared Parameter and click Select.

	 4.	 Choose Abbreviation from the list, and click OK.

Group Parameter Under: Identity Data•	

Instance•	

Assign Category: Rooms•	

	 5.	 Click OK, select Abbreviation, and click OK.

	 6.	 Select a room tag (using the Short Name tag versions naturally).

	 7.	 You can now provide a value for Abbreviation.

	 8.	 Select the Room element directly and find the parameter listed among the other 

parameters in the Identity Data group in the Properties palette.

You should see something like this when you apply the tags to your rooms.

Exercise 4: Modifying the Existing Column Visibility and Material 
Settings
The column family called Doric Column.rfa is provided with the content that is installed 

with Revit. When you load, place, and then examine how it looks in various views, you 

may find that it needs a little adjustment to make it look better in plan views. Left alone, 

it appears a bit too heavy because many of the columns forms are visible in the plan. This 

exercise will change the settings to simplify its plan representation. We will also take this 

opportunity to revisit how the materials are assigned to the column.

Open the family, examine it, and get it ready:

	 1.	 Open the stock family Doric Column.rfa from the Imperial library.

	 2.	 Save the file in another folder location under a new name, something like Our Doric 

Column.rfa (which is just a suggestion).
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	 3.	 Open a new project template, load the column, and place it to take a close look at it 

in a plan view.

The cylindrical portion of the column has too many lines showing, which cause it to 

appear too bold. You need to adjust this:

	 1.	 Select the column, and click Edit Family.

	 2.	 Open the view Floor Plan: Lower Ref. Level.

	 3.	 Zoom in, and select the Revolve form (circles that you see).

	 4.	 Click Visibility Settings on the Mode panel.

	 5.	 Deselect Plan/RCP and When Cut In Plan/RCP, and click OK.

In the Family Editor you will find that elements are not hidden when these settings are 

changed. They become muted (halftone) in order to show they are affected by a visibility 

setting.

	 6.	 Save the family file, click Load Into Project, choose Overwrite The Existing Version, 

and review the result.

You should just see the rectangular base form now.

Add symbolic lines for the circular form:

	 1.	 Back in the column family, sketch a symbolic circle using the Columns [Projection] 

subcategory.

	 2.	 Save the family file, click Load Into Project, overwrite the existing version, and 

review the result.

Manage the material assignment for the column:

	 1.	 Select the column, and click Edit Family.

	 2.	 Open the 3D View: View 1.

	 3.	 Select the revolve form (the upper portion of the column).

	 4.	 Click the Associate Family Parameter button for the Materials parameter (the small 

gray button). This form is assigned to a material already; the equal sign symbol on 

the button indicates this subtlety. Change nothing yet.

	 5.	 Repeat step 4 for the forms that make up the base; all are assigned to the same  

material.

	 6.	 Select the revolve form again, and click the Associate Family Parameter button.

	 7.	 Click Add Parameter, and supply the following:

	 a.	 Set Name to Column Upper.

	 b.	 Leave Discipline set to Common.

	 c.	 Leave Type Of Parameter set to Material.
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	 d.	 Group the parameter under Materials and Finishes.

	 e.	 Choose Type, click OK, and click OK.

	 8.	 Click Family Types.

	 9.	 Select the Material parameter, and click Modify.

	10.	 Replace the name Material with Column Base.

	11.	 Click OK, and save the family.

	12.	 Choose Load Into Project, overwrite the existing version, and open a 3D view.

	13.	 Select the column, and click Edit Type.

	14.	 Change the Material parameters to assign two new materials from the available 

materials in the project.
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Revisions

A critical element  in managing a project of any size is the coordination 

of sheet revisions. Within the Revit platform, you have automated tools made specifically 

to address inputting revision data, clouding areas of change, and creating a report that 

automatically updates. These tools are essential items for dealing with issued changes to 

the project documentation. 

In this chapter, you will learn about the following:

Numbering revisions■■

Drawing revision clouds■■

Issuing a revision■■
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Numbering Revisions
If your titleblock does not contain a revision schedule, refer to Chapter 14, “Sheets,”  

for details on how to create or add one to your titleblock.

To get started, select the View tab, go to the Sheet 

Composition panel (see Figure 18.1), and select Revisions.

You can show revisions in two ways in project documenta-

tion: per project (the default) and per sheet. Before you use 

either of them, you need to get a good understanding of which method will best suit 

your needs:

Using the Per Project setting, all revisions are numbered for sheets across the project •	

according to the sequence of revisions within the Sheet Issues/Revisions dialog box 

(see Figure 18.2).

Using the Per Sheet setting, revision clouds are numbered relative to the sequence of •	

other clouds on a given sheet.

Numbering per Project
With the Numbering radio button at the top right of the Sheet Issues/Revisions dialog 

box set to Per Project, the floor plan view shown in Figure 18.3 has revision clouds for 

revisions 1,3, 5, and 7, and a tag for each cloud. The number in the cloud is the project-

based revision number, while the number in the triangle tag is the revision number 

assigned to the cloud on the sheet. Once you place this view on the sheet, the revision 

schedule will display the numbering sequence as 1, 3, 5, and 7.

Figure 18.1

View tab’s Sheet 
Composition panel 

to start revisions

Figure 18.2

Numbering revi-
sions with the Sheet 

Issues/Revisions 
dialog box
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Numbering per Sheet
Now, set the Numbering radio button at the top right of the Sheet Issues/Revisions dialog 

box to Per Sheet.

When you change the radio button for Numbering, Revit will issue a warning to inform you 

that switching to a different revision numbering scheme can change the revision numbers 

for all revision clouds.

In the floor plan view shown in Figure 18.4, you have a revision cloud for revisions 1, 3, 

5, and 7, and the revision clouds are tagged. The number in the cloud is the project-based 

revision number, while the number in the triangle tag is the revision number assigned to 

the cloud on the sheet. Once you place this view on the sheet, the revision schedule will 

display the numbering sequence as 1, 2, 3, and 4.

Figure 18.3

Floor plan view with 
revision clouds and 
tags, using per-
project numbering, 
and the correspond-
ing sheet revision 
schedule

Figure 18.4

Floor plan view with 
revision clouds and 
tags, using per-sheet  
numbering, and the 
corresponding  
sheet revision 
schedule
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Options for Numbering
Within the Sheet Issues/Revisions dialog box, the order of revisions is based upon the 

Sequence value. Within this dialog box, you can add, reorder, and merge revision rows as 

needed. Revit also allows you to adjust the numbering style to Numeric, Alphabetic, or 

None. You do this by selecting the individual cell under Numbering and choosing from 

the drop-down list. 

Numeric will use whole numbers within the sequence.•	

Alphabetic will use alphabet characters.•	

None will not issue a value, and the tag will show as blank.•	

When using the Alphabetic numbering style, if there are certain characters that you 

need to omit, such as the letters O and I (to avoid being 

read as the numbers 0 and 1), you can set this by clicking 

the Options button in the Alphabetic Sequence section 

to open the Sequence Options dialog box. By default, the 

entire range of the alphabet is used (see Figure 18.5).

Revit does not allow for the use of alphanumeric entries within the numbering scheme, such 

as AD1, AD2, and so on.

You can input detailed information into the cells for each column: Date, Description, 

Issued To, and Issued By. This information can then be displayed within the revision 

schedule table on the sheet. 

Drawing Revision Clouds
Revisions clouds can be drawn for all views (except 3D views) and placed in either the 

view or the sheet. Adding the cloud to the view is recommended with the exception of 

schedules that need to be shown as revised; for that, add the cloud to the sheet. 

To draw a revision cloud, start by opening a view 

(any with the exception of a 3D or schedule view), 

select the Annotation tab, go to the Detail panel (see 

Figure 18.6), and select Revision Cloud. 

You are now prompted to pick a start point for the 

revision cloud. By default, Revit uses the last revision in the 

sequence for the revision cloud. If you need to change this to 

another nonissued revision, you can do so using the drop-

down shown in Figure 18.7 in the Properties palette. Select 

from the provided entries under Identity Data’s Revision 

parameter. Within the drop-down, the entries are prefixed 

Figure 18.5
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with the sequence number to aid in understanding which is the most recent as well as to 

show which revisions have been marked as issued.

With the appropriate revision sequence selected, you are now ready to sketch your 

revision cloud around the revised area. Sketching with Revit uses two arc segments for 

each pick that you make. Revit does not require that the revision cloud be a closed loop 

and does not mind if there are overlapping or multiple 

lines. If you prefer the geometry to be a closed cloud, then 

as you enclose the revised area, pick the original start point 

to close, and Revit will fill in the final segments for a closed 

loop. Click the large check mark (Finish Edit Mode, as 

shown in Figure 18.8) in the Mode panel to close the cloud sketch; or use the shortcut SZ 

(Close) snap to automatically close.

To add additional revision clouds that relate to the same revision, simply draw another 

revision cloud using the previous steps.

When drawing a revision cloud, the default orientation is to draw clockwise. Pressing the 

spacebar will “flip” the cloud and allow you to draw counterclockwise.

Tagging a Revision Cloud
A revision tag is used to identify and graphi-

cally show the revision assigned to each cloud in 

a view. The revision tag behaves like other tags 

within Revit. (Tags are described in Chapter 12, 

“Tags, Schedules, and Keynotes.”) Select the 

Annotate tab, go to the Tag panel, and select Tag 

By Category (see Figure 18.9). A revision tag 

family must be loaded if one does not already 

exist within your project. To verify that you 

have a tag loaded, select the small drop-down 

next to the Tag panel’s name, and choose  

Loaded Tags, as shown in Figure 18.10.

If you have a family shown within the 

Tags dialog box, as shown in Figure 18.11, 

you can begin tagging. If a family does 

not exist, you can load one of the revi-

sion tags that Revit provides (imperial or 

metric) in the Library ➔ Annotations area 

(Revision Tag.rfa or M_Revision Tag.rfa).  

If your organization has another tag 

Figure 18.8
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that is required, click the Load button in order to browse to the location and load the 

family.

As you select each cloud, Revit will display the revision tag next to it. The value shown 

within the tags reflects the revision sequence assigned to the cloud. While you’re placing 

the tags, the Options bar (Figure 18.12) allows you to control the orientation of the tag, 

whether a leader is used, the connection style for the leader (attached or free end), and 

the offset length for the leader from the cloud to the tag.

As you add revisions to the Revisions dialog box, Revit automatically adds them to the 

revision schedule that appears in the title block of each project sheet.

Issuing a Revision
You can continue to modify a revision until it is time for that revision to be issued. With 

the revision clouds and tags added and the revised views placed on sheets as required, you 

are ready to issue the revision. 

To do this, locate the Issued column (refer to Figure 18.2) within the Sheet Issues/

Revisions dialog box. Revit uses a single check box for each sequence row that is used. 

When it’s selected, you will notice the following:

You will no longer be able to change information for that revision.•	

The sequence row, within the dialog box, will be displayed as ghosted to show that it •	

has been issued.

Within project views, you are no longer able to change the assignment from an •	

issued revision to an additional or new revision cloud (see Figure 18.13).

You cannot add revision clouds to the revision, you cannot edit the sketch of the •	

revision cloud, and you cannot use the Instance Properties dialog box to change  

a revision cloud if its revision has already been issued.

All of the previous information remains true as long as the Issued box is selected. If you need 

to make modifications to any of these items, you will need to deselect the Issued check box 

in the Sheet Issues/Revisions dialog box.

Figure 18.12

Tag’s Options bar

Figure 18.13
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Once you have issued a revision, you can also modify the way each revision sequence 

is displayed using the drop-down options within the Show column: Cloud and Tag (the 

default), Tag, or None (see Figure 18.14).
Figure 18.14

Choosing what to 
show in the view
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Collaboration

Utilizing Revit  as a design tool, architects can develop conceptual designs 

that others can then use to develop energy models, they can develop preliminary engi-

neering designs for both structural and MEP designs, and they can even start developing 

preliminary estimates for construction.

The Autodesk Revit platform provides a way to collaborate between multiple disci-

plines within the platform and also provides methods you can use to collaborate with 

resources outside of Revit. Revit can interact with databases and other CAD programs, 

in addition to providing access to drawings to those users who do not have access to or 

do not know how to use conventional modeling or drafting tools.

This chapter explores these topics:

Coordinating work across disciplines■■

Exporting to non-Revit formats■■
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Coordinating Work Across Disciplines
Autodesk Revit provides several tools to help keep your projects consistent with each 

other: the Copy/Monitor tool, the Coordination Review tool, and the Interference 

Check tool.

The Copy/Monitor Tool
One of the primary tools Revit provides is the ability of each of the disciplines— 

architecture, structure, and MEP—to monitor and coordinate changes to elements  

made by other disciplines during the progression of the project. Each discipline can inde-

pendently copy or monitor elements that are being used commonly between disciplines. 

Copy refers to actually making duplicates of common specified elements from a 

linked project into a host project, allowing you to work and interact with the copied 

elements. 

Monitor refers to tracking the elements, usually those elements copied in the Copy 

process defined previously; if the original element changes, a warning will be given 

to alert team members when the project is opened or the linked model is reloaded. 

When to Use

What is each discipline trying to accomplish by utilizing the Copy/Monitor tool?

The architect and structural engineer would each want to track whether the other 

modifies a structural wall, a grid line, or the distance between floors. The MEP engineer 

would want to track these same adjustments and also see whether the architect moves or 

modifies a piece of equipment, whether that item moved to a new location, or whether 

it got changed to another type of equipment. You can monitor changes to the following 

types of elements:

Levels•	

Grids•	

Columns (not slanted columns)•	

Walls•	

Floors•	

Openings•	

In addition to the previous items, in Revit MEP 2011, MEP fixtures are now part of 

this list, including the following:

Plumbing fixtures•	

Air terminals•	

Mechanical equipment•	

Lighting fixtures•	
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Use the Copy/Monitor tool when the architectural and engineering team members 

are all using Revit software on a project and when each team needs to be informed about 

changes to the elements listed previously. 

Although the previous list of items will cover most of the items that you need to moni-

tor, there are a few areas that are not well suited for copying/monitoring:

Slanted columns•	

In-place elements•	

Design options•	

Project phasing•	

Despite its name, there are two different methods (three, if you are using Revit MEP) 

for using the Copy/Monitor tool: 

The first and most apparent method is to use this tool to copy objects from the •	

source model into your model and then track that pair of objects for changes. If 

either one is modified, you will be notified of those changes when you run the 

Coordination Review command (covered in more detail later in this chapter). This 

process is most often used when you are copying and monitoring levels and grid 

lines for all disciplines and for most objects in an architectural model.

The second method for using the Copy/Monitor tool is to skip the copy part and just •	

monitor pairs of objects for change. This is useful when you need to have a larger 

amount of control of objects in your file or when the default copy method built into 

the tool does not work for you. One key area in which this occurs is with walls and 

structural engineers. Within Revit, when a walls is copied from the architect’s model 

using Copy/Monitor, Revit does this based on wall centerlines, and this centerline 

can vary based on the actual composition of the wall. Often, this can result in dif-

ferences of the centerlines between the complex wall the architect has created and 

the simplified wall the engineer wants. The engineer can draw simplified walls in a 

structural model and then use only the Monitor function of the Copy/Monitor tool 

to pick pairs of walls—the architects’ and their own—and monitor those pairs of 

objects for changes.

Lastly, in Revit MEP 2011, you can activate a unique component of the Copy/Monitor •	

tool: Batch Copy. Instead of picking objects to copy individually from the architect’s 

model, you can copy all air terminals, lighting fixtures, mechanical equipment, or 

plumbing fixtures at once.

It is important to keep in mind that this tool tracks changes to only those objects that 

you specify, no more. This means you are not notified if there are any new objects created 

in the source file. During the editing process, if a tracked object is moved, you will be 

shown its new location. If instead the tracked object is deleted from its original location 
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and a new object is placed in another spot, you will be notified only of the deleted object, 

not the new location. It is important to communicate with the extended design team to 

make sure that appropriate editing methods are used. To start the Copy/Monitor pro-

cess, click the Copy button, choose to copy/monitor an object in the current file or from 

a linked file, and select the desired items. Once this selection process is completed, click 

the Finish button. At this point, Revit places a Monitor icon  alerting the user that the 

process has been successfully completed.

This process is similar for the Monitor option with the exception that, after starting the 

Copy/Monitor command, you will need to explicitly click the Monitor button in the rib-

bon before selecting pairs of objects. Although any discipline may opt to use the Monitor 

option, as was described earlier, this will require creating linked pairs of objects rather 

than copying in the object from the referenced model. Click the Finish button to com-

plete the operation.

How to Use

The process for each discipline begins in the same way, appropriately on the Collaborate 

tab (Figure 19.1). Click the Copy/Monitor button (Figure 19.2); you will be asked to make 

a decision about whether to use the current project or select a link.

Use Current Project is best used when multiple disciplines are working together 

within a single .rvt project.

Select Link is used when a project is using multiple, linked .rvt files. Using this will 

copy selected elements from within a linked project to the host project and monitor 

changes to these elements.

If you are using a linked project model from another discipline, you will want to 

choose Select Link. If you are working with multiple disciplines in the same .rvt project 

model, choose the Use Current Project command.

Copy /M onitor     O ptions    

Now you need to set up the options. To do this, click the Options button shown in 

Figure 19.3. The Copy/Monitor Options dialog box opens. Here you decide how or what 

objects will be copied or monitored, although no actual selection of objects is done at this 

point. This process merely defines the guidelines each discipline will follow when you 

select objects. On each tab (Figure 19.4) are columns called 

Original Type and New Type. The Original Type column 

shows all the element types in the linked file (or host if you 

Figure 19.1
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selected the Use Current Project option), and the New Type column allows you to control 

which type will be used from the host project model. You can match the same element 

types or map these to another type based 

on your situation.

An example of where you might want 

to change the mapping of the original type 

to a new type is between the architect and 

structural engineer. The structural engi-

neer is not concerned with the individual 

elements of a wall, such as finishes or air 

gaps. The engineer’s main concern is the 

overall dimensions of the wall and/or spe-

cific structural core materials. Using the 

mapping, the engineer is able to substitute a 

more generic wall without all the detail that 

is required by the architect (Figure 19.5). 

The figure on the left shows what the engi-

neer would prefer to see, and the image 

on the right is the wall style the architect 

would like to use to display in the project. 

Another relevant example is using this 

to substitute structural columns in the same place as the nonstruc-

tural architectural columns. Similar decisions and mapping can 

be done for all the object types previously mentioned. Depending 

on which Revit application you have installed, the interface and 

options available vary slightly while the overall concept is the 

same. When you are done mapping the types, click the OK button.

The Coordination Review Tool
Once the Copy/Monitor process has been set up, this enables each 

discipline to run a report using the Coordination Review. The Coordination 

Review tool tracks the changes made in a report within the referenced model. This tool 

can prove to be invaluable in monitoring the changes that are occurring in the other 

models and providing the user with a variety of options on how to react to these changes.

This brings up another topic not directly related to utilizing the software. Who is responsible 

for actually performing the review—the lead architect or engineer? Or is this responsibility 

delegated to someone else on the team? Well, there is no one correct answer. This is some-

thing that must be decided within each design team, but it is a decision that should be made 

prior to starting a project. Incorporating this decision into your standard operating proce-

dure is essential to ensuring that projects will be successful.

Figure 19.4

Copy/Monitor 
Options dialog box 
showing Original 
Type and New Type 
columns

Figure 19.5

Complex wall (left) 
vs. simplified wall 
(right) for different 
disciplines
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The coordination review begins on the Coordinate panel of the Collaborate tab. 

Click the Coordination Review drop-down, and choose Select Link (Figure 19.6). Select 

the linked file within the project, and the Coordination Review dialog box will appear 

(Figure 19.7).

You now have a series of decisions to make. Depending on the object selected, differ-

ent Action options will appear. The general choices are fairly similar: Postpone, Reject, 

Accept Difference, or Move or Modify the object in your model. Typically you will move 

or modify the object to match the changes made in the linked model. You might use the 

Postpone option to do further research before making a decision on the changes made in 

the linked model. You go through the list of changes made 

in the linked model. If an item in the list is selected, Revit 

can open a view to actually show the objects that have been 

moved or modified if you choose the Show button in the 

bottom left of the Coordination Review dialog box.

As you make each decision, either the objects are modified in the current model to 

match and you accept the differences, or you reject the conditions shown in the linked 

model. Once you decide on all the changes, you should do one more thing before exit-

ing this process: create a report to notify the other people involved about exactly what 

changes have occurred.

The Create Report option generates an HTML file that can then be shared with other 

team members or printed out to keep an accurate record of the changes that have occurred 

throughout the project. This is a crucial step because when other members of the team 

open their model, Revit instantly updates each person’s file as the decisions are made. 

Without a copy of the report, other team members will not be aware of these changes.

Figure 19.6

Coordination 
Review button

Figure 19.7

Coordination 
Review dialog box 

of linked project
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The Interference Check Tool
As the design process proceeds, collaboration/coordination plays a crucial role in the 

decisions that are made. Is there suffi cient room between fl oors for the structure and the 

mechanical equipment? Are structural members interfering with architectural objects 

such as windows or doors? Numerous items could affect design decisions, and as the 

project proceeds, these items will become increasingly more important.

Revit allows you to perform periodic reviews to fi nd these confl icts before the actual 

construction documents are issued. This can prove to be invaluable, because problems 

are discovered in the design process rather than discovering these confl icts in the fi eld. 

This can provide savings in both time and money because this will result in fewer work 

stoppages and will avoid incurring additional costs for modifi cations that have to be 

managed in the fi eld. Revit provides a tool called Interference Check to locate and resolve 

these confl icts during the design process, thus allowing the design professionals to solve 

many of these problems earlier rather than later.

CO O r D I N aT I O N D E C I S I O N

To properly utilize this tool, once again the question arises, who will make the decisions when 

confl icts occur? In our experience, this person should be chosen prior to starting the project 

or standard operating procedure. Typically it should be the lead designer or team leader to 

ensure that the proper coordination occurs before a decision is made. Even among multiple 

disciplines, this involves coordination and agreement before a decision can be made. For 

instance, within the MEP environment, if a diff user and a light are both placed in the same 

position, which object will be moved? This is even further highlighted between disciplines 

when objects interfere with each other. Many times it is necessary to have a team meeting 

between all disciplines to perform the interference conditions so that a responsible party can 

be identifi ed to review and resolve these items. A timetable should be agreed upon prior to 

the project beginning to ensure that too much time does not elapse between such reviews so 

that the interference conditions do not become so numerous as to be unmanageable.

By now you should know where to fi nd the Interference Check tool—on 

the Collaborate tab’s Coordinate panel (Figure 19.8)! The one main differ-

ence is when you choose this tool, you are offered a choice to perform the 

interference check between your project and a linked model, or you can per-

form the check for objects within a single .rvt project model (Figure 19.9).

Select the boxes to indicate which items you want to include in the interference check; 

the selection for each pass should be limited to make the report useful. Once the objects are 

identifi ed, Revit will inspect the entire model or models for the conditions you selected. A 

report will be generated (Figure 19.10) that lists all of the interference conditions the soft-

ware has detected.

Figure 19.8

Interference Check 
button

CO O r D I N aT I O N D E C I S I O N

To properly utilize this tool, once again the question arises, who will make the decisions when 

confl icts occur? In our experience, this person should be chosen prior to starting the project 

or standard operating procedure. Typically it should be the lead designer or team leader to 

ensure that the proper coordination occurs before a decision is made. Even among multiple 

disciplines, this involves coordination and agreement before a decision can be made. For 

instance, within the MEP environment, if a diff user and a light are both placed in the same 

position, which object will be moved? This is even further highlighted between disciplines 

when objects interfere with each other. Many times it is necessary to have a team meeting 

between all disciplines to perform the interference conditions so that a responsible party can 

be identifi ed to review and resolve these items. A timetable should be agreed upon prior to 

the project beginning to ensure that too much time does not elapse between such reviews so 

that the interference conditions do not become so numerous as to be unmanageable.
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Much like the Copy/Monitor process, 

individual conflicts are identified and 

can be highlighted in the model. The 

individual performing the interference 

check can then proceed to fix the inter-

ference condition and refresh the list to 

remove the condition.

Also, like with the Copy/Monitor 

tool, you can generate a report by click-

ing the Export button at the bottom 

of the Interference Report dialog box. 

This provides a written record that can 

be reviewed at a later date.

Some of the more common uses for interference checks include:

Checking for interferences between the Current Project Walls and Current/Linked •	

Structural Framing

Checking for interferences between Current Project Air Terminals, Duct Fittings, •	

Ducts, and Current/Linked Structural Columns

Checking for interferences between Current Project Lighting Fixtures and Current/•	

Linked Structural Framing

Figure 19.9

Interference Check 
dialog box

Figure 19.10

Interference report
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Remember, certain logical decisions have to be made in order to use this tool effec-

tively and for the information to be meaningful. For instance, if the MEP engineer per-

forms an interference check on electrical devices and the walls in the architectural model, 

every instance where a light switch or receptacle occurs will result in an interference con-

dition with the wall. 

Exporting to Non-Revit Formats
Collaboration can mean many things, not only collaborating between multiple design 

software technologies but also working with external databases that are often used by 

other design professionals, contractors, and estimators. During the design process, 

individuals may want to extract information from the model in order to start creating 

preliminary estimates of materials or to utilize information from the model to perform 

more advanced calculations for design. The Revit platform allows you to extract this 

information in a format that can be utilized in almost every type of database software, 

such as Excel, Access, FileMaker Pro, SQL Server, and more.

Exporting to ODBC
Revit allows the user to extract any data from the tables in Revit directly to a database 

using the Microsoft Open Database Connectivity (ODBC) connector. This extraction  

of information can be an invaluable aid for engineers and estimators. Information such  

as length of walls or ducts, types of equip-

ment, or even materials can be extracted for 

use in external databases to be manipulated  

as needed.

To export to an ODBC file, you must first 

create a blank form in the database that you 

want to extract the information to. Once that 

is accomplished, return to Revit, and begin 

the extraction process as follows.

Open the application menu, and choose 

Export ➔ ODBC Database (Figure 19.11; note 

that you may need to scroll the menu down 

slightly to find the ODBC Database option). 

Then navigate to the folder that contains the 

blank form that was created previously. Revit 

extracts all the project and shared parameters 

to this database. Figure 19.12 shows a sample 

of ODBC data in an Excel spreadsheet.

Figure 19.11

Application menu 
and ODBC database 
export
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Once extracted, the design professional can then manipulate the information to utilize 

it for additional computations or estimating conditions. 

The ODBC export is in metric units only, regardless of project units, and may need to be con-

verted using database functions to display in another unit type.

This tool is of primary interest to contractors once the model is completed but can 

also be utilized by design professionals to perform additional computations during the 

design process. This tool is just another asset that Revit provides to ensure that design 

information is correctly passed to the individuals who need it without having to manu-

ally reenter the information, which allows for a much larger margin of error.

Exporting and Importing IFC
In a perfect world, all the teams involved in a project would be working in the Revit 

platform, but this is rarely the case in the real world. Firms often have their own reasons 

for utilizing different design software packages, and we still need a means to collaborate 

and coordinate with these designs also. The use of Industry Foundation Classes (IFC) as 

a vendor-neutral file format from buildingSMART allows for the exchange of intelligent 

data between architectural and downstream applications. The IFC format allows users to 

exchange three-dimensional information and object data as referenced information and 

for interference detection. This format is being constantly revised to allow better collab-

orative exchange of information.

Figure 19.12

Microsoft Excel 
ODBC information
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Exporting IFC

Revit allows you to export your IFC model for other members of the design team 

who may not be utilizing the Revit platform. Open the application menu, and choose 

Export ➔ IFC (Figure 19.13). At the bottom 

of the Export IFC dialog box that opens 

(Figure 19.14), you can choose to export the 

entire model or selected views, along with  

several other options.

Revit Architecture 2011 supports first-stage 

2×3 certification for import and export, as 

well as full (second-stage) IFC Singapore Code 

Checking (BCA) certification for export. For 

BCA, change the type from IFC 2×3 to IFC BCA 

ePlan Check, as shown in Figure 19.15.

Also, by selecting the application menu and 

choosing Export ➔ Options ➔ IFC Options, you 

can control the mapping of objects from Revit 

to the IFC file. Revit contains a file in the ship-

ping product called exportlayers-ifc-IAI.txt 

that includes a predefined mapping done to 

IAI standards as shown in Figure 19.16.

Figure 19.13

Exporting IFC  
information

Figure 19.14

Export IFC  
dialog box

Figure 19.15

IFC export to BCA
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You will find times when an adjustment to the default mappings will be needed. In this 

example, the walkway would be created using the Generic Models Category and created 

with a subcategory called Moving Walkway. When the project is exported, you will want 

to make sure that the moving walkway is correctly mapped to IfcTransportElement and 

the type to IfcTransportElementType within the mapping file. Setting this up and saving 

the configuration will allow for changes to 

be maintained and reused during future file 

exchanges.

Importing IFC

A similar process is available from the main 

application menu to insert IFC information  

into the current Revit model. This tool allows 

IFC objects to be inserted into the Revit model 

that can then be utilized as backgrounds, 

sections, or interference conditions. First 

choose the application menu, then choose 

Open ➔ IFC (Figure 19.17), and finally browse 

to the IFC model.

When importing IFC files, you may find 

that you need to make some adjustments to 

the mapping file to ensure objects are placed 

Figure 19.16

IFC export mapping

Figure 19.17

Opening an IFC file 
and class mappings
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into the correct category. To do this, use the application menu, and choose the Open ➔ 

IFC Options command.

A Final Note on IFC Files

Moving data between different software packages is not 100 percent seamless. Although 

it is true that the use of IFC files can aid in this, the best workflow to keep 100 percent 

fidelity of all data and relationships is to work within the original software in which they 

are created. No IFC file will be as complete and robust as the original file format in which 

it was created. Understanding this now will prepare you for potential data loss that could 

occur if you rely on the IFC file format for a complete transfer. We could write an entire 

chapter on the use of IFC files; our goal in this book is to make you familiar with certain 

key features within Revit and how best to take advantage of using them. You can find 

additional details on IFC files at www.buildingsmart.com/bim.

Exporting and Managing DWF Files
As the project progresses, it is often necessary to share the model with individuals who 

do not have access to any CAD programs or those who may merely want to view the 

model. This is just another part of the collaboration process, but it is often a crucial step. 

Autodesk has provided the means to export the Revit model to non-Revit users. Revit 

has two separate tools for exporting the model: DWF and DWFx. The DWF format is for 

users who have downloaded the free Design 

Review software from the Autodesk website. 

The DWFx can be utilized for users who are 

on the Vista or Windows 7 operating system 

natively or for XP users who have downloaded 

Microsoft’s XPS Viewer. Utilizing these tools, 

a user can export 2D or 3D data that can be 

viewed and printed without needing a copy of 

Revit. Utilizing the Design Review software, 

an individual can also measure distances, 

areas, and query objects within the DWF and 

DWFx files.

This process begins by opening the appli-

cation menu and choosing Export ➔ DWF 

(Figure 19.18). From the dialog box that opens 

(Figure 19.19), you can select the views or 

sheets to be exported in addition to several 

other options.

Figure 19.18

DWF/DWFx export
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On the View/Sheet Set tab, you can choose to export individual views, sheet sets, or 

any specific combination that you want. You will notice in Figure 19.19 that you can 

adjust what is output in the Export list. The options include the following:

<Current View/Sheet Only>, based on what is being worked on in the current view•	

<In Session View/Sheet Set>, based on the current active project•	

Views in the set•	

Sheets in the set•	

All views and sheets in the set•	

Views in the model•	

Sheets in the model•	

All views and sheets in the model•	

Based on these options, you have a full level of control on which views and/or sheet 

combinations you want to include in your DWF.

Click the DWF Properties tab (Figure 19.20). Here, you can choose to export element 

properties, which allows the end user to query objects in the DWF file. In addition, you 

can export room and area boundaries to the DWF file to allow the recipient to query 

square footages. Some facilities management software can also take advantage of the 

room and area boundaries information; without selecting this option, the room and area 

boundaries information is omitted and will be of limited value to facility managers.

You can also choose to compress the file to make it smaller and change from a vector 

output to a raster output, which will reduce the quality of the DWF file.

Figure 19.19

DWF Export Set-
tings dialog box
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The last tab, Project Information (Figure 19.21), allows you to include basic informa-

tion about the project being exported. The DWF file format is much smaller than a Revit 

file so that it can easily be shared with others over standard exchange protocols (email, 

FTP, portal, and so on).

Choosing Next in the DWF Export Settings dialog box will return you to the Export 

dialog box. Adjust the file type to either DWFx or DWF (Figure 19.22). A check box is 

available to either combine the output into a single file or to make use of multiple indi-

vidual files. Naming for this is based on the following naming options.

Figure 19.20

DWF Export  
Settings: DWF  
Properties tab

Figure 19.21

DWF Export  
Settings: Project 
Information tab
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Automatic – Long (Specify Prefix)  ​If you choose this option, it applies the view or sheet 

name (based on what you are exporting) to each of the exported views in the DWF file. 

When this is chosen, the File Name/Prefix text box is available and allows you to enter  

a prefix for all the files (for example, including the project name, issue date, revision  

version, and so on).

Automatic – Short  ​If you choose this option, it grays out the File Name/Prefix text box 

and uses the name of the view or sheet only.

Linking DWF Markup

The DWF format is a very versatile and powerful tool that has advantages over other 

exchange file formats in use today. A reviewer or checker can redline or mark up the 

DWF file with corrections and/or additions and send it back to the Revit user. The Revit 

user then has the option of inserting the marked-up DWF into the Revit model to use  

as a background to see the actual changes or additions 

that need to be addressed. This can serve as a valuable tool 

to ensure that all corrections are made and tracked. This 

command is available on the Insert tab of the Link panel 

(Figure 19.23).

If you click DWF Markup, the DWF file is then inserted automatically as an imported 

symbol within the matching sheet so you can use it as a visual tool to assist in reviewing 

with the Revit model. The markups are pinned in place so you cannot accidentally move 

or manipulate them.

When you insert the DWF markup, you are presented with a mapping legend 

(Figure 19.24) that indicates the DWF views and their matching Revit project sheet views. 

If any of these are not synchronized correctly 

(possibly by changing the view names since 

the DWF file was originally created), you 

can manually choose the right match using 

the Revit View drop-down.

The round-tripping DWF markup capa-

bility displays only for the sheet view and 

will not display within the individual views.

Figure 19.22

Export dialog box

Figure 19.23

DWF Markup button

Figure 19.24

Inserting the DWF 
markup mapping



Exporting to Non-Revit Formats  ■   489

Exporting 2D and 3D CAD
The DWG file format is the most popular file standard used in the industry. At some 

point in your project, a member of the extended team will not be using the Revit plat-

form and will require a DWG to work directly or to use as a reference background. Revit 

has the capability to output DWG files and includes a large number of advanced options 

to get the desired output.

By selecting the application menu 

and then choosing Export ➔ CAD 

Formats ➔ DWG Files or DXF Files 

(Figure 19.25), you can choose to 

export the entire model or selected 

views, along with several other 

options.

When exporting the CAD for-

mats, the interface will be familiar; 

it’s similar to the DWF export 

options for the View/Sheet Set 

tab (Figure 19.26). The real dif-

ference and options can be found 

on the DWG/DXF Properties tab 

(Figure 19.27), which provides 

you with advanced options for 

exporting.

Figure 19.25

Application menu 
and DWG export

Figure 19.26

Export CAD Formats: 
View/Sheet Set tab
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Layer And Properties  ​This determines what happens to a Revit element if it has attributes 

that differ from those defined for its object style category. In AutoCAD 2011 and Revit 

Architecture 2011, view-specific element graphics are referred to as overrides. This option 

allows you to control how categories are exported and to specify their layer controls. The 

override options depend on the overrides you have set in the individual views that you 

are exporting. If there are no view overrides defined in the exported view, the choices 

given will not change your export. There are three values listed in the drop-down:

Category Properties BYLAYER, Overrides BYENTITY will export a Revit element with 

view-specific graphics, and in AutoCAD the differences (overrides) are applied to the 

individual entity, though the entity resides on the same layer as other entities in the 

same Revit category or AutoCAD layer.

All Properties BYLAYER, No Overrides will export a Revit element with view-specific 

graphics, and in AutoCAD the differences (overrides) are ignored. The entity resides 

on the same layer as other entities in the same Revit category or AutoCAD layer. This 

method generates the smallest number of layers and ensures BYLAYER control over 

the entities in the exported DWG file.

All Properties BYLAYER, New Layers For Overrides will export a Revit element with 

view-specific graphics, and in AutoCAD the entity is placed on its own layer. This 

method provides BYLAYER control over the entities in the exported DWG file. Using 

this approach will also increase the number of layers in the exported file based on the 

number of overrides found (one layer for each override).

Colors (new in 2011)   ​There are two values listed in the drop-down: 

Index Color (255 Colors) uses the indexed colors and pen widths, as specified in the 

Export Layers settings, for colors that are set by category. When colors are not set  

Figure 19.27

Export CAD  
Formats: DWG  
Properties tab
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by category and the overrides are preserved in the export, Revit uses the closest 

match from the 255 indexed colors and may not provide an exact RGB or Pantone 

color match.

True Color (RGB Values) uses the RGB value from Revit for the ByLayer and ByEn-

tity parameters, rather than the indexed color from the Export Layers settings. For 

example, if you export room or space color fills, the colors in the exported file will 

match the exact color used in the original file.

Linetype Scaling  ​This control sets your paperspace line type setting in AutoCAD 

(PSLTSCALE) to either 0 or 1 or scales the line types by definition. This setting ensures 

visual fidelity between the line type scales used in Revit and those in the exported DWG 

file. There are three choices listed in the drop-down:

Scaled Linetype Definitions•	

Modelspace (PSLTSCALE = 0)•	

Paperspace (PSLTSCALE = 1)•	

Coordinate System Basis  ​This lets you choose between a project-internal or shared- 

coordinate system. Ultimately it sets an origin point (0,0,0) for the DWG CAD file based 

on the selected coordinate system (either by the internal project 0,0,0 point or by the shared 

coordinates between multiple project files). There are two items listed in the drop-down: 

Project Internal and Shared.

One DWG Unit Is  ​Traditional CAD applications, like AutoCAD, typically use measure-

ments in scaling units. Revit uses real dimensions when creating your project. These 

options allow you to correlate export units with Revit data. There are five items listed in 

the drop-down that you can choose from:

Foot•	

Inch•	

Meter•	

Centimeter•	

Millimeter•	

Text Treatment (new in 2011)  ​There are two methods listed in the drop-down that control 

how text notes are exported: 

Maintain Visual Fidelity for exported text will look exactly like it does in Revit (using 

exact line wrapping). If the text has any special formatting, bullets, or numbered 

lists, the paragraph functionality will be lost on export.

Maintain Functional Fidelity for exported text will include bullet and numbered lists, 

and the visual appearance of the text may vary slightly from the original, whether or 

not the note contains a list (wrapping may vary).
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Solids (3D Views Only)  ​If you have any view other than a 3D view open, this option will 

be grayed out. With a 3D view active, you can export to one of two types: Export As 

Polymesh or Export As ACIS Solids.

Export rooms and areas as polylines  ​Selecting this box means that if you are exporting 

rooms or area elements, the lines that represent the outside boundaries will use polylines 

rather than normal lines (the default option). 

Save To Target Folder  ​Choose Next in the dialog box, and you will be presented with 

additional options (Figure 19.28) that include the following:

File Name/Prefix•	

Files Of Type•	

Naming•	

Xref Views On Sheets check box•	

Naming Automatic – Long (Specify Prefix)  ​If you choose this option, it enables you to 

manually specify a prefix in the File Name/Prefix field or accept the default, which 

uses this format: Revit Sheet/View: Project Name-View Type-View Name.

Naming Automatic – Short  ​This enables Revit to automatically determine the name and 

adds a prefix to the filename of the current view or multiple views and sheets, which 

uses this format: Revit Sheet: Sheet Name or Revit View: View Type-View Name.

When exporting multiple files, for File Name/Prefix, enter a common prefix for the 

exported files. For example, if you are exporting the Level 1 floor plan and south 

Figure 19.28

Save To Target 
options
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elevation views to .dwg files and use the prefix Quidditch Stadium, the resulting 

exported names are Quidditch Stadium Elevation South.dwg and Quidditch Stadium 

Floor Plan Level 1.dwg.

A check box is available to allow external references (Xrefs) to be generated of the 

views and referenced on the sheet(s).

Exporting to gbXML
Green Building XML (gbXML) is an XML data type created to support the growing 

trend of sustainability and green building design. Two of the more common uses of the 

Revit model are for energy analysis and evaluating building performance, and Revit 

has tools to assist in this process. The Revit model can be exported to gbXML easily 

and imported into a wide variety of external analysis programs, such as IES, TRANE 

TRACE, HAP, and Autodesk Ecotect. (Later releases of the Revit software now have 

an export function that ties directly to Autodesk Green Building software, so gbXML 

export is not needed in that case.)

The amount of information extracted will vary depending on the external analysis 

software being utilized. For example, if TRANE TRACE is used, the only information 

exported is information concerning the room area, volume, and 

amount of glass or door areas. This information still provides the 

user with a great time-saver from having to manually enter this infor-

mation into TRANE trace. If the user is in Revit MEP, the design 

information from TRANE trace can be imported into the Revit 

model and utilized within Revit to assist in the design of the HVAC 

systems necessary for the model. Similar workflows exist for the other 

analysis programs.

Click the application menu, and choose Export ➔ gbXML 

(Figure 19.29) to open the Export gbXML dialog box (Figure 19.30) 

where you can choose to export the entire model, along with several 

other options.

You can also enter information about the project, such as the 

building type per ASHRAE, the phases, and how to export the geom-

etry (either as simple with surface shading or several other complex 

options). The Details tab allows you to examine the room areas being 

exported either as a complete unit (the room option) or by analytical 

surfaces to ensure they have been modeled correctly.

Once this information has been exported to the various external analysis programs, 

further energy calculations can be performed.

Figure 19.29

Export gbXML
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Exporting to 3ds Max (FBX)
Another common use of the Revit model is for visualization, and although Revit can 

provide an excellent rendering of the model, there are times when more effects- and  

rendering-specific tools are desired and where the use of Autodesk 3ds Max can be 

a great companion. Additionally, 3ds Max 

allows you to deploy rendering farms, which 

greatly decreases the amount of time neces-

sary to render the Revit model. The Revit 

platform allows for a direct translation into 

3ds Max, which allows the materials assigned 

in Revit to translate 100 percent to 3ds Max 

during the export. By providing this direct 

export, Revit helps expedite the rendering 

process.

The workflow to achieve this is to open a 

3D view in Revit. Once this is done, go to the 

application menu, and choose Export ➔ FBX 

(Figure 19.31). The active 3D view is then 

exported in a format that can be directly 

imported into 3ds Max.

Figure 19.30

Export gbXML  
dialog box

Figure 19.31

Export FBX
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Exporting Room and Area Report
Space planning plays a very large role in the design of buildings to ensure that the correct 

amount of square footage is allocated to individual departments either for renting out a 

space or for programming in the beginning of a project to ensure each department has 

enough space to accommodate its needs. Revit Architecture has a very valuable tool that 

is often overlooked by many users. Although many architects use the Room tool to help 

develop the database for these reports, issues can arise for the MEP engineer as rooms 

are divided up into work areas rather than actual rooms that the MEP engineer needs 

to calculate for correct lighting, HVAC, and power requirements. By utilizing the Room 

Separation Line tool, the architect can divide up rooms for programming and still allow 

the MEP engineer to utilize the rooms for his calculations. The architect can provide a 

visible graphic and a schedule that can be used for space planning.

The Room Separation Line tool is available on the Home tab in the Room & Area 

panel (Figure 19.32). 

You have the option of calculating areas by gross or rentable area. Additionally, you 

have the option of allowing the software to automatically calculate the area or manu-

ally create the area boundaries. If the manual option is selected, 

you then create closed polylines for each of the areas you want to 

defi ne. Once the polylines are created, you can insert an area tag that 

reports the area’s name and square footage (Figure 19.33).

Once these are placed, you can insert a graphic legend to assist 

the architect in displaying the space allocated to each department 

(Figure 19.34).

Schedules can be generated from this information, and if the 

walls are moved, the information is automatically updated.

Room/Area Report is a tool that creates a graphical and math-

ematical HTML report as proof of the digital 

calculation of rooms in your project. (Some 

authorities in Europe and Asia require these area 

reports as part of permit documentation.) Each 

room surface is divided into basic geometrical 

shapes (arc segments, rectangles, triangles), and 

each shape is described with a name that, in 

the table, has the geometrical formula used to 

calculate area (Figure 19.35). To use it, go to the 

application menu, and choose Export ➔ Reports ➔ 

Room/Area Report.

Figure 19.32

Room & Area panel

Figure 19.33

Area and area tag

Figure 19.34

Rentable area and 
legend
Rentable area and 
legend
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When exporting, you can customize the look and feel in the Area Report Settings dia-

log box (Figure 19.36) by clicking the Options button. A key item to consider in this loca-

tion is the Report Window Area As Percentage Of Room Area check box. Selecting this 

will display the windows as a percentage of the room area instead of an overall square 

footage value.

Figure 19.35

Triangulation room: 
area report

Figure 19.36

Area Report  
Settings dialog box



A
Absolute (Path Type) setting, 329
acad.pat file, 351
accelerators, keyboard, 14, 14
Action options for Coordination Review 

tool, 478
Active Dimensions tool, 117, 117
Active Only tool, 13, 394–395
active projects, groups in, 242
active state in View Cube, 18
active work planes, 190–191, 191
Adaptive Component.rft template, 218
Add Elbow control, 49, 63
Add Filters dialog box, 31, 159
Add Parameter option, 211, 211, 213
Add Parameter(s) To Label icon, 364, 366
Add Point tool, 98
Add/Remove buttons, 4
Add Soffit.rvt file, 113
Add To Design Option Set dialog box, 

394, 395
Add To Quick Access Toolbar option, 4
Add To Set button, 394
Add tool for groups, 237
AddCeiling.rvt file, 99
AddCeilingComp.rvt file, 102
AddDoor.rvt file, 92
AddFloor.rvt file, 96
AddMullions.rvt file, 91
Adjust Exposure dialog box, 254–255
Adjust for Mullion Size property, 88
Aligned Dimension tool, 210, 210
Aligned dimensions, 122, 122, 124
alignment and Align tool

3D Control objects, 208, 208
extrusion forms, 193, 194
families, 427, 429, 430
light fixtures with ceiling grid, 

102–103, 103
loadable mass families, 221–222, 221
objects, 59–60, 60
titleblocks, 364
views on sheets, 378–379, 378–379

All Except Picked option, 89
All Grid Lines tool, 94
All layers option, 284
All Objects In Current View option, 319

All Properties BYLAYER, New Layers 
For Overrides setting, 490

All Properties BYLAYER, No Overrides 
setting, 490

All Segments option, 89
All Views And Sheets In The Model 

option, 290
All Views And Sheets In The Set  

option, 290
Alphabetic revision numbering, 468, 468
Alternating Tread Device.rfa family, 180
Analysis Display Style property,  

144–145, 144
Analytical (RS) feature, 436
Angle option, 56
angles

dimensions, 116
rotating objects, 56

Angular Dimension Snap Increments 
setting, 47, 119

Angular dimensions, 122, 123
Annotation Categories tab, 29, 29,  

149, 277
Annotation Crop setting, 22, 146, 147, 

376–377, 377
Annotation tab, 468, 468
Annotation Line Weights tab, 348
Annotation Objects tab, 137
annotations and Annotate tab

bidirectional, 116
categories, 29, 29, 149, 277
crops, 22, 33, 34, 146, 147,  

376–377, 377
design options, 398–400
detailing, 339–342, 345
dimensions 121, 121
families, 168
filled regions, 350–351
keynotes. See keynotes
legends, 42
masking regions, 352
revision clouds, 468, 468
schedules, 321
tags, 316–318, 320
text, 353–354
tools, 6

Appearance tab, 322, 371, 372
application menu, 3–5, 4

Apply Default View Template option, 
161, 161

Apply Hide/Isolate To View option,  
35, 137

applying
design options to views, 395–398, 

395–397
materials, 267, 267

Arc length dimensions, 122, 123
Arc option for grid lines, 62
Architectural columns, 64
Architectural discipline, 143
arcs

grid lines, 62
length, 122, 123
symbolic, 453–454, 454

Area parameter, 70
Area Report Settings dialog box, 496, 496
Area Tag option, 317
areas, 299

plans, 308–310, 309–311
rentable, 311–313, 312–313
room and area reports, 495–496, 

495–496
tags, 317
walls, 70

Arrange tab, 339
Array tool, 56–57, 226, 226
arrays

face-based modeling, 226, 226
objects, 56–58, 57

Artificial Lights dialog box, 258–260, 
258, 260

Artificial Only option, 257
As Underlay option, 140
Assembly Code parameter, 72
Assembly Description parameter, 72
assigning

keynotes, 331, 331
materials

to elements, 266–267, 266
to families, 444–445

phases, 406, 406
Associated Level property, 22, 147, 147
associating views with levels, 44
At Least option, 310
At Library Locations (Path Type)  

option, 330

Index
Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a topic. Italicized 
page numbers indicate illustrations.
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Attach tool for groups, 238
Attach Top/Base button, 114
Attached Details

groups, 236, 246
imported files, 272

attaching walls to roofs, 110, 110, 
112–113, 113

AttachWalls.rvt file, 112
Auto - By Shared Coordinates  

option, 271
Auto - Center to Center option, 271
Auto-Detect option, 285
Auto Dimension Options dialog box, 

121, 121
Auto - Origin to Origin option, 271, 428
AutoCAD

details in, 356
DWF files. See DWF file format
DWG files. See DWG file format
federated model approach, 11
layers, 73
line types, 491
overrides, 490
pattern files, 350–351

Autodesk Seek site, 339
Automatic Ceiling button, 99
automatic curtain grids, 89
automatic dimensions, 434–435
automatic display, 390
Automatic - Long (Specify Prefix) 

option, 290, 297, 387, 487
Automatic - Short option, 291, 297,  

387, 487
Automatically Embed option, 81, 88
AXIS Line tool, 439

B
background

color schemes, 144
setting, 261–262, 261–262

Background Image dialog box, 262, 262
Background setting, 144
Bar Joist family, 450, 451
Base Constraint setting, 70, 84
Base Extension Distance setting, 70
Base is Attached setting, 70
Base Offset setting, 70
based families, 419–420, 419–420
baseline dimensions, 124–125, 124–126
basic walls, 65–69, 66–69
Basic Wheels option, 20
Basics tab, 163, 165, 274–277, 274, 276
BCA (Singapore Code Checking) 

certification, 483
Best quality rendering, 253
bidirectional annotations, 116
BIM (building information  

modeling), 421

Bind Link button, 244
Bind Link Options dialog box, 244, 244, 

272, 272
Bind Links command, 272
Bind tool, 244, 244
binding groups, 244, 244
Black And White color option, 284
blends, 435, 438, 438, 441, 441
blue circles for grid lines, 63
blue solid grips for text boxes, 354
blue squares for grids, 49, 63
blue triangle grips for families, 428, 428
Border 1 Type property, 88
Border 2 Type property, 88
Bottom plane, 152–153
bound space, 300
boundaries

filled regions, 350
phase-specific, 407–408, 408
walls, 75–76, 75

Boundary and Run mode for stairs, 104
Boundary Line tool, 439, 439
branches for families, 169
Browser Organization Properties dialog 

box, 381, 381
building elements, 184
building information modeling  

(BIM), 421
Butt joins, 78, 78
buttons on ribbon, 7–8, 7–8
By Category option, 404
By Filter option, 24
By Host View option, 274–275, 274, 277
By Keynote (Numbering Method) 

option, 330
By Linked View option, 275, 275, 277
By Sheet (Numbering Method) option, 

330, 330

C
C14-SP.txt file, 368
cabinetry, 419
CAD files

DWF. See DWF file format
DWG. See DWG file format
exporting to, 489–493, 489–490, 492
formats, 283
links, 280
titleblocks, 361–362, 361

Calculated Value dialog box, 326, 326
callout views, 41, 41
Camera groups, 149, 149
cameras

in phasing, 149, 149
rendering, 251–252, 251–252
steering wheel, 20, 20

Cancel tool for groups, 238
Cancel Mass tool, 194

cars, 267
casework as loadable family, 172
Catch-all category, 418
categories

families, 169, 417–419, 417, 444
visibility, 24, 136

Category option, 24
Category Properties BYLAYER, 

Overrides BYENTITY setting, 490
ceiling fans, 177, 177, 419, 420
Ceiling tool, 99
ceilings

component placement on,  
102–103, 103

creating, 98–102, 99–102
plans, 35–37, 36–37

Ceilings tab, 99
Center - Ends Arc tool, 108, 202
Chain option

selections, 51, 51
walls, 67

Check All option, 290
Check None option, 290
children of linked files, 273
Choose Space Type And Color Scheme 

dialog box, 309, 312
classes, families, 169–173, 170–173
Clean All Wall Joins option, 143
Clean Same Type Wall Joins option, 143
Clipboard panel, 66
Close Wheel option, 20
clouds

revision, 466–470, 467–470
sky, 261, 261

clues, ribbon, 8, 8
Coarse detail level, 140, 143
Coarse Scale Fill Color parameter, 72
Coarse Scale Fill Pattern parameter, 72
Collaborate tab, 6, 282, 476, 476, 478–479
collaboration, 473

coordination across disciplines. See 
coordination across disciplines

exporting to non-Revit formats.  
See exporting

color
areas, 309–310, 309
background, 261
constant, 268
DGN files, 293–294
DWG files, 284, 287–288, 292, 

490–491
fills, 276–277
schemes, 22, 144, 144, 310

Color Fill setting, 276–277
Color Scheme property, 22, 144, 144
Color Scheme Location property, 22, 

144, 144
Colors Not Preserved box dialog box, 310
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Colors setting, 284, 292, 490–491
column buttons, 8
columns

adding, 64
families, 462–464
grids, 61–65, 62–64
visibility and material settings, 

462–464
Combine Selected Views And Sheets Into 

A Single File option, 297, 387
Comments parameter, 70
CompanyLogo.jpg file, 362
compass ring in View Cube, 18
complexity

families, 451, 451
groups, 245

Component tool, 180
components

detailing, 337–339, 337–339
families, 169, 172

Conant, David, 429
conceptual design environment, 184
Conceptual Mass Family Editor, 223
Conceptual Mass panel, 185–186,  

185, 231
Concrete material, 264, 264
Configuration Options bar, 79
consistency in family parameter  

names, 433
Consistent Colors visual style, 13,  

141, 141
Constant Colors style, 268
Constrain setting

arraying objects, 57
moving objects, 54

constraints, equality, 127–130, 127–129
controls, ribbon, 7–8, 7–8
Convert Lines tool, 437
Convert To Link dialog box, 243, 243
converting

groups to links, 243, 243
line styles, 437
linked files to imports, 272
solid forms to void forms, 205, 205
temporary dimensions, 119–120, 120

Coordinate System Basis setting, 292, 491
coordination across disciplines, 474

Coordination Review tool,  
477–478, 478

Copy/Monitor tool, 474–477, 
476–477

Interference Check tool, 479–481, 
480–481

responsibility for, 479
Coordination discipline, 143
Coordination panel, 282
Coordination Review dialog box,  

478, 478

Coordination Review tool, 477–478, 478
Copy/Monitor Options dialog box, 

476–477, 477
Copy/Monitor tool, 474–477, 476–477
Copy option

grid lines, 63
rotating objects, 56

Copy tool, 55
copying

grid lines, 63
objects, 55, 55

core boundaries, 75–76, 75
Core Centerline plane, 67, 67
Core Face Exterior plane, 67, 67
Core Face Interior plane, 67, 67
Cost parameter for walls, 72
Counter Top-L Shaped w Sink.rfa  

family, 181
Course detail level, 32, 32
CPS viewer, 294
Create A Shared Parameter File dialog 

box, 365
Create Ceiling Boundary tab, 101
Create Filled Region Boundary tab, 350
Create Floor Boundary tab, 96–97
Create Floors option, 228
Create Form tool, 216

extrusion forms, 193
loadable mass families, 220
void forms, 204

Create Group dialog box, 237, 237
Create Group tool, 236–238
Create Instance option, 238, 239
Create panel, 66
Create_Plans.rvt file, 36
Create Report option, 478
Create Roof Footprint tab, 109, 111
Create Roof option, 230
Create Roof Soffit Boundary tab, 113
Create Similar tool, 239
Create Stairs Sketch tab, 104, 106, 108
Create View Template From View option, 

160, 160
CreateRoof.rvt file, 109
CreateStair.rvt file, 104, 106, 108
Crop Region On/Off option, 13
Crop Region Visible setting, 22, 33, 34, 

146, 376
crop regions

sheets, 376–377, 376–377
working with, 33, 34

Crop View option, 22, 33, 251, 376
cropping

annotations, 22, 33, 34, 146, 147, 
376–377, 377

views, 146, 146–147
cross section shapes and profiles, 191

description, 184

extrusion forms, 193, 193
loft forms, 195–196, 195–196
revolve forms, 199, 199
sweep forms, 200, 201

crossing windows
face-based modeling, 231
selections, 50

CSI format, 338
Ctrl+clicking for selection, 50
Current View Only option, 284
Current View/Sheet Only option, 289
Curtain Grid tool, 87
Curtain Panel property, 88
Curtain System By Face tool, 229, 230
curtain systems

description, 225
mass, 229, 230

Curtain Wall Dbl Glass.rfa file, 92–93
Curtain Wall type, 87–88, 87
curtain walls, 65

creating, 87–89, 87–89
doors for, 92–94, 93
exterior glazing and storefront, 

94–96, 94–96
grids, 89–90, 89–90
jambs, 336, 336
mullions, 90–92, 91–92
vs. windows, 81

Custom option
filled regions, 351
linked files, 163, 164, 276–277, 276

Custom Factor option, 285
Custom Image option, 262
Custom rendering quality, 253
Customize Quick Access Toolbar dialog 

box, 4–5, 4
Cut Geometry tool

families, 443, 443
void forms, 205
walls, 81–82

Cut option for filters, 31
Cut Patterns Override option, 31
cut planes, 152–153
Cut representation for families, 417
cylindrical extrusion forms, 193, 194

D
Dataset 1301.rvt file, 338
Dataset 1302.rvt file, 340
datum

defined, 44
for dimensions, 124
families, 168, 168

day rendering, 250–253, 251–252
decals, 268
dedicated views, 390
Default 3D View tool, 149
Default City List, 252
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default.rte template, 2, 153, 191
Default View Template option, 22, 145
defaults

current phase, 405
templates, 191

Define Location By option, 252
Defines Origin setting, 428
Defines Slope option, 110
deleting

constraints, 128
dimensions, 130
groups, 245

Demolish tool, 411, 411
Demolished state in phases, 405
demolishing elements, 411, 411
Depth Clipping dialog box, 148, 148
Depth parameter for families, 438
Description setting

materials, 319–320, 319
walls, 72

design options, 389
applying to views, 395–398, 395–397
defined, 390
editing, 393–395, 393–395
primary, 395–398, 395–397
setting up, 392, 392–393
tags and annotation in, 398–400
terminology, 390–391, 391

Design Options control, 13, 13
Design Options dialog box, 13, 392–393, 

392–393, 397
Design Options tab, 395, 395
Design Web Format (DWF) file format. 

See DWF file format
Detail groups, 236
Detail Items tab, 344
Detail Level setting, 151, 151

By Host View, 275
instances, 21
linked files, 276
View Control bar, 12

detail levels
families, 421–422, 422–423
views, 32–33, 32–33

Detail Line tool, 345
details and detailing, 335

components, 337–339, 337–339
and drafting views, 336–337, 336
embedding in families, 343–345, 343
filled regions, 350–351, 350–351
insulation, 349–350, 349
legend components, 341–343, 

341–342
libraries for, 355–358, 357
lines, 345–346, 346

editing, 346–347, 347
line weight plotting, 348, 348
overriding, 349
patterns, 348, 348

masking regions, 351–352, 352
repeating, 340–341, 340–341
text, 352–355, 353–354
tools, 345

DGN files, 293–294, 293–294
DGN Properties tab, 293, 294
dialog launcher buttons, 7, 7
Dimension setting, 85
Dimension String Type setting, 125
Dimension Text dialog box, 127, 127
Dimension tool for families, 427
dimensional editing, 209–210, 209–210
Dimensional Parameters.rvt file, 215
dimensions

automatic, 434–435
Equality Constraint option, 127–130, 

127–129
faking, 53
families, 433–435
leaders, 85
levels, 46, 47
lines, 346
listening, 52–53
locking, 128–130, 128–130,  

429–430, 430
parameters, 211–212, 212

creating, 212–215, 213–214
testing, 215–217, 215–218

permanent. See permanent 
dimensions

spot, 130–131, 130–131
temporary. See temporary 

dimensions
text overrides, 126–127, 126–127
titleblocks, 360
units, 132, 132–133
viewing, 53

Dimming field, 261
Disallow Join option, 79
Discipline setting

description, 22
Graphics group, 143–144, 144
linked files, 276

Disjoin option
moving objects, 54
rotating objects, 56

display for mass objects, 185–186, 
185–186

Display Model property, 21, 140, 140
Dissolve tool, 222, 222
distances. See dimensions
DLH-Series Bar Joist.rfa family, 180–181
Do Not Display option, 140
Do Not Duplicate Existing Views  

option, 37
Do Not Show Me This Message Again 

option, 186
doors

creating, 84–86, 85–86

curtain walls, 92–94, 93
families, 169, 172, 172
properties, 86
schedules, 320, 321
with variable swing angle

creating, 452–454, 453–454
nesting, 454–459, 456–459

Doric Column.rfa family, 462
Draft rendering quality, 253
drafting views

creating, 41
and detailing, 336–337, 336

Drag Wall End controls, 53, 53
Draw option for grid lines, 62
Draw Mirror Axis option, 59
draw order in detailing, 339
Draw panel, 66
drawing area, 12

Status bar, 13–14, 13
View Control bar, 12–13, 12

drawing lists, 321
Drawing Unit setting, 292
driving points, 190, 190
drop-down arrows, 8, 8
drop-down buttons, 7–8, 8
Duplicate As A Dependent option, 27, 35
Duplicate Group Names dialog box, 

244, 244
Duplicate option for views, 26, 26, 35
Duplicate View option, 26, 26
Duplicate With Detailing option, 27, 

35, 398
duplicating views, 35
DWF Export Settings dialog box, 295–296, 

295, 384–386, 384–386, 485–487, 
486–487

DWF file format
exporting, 294–297, 295–296,  

485–488, 485–488
link management, 280
linking, 297
markup linking, 488, 488
sheets, 383–387, 384–386

DWF Markup option, 488
DWF Markup tab, 280
DWF Properties tab, 295, 295, 384–385, 

385, 486, 487
DWFx files, 294, 383
DWG file format, 283

exporting, 287–292, 288–291, 489–493, 
489–490, 492

fonts, 286–287
imported, 161
line weights, 285–288, 286
linking and importing, 283–287, 

284, 286
DWG Properties tab, 291, 291,  

489–490, 490
DXF files, 285
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E
E1 30 x 42 Horizontal.rfa family, 373
earth patterns for filled regions,  

350–351, 350
edges

dimensions, 217, 217–218
editable, 207
Shaded with Edges style, 13, 141, 141
Silhouette Edges feature, 141, 142

Edit Assembly dialog box
ceilings, 100
details, 344
stacked walls, 83–84, 83
walls, 73–77, 73–74, 77

Edit Boundary button, 97
Edit Color Scheme dialog box, 309–310, 

309–310
Edit Extrusion option, 442
Edit Family option, 223, 231
Edit Group toolbar, 237
Edit In-Place option, 217
Edit Label dialog box, 363–364, 363, 366
Edit Profile option, 440
Edit Profile tab, 79
Edit rendering quality, 253
Edit Schedule option, 324
Edit Selected option, 398
Edit Shared Parameters dialog box, 365, 

365, 368, 368
Edit Type option

dimensions, 124, 124
walls, 72, 72

Editable Only control, 14
editing

design options, 393–395, 393–395
detail lines, 346–347, 347
dimensional, 209–210, 209–210
forms, 206–210, 207–211
lights, 260, 260
loadable mass families, 223–225, 

224–225
objects

aligning, 59–60, 60
arraying, 56–58, 57
copying, 55, 55
mirroring, 59, 59
moving, 52–54, 52–54
resizing, 58–59, 58
rotating, 55–56, 55–56
selecting, 50–52, 50–52
trimming and extending,  

60–61, 61
push/pull, 208, 208
text styles, 355

editing tools, 50, 50
Electrical discipline, 143–144
Element Properties settings, 295

elements
keynotes, 331
properties, 10, 295
visibility, 24, 136

Elements option, 24
elevations

levels, 46, 46
settings, 223, 224
shared, 49
symbols, 38–39, 38
tags, 39, 39
views, 38–39, 38–39

Ellipse tool, 220, 220
embedding

detail components in families, 
343–345, 343

walls, 81–82, 81–82
Enable DGN Template option, 294
End Angle setting, 439
Entire Walls option, 121, 122
entourage elements, 267
Equality Constraint option, 127–130, 

127–129
equality of families, 430, 430
evaluation of families, 451
Exclude Options option, 13, 394–395
Exclude tool, 239–240, 239–240
excluding groups, 239–240, 239–240
Existing Construction phase, 405
existing phases, 405, 412–413, 412–413
Existing state of phases, 405
expanded panel arrows, 7, 8
expanded panels, 8, 8
exploding imported details, 356
Export dialog box

DWF files, 487, 488
DWG files, 290

Export CAD Formats dialog box,  
289–293, 289, 291, 293, 489, 489

Export DWF dialog box, 296–297, 296, 
386, 386

Export gbXML dialog box, 493, 494
Export IFC dialog box, 483, 483
Export Layers dialog box, 287–288,  

288, 294
Export option in rendering, 255
Export rooms and areas as polylines 

option, 292, 492
exporting, 481

to 3ds Max, 494, 494
DGN files, 293–294, 293–294
DWF files, 294–297, 295–296,  

485–488, 485–488
DWG files, 287–292, 288–291,  

489–493, 489–490, 492
to gbXML, 493, 493–494
IFC format, 482–484, 483–484
to ODBC, 481–482, 481–482

room and area reports, 495–496, 
495–496

schedules, 324
sheets, 383–387, 384–386

exportlayers-ifc-IAI.txt file, 483
exposure settings, 254–255
Exposure Value setting, 254
extending objects, 60–61, 61
Extents group for views, 146, 146

Associated Level property, 147, 147
cropping, 146, 146–147
Depth Clipping property, 148, 148
Far Clipping and Far Clip Offset 

properties, 148–149, 149
Scope Box property, 147–148, 148
View Range property, 147, 147

exterior glazing for curtain walls, 94–96, 
94–96

Exterior Glazing type, 87, 87
Exterior lighting scheme, 257
exterior renderings, 250–253, 251–252
external mass families, 218

creating, 219–222, 219–222
editing, 223–225, 224–225
in projects, 222–223

external references (Xrefs), 180, 448
Extrusion Form.rvt file, 194, 196
extrusions, 187, 187

building, 193–194, 193–194
families, 435
roofs by, 111–113, 112–113
solid, 438, 438

F
face-based families, 176, 419–420, 

419–420
face-based modeling

curtain systems, 229, 230
mass floors, 227–228, 227–228
mass walls, 228, 228–229
Model By Face objects, 225–226, 226
tools, 227, 227
updating elements, 231, 232

faking dimensions, 53
families, 167, 415

adding information to, 175–176
assigning materials to, 444–445
categories, 417–419, 417, 444
classes, 169–173, 170–173
columns, 462–464
description, 9–10
detail embedding in, 343–345, 343
dimensions, 433–435
doors with variable swing angle

creating, 452–454, 453–454
nesting, 454–459, 456–459

equality, 430, 430
finding and loading, 174
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forms, 437–444
functions, 168–169, 168
geometry, 435–436
hosted, 176–177, 176–177, 419–420, 

419–420
in-place, 172–173, 173, 186–187, 

186–187
level of detail, 421–422, 422–423
lines, 436–437
loadable, 172, 172, 218–225, 219–225
locks, 429–430, 430
modifying vs. new decisions, 

416–417
names, 178, 447
nested, 180–181, 180, 448, 448
nonhosted, 176–177, 176–177
parameters, 182, 182, 431–433, 444, 

449–450, 449–450, 459–462, 
461–462

parametric vs. nonparametric, 
423–424

placing, 174, 179–180, 179, 420, 421
practical matters, 450–451, 450–451
preparing for, 416
reference lines, 429, 429
reference planes, 425–428, 425–428
replacing, 175
room tags, 459–462, 461–462
shared, 181–182, 448–449, 449
system, 170–171, 170–171
templates, 418
titleblocks, 360–361, 361
tools, 424–425, 424
trees, 169, 169
type catalogs, 446, 446
types, 177–178, 446, 446
updating, 178–179
visibility, 437, 437, 445–446, 446
walls, 65, 225
Yes/No parameters, 445–446, 446

Families section on home screen, 2, 2
Family Already Exists dialog box,  

224, 224
Family Categories And Parameters 

dialog box, 424, 448, 449
Family Editor, 172

face-based modeling, 231
features, 424–425
terms, 416
titleblocks, 360–361

Family Types dialog box, 212, 212, 
214–216, 424, 424

Far Clip Offset property, 148–149, 149
Far Clipping property, 148–149, 149
FBX format, exporting to, 494, 494
feet units, 47
Few Clouds option, 261

Fields tab
rooms, 304, 307
schedules, 322–323
sheets, 382, 382

file size
and families, 450, 450
and groups, 246–247

files, linked
managing, 278–280, 278–280
overview, 161–164, 162–164
tagging in, 280–283, 281–283
visibility/graphics overrides,  

273–277, 273–277
Files Of Type setting, 297
Fill Pattern Graphics dialog box, 28, 28, 

31–32
Fill Patterns dialog box, 351, 351
filled blue grips for splines, 347, 347
filled regions

creating, 350–351, 350–351
titleblocks, 360

Filter control, 13, 14
Filter dialog box

face-based modeling, 231, 232
selections, 52, 52

Filter tab
keynotes, 332, 332
schedules, 322, 325, 325

Filter tool, 30, 52
filters

face-based modeling, 231, 232
keynotes, 332, 332
phases, 403–404, 404, 412, 412
schedules, 322, 325, 325
selections, 52, 52
visibility, 30–32, 30–32, 157–160, 

157–159
Filters dialog box, 30, 30, 157–158, 159
Filters tool, 149
finding families, 174
Fine detail level, 140
Fine/Medium detail level, 32, 32
Finish Edit Mode button, 105, 107
Finish Face Exterior plane, 67, 67
Finish Face Interior plane, 67, 67
Finish tool for groups, 238
Finish Mass tool, 194
Fire Rating parameter, 72
Fit to Window option, 20
Fix Groups option, 246
Fixture Options, 258–259
flip controls, 53
floating toolbars, 6
Floor By Face tool, 228, 228
floors

creating, 96–97
families, 225
mass, 227–228, 227–228

plans, 35–37, 36–37
sloped, 97, 97
tapered, 98, 98

Floors tab, 97–98, 105
fonts

DWG files, 286–287
text styles, 354

footprint, roofs by, 109–110, 110
Foreground setting for color scheme, 144
Form Element panel, 217, 217
Format dialog box

schedules, 326, 326
units, 132, 132

formats, CAD, 283
Formatting tab for schedules, 322, 

325–326, 371, 371
forms

editing, 206–210, 207–211
extrusion, 193–194, 193–194
families, 437–444
mass. See mass forms

free points, 189
Freeze Drawing extension, 336
Full Navigation wheel, 19, 20
Full Path setting, 329
Function setting for walls, 72, 88
furniture as loadable family, 172
furniture.rft template, 418
furniture systems.rft template, 418

G
gable roofs, 109, 110
gbXML, exporting to, 493, 493–494
general notes, 355
Generic Model.rft template, 433–434, 455
Generic Models category, 417–418
geometry

families, 435–436
imported, 232–233, 232
rendering, 250

Geometry panel, 66
glazing for curtain walls, 94–96, 94–96
global visibility, 136
Go Home option, 18, 20
Go To View dialog box, 190
Graphic Display Options property, 21, 

141, 142
Graphic Overrides tab, 404–405, 405
Graphic Settings option, 385
Graphical option for resizing objects, 58
Graphics dialog box for linked files, 

282, 282
Graphics group properties for views, 

139, 139
Analysis Display Style, 144–145, 144
Color Scheme, 144, 144
Detail Level, 140, 140
Discipline, 143–144, 144
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Display Model, 140, 140
Graphic Display Options, 141, 142
Hide At Scales Coarser Than, 144, 144
Orientation, 143, 143
Sun Path, 145, 145
Underlay, 142
View Scale and Scale Value, 139, 139
Visibility/Graphics Overrides 

feature, 140, 140
Visible In Option, 145, 145
Visual Style, 141, 141
Wall Type Joins, 143, 143

Green Building XML (gbXML), 493, 494
Grid Line tool, 94
Grid Line Segment tool, 94
Grid Lines option, 371
grids and grid lines

ceilings, 99, 100
columns, 61–65, 62–64
curtain walls, 87–90, 88–90
imported files, 272
levels, 49
revision schedules, 371
sheets, 378–379, 378–379

grips
families, 428, 428
splines, 347, 347
text boxes, 354

Ground Plane At Level option, 253
Group And Associate option

arraying objects, 57
face-based modeling, 226

Group Editor, 237, 237
Group Options for lights, 258
Group To Save setting, 242
groups, 235

binding, 244, 244
complexity, 245
creating, 236–237, 237
deleting, 245
design options, 392
excluding, 239–240, 239–240
file size, 246–247
levels, 246, 246
lights, 258–261, 258–260
linking, 243–244, 243
loading, 242–243, 243
mirroring, 246
moving to projects, 240, 240
nesting, 245
organizing, 236, 236
placing, 238–239, 239
reloading, 243, 243
removing elements, 240–241, 241
saving, 242, 242
worksharing, 246

Guide Grid Name dialog box, 378
guide grids for sheets, 378–379, 378–379

H
Halftone setting

By Host View, 275
filters, 31
visibility, 151

Halftone/Underlay settings, 142, 142
hatch patterns, importing, 356
Haze level setting, 261
Height option, 67, 69
Height Offset From Level option, 99–100
heights

and datums, 44
walls, 67, 69

Help option, 18, 20
Hidden Line visual style, 12, 141, 141
Hidden Lines category, 422
Hide At Scales Coarser Than setting, 139, 

144, 144
Hide Category option, 35, 137
Hide Element option, 35, 137, 157
Hide In View tool, 24, 24
Hide option for worksets, 165
Hide tool, 34
hiding vs. overriding, 136
High rendering quality, 253
Highlight Boundaries option, 301
Highlights exposure setting, 254
Hip roofs, 110
Home tab, 6
Horizontal Alignment option, 364
horizontal floors, 96, 96
host families, 169–170, 419–420, 

419–420
hosted families, 170, 176–177, 176–177, 

419–420, 419–420
hosted points, 189–190

I
i_Groups-Condominium.rvt file, 26, 28
Identity Data group for views, 145, 145
Identity tab for tags, 320
IFC (Industry Foundation Classes)

exporting, 482–484, 483–484
importing, 484–485, 484

images
background, 262, 262
titleblocks, 360, 363

Imperial Library, 338, 338
imperial units, 10
Import CAD Formats dialog box, 361, 361
Import CAD option, 283
Import Line Weights dialog box, 286, 286
Import/Link RVT dialog box,  

270–271, 270
Import option for linked files, 280
Import panel for mass families, 232, 232
Import Units setting, 285

Imported Categories tab, 29, 29, 149, 
161–162, 277, 287, 287

imported geometry, mass families from, 
232–233, 232

Imported Objects tab, 137
importing

details, 355–356
DGN files, 293–294, 293–294
DWG files, 283–287, 284, 286
IFC, 484–485, 484
titleblock data, 361, 361

In Entire Project option, 51
In-Place Editor panel, 198, 200
in-place families, 169, 172–173, 173, 

186–187, 186–187
In-Place Mass tool, 186, 193, 199
In Session View/Sheet Set option,  

289, 289
inactive state of View Cube, 18
inches units, 47
Include Attached Detail Groups As 

Views option, 242
Include Attached Details option, 242, 272
Include Elements From Linked Files 

option, 281
Include Grids option, 242, 272
Include Levels option, 242, 272
Inconsistent Groups dialog box, 246, 246
Increase/Decrease Focal Length  

option, 20
increments, snap, 47, 119, 119
Index Color (255 Colors) setting, 

490–491
Industry Foundation Classes (IFC)

exporting, 482–484, 483–484
importing, 484–485, 484

infill elements, 409–410, 409–410
InfoCenter toolbar, 5, 5
Insert From File tool, 357
Insert tab, 6
Insert Views dialog box, 357, 357
inserting details, 357, 357
instance parameters

dimensions, 214, 214
families, 431

instance properties, 10
schedules, 324
walls, 70, 70

Instance Properties dialog box, 324
instances of families, 169
insulation, 349–350, 349
Insulation Bulge To Width Ratio  

setting, 349
Insulation tool, 349
Insulation Width setting, 349
Interference Check tool, 479–481, 

480–481
Interference Detection tool, 437
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Interference Report dialog box, 480, 480
Interior lighting scheme, 257
Interior Type property, 88
Invert color option, 284
Is Reference setting, 427–428, 427–428
Isolate Category option, 34, 137
Isolate tool, 34
Isolate Element tool, 35, 137, 203, 203
Itemize Every Instance option, 371

J
jambs, curtain wall, 336, 336
Join button, 114
Join Condition property, 88
Join Geometry tool

families, 443
void forms, 206, 206

joins, walls, 77–79, 78, 143, 143

K
key schedules, 306–308, 306–308, 321
keyboard accelerators, 14, 14
Keyboard Shortcut dialog box, 14, 14
Keynote Legend Properties dialog box, 

332, 332
Keynote Listing dialog box, 331
Keynote parameter for walls, 72
keynotes, 315, 327, 328

assigning, 331, 331
creating, 331–332, 331
legends, 332, 332
text files, 328–330, 329–330,  

333–334, 333–334
Keynotes dialog box, 329, 331, 331
Keynoting Settings dialog box, 329,  

329, 332
kit-of-parts families, 180, 180, 448, 448

L
Label Parameters list, 364
Label tool, 363–364
labeled dimensions, 214, 214
labels

families, 431
tabs, 7, 7
titleblocks, 360, 363–366, 366

landings, stairs with, 106–107, 107
landscaping, 267
layers

DWG files, 287–288, 288, 292, 490
Revit vs. AutoCAD, 73
walls, 73–76, 73, 75

Layers setting, 284
Layers And Properties setting, 292, 490
Layout property, 88
Leader option, 85, 301
leaders

doors, 85

importing, 356
rooms, 301
text, 353–354, 353–354

legends
areas, 309, 309
detailing, 341–343, 341–342
keynotes, 332, 332
views, 42, 42

Length setting, 70
Length Dimension Snap Increments 

setting, 47, 119
letters for grid lines, 63
level behavior of families, 419
level of detail (LOD)

families, 421–422, 422–423
views, 32–33, 32–33

Level tool, 8, 49, 220
levels

creating, 48–49, 48–49
DGN files, 293–294
groups, 246, 246
imported files, 272
overview, 44–47, 45–47

libraries for detail, 355–358, 357
light fixtures, aligning with ceiling grid, 

102–103, 103
Light Group Editor, 259
Light Source option, 256, 257
Lighting Scheme settings, 251, 257, 257
lights and lighting

editing, 260, 260
grouping, 258–261, 258–260
overview, 256–258, 256–258
rendering, 250–251

Lights Group dialog box, 259
Line Patterns dialog box, 348, 348
Line Styles dialog box, 347, 347
Line tool

mass forms, 192
reference lines, 188
spiral stairs, 108
stairs, 104

line weights
DWG files, 285–288, 286
plotting, 348, 348

Line Weights dialog box, 348, 348
Linear Array option, 56
Linear dimensions, 122, 122, 124
Linear/Radial setting, 57
lines

By Host View, 275
detail, 345–346, 346

editing, 346–347, 347
line weight plotting, 348, 348
overriding, 349
patterns, 348, 348

families, 436–437
imported, 356
titleblocks, 360–362

Linetype Scaling setting, 292, 491
Linework tool, 349
Link CAD option, 283
Link Revit tool, 270, 270
Link tool for groups, 243
linked files

managing, 278–280, 278–280
overview, 161–164, 162–164
tagging in, 280–283, 281–283
visibility/graphics overrides,  

273–277, 273–277
Linked View setting, 275–276
linking

DWF files, 297
DWF markup, 488, 488
DWG files, 283–287, 284, 286
groups, 243–244, 243
Revit models, 270–272, 270–272

listening dimensions, 52–53
Load As Group Into Open Projects 

option, 238–239
Load Family dialog box, 86
Load Family tool, 86, 373
Load feature for groups, 242
Load File As Group dialog box, 242
Load From Library panel, 338, 373
Load Into Project option, 223–224
loadable families, 169

overview, 172, 172
placing, 174, 179–180, 179
replacing, 175

loadable mass families, 218
creating, 219–222, 219–222
editing, 223–225, 224–225
in projects, 222–223

Loaded Tags option, 316
loading

families, 174, 458–459, 459
groups, 242–243, 243
tags, 316–317
titleblocks, 367–369, 368–369

Local Alias column, 279
local visibility, 136
Located In setting, 280
Location dialog box, 145
Location Line parameter, 67, 70
Location Weather And Site dialog box, 

252, 252
Lock Profiles option, 217
Lock To Selection option, 18
locked dimensional parameters, 212
locking dimensions, 128–130, 128–130, 

429–430, 430
LOD (level of detail)

families, 421–422, 422–423
views, 32–33, 32–33

Loft Form.rvt file, 198–199
loft forms, 187, 187, 195–198, 195–198
Low rendering quality, 253
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M
main models, 390
main screen, 3, 3

drawing area, 12–14, 12–14
menu and toolbar, 3–5, 4
Options bar, 9, 9
Project Browser, 11–12, 11
Properties palette, 9–11, 9–11
ribbon, 5–8, 5–8

Maintain Functional Fidelity setting, 491
Maintain Visual Fidelity setting, 491
Make Element Editable icon, 240
Make Plan View option, 48
Make Primary option, 397
Make Surface From Closed Loops 

option, 193, 202
Make This Temporary Dimension 

Permanent option, 209
Manage Images dialog box, 363
Manage Links dialog box, 278–280, 279
Manage tab

description, 6
design options, 392
detail level, 33
families, 449, 449
filled regions, 351
line weights, 348
lines, 347
materials, 263–264
phases, 403, 411, 411
sheets, 374, 380
snap increments, 47
titleblocks, 365, 368

Manage ribbon tab, 137
Manage Worksets dialog box, 280
Manage Worksets option, 280
Manual option for DWG files, 291
Manual - Base Point option, 271
Manual - Center option, 271
Manual - Origin option, 271
Manual (Specify file name) option, 297
Manufacturer parameter, 72
Mark parameter, 70
masking regions

adding, 351–352, 352
titleblocks, 360

mass faces, 184
mass families

description, 184
from imported geometry,  

232–233, 232
loadable, 218

creating, 219–222, 219–222
editing, 223–225, 224–225
in projects, 222–223

mass floors
adding, 227, 227
description, 184, 226
tools, 228, 228

Mass Floors dialog box, 227, 227
mass forms

description, 184
editing, 206–210, 207–211
extrusion, 193–194, 193–194
loft, 195–198, 195–198
preparing for, 191–192, 192
revolve, 198–200, 199–200
surface, 202–203, 202–203
sweep, 200–202, 200–201
void, 203–206, 203–206

mass instances, 184
mass objects, 184

in-place mass families, 186–187, 
186–187

visibility and display, 185–186, 
185–186

Mass.rft template, 218–219, 232
massing, 183

description, 184
face-based modeling, 225–231, 

226–232
mass families. See mass families
references and work planes, 187–191, 

188–191
Massing & Site tab, 6, 185–186, 193,  

227, 231
massing studies, 184
Material Tag tool, 317, 319–320, 319–320
Material Takeoff Properties dialog box, 

325, 325
material takeoffs, 321, 324–327, 325–327
materials

adding and adjusting, 263–265, 
263–266

assigning to elements, 266–267, 266
assigning to families, 444–445
columns, 462–464
keynotes, 331–332
Paint tool, 267, 267
rendering, 250

Materials dialog box, 263–267, 263
ceilings, 100, 101
mass objects, 185, 185
walls, 75–77, 75

Measure panel, 66
Mechanical discipline, 143–144
Medium setting

Detail Level, 140
rendering quality, 253

metric units, 10
Mid Tones exposure setting, 254
Mini Full Navigation wheel, 19, 20
Mini Tour Building wheel, 19, 20
Mini View Object wheel, 19, 20
Mirror tool, 59
mirroring

groups, 246
objects, 59, 59

Miter joins, 78, 78
Model By Face objects, 225–227, 226–227
Model Categories tab, 23, 23, 27, 149

lighting, 256, 257
linked files, 274, 274, 277

model crops, 33, 34, 377, 377
model families, 168–169
Model groups, 236
Model Line Weights tab, 348, 348
model lines for families, 436
Model Objects tab, 137, 137
Model parameter for walls, 72
model-to-model relationships, 169
modeling, 43

ceilings, 98–103, 99–103
column grids, 61–65, 62–64
doors, 84–86, 85–86
editing tools. See editing
face-based. See face-based modeling
floors, 96–98
levels, 44–49, 45–49
roofs, 109–114, 109–110, 112–114
stairs and railings, 104–108,  

105–108
walls. See walls
windows, 84–86, 85–86

Modify panel, 66
Modify tab, 6, 9

arraying objects, 56
copying objects, 55
detail lines, 347
mirroring objects, 59
moving objects, 54
resizing objects, 58
rotating objects, 56
tools, 50, 50
trimming objects, 60

modifying schedules, 324
ModifyManualGrids.rvt file, 90
ModifySFGrids.rvt file, 90
monitoring with Copy/Monitor,  

474–477, 476–477
Move Crop Boundary option, 20
Move To Project option, 240
Move To setting, 57
Move tool, 54, 99, 100
moving

groups to projects, 240, 240
objects, 52–54, 52–54
panels, 6

mullions, 90–92, 91–92
Multi-Category option, 317
Multiple option for copying objects, 9, 55
Multiple Alignment option, 60
multiple design options, 391
Multiple Selection panel, 228
multiple views, selecting, 381
multistory buildings, stairs in, 104
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N
Name dialog box, 186
names

design options, 392
dimension types, 125, 125
DWF files, 297, 387, 487–488
DWG files, 290, 492
families, 178, 447
family parameters, 433
groups, 237
levels, 45–46, 45–46
mass objects, 186
reference planes, 426
schedules, 407
sheets, 374
types, 178
work planes, 111, 190

Naming Automatic - Long (Specify 
Prefix) setting, 492

Naming Automatic - Short setting, 492
natural light, 256
Nested Links setting, 277
nesting

families, 180–181, 180, 448, 448
groups, 245
links, 277
variable 2D swings, 454–459, 

456–459
New Area Plan dialog box, 308, 311
New button, 2
New Conceptual Mass option, 219
New Construction phase, 405
New Drafting View dialog box, 41
New Filters button, 158
New Keynote Legend dialog box, 332
New Legend View dialog box, 42
New Material Takeoff dialog box, 325
New Pattern dialog box, 351
New Plan dialog box, 37, 37
New Project dialog box, 5, 5
New Schedule dialog box

components, 322, 322
rooms, 304, 304, 306, 306

New Sheet dialog box, 373, 376
New state of phases, 405
New Type column, 476–477, 477
Next Pan/Zoom action, 17
nonhosted families, 176–177, 176–177
nonparametric families, 423–424
Normal setting for Display Model, 140
Not A Reference option, 427
Not Displayed option, 404
Not Overridden button, 273–274, 273
notes

keynotes. See keynotes
schedules, 321
text. See text

Number setting for arrays, 57

numbering
grid lines, 63
revisions, 466–468, 466–468
room tags, 399

Numeric option for revision  
numbering, 468

Numerical option for resizing objects, 58

O
Object Styles dialog box, 25, 137–138, 

137, 256, 404
Object Styles settings, 150, 277
objects

aligning, 59–60, 60
arraying, 56–58, 57
copying, 55, 55
mirroring, 59, 59
moving, 52–54, 52–54
resizing, 58–59, 58
rotating, 55–56, 55–56
selecting, 50–52, 50–52, 94
styles, 137–138
trimming and extending, 60–61, 61

ODBC (Open Database Connectivity), 
exporting to, 481–482, 481–482

office items, 267
Offset setting

levels, 48
roofs, 111
walls, 67, 69, 69

one-click zooms, 17
One DWG Unit Is setting, 491
One Segment option, 89
Only Selected Objects In Current View 

option, 319
Open Database Connectivity (ODBC), 

exporting to, 481–482, 481–482
openings for walls, 79–81, 79–80
Openings setting for pick options,  

121, 122
option sets, 390
Options bar

aligning objects, 60
arrays, 57, 57
columns, 64, 64
curtain walls, 87
dimensions, 121, 121
doors, 85
extrusion forms, 193, 193
families, 425
insulation, 350
legends, 42, 42, 342, 342
levels, 48, 48
lights, 259, 259
resizing objects, 58
rooms, 301
tags, 470, 470
tools, 9, 9

wall joins, 79
walls, 67, 69, 69
windows, 86

Options dialog box, 3
Options option

steering wheel, 20
View Cube, 18

Ordinate Dimension Settings dialog box, 
125, 126

ordinate dimensions, 124–125, 124–126
Orient to a Plane option, 18, 20
Orient to Direction option, 18
Orient to View option, 18, 20, 285
orientation

3D Control objects, 208
doors, 85
projects, 22, 143, 143

Orientation setting
doors, 85
projects, 22, 143, 143

Original Type column, 476, 477
origins in families, 428
orphaned tags, 282–283, 282–283
orthographic 3D views, 42
Outlet Duplex.rfa family, 180
Output resolution settings, 254
Overridden option for phase filters, 404
Override Display Settings For This 

Instance option, 274
Override Graphics In View option, 157
overrides

dimension text, 126–127, 126–127
DWG files, 490
vs. hiding, 136
lines, 349
Visibility/Graphics. See Visibility/

Graphics Overrides dialog box
Overwrite Existing Version option, 231
Overwrite the existing version option, 

224–225, 224
Overwrite the existing version and its 

parameter values option, 225

P
padlocks

description, 60, 60
dimensions, 429–430, 430

Paint tool, 267, 267
Pan tool, 16
panels, 6, 6
parameters and Parameter Properties 

dialog box
dimensional, 211–212, 212

creating, 212–215, 213–214
testing, 215–217, 215–218

families, 182, 182, 431–433, 444, 
449–450, 449–450, 459–462, 
461–462
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sheets, 380, 380
titleblocks, 365–366, 368, 369
walls, 69–72, 70–72

parametric families, 423–424
parents of linked files, 273
Path Type column, 279
paths

keynotes, 329–330
linked files, 279
sweep forms, 200

Pattern setting, 275
patterns

By Host View, 275
filled regions, 351
lines, 348, 348

people, 267
Per Project setting, 466
Per Sheet setting, 466–467, 467
permanent dimensions, 121, 121

baseline and ordinate, 124–125, 
124–126

editing, 209, 209
pick options, 121, 122
placement options, 121
styles, 122, 122–123

permanent visibility, 136–137
Perspective Line Weights tab, 348
Phase setting

cameras, 149
description, 22
linked files, 276
schedules, 322, 407
visibility, 406

Phase Created setting, 70
Phase Demolished setting, 70, 405
Phase Filter setting

cameras, 149
description, 22
linked files, 276

Phase Filters tab, 403–404, 404, 412, 412
phases, 401

assigning, 406, 406
camera groups, 149, 149
demolishing elements, 411, 411
description, 405–406, 406
infill elements, 409–410, 409–410
rendering and existing, 412–413, 

412–413
room boundaries, 407–408, 408
schedules, 407, 407
tools, 402–405, 402–405

Phasing dialog box, 403, 403
Photometric lights, 256
Pick a line and use the work plane it was 

sketched in option, 111
Pick A Plane option, 111
Pick Entire Walls method, 121

Pick Faces option, 66
Pick Individual References option, 121
Pick Line option, 66, 346
Pick Lines tool

levels, 48
titleblocks, 362
walls, 69, 69

pick options
dimensions, 121, 122
grid lines, 62
levels, 48
titleblocks, 362
walls, 69, 69, 96, 101, 101

Pick Mirror Axis option, 59
Pick tool

grid lines, 62
walls, 69

Pick Walls tool, 96, 101, 101, 109, 114
Pin tool, 271
Pin Position tool, 90–91
pinning files, 3
Place A Component button, 174
Place At setting, 285
Place Ceiling tab, 99–100
Place Curtain Grid tab, 89
Place Detail Lines tab, 345, 346
Place Label tab, 48
Place Line tab, 362
Place Mass command, 223
Place Model Group option, 238
Place Mullion tab, 91–92, 94
Place On Face option, 176
Place On Vertical Face option, 176
Place On Work Plane option, 176, 223
Place Room tab, 300–301, 300
Place Structural Column tab, 64–65
Place Wall tab, 5, 66, 68, 68
Place Window tab, 317
placing

dimensions, 121
families, 174, 179–180, 179, 420, 421
groups, 238–239, 239

Plan Swing category, 155, 156
plan view for stairs, 104
Plan View Types option, 48
plotting line weights, 348, 348
Point tool, 190
Position dialog box, 145
Position Not Saved column, 279
Positioning options for linked files, 271
predefined tags, 316
Prefer option for alignment, 60
Preserve color option, 284
Preserve Graphic Overrides option, 280
preset rendering options, 253
Press & Drag option, 14, 53–54
Previous Pan/Zoom action, 17

primary design options, 392
accepting, 395–398, 395–397
defined, 390

Print dialog boxes, 296
print settings

DWF files, 296, 385, 385
halftones, 142, 142
level of detail, 32–33
resolution, 254

Print Setup dialog box, 142, 142, 296, 
385, 385

Printer rendering option, 254
profiles

families, 440
locking and unlocking, 217
loft forms, 195–196, 195
walls, 79–81, 80

Project Browser, 11–12, 11
families, 169, 169
groups, 236, 236, 243, 243
rooms, 300
views, 37, 37
walls, 66, 66

Project Information dialog box for 
titleblocks, 369, 369

Project Information tab for DWF files, 
296, 386, 386, 487, 487

Project North setting, 143
project parameters and Project 

Parameters dialog box
families, 431
sheets, 380
titleblocks, 368–369, 368

Project Phases tab, 403, 403
Projection/Surface option, 31
ProjectLogo.jpg file, 362
projects

creating, 2
templates, 5

Projects section, 2, 2
ProMaterials library, 264
properties and Properties palette, 9–11, 9–11

dimensions, 124, 124
families, 425
phases, 406–407, 406–407
views, 21, 21, 138–139

Extents group, 146–149, 146–149
Graphics group, 139–145, 139–145
Identity Data group, 145, 145
Phasing and Camera groups, 

149, 149
Visibility/Graphics overrides, 

22–29, 23–26, 28–29
Properties panel, 66
Purge Unused tool, 245–246
push/pull editing, 208, 208
pushpin controls, 3, 89–90, 89–90
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Q
quality rendering settings, 253–255, 

254–255
Quick Access toolbar (QAT), 4, 4

R
rac_advanced_sample_project.rvt file

areas, 308, 311
doors and windows, 85
furniture, 23
rooms, 300–303, 306
sheets, 373

rac_basic_sample_project.rvt file
keynotes, 329
materials, 266
rendering, 251
schedules, 321, 324
sheets, 373, 378, 380
walls, 69

Radial arrays, 56
Radial dimensions, 122, 123
radius

3D Control objects, 208, 208
dimensional editing, 209, 209
walls, 67, 78

radius joins, 67, 78
railings

creating, 104–108, 105–108
system families, 171

ramps, 171
raster files, 297–298
Re-center Crop Boundary option, 20
real-time rendering, 268, 268
Realistic Materials style, 268
Realistic visual style, 13, 141, 141, 268
Recent Files screen, 2, 2

family templates, 418
loadable mass families, 219

recently opened files, 3
Reconcile Hosting browser, 282, 282
Reconcile Hosting command, 282–283, 

282–283
Rectangle tool, 196
Ref Plane tool, 192
reference lines

characteristics, 188–189, 189
families, 429, 429
titleblocks, 360

reference planes
adding, 455
characteristics, 188, 188
families, 425–428, 425–428

Reference Point tool, 190, 190
reference points, 189–190
Reference tool, 189, 189
Reference Type column, 279
Referencing Detail property, 22

referencing drawings, 180
referencing in CAD, 448
Referencing Sheet property, 22
Region option, 253
regions

crop, 33, 34, 376–377, 376–377
filled, 350–351, 350–351
masking, 351–352, 352, 360
rendering, 253

Related to Mass parameter, 70
Relative (Path Type) option, 330
Reload option, 280
Reload From option, 280
reloading

groups, 243, 243
linked files, 280

Remove tool, 237
files, 280
group elements, 237

Remove Hidden Lines tool, 422
removing

elements from groups, 237,  
240–241, 241

files, 280
lights from groups, 259
selection set element categories, 52

renaming
design options, 392
levels, 45–46, 45–46

Render Appearance Library dialog box, 
265, 265

Render Appearance tab, 264–266, 
264–266

rendering and Rendering dialog box, 249
background, 261–262, 261–262
day, 250–253, 251–252
exposure, 254–255
lighting, 256–261, 256–260
materials, 263–267, 263–267
phases, 412–413, 412–413
quality settings, 253–255, 254–255
real-time, 268, 268
workflow, 250

rentable areas, 311–313, 312–313
repeating details, 340–341, 340–341
Replace Halftone With Thin Lines 

option, 142, 142
replacing loadable families, 175
Report Window Area As Percentage Of 

Room Area option, 496
Reporting Parameter feature, 433
reports

Coordination Review tool, 478
room and area, 495–496, 495–496

Reset Front option, 18
Reset Profile option, 80
Reset Temporary Hide/Isolate option, 35
Resizing Datum Extent controls, 49, 63

resizing objects, 58–59, 58
resolution for rendering, 254
Resources section, 2, 2
Restore Excluded Member option,  

240, 240
Restore Original Center option, 20
Reveal Hidden Elements tool, 13, 24–25, 

25, 136, 136
revision clouds

drawing, 468–470, 468–470
numbering, 466–467, 467

Revision Properties dialog box, 370–372, 
370–372

revision schedules
description, 321
titleblocks, 370–373, 370–373

Revision Tag.rfa family, 469
revisions, 465

issuing, 470–471, 470–471
numbering, 466–468, 466–468
revision clouds, 468–470, 468–470

Revisions dialog box, 470
Revit family (RFA) file components, 85
Revit Family Style Guide, 447, 450
Revit tab, 278–279, 279
Revit Links tab, 273, 273
RevitKeynote_Imperial.txt file, 333
RevitKeynote_Metric.txt file, 333
Revolve Form.rvt file, 200
revolves

families, 435–436, 439, 439
forms, 187, 187, 198–200, 199–200
solid, 439, 439

Rewind tool, 19, 19
.rfa extension, 219
ribbon

clues, 8, 8
controls, 7–8, 7–8
working with, 5–7, 5–7

Roof By Face tool, 230–231, 230–231
Roof Reference Level option, 111
RoofExtrusion.rvt file, 111
roofs

by extrusion, 111–113, 112–113
families, 173, 225
by footprint, 109–110, 110
mass, 230–231, 230–231
soffits, 113–114, 113–114
types, 109, 109

Room & Area panel, 495, 495
room and area reports, 495–496, 

495–496
Room/Area Report tool, 495
Room Bounding parameter, 70
Room Separation Line tool, 302–303, 

495, 495
Room Tag option, 317
Room Tag.rfa family, 459
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room tag.rft template, 418
rooms, 299

bounding, 71, 71
building, 300–302, 300–302
phase-specific boundaries,  

407–408, 408
schedules, 303–308, 304–308
separation lines, 302–303, 303
tags, 399, 459–462, 461–462

Rooms And Areas In A Separate 
Boundary Layer option, 295, 385

Rotate After Placement option, 64
Rotate tool, 55
Rotate True North tool, 143
rotating objects, 55–56, 55–56
Run mode for stairs, 104
.rvt files, linking, 270–272, 270–272
RVT Link Display Settings dialog box, 

274, 274
Basics tab, 274–277, 274, 276
category tabs, 277
overrides, 163–164, 163–165
Worksets tab, 277, 277

S
Same As Group Name option, 242
Saturation exposure setting, 254
Save feature, 242, 242
Save Group option, 242, 242
Save Image dialog box, 255
Save Markups option, 280
Save Positions option, 280
Save To Library tool, 357
Save To Project dialog box, 255
Save To Target Folder dialog box,  

296–297, 296, 492, 492
Save View option, 18, 20
Save Views dialog box, 357, 357
Saved Path column for linked files, 279
Saved Path setting for keynotes, 329
saving

DWF settings, 296, 296
groups, 242, 242
to libraries, 357, 357

Scale tool, 12, 58
Scale Value property, 21, 139, 139
scales for views, 32–33, 32–33
Schedule Building Components  

option, 322
Schedule Properties dialog box, 304–307, 

305, 307, 322, 323
Scheduled Fields (In Order) list, 323
schedules, 320–321, 321

creating, 321–323, 322–323
design options, 396, 397
exporting, 324
key, 306–308, 306–308, 321
and keynotes, 315

material takeoff, 324–327, 325–327
modifying, 324
phases, 407, 407
revision, 370–373, 370–373
rooms, 303–308, 304–308
types, 321

Scope Box setting, 22, 147–148, 148, 426
Screen rendering option, 254
searches, for, 5
secondary design options

defined, 390
setting up, 392

section views, 39–40, 40
Select All Instances option, 51, 51, 245
Select Link option, 476, 478
Select Multiple option, 228–230
selecting

linked files, 476, 478
mass objects, 228–230
multiple views and sheets, 381
objects, 50–52, 50–52
voids, 204

separation lines for rooms, 300,  
302–303, 303

Sequence Options dialog box, 468, 468
Set Current View As Home option, 18
Set Front to View option, 18
Set tool, 190
Shaded style, 12, 141, 141
Shaded with Edges style, 13, 141, 141
shaders, 264
Shadows exposure setting, 254
Shadows On/Off function, 13
shape profiles, 195
shared elevations, 49
shared families, 181–182, 448–449, 449
shared parameters

families, 182, 182, 431, 449–450, 
449–450, 459–462, 461–462

titleblocks, 365–367, 365–366, 369
Shared Parameters dialog box, 366, 369
Sheet Classification parameter, 380, 381
Sheet Composition panel, 373, 375
Sheet Issues/Revisions dialog box,  

466–468, 466, 470–471, 471
Sheet List Properties dialog box, 382–383, 382
Sheet Title dialog box, 374
sheets, 359

creating, 373–374, 374
crop regions, 376–377, 376–377
displaying, 290
exporting, 383–387, 384–386
keynote ordering, 330, 330
organizing, 380–382, 380–382
sheet lists, 382–383, 382–383
titleblocks. See titleblocks
views on, 373, 375–376, 375, 378–379, 

378–379, 382

Sheets In The Model option, 290
Sheets In The Set option, 290
Shift key for copying objects, 55
shortcuts, keyboard, 14, 14
Show Above The Ribbon option, 4
Show Below The Ribbon option, 4
Show Categories From All Disciplines 

option, 316–317, 322
Show Compass option, 18
Show Crop Region button, 376
Show Hidden Lines tool, 422
Show/Hide Crop Region option, 13
Show/Hide Rendering Dialog option, 13
Show In List setting, 290
Show Mass mode, 186
Show Mass tool

face-based modeling, 227, 231
mass object visibility, 185–186, 185

Show option
orphaned tags, 282, 282
phase filters, 404, 412, 412
worksets, 165

SHX fonts, 286–287
Shxfontmap.txt file, 287
signs, 267
Silhouette Edges feature, 141, 142
Simple option for filled regions, 351
Singapore Code Checking (BCA) 

certification, 483
Single Flush.rfa family, 179, 452–454, 

453–454, 458
16_Project_With_Phases.rvt file, 409
16_Rendering_With_Phases.rvt file, 413
size

files, 246–247, 450, 450
objects, 58–59, 58

Size Crop button, 377
Sketch tool, 48–49
Sketch Ceiling tool, 100
sky for background, 261
slip joint at metal panel/plaster plan 

detail, 337, 337
Slope Arrow button, 97
sloped floors, 96–97, 96–97
snap increments, 47, 119, 119
Snaps dialog box, 119, 119
soffits, 113–114, 113–114
Solid/Void list, 205
solids

blends, 438, 438
converting to voids, 205, 205
extrusions, 438, 438
families, 437
revolves, 439, 439

Solids (3D Views Only) option, 292, 492
Sort option for orphaned tags, 282
Sorting/Grouping tab

revision schedules, 371, 371
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rooms, 304
schedules, 322–323, 323, 325, 325
sheets, 382, 382

Spacing property for curtain walls, 88
Specialty Equipment category, 417, 419
Specify layers option, 284
Specify Types dialog box, 179, 179
spelling of categories, 423
spiral stairs, 108, 108
Spline Through Points tool, 190
splines, 347, 347
split buttons, 8, 8
Split tool for walls, 95, 95
Spot Coordinate option, 131, 131
spot dimensions, 130–131, 130–131
Spot Elevation option, 130, 131
Spot Slope option, 131, 131
Sprung roof structures, 173, 173
Square Off joins, 78, 78
stacked walls, 65, 82–84, 83
Stainless Steel material, 264, 264
stairs, 104

with landings, 106–107, 107
spiral, 108, 108
straight run, 104–105, 105–106
system families, 171

Standard lights, 256
Start Angle parameter, 439
Status bar

design options, 393–394, 393
information on, 13–14, 13

Status column for linked files, 278
steering wheels, 18–20, 19–20
Storefront type

accessing, 87, 87
walls, 94–96, 94–96

straight run stairs
creating, 104–105, 105–106
with landings, 106–107, 107

Strong reference planes, 427
Structural columns, 64, 64
Structural discipline, 143
structural steel families, 450
Structural Usage setting, 70–71, 71
structure of walls, 73–77, 73–75, 77
Structure parameter, 72
Structure tab, 6
styles

Analysis Display Style, 144–145, 144
dimension, 122, 122–123
object, 137–138
text, 354–355, 354
visual, 12–13, 268, 268

subcategories of families, 422–423,  
423, 444

Sun And Artificial option, 257
Sun Only option, 257

Sun Path feature, 145, 145
Sun Path On/Off function, 13
Sun Settings dialog box, 251–253, 252, 

258, 258
Sun System lights, 256
super families, 423, 448–449
surfaces

dimensions, 217, 217–218
editable, 207
forms, 187, 187, 202–203, 202–203

Swatch Shape setting, 265, 266
Sweep Form.rvt file, 202
sweeps

families, 436, 439–440, 440
forms, 187, 187, 200–202, 200–201

swept blends, 436, 441, 441
Switch Windows tool, 223
symbolic arcs, 453–454, 454
symbolic lines, 436
symbols

component, 337–339, 337–339
elevation, 38–39, 38
titleblocks, 360

system families
overview, 170–171, 170–171
walls, 65

T
tab bar, 5, 5
Tab key for object selection, 94, 231
tabs, 5–7, 7
Tag All Not Tagged dialog box, 318, 318
Tag All tool, 281, 317–319, 318
Tag By Category tool, 281, 317–318,  

469, 469
Tag By Material tool, 320, 320
Tag On Placement option, 86, 301,  

317, 317
Tag Orientation option, 301
Tag panel, 317
Tag tab, 6
tags, 315–316, 316

in design options, 398–400
doors, 85
elevation, 39, 39
linked models, 280–283, 281–283
loading, 316–317
Material Tag tool, 319–320, 319–320
revision clouds, 469–470, 469
rooms, 399, 459–462, 461–462
Tag All tool, 318–319, 318
Tag By Category tool, 318
uses, 317, 317

Tags dialog box, 316–317, 317, 469, 469
Tags option, 85
tapered floors, 96, 96, 98, 98
TaperedFloor.rvt file, 98

templates
default, 191
DGN, 294
families, 418
projects, 5
views, 160–161, 160–161

Temporary Dimension Properties dialog 
box, 118, 118

temporary dimensions, 116–117, 116–117
converting, 119–120, 120
editing, 209
levels, 46, 47
lines, 346
listening, 53, 53
settings, 118, 118
snap increments, 119, 119

Temporary Hide/Isolate tool, 13, 34–35, 
137, 137

Temporary state in phases, 405
temporary visibility, 136–137
testing

dimensional parameters, 215–217, 
215–218

families, 451
titleblocks, 367–369, 368–369

text, 352–353
adding to views, 353–354, 354
dimension text overrides, 126–127, 

126–127
exporting, 292, 491–493
general notes, 355
keynotes, 328–330, 329–330,  

333–334, 333–334
revision schedules, 372
styles, 354–355, 354
titleblocks, 360

Text Notes tab, 353, 353
Text tool, 353, 362
Text Treatment setting, 292, 491–493
thickness of tapered floors, 98, 98
3D CAD files, exporting, 489–493, 

489–490, 492
3D Control objects, 208, 208
3D models

exporting, 292
massing tools. See massing

3D View tool, 197
3D views

dimensional editing, 209, 210
orthographic, 42
rendering, 251, 251
stairs, 104
steering wheel, 20, 20

3ds Max, exporting to, 494, 494
Title Case, 433
Title On Sheet setting, 22, 145
Titleblock Add Text.rfa family, 362
Titleblock.dwg file, 361
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Titleblock RS.rfa family, 370
titleblocks, 8, 360

creating, 360–364, 361–363
loading and testing, 367–369, 

368–369
revision schedules, 370–373, 370–373
shared parameters, 365–367, 

365–366
sheets, 374, 374

toolbars, 6
tooltips, 8, 8
Top Constraint setting, 70, 84
Top Extension Distance setting, 70
Top is Attached setting, 70
Top Level setting, 246
Top Offset setting, 70
Top plane, 152–153
torn-off panels, 6, 6
Tour Building wheel, 19
Tower Mass.rvt file, 203
transparency

applying, 27, 28
By Host View, 275
filters, 31

Transparency setting, 275
Transparent setting, 31, 151
Trim/Extend Multiple Elements tool, 61
Trim/Extend To A Corner tool, 61
trimming objects, 60–61, 61
True Color (RGB Values) setting, 491
TrueType fonts, 286–287, 354
2D CAD files, exporting, 489–493, 

489–490, 492
2D Steering wheel, 19
type catalogs, 179–180, 179, 446, 446
Type Comments setting, 72
Type Mark setting, 72
Type Of Parameter setting, 213
type parameters, 431
type properties, 10
Type Properties dialog box, 10–11, 11

ceilings, 100
curtain walls, 88, 96, 96
detailing, 340
dimensions, 124–125, 125–126
families, 178
filled regions, 351
floors, 98
keynotes, 331, 331
materials, 266, 266
mullions, 91
sheets, 381, 381
stacked walls, 82–84
text, 354, 354
titleblocks, 362–363
units, 132, 132
walls, 72, 72, 74

Type Selector, 9–10
columns, 64–65
detailing, 339
families, 425
views, 39
walls, 68, 68

types, families, 169
creating, 177–178
names, 447
overview, 446, 446

U
Uncheck All button, 245
Unconnected Height setting, 70, 84
Underlay setting, 22, 142, 142
Underlay Orientation setting, 22,  

142, 142
Ungroup option, 246
Unhide Category option, 25
Unhide Element option, 25
Unhide Hidden Elements panel, 25, 25
units, 10

assumptions, 47
dimensions, 132, 132–133
DWG files, 285

Units setting, 285
Unjoin Geometry tool, 443
Unload option for linked files, 280
unlocking profiles, 217
Unresolved References dialog box,  

278, 278
Update To Face option, 226, 231, 233
updating

face-based modeling elements,  
231, 232

families, 178–179
Upper Limit and Offset option, 301
URL setting for walls, 72
Use Compressed Raster Format option, 

296, 385
Use Current Project option, 476–477
Use Global Setting option, 165
Use Project Settings option, 132, 326
Use Standard Format option, 296, 385

V
variable swing angle, doors with

creating, 452–454, 453–454
nesting, 454–459, 456–459

vertical reference planes, 455
vertices

dimensions, 217, 217–218
editable, 207

View Control bar
curtain walls, 87
functions, 12–13, 12
hidden elements, 25

and Properties palette, 138
Sun Path, 145, 145
visual styles, 268, 268

View Cube, 17–18, 18
View Depth plane, 152–153
View Filters setting, 276
view lists, 74, 74, 321
View Name property, 22
View Object wheel, 19
View panel, 66
View Range feature and dialog box, 147, 

147, 152–157, 152–156
View Range setting, 22, 147, 147, 276
View Reference option, 317
View Scale property, 21, 139
View Scale-To-Detail Level 

Correspondence dialog box, 33, 33
View/Sheet Set tab, 293, 384, 384, 486, 

486, 489, 489
view-specific element, 116
view states for ribbon, 7
View Templates dialog box, 160
viewing dimensions, 53
Viewports tab, 379
views and View tab, 6, 15

3D. See 3D views
adding, 35
callout, 41, 41
crop regions, 33, 34
design options applied to, 395–398, 

395–397
Detail Level property, 140, 140
drafting, 41, 336–337, 336
elevation, 38–39, 38–39
filters, 30
floor and ceiling plans, 35–37, 36–37
keyboard accelerators, 14
keynote files, 329
keynote legends, 332
legends, 42, 42
level of detail, 32–33, 32–33
plan, 37
properties, 138–139

descriptions, 21–22, 21
Extents group, 146–149, 146–149
Graphics group, 139–145, 

139–145
Identity Data group, 145, 145
Phasing and Camera groups, 

149, 149
Visibility/Graphics overrides, 

22–29, 23–26, 28–29
revisions, 466
section, 39–40, 40
selecting, 381
sheets, 373, 375–376, 375, 378–379, 

378–379, 382
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switching, 223
templates, 160–161, 160–161
Temporary Hide/Isolate, 34–35
titleblocks, 370
zoom and pan tools, 16–20, 16–20

Views dialog box, 375, 375
Views In The Model option, 290
Views In The Set option, 290
Views/Sheet Set tab, 295, 295
visibility, 135. See also views and  

View tab
columns, 462–464
concepts, 136–137, 136–137
families, 437, 437, 445–446, 446
filters, 30–32, 30–32, 157–160, 

157–159
level heads, 49
linked files, 161–164, 162–164
mass objects, 185–186, 185–186
object styles, 137–138
View Range feature, 152–157, 

152–156
view templates, 160–161, 160–161
Visibility/Graphics Overrides dialog 

box, 149–152, 150–151
worksets, 164–165, 164–165

Visibility/Graphics Overrides dialog box
design options, 395–396, 395
DWG files, 287
families, 425
filters, 30–32, 31, 157–159, 157, 159
lighting, 256, 257
linked files, 161–163, 162, 273–274, 

273, 277, 287, 287
mass objects, 185
settings, 149–152, 150–151
View Range, 153–156, 154, 156
view templates, 160
visibility concepts, 136
working with, 22–29, 23, 29
worksets, 164–165, 165

Visibility/Graphics Overrides property, 
21, 140, 140

Visibility setting
By Host View, 275
families, 437
filters, 31

Visibility Settings dialog box, 437, 437
Visible In All Views option, 164, 164
Visible In Option setting, 139, 145, 145
Visible In View option, 51
Visible layers option for DWG files, 284
Visible parameter for families, 437, 437
Visual Style options, 12–13, 21, 141, 141
Void Extrusion option, 442
voids

families, 437, 441–442
forms, 203–206, 203–206
selecting, 204

Volume parameter, 70

W
W-Wide Flange.rfa family, 179
Walkthrough tool, 149
Wall button, 66, 66
Wall By Face tool, 228, 228–229
Wall Centerline plane, 67, 67
Wall Closure setting, 426
Wall Edit Profile tool, 79
Wall Join Display property, 22
Wall Opening tool, 79–80, 79
Wall Type Joins property, 143, 143
walls

attaching to roofs, 110, 110,  
112–113, 113

basic, 66–69, 66–69
curtain. See curtain walls
embedding, 81–82, 81–82
families, 65, 225
joins, 77–79, 78, 143, 143
mass, 228, 228–229
openings, 79–81, 79–80
parameters, 69–72, 70–72
profiles, 79–81, 80
room bounding, 71, 71
stacked, 82–84, 83
structure, 73–77, 73–75, 77
temporary dimensions, 120, 120
type properties, 72, 72
windows in, 118, 118

Walls tab, 112, 114
Weak reference planes, 427
Wheel menu, 20
White Point setting, 254

Width parameter for walls, 72
window selections, 50, 50–51
windows

creating, 84–86, 85–86
vs. curtain walls, 81
loadable families, 172, 172
properties, 86
in walls, 118, 118

Wireframe visual style, 12, 141, 141
Work Plane-Based option, 176, 176
Work Plane dialog box, 111, 199, 199
work planes

active, 190–191, 191
revolve forms, 199, 199
specifying, 111

workflow in rendering, 250
Workset control, 13, 13
Workset dialog box, 13
worksets

displaying, 13
linked files, 277, 277
managing, 280
working with, 164–165, 164–165

Worksets dialog box, 280
Worksets tab, 164–165, 277, 277
worksharing groups, 246
Wrapping at Ends setting, 72
Wrapping at Inserts setting, 72

X
X-Ray tool, 220, 221
XPS viewer, 294, 383, 485
Xrefs (external references), 180, 448

Y
Yes/No settings, 445–446, 446

Z
04_Dimension_Baseline Ordinate.rvt 

file, 125
Zoom All To Fit action, 17
Zoom In Region tool, 16–17, 16–17
Zoom Out (2X) action, 17
Zoom Sheet Size action, 17
Zoom To Fit action, 17
Zoom tool, 16, 16
zooms, one-click, 17
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